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Legal Notices
Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, 
Inc.

The software described in this document is furnished under a license agreement. You can obtain a copy of that license by 
visiting Avid's Web site at www.avid.com. The terms of that license are also available in the product in the same directory as 
the software. The software may not be reverse assembled and may be used or copied only in accordance with the terms of the 
license agreement. It is against the law to copy the software on any medium except as specifically allowed in the license 
agreement.

Avid products or portions thereof are protected by one or more of the following United States Patents: 4,970,663; 5,267,351; 
5,309,528; 5,355,450; 5,396,594; 5,440,348; 5,467,288; 5,513,375; 5,528,310; 5,557,423; 5,568,275; 5,577,190; 5,584,006; 
5,640,601; 5,644,364; 5,654,737; 5,715,018; 5,724,605; 5,726,717; 5,729,673; 5,745,637; 5,752,029; 5,754,851; 5,799,150; 
5,812,216; 5,852,435; 5,584,006; 5,905,841; 5,929,836; 5,930,445; 5,946,445; 5,987,501; 6,016,152; 6,018,337; 6,023,531; 
6,058,236; 6,061,758; 6,091,778; 6,105,083; 6,118,444; 6,134,607; 6,141,691; 6,198,477; 6,201,531; 6,223,211; 6,249,280; 
6,269,195; 6,317,158; 6,317,515; 6,330,369; 6,351,557; 6,353,862; 6,357,047; 6,392,710; 6,404,435; 6,407,775; 6,417,891; 
6,426,778; 6,477,271; 6,489,969; 6,512,522; 6,532,043; 6,546,190; 6,552,731; 6,553,142; 6,570,624; 6,571,255; 6,583,824; 
6,618,547; 6,636,869; 6,665,450; 6,678,461; 6,687,407; 6,704,445; 6,747,705; 6,763,134; 6,766,063; 6,791,556; 6,810,157; 
6,813,622; 6,847,373; 6,871,003; 6,871,161; 6,901,211; 6,907,191; 6,928,187; 6,933,948; 6,961,801; 7,043,058; 7,081,900; 
7,103,231; 7,266,241; 7,280,117; RE40,107; D392,269; D396,853; D398,912. Other patents are pending.

This document is protected under copyright law. An authorized licensee of Avid Symphony may reproduce this publication for 
the licensee’s own use in learning how to use the software. This document may not be reproduced or distributed, in whole or in 
part, for commercial purposes, such as selling copies of this document or providing support or educational services to others. 
This document is supplied as a guide for Avid Symphony. Reasonable care has been taken in preparing the information it 
contains. However, this document may contain omissions, technical inaccuracies, or typographical errors. Avid Technology, 
Inc. does not accept responsibility of any kind for customers’ losses due to the use of this document. Product specifications 
are subject to change without notice.

Copyright © 2008 Avid Technology, Inc. and its licensors. All rights reserved.

The following disclaimer is required by Apple Computer, Inc.:
APPLE COMPUTER, INC. MAKES NO WARRANTIES WHATSOEVER, EITHER EXPRESS OR IMPLIED, REGARDING 
THIS PRODUCT, INCLUDING WARRANTIES WITH RESPECT TO ITS MERCHANTABILITY OR ITS FITNESS FOR ANY 
PARTICULAR PURPOSE. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT PERMITTED BY SOME STATES. THE 
ABOVE EXCLUSION MAY NOT APPLY TO YOU. THIS WARRANTY PROVIDES YOU WITH SPECIFIC LEGAL RIGHTS. 
THERE MAY BE OTHER RIGHTS THAT YOU MAY HAVE WHICH VARY FROM STATE TO STATE.

The following disclaimer is required by Sam Leffler and Silicon Graphics, Inc. for the use of their TIFF library:
Copyright © 1988–1997 Sam Leffler 
Copyright © 1991–1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software [i.e., the TIFF library] and its documentation for any purpose 
is hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of 
the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any 
advertising or publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon 
Graphics.

THE SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR 
OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT 
OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, 
DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF 
LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

http://www.avid.com
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The following disclaimer is required by the Independent JPEG Group:
This software is based in part on the work of the Independent JPEG Group.

This Software may contain components licensed under the following conditions:
Copyright (c) 1989 The Regents of the University of California. All rights reserved. 

Redistribution and use in source and binary forms are permitted provided that the above copyright notice and this paragraph 
are duplicated in all such forms and that any documentation, advertising materials, and other materials related to such 
distribution and use acknowledge that the software was developed by the University of California, Berkeley. The name of the 
University may not be used to endorse or promote products derived from this software without specific prior written 
permission. THIS SOFTWARE IS PROVIDED ``AS IS'' AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES, 
INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE. 

Copyright (C) 1989, 1991 by Jef Poskanzer. 

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby 
granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission 
notice appear in supporting documentation. This software is provided "as is" without express or implied warranty. 

Copyright 1995, Trinity College Computing Center. Written by David Chappell. 

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby 
granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission 
notice appear in supporting documentation. This software is provided "as is" without express or implied warranty. 

Copyright 1996 Daniel Dardailler. 

Permission to use, copy, modify, distribute, and sell this software for any purpose is hereby granted without fee, provided that 
the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in 
supporting documentation, and that the name of Daniel Dardailler not be used in advertising or publicity pertaining to 
distribution of the software without specific, written prior permission. Daniel Dardailler makes no representations about the 
suitability of this software for any purpose. It is provided "as is" without express or implied warranty. 

Modifications Copyright 1999 Matt Koss, under the same license as above. 

Copyright (c) 1991 by AT&T. 

Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this 
entire notice is included in all copies of any software which is or includes a copy or modification of this software and in all 
copies of the supporting documentation for such software. 

THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, 
NEITHER THE AUTHOR NOR AT&T MAKES ANY REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE 
MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.

This product includes software developed by the University of California, Berkeley and its contributors.

The following disclaimer is required by Nexidia Inc.:
© 2006 Nexidia.  All rights reserved.

Manufactured under license from the Georgia Tech Research Corporation, U.S.A. Patent Pending.

The following disclaimer is required by Paradigm Matrix:
Portions of this software licensed from Paradigm Matrix.

The following disclaimer is required by Ray Sauers Associates, Inc.:
“Install-It” is licensed from Ray Sauers Associates, Inc. End-User is prohibited from taking any action to derive a source code 
equivalent of “Install-It,” including by reverse assembly or reverse compilation, Ray Sauers Associates, Inc. shall in no event be 
liable for any damages resulting from reseller’s failure to perform reseller’s obligation; or any damages arising from use or 
operation of reseller’s products or the software; or any other damages, including but not limited to, incidental, direct, indirect, 
special or consequential Damages including lost profits, or damages resulting from loss of use or inability to use reseller’s 
products or the software for any reason including copyright or patent infringement, or lost data, even if Ray Sauers Associates 
has been advised, knew or should have known of the possibility of such damages.
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The following disclaimer is required by Videomedia, Inc.:
“Videomedia, Inc. makes no warranties whatsoever, either express or implied, regarding this product, including warranties with 
respect to its merchantability or its fitness for any particular purpose.”

“This software contains V-LAN ver. 3.0 Command Protocols which communicate with V-LAN ver. 3.0 products developed by 
Videomedia, Inc. and V-LAN ver. 3.0 compatible products developed by third parties under license from Videomedia, Inc. Use 
of this software will allow “frame accurate” editing control of applicable videotape recorder decks, videodisc recorders/players 
and the like.” 

The following disclaimer is required by Altura Software, Inc. for the use of its Mac2Win software and Sample 
Source Code:
©1993–1998 Altura Software, Inc.

The following disclaimer is required by Ultimatte Corporation:
Certain real-time compositing capabilities are provided under a license of such technology from Ultimatte Corporation and are 
subject to copyright protection.

The following disclaimer is required by 3Prong.com Inc.:
Certain waveform and vector monitoring capabilities are provided under a license from 3Prong.com Inc.

The following disclaimer is required by Interplay Entertainment Corp.:
The “Interplay” name is used with the permission of Interplay Entertainment Corp., which bears no responsibility for Avid 
products.

This product includes portions of the Alloy Look & Feel software from Incors GmbH.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

© DevelopMentor

This product may include the JCifs library, for which the following notice applies:
JCifs © Copyright 2004, The JCIFS Project, is licensed under LGPL (http://jcifs.samba.org/). See the LGPL.txt file in the Third 
Party Software directory on the installation CD.

Avid Interplay contains components licensed from LavanTech. These components may only be used as part of and in 
connection with Avid Interplay.

Attn. Government User(s). Restricted Rights Legend
U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or 
“commercial computer software documentation.” In the event that such Software or documentation is acquired by or on behalf 
of a unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms 
of the License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks
888 I/O, Adrenaline, AirPlay, AirSPACE, AirSPACE HD, AirSpeed, ALEX, Alexis, AniMatte, AudioSuite, AudioVision, AutoSync, 
Avid, Avid Advanced Response, Avid DNA, Avid DNxcel, Avid DNxHD, AVIDdrive, AVIDdrive Towers, Avid DS Assist Station, 
Avid ISIS, Avid Learning Excellerator, Avid Liquid, Avid Mojo, AvidNet, AvidNetwork, Avid Remote Response, AVIDstripe, 
Avid Unity, Avid Unity ISIS, Avid Xpress, AVoption, AVX, CamCutter, CaptureManager, ChromaCurve, ChromaWheel, 
Conectiv, CountDown, DAE, Dazzle, Deko, DekoCast, D-Fi, D-fx, DigiDelivery, Digidesign, Digidesign Audio Engine, 
Digidesign Intelligent Noise Reduction, DigiDrive, Digital Nonlinear Accelerator, DigiTranslator, DINR, DNxchange, do more, 
D-Verb, Equinox, ExpertRender, Face Robot, FACE ROBOT, FastBreak, Fast Track, FieldPak, Film Composer, FilmScribe, 
FluidMotion, FXDeko, HIIP, HyperSPACE, HyperSPACE HDCAM, IllusionFX, Image Independence, iNEWS, 
iNEWS ControlAir, Instinct, Interplay, Intraframe, iS9, iS18, iS23, iS36, ISIS, IsoSync, LaunchPad, Lightning, Lo-Fi, 
Magic Mask, make manage move | media, Marquee, Matador, Maxim, MCXpress, Media Browse, Media Composer, 
MediaDock, MediaDock Shuttle, Media Fusion, Media Illusion, MediaLog, Media Reader, Media Recorder, MEDIArray, 
MediaShare, MediaStream, Meridien, MetaFuze, MetaSync, MicroTrack, MissionControl, MovieBox, NaturalMatch, Nearchive, 
NetReview, NewsCutter, Nitris, OMF, OMF Interchange, OMM, Open Media Framework, Open Media Management, PCTV, 
Pinnacle MediaSuite, Pinnacle Studio, Pinnacle Systems, ProEncode, Pro Tools, QuietDrive, Recti-Fi, RetroLoop, rS9, rS18, 
SalesView, Sci-Fi, ScriptSync, SecureProductionEnvironment, Show Center, Softimage, Sound Designer II, SPACE, 
SPACEShift, SpectraGraph, SpectraMatte, Sputnik, SteadyGlide, SubCap, Symphony, SynchroScience, TARGA, Thunder, 
Thunder Station, TimeLiner, Torq, Trilligent, UnityRAID, Vari-Fi, Velvet, Video RAID, Video Slave Driver, VideoSPACE, Xdeck, 
and X-Session are either registered trademarks or trademarks of Avid Technology, Inc. in the United States and/or other 
countries.

http://www.apache.org/
http://jcifs.samba.org/
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Adobe and Photoshop are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States 
and/or other countries. Apple and Macintosh are trademarks of Apple Computer, Inc., registered in the U.S. and other 
countries. Windows is either a registered trademark or trademark of Microsoft Corporation in the United States and/or other 
countries. All other trademarks contained herein are the property of their respective owners.

Footage
Arri — Courtesy of Arri/Fauer — John Fauer, Inc.
Bell South “Anticipation” — Courtesy of Two Headed Monster — Tucker/Wayne Atlanta/GMS.
Canyonlands — Courtesy of the National Park Service/Department of the Interior.
Eco Challenge British Columbia — Courtesy of Eco Challenge Lifestyles, Inc., All Rights Reserved. 
Eco Challenge Morocco — Courtesy of Discovery Communications, Inc.
It’s Shuttletime — Courtesy of BCP & Canadian Airlines. 
Nestlé Coffee Crisp — Courtesy of MacLaren McCann Canada. 
Saturn “Calvin Egg” — Courtesy of Cossette Communications. 
“Tigers: Tracking a Legend” — Courtesy of www.wildlifeworlds.com, Carol Amore, Executive Producer.
"The Big Swell" — Courtesy of Swell Pictures, Inc.
Windhorse — Courtesy of Paul Wagner Productions.

Arizona Images — KNTV Production — Courtesy of Granite Broadcasting, Inc., 
Editor/Producer Bryan Foote.
Canyonlands — Courtesy of the National Park Service/Department of the Interior.
Ice Island — Courtesy of Kurtis Productions, Ltd.
Tornados + Belle Isle footage — Courtesy of KWTV News 9.
WCAU Fire Story — Courtesy of NBC-10, Philadelphia, PA.
Women in Sports – Paragliding — Courtesy of Legendary Entertainment, Inc.

GOT FOOTAGE?
Editors — Filmmakers — Special Effects Artists — Game Developers — Animators — Educators — Broadcasters — Content 
creators of every genre — Just finished an incredible project and want to share it with the world?

Send us your reels and we may use your footage in our show reel or demo!*

For a copy of our release and Avid’s mailing address, go to www.avid.com/footage.

*Note: Avid cannot guarantee the use of materials submitted.

Avid Symphony Conform and Finishing Guide • 0130-07975-01 • June 2008

http://www.wildlifeworlds.com
http://www.avid.com/footage
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Using This Guide

This guide contains the task-oriented instructions, conceptual information, and reference 
material you need to use the conform and finishing features of your Avid Symphony™ 
system. These features include project transfer, HD support, tracking and stabilization 
parameters, and Symphony color correction.

This guide is intended for all users who need information for the conform and finishing 
processes..

Unless noted otherwise, the material in this document applies to the Windows® XP, 
Windows Vista®, and Mac OS® X operating systems.The majority of screen shots in this 
document were captured on a Windows system, but the information applies to both Windows 
and Mac OS X systems. Where differences exist, both Windows and Mac OS X screen shots 
are shown.

n The documentation describes the features and hardware of all models and applies to both 
the Windows and Mac OS X operating systems. Your system might not contain certain 
features and hardware that are covered in the documentation, and might not be available on 
both Windows and Mac OS X.

Symbols and Conventions

Avid documentation uses the following symbols and conventions:

Symbol or Convention Meaning or Action

n A note provides important related information, reminders, 
recommendations, and strong suggestions.

c A caution means that a specific action you take could cause harm to 
your computer or cause you to lose data.

w A warning describes an action that could cause you physical harm. 
Follow the guidelines in this document or on the unit itself when 
handling electrical equipment.
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If You Need Help

If you are having trouble using your Avid product:

1. Retry the action, carefully following the instructions given for that task in this guide. It 
is especially important to check each step of your workflow.

2. Check the latest information that might have become available after the documentation 
was published:

- If the latest information for your Avid product is provided as printed release notes, 
they ship with your application and are also available online.

If the latest information for your Avid product is provided as a ReadMe file, it is 
supplied on your Avid installation CD or DVD as a PDF document 
(README_product.pdf) and is also available online.

You should always check online for the most up-to-date release notes or ReadMe 
because the online version is updated whenever new information becomes 
available. To view these online versions, select ReadMe from the Help menu, or visit 
the Knowledge Base at www.avid.com/readme.

> This symbol indicates menu commands (and subcommands) in the 
order you select them. For example, File > Import means to open the 
File menu and then select the Import command.

This symbol indicates a single-step procedure. Multiple arrows in a list 
indicate that you perform one of the actions listed.

(Windows), (Windows 
only), (Macintosh), or 
(Macintosh only)

This text indicates that the information applies only to the specified 
operating system, either Windows or Macintosh OS X.

Bold font Bold font is primarily used in task instructions to identify user interface 
items and keyboard sequences.

Italic font Italic font is used to emphasize certain words and to indicate variables.

Courier Bold font Courier Bold font identifies text that you type.

Ctrl+key or mouse action Press and hold the first key while you press the last key or perform the 
mouse action. For example, Command+Option+C or Ctrl+drag.

Symbol or Convention Meaning or Action

http://www.avid.com/readme
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3. Check the documentation that came with your Avid application or your hardware for 
maintenance or hardware-related issues.

4. Visit the online Knowledge Base at www.avid.com/onlinesupport. Online services are 
available 24 hours per day, 7 days per week. Search this online Knowledge Base to find 
answers, to view error messages, to access troubleshooting tips, to download updates, 
and to read or join online message-board discussions.

Accessing the Online Library

The Online Library for your Avid editing application contains all the product documentation 
in PDF format, including a Master Glossary of all specialized terminology used in the 
documentation for Avid products.

The Online Library for your Avid editing application is installed along with the application 
itself.

n You will need Adobe® Reader® to view the PDF documentation online. You can download 
the latest version from the Adobe web site.

To access the Online Library, do one of the following:

t From your Avid editing application, select Help > Online Library

t (Windows only) From the Windows desktop, select Start > All Programs > Avid > Avid 
editing application > Online Library

t Browse to the Online Library folder, and then double-click the MainMenu file.

The Online Library folder is in the same location as the application itself, for example:

(Windows) C:\Program Files\Avid\Avid editing application\Online Library

(Macintosh) MacintoshHD/Applications/Avid editing application/Online Library

Accessing the Goodies Folder

Avid supplies a Goodies folder located on the editing application DVD. Access the Goodies 
folder by browsing the DVD. This folder contains programs and files you might find useful 
when trying to perform functions beyond the scope of your Avid editing application.

http://www.avid.com/onlinesupport
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The information in the Goodies folder is provided solely for your reference and as 
suggestions for you to decide if any of these products fit into your process. Avid is not 
responsible for the manufacture, support, or sales of these products. Avid is also not 
responsible for any loss of data or time, or any other adverse results related to the use of 
these products. All risks of using such products or accessing such Web sites are entirely your 
own. The Web sites listed in the Goodies folder are not under the control of Avid, and Avid 
is not responsible for their content, any changes or updates to them, or the collection of any 
personal data or information by the operators of such Web sites. All information and product 
availability is subject to change without notice.

How to Order Documentation

To order additional copies of this documentation from within the United States, call Avid 
Sales at 800-949-AVID (800-949-2843). If you are placing an order from outside the United 
States, contact your local Avid representative.

Avid Training Services

Avid makes lifelong learning, career advancement, and personal development easy and 
convenient. Avid understands that the knowledge you need to differentiate yourself is always 
changing, and Avid continually updates course content and offers new training delivery 
methods that accommodate your pressured and competitive work environment.

To learn about Avid's new online learning environment, Avid Learning Excellerator™ 
(ALEX), visit http://learn.avid.com.

For information on courses/schedules, training centers, certifications, courseware, and 
books, please visit www.avid.com/training or call Avid Sales at 800-949-AVID 
(800-949-2843).

http://learn.avid.com
http://www.avid.com/training


1 Section I
Conforming and Mastering

The following chapters contain information to help you conform and master
your project:

• Conforming and Transferring Projects

• Working with HD Media
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1 Conforming and Transferring Projects

Avid offers a range of editing applications for editing film, video, and audio. Within the Avid 
family of editing and finishing products, you can work at the system most appropriate for 
your task. When you are ready for the next step in the process, you can easily move your 
work to another system. For example, you might start your project on a Media Composer® 
offline system and then move it to a Symphony or Avid DS online system when you are 
ready for finishing. You can also send audio media to a Digidesign® Pro Tools® system and 
edit the finished audio into the final sequence.

The following sections contain information about conforming and transferring projects.

• Compatibility Between Applications

• Preparations for Conforming

• Conforming Workflow

• Conforming Sequences with Color Correction

• Transferring Project and Media Files

Compatibility Between Applications
Avid editing products are designed so you can easily move projects and media from one 
system to another and preserve your edits and effects. In a typical offline-to-online 
workflow, you create a program on one Avid editing system—choosing the footage, making 
edits, adding effects—and then transfer your program to another Avid system for final 
finishing. This re-creation of the offline project on an online system is called conforming, 
and Avid’s solution is called Total Conform. Finishing might involve recapturing in a final 
resolution, making color corrections, adjusting effects, and outputting the final master. 

Alternatively, you can use the same media for offline and online editing. You can access the 
media in several ways, such as sharing media in an Avid Unity™ environment, or 
transferring removable drives from one system to another. The clips and sequences 
automatically link to the media, and you can complete the final finishing.
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n Specific information for transferring projects to Avid DS is contained in the Avid DS 
Conform Guide, which is available from the Avid DS Support Center or the Avid Customer 
Support Knowledge Base. To access the Knowledge Base, go to 
www.avid.com/onlinesupport.

If you are moving from one Avid editing product to another in the current release, or from a 
product in a previous release to a product in the current release, you can move project files 
and media without losing any of your work.

However, when you move projects from a product in the current release to a product in the 
previous release, some effects that have been created with features that are new for a 
particular release do not appear, or appear as unknown effects.

Preparations for Conforming

The following topics provide information that you should review before you begin the 
transferring and conforming process described in “Conforming Workflow” on page 30.

If possible, work with the offline editor to plan the online edit. Planning the online edit 
makes the online session easier and more efficient.

Delivery Requirements for Final Masters

The requirements for your final masters determine factors such as the project type used 
during the offline edit. Ideally, the offline edit is done with the online edit in mind.

The most important delivery requirements are the formats and frame rates. A broadcast 
network might require a range of formats: NTSC, PAL, and HD, at 4:3 and 16:9. Avid’s 
Universal Mastering provides you with the ability to output multiple versions from the same 
source file—see “Step 10: Create the Final Masters” on page 40. Make sure that the offline 
edit is done at the same frame rate, or a compatible frame rate, as the online edit.

If you are delivering an HD project, and the offline will be done in SD, consider how the SD 
media will be downconverted. If the project requires complex effects, use an anamorphic 
downconvert, rather than center-cut or letterbox, to reduce the adjustments required in the 
final conform.

http://www.avid.com/onlinesupport
http://www.avid.com/onlinesupport
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Offline Formats for HD

If your project requires final mastering in HD, use the corresponding SD project for offline 
editing, as listed in the following table.

When you start the online session, you can create a new project in the final format, or use the 
original project and change the project format. See “Understanding Options for Changing 
the Project Format” on page 64.

File Transfer for the Online Session

Before you begin moving project files between Avid editing applications, consider the 
following.

• What files will you transfer? Determine if you need to transfer project information, 
video media, audio media, or all three. See “Step 1: Transfer Files” on page 30.

• How will you transfer the files? Determine the most appropriate method for 
transferring your project files. See “Devices and Methods for Transferring Files” on 
page 48.

HD Online SD Offline

720p/23.976 23.976p NTSC

720p/25 25p PAL

720p/29.97 30i NTSC

720p/50 25p PAL

720p/59.94 30i NTSC

1080p/23.976 23.976p NTSC or 24p NTSC

n 24p NTSC sequences require additional conversion. See “Converting a 24p 
NTSC Sequence to 1080p/23.976” on page 69.

1080p/24 24p NTSC or 24p PAL

1080p/25 25p PAL

1080p/29.97 30i NTSC

1080i/50 25i PAL

1080i/59.94 30i NTSC
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System Compatibility for the Online Session

Make sure that files transfer correctly between editing systems, and that both systems 
include the necessary applications. Consider the following:

Frame Rates

Make sure both editing systems support the same frame rates. For example, some offline 
systems support 24p projects and some do not. You might require a 24p project to deliver 
multiple output formats.

File Naming

To make it easier to move files between products and across platforms, use the following 
guidelines when naming files: 

• Do not use the following characters in project, bin, or other file names:

/ \ : * ? ” < > | 

The Windows system does not recognize these characters in file names and substitutes 
other characters, possibly making the file name unrecognizable.

n You can use these characters in bin names if you are sharing bins between Symphony, Media 
Composer, Avid Xpress, or NewsCutter® products. You cannot use these characters in bins 
you share with Avid DS or Pro Tools.

• Do not add spaces at the beginning or end of a file name. The Windows system displays 
such files but might be unable to open them.

• Do not use a period at the end of a file name. The Windows system displays such files 
but might be unable to open them.

• On Macintosh® systems, beginning with v7.2, you can enable a setting in your Avid 
editing application that prevents you from using restricted characters in file names. This 
setting automatically adds the correct file name extensions to files for your project. The 
Use Windows Compatible File Names setting in the General Settings dialog box is 
selected by default. With this setting selected, the file name extension .avp is added to 
project files and .avb is added to bin files when they are saved. These file name 
extensions are also attached to existing files.



Preparations for Conforming

27

Title Fonts

If the project includes titles and you are moving between Macintosh and Windows systems, 
make sure you have the same font with exactly the same name (preferably from the same 
supplier) on both the Macintosh and Windows systems. Check the font carefully because the 
same font can have slightly different names. For example, Times New Roman on the 
Macintosh system is named Times New Roman Regular on the Windows system.

If you open a title on the online system that does not have a matching font, a dialog box 
opens that allows you to substitute the font in the title with a font that exists on your system. 

For best results, use OpenType® fonts, which reduce problems when transferring projects 
from one platform to another.

AVX Plug-Ins

If your project contains AVX™ plug-in effects and you are moving across platforms, make 
sure the same plug-ins are available on both the Macintosh and Windows systems. If the 
same AVX plug-in effect is not available, you can mix down or render the effect to a 
high-quality resolution and then transfer it using an OMFI or an AAF file. However, you 
cannot change the parameters of the effect.

Preparing Graphics for the Online Session

The most critical step when preparing graphics for online is to make sure that the elements 
you are going to import are created correctly. The following table summarizes various 
requirements.

Aspect Requirement Notes

Frame size
(4:3)

Square pixels:
648 x 486 (NTSC)
640 x480 (NTSC DV)
768 x 576 (PAL)

These are the preferred sizes for NTSC and PAL. 720 x 540 can also 
be used, in some situations, for both NTSC and PAL. These are 
stored by the application as non-square pixels. For more 
information, see “Preparing Graphics Files for Import” in the Help.

Frame size
(16:9)

Square pixels:
864 x 486 (NTSC 
anamorphic)
1024 x 576 (PAL 
anamorphic)
1280 x 720 (HD)
1920 x 1080 (HD)

Preferred sizes. SD media is stored by the application as 
non-square pixels.
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Preparing Effects for the Online Session

In general, effects from older systems are automatically conformed by newer systems. 
However, be aware of the following issues:

• If you’re working in an offline SD project with complex effects and you plan to conform 
as HD, the media should be downconverted anamorphically. Media downconverted as 
4:3 or letterbox causes problems when you conform effects such as picture-in-picture.

• If you are conforming a sequence that includes effects created with Avid FX, mix down 
or render the effects to a high-quality resolution on the offline system and then transfer 
them using an OMFI or an AAF file. You cannot adjust an Avid FX effect on a 
Symphony system.

• Wipes that include borders that were created in Media Composer Adrenaline v2.2.x or 
earlier, or Avid Xpress Pro v5.2.x or earlier do not conform precisely. In these versions, 
borders for the wipes end on screen; in Symphony borders end off screen.

Alpha channel White foreground 
(transparent), black 
background (opaque)

This is the standard used by graphics, animation, and compositing 
packages. The graphics need to have the alpha channel inverted on 
import.

Color mode RGB
ITU-R 601
ITU-R 709

Other formats, including CMYK, can cause import errors.
ITU-R 601 is used for SD and ITU-R 709 is used for HD. In HD 
projects, your Avid editing application automatically converts the 
media.

File format Various Your Avid editing application accepts many file formats for input. 
TIFF (.tif) and PICT (.pct) are commonly used formats. See “Import 
Specifications for Supported Graphics File Formats” in the Help.

File field order Odd (Upper field first)
Even (Lower field 
first)

For interlaced media, your Avid editing application uses the 
following order: 

• NTSC (601 and DV): lower field first

• PAL 601: upper field first

• PAL DV: lower field first

• HD Interlaced: upper field first

If the field order of the graphic is not correct, select the field order of 
the graphic during import and the application reverses the fields 
appropriately. 

Field order does not apply to progressive media. See “Field 
Ordering in Graphic Imports and Exports” in the Help.

Aspect Requirement Notes
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Preparing Titles for the Online Session

You have the option to save titles in multiple aspect ratios. If you’re working with 
anamorphically downconverted media, save the title as 16:9. After opening the sequence in 
an HD project, re-create title media, see “Step 7: Re-create Title Media” on page 35. This 
method lets you correctly create titles that fit in the 4:3 center cut or that extend beyond the 
center cut.

If you’re working with media downconverted to center cut or letterbox, save the title as 4:3. 
In this case the titles will appear centered, within the 4:3 center cut.

n If you are working in 23.976p, 24p, or 25p projects, you can output your project in both 
NTSC and PAL video formats, and in both 4:3 and 16:9 aspect ratios. You need to save a 
title at each aspect ratio you need for your output requirements, but video format conversion 
is handled automatically by your system’s hardware. For more information, see “Saving 
Multiple Format Titles” in the Help.

Preparing Audio for the Online Session

Your project might involve audio that is exported from the offline system, sweetened in an 
audio application such as Pro Tools, and imported into the online system, see “Step 5: 
Import and Lay in the Final Audio Mix” on page 34.

If you are sharing files with Pro Tools, you can use the WAVE or AIFF-C format. Pro Tools 
v6.9 or later also supports MXF files For more information, see “Transferring Audio Files” 
on page 44.

n DigiTranslator™ v2.0 is required on the Pro Tools system for import and export of OMF and 
AAF files.

You can also transfer files to Pro Tools through Interplay. For more information, see “Using 
Pro Tools and Interplay” in Avid Interplay Best Practices.

If you are sharing files between Macintosh and Windows systems, avoid using 
Sound Designer II™, which is a Macintosh format. For more information, see “Transferring 
Sound Designer II Audio Files from Macintosh Systems” on page 45.
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Conforming Workflow

The following topics provide information to help you transfer projects from one Avid editing 
system to another and conform the sequence to create one or more finished masters. These 
steps are based on an offline-to-online workflow that uses Symphony as the online system. 
For projects that you plan on finishing on an Avid DS online system, refer to the product 
documentation that comes with Avid DS.

Before you start the process described in the following topics, you should review the 
information provided in “Preparations for Conforming” on page 24 to ensure that your 
offline materials are ready for transferring and conforming.

• Step 1: Transfer Files

• Step 2: Open the Project

• Step 3: Measure the Video Signal

• Step 4: Recapture Media

• Step 5: Import and Lay in the Final Audio Mix

• Step 6: Batch Import Graphics

• Step 7: Re-create Title Media

• Considerations when Re-creating Title Media

• Redefining a Font Replacement

• Step 8: Refine Effects and Perform Color Correction

• Step 9: Render Effects as Needed

• Step 10: Create the Final Masters

For specific information about HD workflows, see “Working with HD Media” on page 55. 
For specific information about film-based workflows, see “Working in a Film Project” in the 
Help.

n If you are transferring projects and media but not performing an online edit, refer to 
“Transferring Project and Media Files” on page 43.

Step 1: Transfer Files

There are several different methods for transferring project files and media files, depending 
on the requirements of your project.



Conforming Workflow

31

Transferring Project Information Only

Project information includes the information about the components of your project (such as 
settings, bins, master clips, edited sequences, and so on), but does not include the media for 
these components. This project information is sometimes called metadata. Transfer only 
project information if you are planning to recapture media (for example, from an offline 
resolution to an online resolution) or relink media in an Avid Unity environment. 

Options for transferring project information include:

• Transferring a project folder from one desktop to another. This option allows you to 
transfer complete project information, but you need to use the desktop operating system 
to copy and transfer files. See “Transferring Project Files and Media Files Using 
Nonshared Storage” on page 46.

• Creating an OMFI or an AAF file (composition only). This option allows you to export 
from the Avid editing application, but is limited to a single sequence or master clip. See 
“Exporting OMFI and AAF Files” in the Help.

• Sharing project information in an Avid Unity environment. See “Transferring a Project 
Using Shared Storage” on page 46.

• Creating an AFE file. This option allows you to transfer complete project information, 
but is currently limited to transfers to an Avid DS system. See “Exporting Projects and 
Bins Using AFE Files” in the Help.

Transferring Project Files and Media Files

Transfer project files and media files if you want to transfer media files to another Avid 
editing system, for example, if the offline sequence uses a broadcast-quality resolution and 
you want to add Symphony color correction. Options include:

• Transferring a project folder along with a removable media drive. This option allows 
you to transfer complete project information, but you need to use the desktop operating 
system to copy and transfer files. See “Transferring Project Files and Media Files Using 
Nonshared Storage” on page 46.

• Creating an OMFI or an AAF file that references a removable media drive. This option 
allows you to work within the Avid editing application, but is limited to a single 
sequence or master clip. You can link to media files that you have copied or 
consolidated to a single drive. See “Exporting OMFI and AAF Files” in the Help.

• Creating an OMFI or an AAF file with embedded media. This option allows you to 
create a single OMF or AAF file, which you can consolidate onto a single drive.

If you want to transfer audio media to a digital audio workstation, such as a Pro Tools, 
system, see “Transferring Audio Files” on page 44 or “Using Pro Tools and Interplay” in 
Avid Interplay Best Practices.
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Step 2: Open the Project

Depending on the project requirements and your personal preference, you can open a project 
in the following ways:

• Start a new project.

- Use the Select Project dialog box to create a new project with the format you want 
to use for final mastering. Starting a new project lets you configure the project 
settings and eliminate any errors or problems caused by the offline project’s 
settings.

You can then use the File > Open Bin command to open the bins that you’ve 
transferred from the original project and load the final sequence. If you are finishing 
an HD project, and the offline project was done in SD, use the Modify command to 
change the sequence format, see “Understanding Options for Modifying the 
Sequence Format” on page 66.

- If you transferred an OMFI or an AAF file with embedded media, create a new 
project and bin and import the OMFI or the AAF file. The sequence automatically 
links to the media.

n If the clips and sequences do not link automatically, select File > Refresh Media Directories.

• Open a transferred or shared project.

- If you transferred project files, the original project appears in your list of projects. 
(Depending on the location into which you copied the files, you might need to use 
the Browse button in the Select Project dialog box to locate the project.) Open the 
project, and all project settings and bins are displayed.

- If you transferred both project files and media, and your media is compatible, the 
original project appears in your list of projects. Open the project and all project 
settings and bins are displayed. Clips and sequences automatically link to the 
media.

- If you are finishing an HD project, and the offline project was done in SD, change 
the project format, see “Understanding Options for Changing the Project Format” 
on page 64 and then change the sequence format. See “Understanding Options for 
Modifying the Sequence Format” on page 66.

- For information about working with shared projects and media in an Avid Unity 
environment, see “Transferring a Project Using Shared Storage” on page 46.
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Step 3: Measure the Video Signal

When working with analog material, measure the actual video signal during both input and 
output to make sure the signal does not exceed the broadcast specification.

n For SDI or HD-SDI formats, you cannot adjust input or output levels by using the video 
controls in your Avid editing application. For HD media, you can calibrate only HD 
component output, which is usually used for monitors.

For more information, see the following topics in the Help: 

• Preparing for Video Input

• Calibrating for Video Output

• Advanced Video Output Calibration

c Symphony requires that the deck and the Avid Nitris hardware be genlocked to the 
same timing source when capturing or outputting. For more information, see 
“Selecting the Sync Source for Capture” and “Selecting the Sync Source for Output” in 
the Help.

Step 4: Recapture Media

If you did not transfer media, or you need to recapture your media at a higher resolution, use 
one of the following options:

• Recapture master clips: Offers complete flexibility to make revisions, but takes the 
most time and disk space.

• Recapture a sequence: Provides a one-step process, but limits your options during 
capturing. You can make revisions using only assigned handle lengths.

• Decompose the sequence and recapture the new clips: Captures only enough media 
to re-create the sequence. You can specify the length of handles, which you can use for 
minor revisions. This method is more flexible than capturing from the sequence because 
new clips are created, which you can sort and selectively capture. This method uses 
minimal storage and can be one of the fastest methods for recapturing.

In most cases, do not decompose clips created from imported graphics, which is an 
option in the Decompose dialog box. These decomposed clips might cause problems 
when batch importing, particularly if the sequence uses only part of an 
imported animation.
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• Use the Show Reference Clips option: Lets you reveal the source clips of a sequence 
in a single bin by selecting the “Show reference clips” option in the Bin Display dialog 
box, and then recapturing the source clips. This method can be faster than recapturing a 
sequence or decomposing if the lengths of the new audio and video clips created differ 
from the original master clips. Because two passes are necessary to capture audio and 
video from a single source if the lengths are not the same, it is sometimes faster to 
capture a slightly longer master clip than to capture the new clips once for audio and 
once for video. This method also gives you more opportunity for revisions. However, 
this method uses more disk space and capturing can take longer. It can be a good 
compromise between capturing all the original clips and capturing only the clips needed 
to re-create the source.

For instructions on recapturing, see “Recapturing Your Material” in the Help.

n When you recapture from SD source tapes, Avid recommends that you readjust the video 
levels. You can transfer video input settings from another system, but the existing settings 
have been calibrated to a different set of hardware and might not operate properly. 

If you are capturing serial digital video (SDI), your Avid editing application ignores the 
video input settings.

Step 5: Import and Lay in the Final Audio Mix

In most cases, the final audio mix was done as part of the offline edit or was done by an 
audio editor on a digital audio workstation, possibly using Digidesign Pro Tools. In either 
case, import the OMFI or the AAF file. For more information, see “Transferring Audio 
Files” on page 44, “Importing Files” in the Help, and “Using Pro Tools and Interplay” in 
Avid Interplay Best Practices.

After importing the audio mix, calibrate the audio hardware and channels as described in the 
following topics in the Help:

• “Changing the Audio Hardware Calibration Setting”

• “Calibrating Audio Input Channels”

• “Calibrating Audio Output Channels”

Then use the Audio tool to monitor the audio levels. See “Understanding the Audio Tool” in 
the Help.

You can quickly check the peak values of the sequence. See “Using the Console Window to 
Check Audio Levels” in the Help.
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Step 6: Batch Import Graphics

If you are working with master clips or sequences that contain imported material, you can 
use the Batch Import command to reimport the source files. For example, you might want to:

• Upgrade the video resolution of the imported files to an online resolution.

• Replace low-quality material with high-quality material finished with other 
applications.

• Create new media files when the media files are lost or accidentally deleted.

c Reimporting requires your original source files. Do not delete the media files for 
imported files unless you have access to the source files.

Here are two tips for making batch importing easier:

• Placing a “graphics” folder inside the project folder of your offline project makes the 
batch import process easier because the path will be the same, or at least faster to find.

• It is easy to edit revised graphics into your project by giving them the same names as the 
original graphics, copying the revised graphics to the folder that contains the original 
graphics, and batch importing the revised graphics. You can also edit new graphics into 
your project by deleting the media for your original graphics, batch importing your 
sequence, and pointing the old clips to the revised graphics files. 

For instructions on batch importing, see “Reimporting Files” in the Help.

Step 7: Re-create Title Media

After you transfer or import all files, you might need to re-create title media if you did not 
render the titles, or if you want to change the resolution of the titles.

For more information related to the re-creation of title media, see “Considerations when 
Re-creating Title Media” on page 36.

To re-create the title media:

1. Select all video tracks that contain titles.

2. Mark an IN point and an OUT point to create a segment that includes all your titles.
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3. Select Clip > Re-create Title Media.

- If you have the same font on both systems, the equivalent font appears 
automatically.

Because the mapping process changes the exact appearance of the font, check your 
titles carefully. It might be easier to check your titles from the bin than from the 
sequence.

- If a title opens and the system does not recognize the font, you see a dialog box that 
allows you to substitute the font in the title for one that is installed on the system. 

This replacement creates a font mapping, which is saved as a Site setting. For 
information on changing the font mapping, see “Redefining a Font Replacement” 
on page 37.

If more than one font in the title needs replacement, the dialog box remains open 
after you click OK, and a new message identifies the next font that needs 
replacement. 

4. Select a drive and resolution for the re-created title media, and click OK.

For more information, see “Re-creating Title Media” in the Help.

Considerations when Re-creating Title Media

You should be aware of the following when re-creating title media:

• For best results, use OpenType fonts, which reduce problems when transferring projects 
from one platform to another.

• If you are moving across platforms and the transferred title text uses a single style (the 
same font and type size), the title text aligns as closely as possible to its original 
position. The size of the text bounding box adjusts to accommodate the differences 
between the Macintosh and Windows versions of the font used. You might see a 
changed leading value in the Title Tool leading field to adjust for multiline text.

Because the Macintosh and Windows systems handle fonts differently, you might see 
variations in the appearance of titles between the two systems. If necessary, adjust the 
size of the bounding box, leading values, or kerning information. 

For example, bounding boxes that were set on a Macintosh system might appear in a 
different size on a Windows system. Some clipping of the new text might occur and 
words can be lost. If this clipping occurs, you need to open the title, select the text box, 
and manually change the size of the text box or the size of the fonts to display all the 
text. 

For more information on differences between the Macintosh and Windows versions of a 
font, contact the font supplier.



Conforming Workflow

37

• If the original system used any applications to manipulate font display (such as Adobe 
Type Manager®), the enhancements these applications provided on the original system 
(such as character anti-aliasing or character spacing) will not transfer to a system not 
using the application.

• Titles created in an offline project with anamorphically downconverted media should be 
saved as 16:9. See “Preparing Titles for the Online Session” on page 29.

Redefining a Font Replacement

You can redefine a font replacement at any time. However, your new font choice is applied 
only to a title currently in the Title tool and future replacements. It does not affect the font 
replacement information in titles you have worked with previously.

Font relationships are saved as a site settings file named AvidFontSub.avt. This file is located 
in the Settings folder, which is located in the Avid Symphony folder on your internal drive.

Once you have defined a font replacement, your Avid editing application uses that definition 
across all projects and all users of the system. If you want to switch to a different 
replacement font for a title, you must redefine the font replacement. 

n If you replace the font for a title and return that title to an Avid editing application on a 
Macintosh system, the new font information will be associated with the title. You must 
reapply the Macintosh font to restore the title to its original Macintosh style.

To redefine a font replacement:

1. Open a title in the Title tool.

2. Select Object > Font Replacement.

The Font Replacement dialog box opens. 

3. Click the Unknown Fonts menu on the left, and select the original font.

4. Click the Available Fonts menu on the right, and select the replacement font you want to 
use.

When you select a font from the Available Fonts menu, a preview of that font appears in 
the text boxes.

5. Click OK.

The system updates the font in the open title and records the new replacement 
information for future use.
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Step 8: Refine Effects and Perform Color Correction

After reviewing the sequence, you might find you need to adjust effects, add effects, or 
perform color correction. 

Color Correction: You can use Symphony Color Correction tools for a variety of tasks, 
including review and adjustment of the chroma and luma levels and color adjustments to 
selected areas (secondary color correction). For more information, start with “Symphony 
Color Correction: Basics” in the Help and then see the chapters in Section II of this guide.

For information about conforming sequences that contain color correction, see “Conforming 
Sequences with Color Correction” on page 40.

Motion Effects: You might need to choose a different rendering method for motion effects 
after recapturing media in a final online resolution. If a traditional motion effect is used, 
consider promoting it to a Timewarp effect. For more information, see “Playing and 
Rendering Motion Effects” in the Help.

Chroma and luma keys: Chroma and luma keys conform in Symphony as they were 
created in the offline system. However, you might find problems with the keys, especially 
when working in an uncompressed resolution. For maximum options in adjusting keys, 
promote 2D keys to 3D. The 3D Warp effect in Symphony includes parameters for the 
SpectraMatte effect. For more information, see “Creating Key Effects” in the Help.

The following topics in the Help provide information about other finishing tools:

• “Motion Tracking and Stabilization” in the Help.

• “Using the Reformat Effects” in the Help

• “Understanding the Intraframe Effects” in the Help

• “Getting Started with the Paint and AniMatte Effects” in the Help

• ”Scratch Removal” in the Help

For complete information about effects, see the Avid Advanced Effects Guide, which is 
included in the Help and is also available as a PDF file in the Avid Online Library.
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Conforming Sequences Created on Other Avid Editing Systems

A few effects created on other Avid editing systems might not match exactly when 
conformed on Symphony. You should check these effects carefully as part of the online 
conform process:

• Borders for wipes or PIPs: Border position might vary. For wipes created on 
Media Composer Adrenaline v2.2.x or earlier, or Avid Xpress Pro v5.2.x or earlier, 
borders end on screen; for wipes created on or conformed on Symphony, borders end off 
screen.

• ChromaKey, Luma Key: Due to changes in hardware processing, a key created on a 
Symphony Meridien™ system might not be properly keyed on a more recent Symphony 
system. Promote all Chroma Keys to SpectraMatte keys and remake the effects. 
Promote all Luma keys to 3D Warp Luma Keys and remake the effect using the Luma 
Range parameters.

• Color Effect: For Color effects created on Media Composer or Avid Xpress Pro, the 
Chroma Adjust parameter values might not match.

• 3D Effects Parameters: 3D effects on Meridien systems include additional shapes that 
are not included on Symphony. The supported shapes might behave differently than they 
do on Meridien systems. This is especially true for Page Folds when applied with a 
backing, to a title, or to an imported graphic. For more information, see “3D Effects 
Parameters” in the Help.

Step 9: Render Effects as Needed

On a Symphony system, most effects play in real time. However, you might need to render 
some complex effects or plug-in effects. For more information, see “Real-Time Playback of 
Video Effects” and “Basics of Effects Rendering” in the Help.

The ExpertRender feature includes a special setting called Prepare for Digital Cut. For more 
information, see “ExpertRender” in the Help.
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Step 10: Create the Final Masters

Avid’s Universal Mastering features offer you a range of output formats you can use for your 
final master. The output formats that are available depend on the format of your source 
footage.

• If your source footage is 23.976p, 24p or 25p, you can use the Digital Cut tool to output 
broadcast masters in NTSC and PAL formats, both from the same sequence. You can 
use the Reformat effect or the Pan and Scan effect to create 4:3, 14:9, and 16:9 versions 
of the sequence. In addition, the Digital Cut tool includes the option to automatically 
output titles as 4:3 or 16:9 to match your sequence. You can also output versions for 
special purposes, such as NTSC 24, for recording audio at the film rate.

• If your source footage is HD, you can use the Video Output Tool to crossconvert to a 
compatible HD format, and downconvert to an NSTC or PAL format. For more 
information, see “Preparing for Converting HD Formats” in the Help.

• All formats let you use the Export tool to output in popular file formats, including 
QuickTime and Windows Media. Avid codecs for QuickTime let you input and output 
files quickly, and you can install the codecs on graphics workstations for the most 
efficient input and output. For more information, see “Exporting Frames, Clips, or 
Sequences: Advanced” in the Help.

• You can use FilmScribe™ to create cut lists and change lists, and EDL Manager to 
create an EDL. For more information, see “Using FilmScribe” and “Using EDL 
Manager” in the Help.

Conforming Sequences with Color Correction

The following topics explain how sequences with color correction conform as they are 
moved between Symphony and certain other Avid editing applications, and how you can 
transfer color correction adjustment values from one type of color correction to another in 
cases where color corrections do not conform as you want.

Conforming Color Correction Sequences with 
Symphony Meridien Systems

In Symphony, if you open a Symphony Meridien sequence containing relationship color 
corrections, a message box appears informing you that you are attempting to open a 
sequence with an older type of color correction. You can choose to continue working with 
the existing sequence or to create a duplicate sequence with updated color corrections.
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• If you continue to open the original sequence, the older relationship color corrections do 
not appear on the Timeline and cannot be played or adjusted.

• If you choose to create an updated duplicate sequence, Symphony converts the older 
relationship color corrections to color corrections that you can view, play, and further 
adjust in Symphony. The unaltered original sequence is also retained.

In Symphony, if you open a Symphony Meridien sequence containing Color Correction 
effects, those effects conform correctly in Symphony and are available for further 
adjustment.

Color corrections created in Symphony have limited backward compatibility with 
Symphony Meridien systems. In a Symphony Meridien system, if you open a Symphony 
sequence, you see the following behavior with color corrections:

• Color Correction effects appear and are available for further adjustment.

n You must enter Color Correction mode and click one of the Segment Mode buttons to see the 
parameter settings in the Color Correction tool.

• Relationship color corrections appear as Color Correction effects, not as relationship 
color corrections, so the relationship aspect of the corrections is lost. However, you can 
usually recreate the relationships using color correction templates, as described in 
“Transferring Color Corrections with Color Correction Templates” on page 42.

• When segments contain both a Source and a Program relationship color correction, only 
one of those corrections (the one applied first in time) appears as a color correction 
effect.

You can also use a Console command to convert Symphony sequences with color correction 
relationships, and then transfer them to a Symphony Meridien system.

To convert a Symphony sequence with Color Correction relationships and transfer it 
to a Symphony Meridien system:

1. Load the sequence you want to transfer into the Timeline. 

2. Select Tools > Console.

3. In the Console command line, type:

backrevcc

4. Press Enter.

5. Transfer the sequence to the Symphony Meridien system.

6. On the Symphony Meridien system, render the effects.

n You cannot convert sequences that contain Color Correction relationships applied to Freeze 
Frames and Motion Effect Strobe effects.
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Conforming Color Correction Sequences with Media Composer or 
Avid Xpress Pro Systems

In Symphony, if you open a sequence created on a Media Composer or Avid Xpress Pro 
system, all existing Color Correction effects conform. You can view and play the Color 
Correction effects in the Timeline, and you can make further adjustments to the Color 
Correction effects in the Color Correction tool.

If you want to convert existing Color Correction effects to relationship color corrections, you 
can do so using color correction templates, as described in “Transferring Color Corrections 
with Color Correction Templates” on page 42.

In an Avid editing application that works with Media Composer or Avid Xpress Pro, if you 
open a Symphony sequence, you see the following behavior with color corrections:

• All color corrections (whether relationship or Color Correction effect) that use color 
correction controls available in Media Composer or Avid Xpress Pro conform as Color 
Correction effects.

• Color correction adjustments that are unique to Symphony, for example adjustments on 
the Channels, Levels, or Secondary tabs, do not conform in Media Composer or 
Avid Xpress Pro. A color correction that uses these adjustments appears in the Timeline 
(and if it also contains HSL or Curves adjustments they are available), but you cannot 
view or further adjust the adjustments that are unique to Symphony.

• When segments contain both a Source and a Program relationship color correction, only 
one of those corrections (the one applied first in time) appears as a color correction 
effect.

Transferring Color Corrections with Color Correction Templates

In many situations where a color correction does not conform between one Avid editing 
application and another in the way that you want, all of the color correction adjustment 
values that you need are still intact, so you can work around the problem by using color 
correction templates to transfer the color correction adjustment values to a new type of 
correction. The following procedure provides an example of one typical transfer.
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To convert a Color Correction effect in a sequence originally created in an Avid Media 
Composer product to a relationship color correction:

1. In Color Correction mode, move the position indicator to the Color Correction effect 
whose adjustment values you want to transfer, and make sure that you are monitoring 
the track in the Timeline that contains the effect.

2. Drag the Color Correction template icon from the Color Correction tool to a bin.

The application saves a color correction template in the bin. If you want, you can 
rename the template to clarify its origin.

3. Click the Remove Effect button to remove the original Color Correction effect from the 
segment.

4. (Option) If you intend to use a relationship color correction that will apply to multiple 
segments, taking the place of multiple individual Color Correction effects, you might 
need to move to each of the other segments and remove the existing Color Correction 
effects from each.

5. In the Correction Type menu, select the relationship color correction you want to use.

6. Do one of the following:

t To apply all of the adjustment values stored in the template, drag the Color 
Correction template icon that you created in step 2 from the bin, and drop it on the 
monitor containing the current segment.

t To apply only those adjustment values from the template that appear in one Color 
Correction tool tab, drag the Color Correction template icon that you created in step 
2 from the bin, and drop it on the appropriate tab in the Color Correction tool.

For example, drop the icon on the Curves tab to apply only Curve adjustments to the 
new relationship.

Transferring Project and Media Files

The following topics describe the options and methods you can use to transfer project files 
and media between Windows systems, between Macintosh systems, and between Windows 
and Macintosh systems:

• Transferring Audio Files

• Transferring Sound Designer II Audio Files from Macintosh Systems

• Working with Sound Designer II Audio Files on Macintosh Systems

• Transferring a Project Using Shared Storage
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• Transferring Project Files and Media Files Using Nonshared Storage

• Devices and Methods for Transferring Files

• Nonshared Storage Issues for Cross-Platform Collaboration

• Transferring Media Files from Media Composer Version 7.2 or Avid Xpress Version 2.1

Transferring Audio Files

You might need to transfer audio separately from video. One workflow might involve 
sending audio from an offline system to a Pro Tools system for sweetening, and then sending 
the finished audio to a Symphony system for syncing with final video.

When you are moving your sequence to an audio-editing application, you need to export the 
sequence as an OMFI or an AAF file, see “Exporting OMFI and AAF Files” in the Help. If 
you are working with a Pro Tools system, you can streamline your workflow by using the 
Send To feature, see “Send To Digidesign Pro Tools” in the Help. The Send To Digidesign 
Pro Tools templates export an AAF file.

• If the audio-editing application to which you are moving your sequence supports the 
audio format used to create your sequence, you can export the sequence as an OMFI or 
an AAF composition without audio media and move the original media files to the 
audio-editing workstation. 

• If the audio editing application to which you are moving your sequence does not support 
the audio format in your sequence, you must export the sequence as an OMFI or an 
AAF composition with audio media and convert the audio media to the appropriate 
format.

OMFI files have a 2-GB file-size limit.

The following table lists Pro Tools support for embedded audio. Pro Tools does not support 
embedded video.

For information on importing into and exporting from the audio-editing application, see the 
documentation for the audio-editing application.

Pro Tools Version Audio embedded in OMFI Audio embedded in AAF

AIFF-C WAVE MXF AIFF-C WAVE MXF

Pro Tools v7 or later Yes Yes No Yes Yes Yes

Pro Tools v6.9 or later Yes Yes No Yes Yes No

Pro Tools v6.7 or earlier Yes Yes No No No No
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n DigiTranslator v2.0 is required on the Pro Tools system for import and export of OMF and 
AAF files.

For information about working with Sound Designer II audio files, see “Transferring Sound 
Designer II Audio Files from Macintosh Systems” on page 45 and “Working with Sound 
Designer II Audio Files on Macintosh Systems” on page 45.

For information on working with ProTools in an Interplay environment, see “Using Pro 
Tools and Interplay” in Avid Interplay Best Practices.

Transferring Sound Designer II Audio Files from Macintosh Systems

Sound Designer II audio media is a Macintosh format and is not supported on Windows. 

To transfer Sound Designer II media to a Windows system, export an OMFI or AAF 
composition that includes the media and convert the media to AIFF-C or WAVE. Use the 
Export command or the Send To command.

Working with Sound Designer II Audio Files on Macintosh Systems

Sound Designer II audio media has limited support on Media Composer Macintosh systems. 

The following features are supported:

• You can play Sound Designer II audio that was created on another system and 
transferred. 

• You can export audio as Sound Designer II media through the Audio option of the 
Export command.

The following features are not supported:

• You cannot select Sound Designer II as the file format for a project or output Sound 
Designer II media in a digital cut.

• You cannot export or convert Sound Designer II media through OMF or AAF. 

You can use the Consolidate or Transcode feature to convert Sound Designer II media to 
another audio file format, or you can convert it as part of an OMF or AAF export.
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Transferring a Project Using Shared Storage

If you are using your Avid editing system in an Avid Unity environment, you can use Avid 
Interplay to share media files, projects, and bins between systems. For more information, see 
your Avid Unity and Avid Interplay documentation.

You can also share bins and projects in an Avid Unity environment that does not use Avid 
Interplay. See “Sharing Bins and Projects in an Avid Unity Environment” in the Help and in 
the Avid Unity documentation.

Transferring Project Files and Media Files Using Nonshared Storage

To transfer project files (information about the components of your project, such as bins, 
master clips, edited sequences, and so on) and user profiles between Avid systems, you must 
transfer specific folders directly into the Avid Projects or Avid Users folder before starting 
the application. You can also transfer the Site Settings file between systems. 

n For information about these files and folders, see “Avid Projects and Avid Users Folders” in 
the Help.

If the media is compatible, you can transfer media files between systems by using a 
removable media drive. For information about media compatibility, see “Compatibility 
Between Applications” on page 23. For information on devices for transfer, see “Devices 
and Methods for Transferring Files” on page 48.

n Transferring a project folder does not transfer accompanying media files.

To transfer project files and associated media files to another Avid system:

1. (Option) Consolidate the media for the project onto an appropriate drive for transfer to 
the other system.

For more information on consolidating, see “Consolidating Media” in the Help.

For more information on devices for transfer, see “Devices and Methods for 
Transferring Files” on page 48.

c Do not rename the folder named OMFI MediaFiles or Avid MediaFiles (for MXF files) 
located on the media drive. The target system uses the folder name to locate the media 
files.

2. Select the project folder, user folder, or Site Settings file you want to transfer (the folder 
uses the project name or user name you provide). You do not need to copy the Statistics 
folder, which is located in the project folder. This folder can be large and is not needed 
by the transferred project. 

The default locations for application folders are listed in the following tables. 
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n The exact location depends on your Avid editing application, its version, and how it was 
installed on your system. Older versions store projects in an Avid Projects folder that is 
located in the same folder as the application.

3. Copy the folders or files you want to maintain at the new location onto a storage device 
or a location on a server.

Alternatively, create a folder at the top level of the media drive and copy the folders or 
files to that folder.

4. If you are transferring a removable drive, quit your Avid editing application and shut 
down your system.

5. Remove the drives containing the media files, and take them and the storage device to 
the new location.

6. With the system at the new location turned off, insert or connect the drives and start the 
system.

7. Copy the folders or files to the appropriate folder.

Folder or File Location

Project folder Private projects:

• (Windows) drive:\Documents and Settings\Windows login name\My 
Documents\Avid Projects

• (Macintosh) Macintosh HD/Users/Mac login name/Documents/Avid 
Projects

Shared projects:

• (Windows) drive:\Documents and Settings\All Users\Shared 
Documents\Shared Avid Projects

• (Macintosh) Macintosh HD/Users/Shared/Avid editing 
application/Shared Avid Projects

n For information about private projects and shared projects, see “Select Project Dialog 
Box” in the Help.

User folder (Windows) drive:\Program Files\Avid\Avid editing application\Avid Users

(Macintosh) Macintosh HD/Users/Shared/Avid editing application\Avid 
Users

Site Settings file (Windows) drive:\Program Files\Avid\Avid editing application\Settings

(Macintosh) Macintosh HD/Applications/Avid editing application/Settings
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The folder locations might be slightly different, depending on the product and how it 
was installed. Ignore any Resource folders or files that appear.

8. Start your Avid editing application.

The new project appears in the Project window. New user settings appear in the Users 
list. Site settings are active for all projects at the new location.

c Do not open a project directly from the transfer device. You must copy the folder to the 
system drive first.

9. Select a user, open the project, and resume work.

n Your Avid editing application reconstructs the MediaFiles database the first time you start 
the application to incorporate the new media into the system’s internal directory.

Do not rename the project folder. The project settings do not link to the project if you rename 
the project folder.

Devices and Methods for Transferring Files

Options for transferring files vary depending on the source and destination systems. The 
following tables provide options for moving project files, media files, or both. These tables 
list the various ways to transfer data, the prerequisite hardware or software, and any 
restrictions.

For specific information about cross-platform transfers, see “Nonshared Storage Issues for 
Cross-Platform Collaboration” on page 52.

Transferring Files Between Macintosh Systems

The following table shows the available methods for transferring files between 
Macintosh systems.
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Method Requirements Restrictions

All Files (Can be used as media drives)

External SCSI drive None For compatibility information, see the Avid Drive Striping 
Tables, which are available on the Avid Customer Support 
Knowledge Base. See also “Getting Information About Striped 
Drives” in the Help.

Fibre Channel drive None For compatibility information, see the Avid Drive Striping 
Tables.

External 1394 
(FireWire) drive

HFS+ format Cannot be used as a media drive for Symphony. For 
compatibility information, see the Avid Drive Striping Tables.

Project Files, OMF Files, and AAF Files (including embedded media)

Server-based network None None.

External 1394 
(FireWire) drive or 
USB2 drive

HFS+ format Size of the disk.

Floppy disk Macintosh-formatted 
disk

Holds 1.4 MB. 

CD-ROM None HFS+ format is recommended. Do not use ISO 9660 format, 
which truncates file names. Do not use hybrid CD-ROMs, 
unless you create them with the Joliet extension, which supports 
long file names.

DVD None None, if you use the native DVD format.

E-mail E-mail software that 
supports attachments

See the documentation for the e-mail software.

FTP Network access and 
FTP software on both 
systems

For the Fetch application, one system must be set to “Server” 
mode. This method can be very slow.

AppleShare Network access on 
both systems

Activate AppleShare on the sending system to allow a guest or 
registered user to log in.

DigiDelivery™ Installation of 
DigiDelivery 
hardware and 
software

None. See www.digidesign.com/products/digidelivery/.

http://www.digidesign.com/products/digidelivery/
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Transferring Files Between Windows Systems

The following table shows the available methods for transferring files between Windows 
systems.

Method Requirements Restrictions

All Files (can be used as media drives)

External SCSI drive None For compatibility information, see the Avid Drive Striping 
Tables, which are available on the Avid Customer Support 
Knowledge Base.

Fibre Channel drive None For compatibility information, see the Avid Drive Striping 
Tables.

External 1394 
(FireWire) drive

None Cannot be used as a media drive for Symphony. 

For compatibility information, see the Avid Drive Striping 
Tables.

Project Files, OMF Files, and AAF Files (including embedded media)

Server-based network None None.

External 1394 
(FireWire) drive or 
USB2 drive

None Size of the disk.

Floppy disk PC-formatted disk Holds 1.4 MB. 

CD-ROM None Do not use ISO 9660 format, which truncates the file 
names. Files copied from a CD-ROM to a Windows system 
retain the read-only attribute. To change this attribute, see 
the Windows documentation

DVD None None, if you use the native DVD format.

Files copied from a DVD to a Windows system retain the 
read-only attribute. To change this attribute, see the 
Windows documentation.

E-mail E-mail software that 
supports attachments

See the documentation for the e-mail software.

FTP Network access and FTP 
software on both systems

See the FTP software documentation.

DigiDelivery Installation of 
DigiDelivery hardware 
and software

None. See www.digidesign.com/products/digidelivery/.

http://www.digidesign.com/products/digidelivery/
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Transferring Files Between Macintosh and Windows Systems

The following table shows the available methods for transferring files between Macintosh 
and Windows systems.

Method Requirements Restrictions

All Files (can be used as media drives)

Macintosh external 
drive (SCSI or Fibre 
Channel)

HFS+ format and an 
application that enables 
the Windows system to 
read Macintosh drives.

See “Nonshared Storage Issues for Cross-Platform 
Collaboration” on page 52.

For compatibility information, see the Avid Drive Striping 
Tables, which are available on the Avid Customer Support 
Knowledge Base. 

External 1394 
(FireWire) drive

HFS+ format and an 
application that enables 
the Windows system to 
read Macintosh drives.

Cannot be used as a media drive for Symphony. 

For compatibility information, see the Avid Drive Striping 
Tables.

Project Files, OMF Files, and AAF Files (including embedded media)

Server-based network Macintosh and 
Windows integration

Rename files to avoid problems with illegal characters. See 
“System Compatibility for the Online Session” on page 26.

External 1394 
(FireWire) drive or 
USB2 drive

HFS+ format Size of the disk.

Floppy disk PC-formatted disk Holds 1.4 MB.

CD-ROM An application that 
enables the Windows 
system to read 
Macintosh drives.

HFS+ format is recommended. Do not use ISO 9660 format, 
which truncates the file names. Do not use hybrid CD-ROMs, 
unless you create them with the Joliet extension, which 
supports long file names. Properly created hybrid CD-ROMs 
do not require an application that enables the Windows system 
to read a Macintosh-formatted CD-ROM.

Files copied from a CD-ROM to a Windows system retain the 
read-only attribute. To change this attribute, see the Windows 
documentation.

DVD None None, if you use the native DVD format.

Files copied from a DVD to a Windows system retain the 
read-only attribute. To change this attribute, see the Windows 
documentation.
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Nonshared Storage Issues for Cross-Platform Collaboration

When you share media files by using a nonshared storage device—either peer-to-peer, over a 
network, or using removable storage—the following restrictions apply:

• NTFS drives formatted on a Windows system can be read only on Macintosh systems 
running Mac® OS X 10.4 or later.

• Striped or nonstriped drives formatted as HFS or HFS+ on a Macintosh system can be 
read on a Windows system, if an application that lets Windows systems read the drives 
is installed on the Windows system.

To avoid problems when reading a connected HFS or HFS+ drive, do the following:

• On the Macintosh system, after transferring the media files to the HFS or HFS+ drive, 
give the media folder a name other than “OMFI MediaFiles” or “Avid MediaFiles”. You 
cannot change the name of the OMFI folder after you connect the drive to the system.

• Make sure the permissions on the HFS or HFS+ volume allow access by other users:

a. Select the drive in the Finder.

b. Select File > Get Info

c. Select “Ignore ownership on this volume.”

• On the Windows XP system, after connecting the drive and transferring the media files 
to an NTFS drive, turn off the system, disconnect the drive, reboot, and then restart the 
Avid system. 

E-mail E-mail that supports 
attachments

See the documentation for the e-mail software.

FTP Network access and 
FTP software on both 
systems

For more information on using Fetch on Macintosh systems, 
see www.fetchsoftworks.com.

DigiDelivery Installation of 
DigiDelivery hardware 
and software

None. See www.digidesign.com/products/digidelivery/.

Method Requirements Restrictions

http://www.fetchsoftworks.com
http://www.digidesign.com/products/digidelivery/
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Transferring Media Files from Media Composer Version 7.2 or 
Avid Xpress Version 2.1

Video media from Media Composer v7.2 or Avid Xpress v2.1 is not directly compatible with 
later releases, so you must export with specific format settings. The import process might be 
slow, and your media loses some quality.

For more information about working with Media Composer v7.2, Avid Xpress v2.1, and 
other versions of Avid editing products released before July, 2001, see the Avid Products 
Collaboration Guide, which is available on the Avid Customer Support Knowledge Base.

To transfer video media from v7.2 or Avid Xpress v2.1 to a later release:

t In the Export Format dialog box, select OMFI Composition Standard -AIFC, Video 
Only, OMFI 1.0, With Media. You can then import the OMFI file.

http://www.avid.com/onlinesupport
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2 Working with HD Media

Avid editing applications include support for capture, editing, and output of high-definition 
(HD) media in the following resolutions:

• 1:1 HD (uncompressed 8-bit and 10-bit)

• Avid DNxHD (8-bit and 10-bit)

Avid DNxHD encoding technology delivers mastering-quality HD media at standard 
definition (SD) data rates and file sizes.

• DVCPRO HD

• HDV

• XDCAM HD

Depending on the model of your Avid editing application and on your Avid input/output 
hardware, some of these resolutions might not be available.

Avid editing applications capture and process DVCPRO HD media and HDV media in its 
native format, through a 1394 port on your computer. On a Windows system with an Avid 
Adrenaline or an Avid Mojo, the 1394 port must be on an optional IEEE-1394 card installed 
on a bus separate from the one used by the Avid Adrenaline or Avid Mojo.

The following sections describe the features and options that let you capture, edit, and output 
HD media:

• High-Definition Television

• HDTV Workflows

• Editing in HD

• Working with HDV
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High-Definition Television
High-definition television (HDTV) is a digital broadcasting technology that delivers a larger, 
clearer, more detailed picture than standard definition television (SDTV). HDTV refers to 
specific digital television (DTV) formats that have been standardized by the Advanced 
Television Systems Committee (ATSC) and adopted by the United States Federal 
Communications Commission (FCC). HDTV for PAL has been standardized by the Digital 
Video Broadcasting (DVB) consortium.

For a table that lists the HDTV digital formats and resolutions that are supported in your 
Avid editing application, see “Resolution Specifications: HD” in the Help.

HDTV uses a 16:9 aspect ratio in place of the standard definition 4:3 ratio. The following 
illustration compares the pixel size of the most common HD formats — 720p and 1080i — 
to that of the digital version of standard definition NTSC media (ITU-R 601). Both 1080i 
and 720p formats fill the 16x9 screen on HD television sets.

For more information about HD technology, see the Avid HD Handbook: An A to Z Guide, 
which is available on the Avid web site, www.avid.com.
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HDTV Workflows

This section describes three common workflows for creating HDTV output:

• Creation of film-based television programs 

• Creation of video-based television programs 

• Creation of video graphics for broadcast 

For a more detailed description of the conform workflow, see “Conforming Workflow” on 
page 30.

HD Workflow: Film-Based Television Workflow

The following workflow describes the steps in creating film-based television programs that 
originate on film footage and that are planned for NTSC HDTV broadcast. This workflow 
uses features that let you change the project and sequence format, eliminating the need to 
create a new project and sequence. Modifying the format of the sequence lets you keep both 
offline SD material and online HD material available in the same project.

For PAL broadcast, transfer film at 1080p/25, edit offline in a 25p PAL project, and edit 
online in a 1080p/25 project.

“Offline Workflow: 24-fps Film Source for HDTV” on page 59 shows the offline stage of 
the workflow for such programs, and “Online Workflow: 24-fps Film Source for HDTV” on 
page 60 shows the online stage.

For a more detailed description of the conform workflow, see “Conforming Workflow” on 
page 30.For a more detailed description of the conform workflow, see “Conforming 
Workflow” in the Help.

To create a film-based HDTV program:

1. Use a telecine process to transfer 24-fps film footage to HD 1080p/23.976 video at 1:1. 

The transfer should also create a shot log (for example, a FLEx file).

2. Create a 23.976p SD project in any Avid editing application that supports a 23.976p 
project.

3. Convert the shot log file with ALE and import it into the project to create one or 
more bins.
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4. Use a 24p deck to downconvert the HD video to ITU-R 601 SD video and batch capture 
the logged clips in an offline resolution, based on the shot log.

The deck adds 2:3 pulldown (NTSC) or 4.1% speedup (PAL). The Avid system removes 
the extra pulldown fields and creates 23.976p media.

5. Edit at 23.976 fps, apply effects, and create a final sequence.

6. (Option) If a retransfer is needed, use FilmScribe to create an OCN (original camera 
negative) pull list for another telecine process, to retransfer footage used in the final edit.

7. (Option) Export an OMFI or AAF file to a Pro Tools digital audio workstation to create 
a final audio mix.

For more information, see “Transferring Audio Files” on page 44.

8. A negative cutter uses the pull list to create a reel of selects from the original negative 
(picture only).

The telecine process uses the assembled reel to create a full color-corrected or flat-grade 
transfer to tape. The process also creates a new transfer file.

9. Transfer the project files to an Avid editing application.

If you are using an Avid Unity shared storage system, the project links to the existing 
SD media. If you are not using Avid Unity, transfer the SD media for reference.

10. Open the project and change its format to 1080p/23.976. 

See “Understanding Options for Changing the Project Format” on page 64. Review the 
offline sequence. Then modify the format of the sequence to create a new 1080p/23.976 
sequence. See “Understanding Options for Modifying the Sequence Format” on page 
66.

11. Convert the transfer file with ALE and import it.

12. Relink by KeyKode: relink the 1080p/23.976p sequence and clips by key numbers 
(FTFT). Then batch capture clips as HD media, using an HD resolution. 

13. (Option) Import the final audio mix.

14. Complete any other finishing, using the original offline sequence for reference.

15. Use the Digital Cut tool to output a 1080p/23.976 master tape. Then convert the master 
tape to 720p/59.94 or 1080i/59.94 for broadcast.

Optionally, use the Avid editing application to crossconvert to 720p/59.94 or 
1080i/59.94 for preview or reference. The HD VTR can also create 1080i/50 for PAL 
broadcast.

See “Offline Workflow: 24-fps Film Source for HDTV” on page 59 and “Online 
Workflow: 24-fps Film Source for HDTV” on page 60.
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Offline Workflow: 24-fps Film Source for HDTV
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Online Workflow: 24-fps Film Source for HDTV
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HD Workflow: Video-Based Television Workflow

The following workflow describes the steps in creating video-based television programs that 
originate on video footage and are planned for HDTV broadcast. 

The workflow for creating such programs uses a single system for offline and online editing, 
but you can adapt it to use one system for offline editing and another for online editing. This 
workflow uses features that let you change the project and sequence format, eliminating the 
need to create a new project and sequence. Modifying the format of the sequence lets you 
keep both offline SD material and online HD material available in the same project.

You can use this workflow for video footage shot at 720p/23.976, 720p/59.94 or 
1080p/29.97. In these cases, however, you cannot simply change the project format (step 6). 
Instead, you need to create a new project that matches the source footage, open the bin or 
bins from the NTSC 30i project, change the sequence format, decompose, and batch capture.

For a more detailed description of the conform workflow, see “Conforming Workflow” on 
page 30.For a more detailed description of the conform workflow, see “Conforming 
Workflow” in the Help.

To create a video-based HDTV program:

1. Shoot HD video.

2. Use an HD VTR to downconvert the source tape to 30i NTSC, 25i PAL, or 25p PAL.

3. Create an offline project, as shown in “Offline Formats for HD” on page 25.

For example, if you plan to finish at 1080i/59.94, create a 30i NTSC project.

4. Capture your material. Edit, apply effects, and create a final sequence.

5. (Option) Export an OMFI or AAF file to a Pro Tools digital audio workstation to create 
a final audio mix.

For more information, see “Transferring Audio Files” on page 44.For more information, 
see “Transferring Audio Files” in the Help.

6. Change the project format to the corresponding HD online format. 

For more information, see “Understanding Options for Changing the Project Format” on 
page 64.

7. Duplicate the final sequence, and then modify the format of the sequence to create a new 
sequence in the corresponding HD format.

For more information, see “Understanding Options for Modifying the Sequence 
Format” on page 66.

8. Decompose the new HD sequence and batch capture from the source tape.

9. (Option) Import the final audio mix.
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10. Finish the sequence by batch capturing graphics, recreating title media and reviewing 
the program for effects that need fine-tuning.

Use the original offline sequence for reference. 

11. Render all effects and output a master tape.

The following illustration shows an offline/online workflow using an HD video source 
for HDTV
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HD Workflow: Broadcast Graphics Workflow

Another HDTV workflow produces graphics, such as bumpers and promos that are created 
in graphics programs for HDTV broadcast.

To create a graphics-based HDTV program:

1. Create files on a graphics workstation, using either 1280x720 for 720p or 1920x1080 for 
1080i.

2. Export the files to a location that the Avid editing system can access.

3. Create a 720p or 1080i project, import the files, edit, and finish.

4. Create a broadcast master tape in the desired format. Cross-convert to output an 
alternative format.

The following illustration shows a broadcast graphics workflow.
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Editing in HD

The following sections describe features that are specific to HD projects.:

Understanding Options for Changing the Project Format

The Format tab in the Project window lets you change the format of the project to another 
format that shares the same frame rate. On systems with supported Avid input/output 
hardware, you can also change the raster type to improve performance as you edit HD 
projects.

Changing formats is especially useful if you are working with downconverted HD material 
in an offline-to-online workflow, see “HD Workflow: Video-Based Television Workflow” on 
page 61. Each HD format has an equivalent SD format that you can use for offline editing, as 
shown in the following table.

HD Online SD Offline Notes

720p/23.976 23.976p NTSC You cannot change between these project formats 
because the edit rates are different. See “Converting 
a 23.976p NTSC Sequence to 720p/23.976” on page 
70.

720p/25 25p PAL or 25i PAL Change the project format and modify the sequence.
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720p/29.97 30i NTSC You cannot change between these project formats 
because the edit rates are different. Use an NTSC 
30i project for offline editing, then open a new 
720p/29.97 project for online editing. Open the 
desired NTSC 30i bins and modify the final 
sequence, as described in “Understanding Options 
for Modifying the Sequence Format” on page 66.

720p/50 25p PAL or 25i PAL You cannot change between these project formats 
because the edit rates are different.

720p/59.94 30i NTSC You cannot change between these project formats 
because the edit rates are different, see “Editing at 
60 fps” on page 72. Use an NTSC 30i project for 
offline editing, then open a new 720p/59.94 project 
for online editing. Open the desired NTSC 30i bins 
and modify the final sequence, as described in 
“Understanding Options for Modifying the 
Sequence Format” on page 66.

1080p/23.976 23.976p NTSC or 
24p NTSC

For 23.976p NTSC, change the project format and 
modify the sequence. 24p NTSC sequences require 
additional conversion. See “Converting a 24p NTSC 
Sequence to 1080p/23.976” on page 69.

1080p/24 24p NTSC or 24p 
PAL

Change the project format and modify the sequence.

1080p/25 25p PAL or 25i PAL Change the project format and modify the sequence.

1080p/29.97 30i NTSC You cannot change between these project formats 
because the edit rates are different. Use an NTSC 
30i project for offline editing, then open a new 
1080p/29.97 project for online editing and open the 
desired NTSC 30i bins. You do not need to modify 
the sequence. Duplicate the sequence. Then batch 
capture the duplicated sequence or decompose and 
batch capture.

1080i/50 25i PAL or 25p PAL Change the project format and modify the sequence.

1080i/59.94 30i NTSC Change the project format and modify the sequence.

HD Online SD Offline Notes
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Another use for this feature is if you are working in an HD project and need to capture SD 
material. In an HD project, you can capture only HD material, and in an SD project, you can 
capture only SD material. Temporarily changing from an HD project to an SD project gives 
you access to the SD compressions. You can capture the material you need, then change 
back to the HD project and work with both SD and HD clips, see “Mixing SD and HD 
Material in a Project” on page 71.

Changing the Project Format

When you change the project format, the following changes take place:

• The hardware changes to support input and output for the new project.

• The available resolutions and, for some configurations, raster types change to those of 
the new project.

• Any new sequences you create use the format of the new project.

If necessary, you can then modify the format of an existing sequence, see “Understanding 
Options for Modifying the Sequence Format” on page 66.

To change the project format:

1. Click the Format tab on the Project window.

2. Select the corresponding format for your workflow.

n You can select only projects with the same edit rate.

3. If available, click the Raster Type menu and select a raster type.

For information on raster types and raster sizes, see “Raster Types” in the Help.

Understanding Options for Modifying the Sequence Format

When your Avid editing application creates a sequence, it uses the format of the current 
project. You can change the format of an existing sequence by selecting Clip > Modify. See 
“Modifying the Format of a Sequence” on page 69.
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The choice of formats is limited to compatible frame rates of the sequence. For example, you 
can change an NTSC 30i sequence to 1080i/59.94 or to 720p/59.94, but not to 
1080p/23.976. (You can, however, convert a 24p NTSC sequence to 23.976p. See 
“Converting a 24p NTSC Sequence to 1080p/23.976” on page 69).

In some cases, where the timecode format needs to be changed, your Avid editing 
application creates a new, modified sequence. Media for this new sequence is offline. In 
other cases, where the timecode format does not need to be changed, the application 
modifies the existing sequence and media stays online. 

You can check the format of the sequence in the Format column of the bin. (For instructions 
on adding a column to a bin, see “Displaying Formats in a Bin” on page 71.)

New 720p 
sequence

Modified 1080i 
sequence



2  Working with HD Media

68

The following table shows the choices you have for modifying sequences and how each type 
of sequence is modified.

To modify the format of clips not used in the sequence, create a sequence of the selected 
clips and then modify the sequence. One way to create a sequence of clips is to select the 
clips, hold down the Alt key, and select Bin > AutoSequence. See “Using the AutoSequence 
Command” in the Help.

Original Sequence Choices for Modifying How Sequence is Modified

23.976p NTSC 1080p/23.976 Existing sequence is duplicated with the 
extension 1080p. Media in the duplicated 
sequence is offline.

To convert to 720p/23.976, see “Converting a 
23.976p NTSC Sequence to 720p/23.976” on 
page 70.

24p NTSC 1080p/24 Existing sequence is duplicated with the 
extension 1080p. Media in the duplicated 
sequence is offline.

23.976 NTSC Existing sequence is duplicated with the 
extension 23.976 fps. Media is offline. See 
“Converting a 24p NTSC Sequence to 
1080p/23.976” on page 69.

 24p PAL 1080p/24 Existing sequence is duplicated with the 
extension 1080p. Media in the duplicated 
sequence is offline.

25p PAL 1080p/25 Existing sequence is modified. Media remains 
online.

25i PAL 1080i/50 Existing sequence is modified. Media remains 
online.

30i NTSC 720p/59.94 Existing sequence is duplicated with the 
extension 60 fps. Media in the duplicated 
sequence is offline.

1080i/59.94 Existing sequence is modified. Media remains 
online. Not available in 720p projects.

For 1080p/29.97 projects, you can work with 
the 30i NTSC sequence without converting it.

1080i/50 Existing sequence is modified. Media remains 
online.
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Modifying the Format of a Sequence

To modify the format of a sequence:

1. (Option) Duplicate the sequence. 

2. Select the sequence you want to modify.

3. Select Clip > Modify.

The Modify dialog box opens.

4. Select Set Format from the top list.

5. Select the format to which you want to convert from the Format menu.

6. Click OK.

A message box tells you whether the sequence has been duplicated or modified.

Your Avid editing application changes the format of the sequence. In cases where 
timecode needs to be converted, the application creates a new sequence and unlinks the 
media. No media is converted. For more information, see “Understanding Options for 
Modifying the Sequence Format” on page 66.

Converting a 24p NTSC Sequence to 1080p/23.976

The most efficient offline format for a project that needs to be delivered as 1080p/23.976 is 
23.976p (NTSC). In some cases, however, you might need to edit the offline sequence at 
24 fps — for example, if the offline system does not support 23.976p NTSC projects. To 
convert a 24p NTSC sequence to 1080p/23.976p, you need to take an intermediate step and 
first convert it to 23.976p NTSC.

Several limitations apply to this conversion:

• Audio captured without pulldown (60 Hz) needs to be recaptured with pulldown (NTSC 
reference at 59.94 Hz).

• Media for the new 23.976p sequences and clips is offline. Sequences and clips cannot be 
linked to the original 24p media.

• You need to batch capture and import media. In most cases, you would do this after 
converting the sequence to 1080p/23.976.

The last two limitations also apply to other sequence conversions that create new sequences.

To convert a 24p NTSC sequence to 1080p/23.976:

1. On the HD online system, open a 1080p/23.976p project or create a new one.

2. Switch the project format to 23.976p NTSC. 

3. Open the bin that contains the original 24p sequence and select the sequence.
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4. Select Clip > Modify.

The Modify dialog box opens.

5. Select Set Format from the top list and select 23.976 NTSC from the Format menu.

6. Click OK.

The application creates a new sequence labeled with the extension 23.976 fps.

7. Switch the project format back to 1080p/23.976p project.

8. Select the new 23.976p sequence.

9. Select Clip > Modify.

10. Select Set Format from the top list and select 1080p/23.976 from the Format menu.

11. Click OK.

12. Batch capture, import graphics, and finish the sequence.

Converting a 23.976p NTSC Sequence to 720p/23.976

Because the source edit rates are different for these formats, you cannot simply change the 
project and sequence format. The following sequence is based on source material shot or 
transferred to 720p/23.976 and edited offline in a 23.976p NTSC project.

To convert a 23.976p NTSC sequence to 720p/23.976:

1. In the 23.976p NTSC project, duplicate the final sequence and move it to a new bin.

2. Decompose the sequence.

3. Select the master clips and export them as a shot log file.

4. Create a 720p/23.976p HD project.

5. Import the shot log file into a bin.

6. Batch capture the clips.

7. Open the SD bin containing the duplicated sequence.

8. Relink the SD sequence to the new HD clips.

See “Relinking Clips to a New Project Format” in the Help.
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Mixing SD and HD Material in a Project

You can mix SD and HD material in the same project. You can even mix SD and HD 
material in the same Timeline if the edit rates match. For example, you can edit both NTSC 
30i and 1080i/59.94 into the same sequence and then play the sequence in real time. This 
feature is useful if you want to preview SD material in an HD project. For more information, 
see “Mixing Resolutions” and “Mixing Video Formats in a Sequence” in the Help.

• In an HD sequence, an SD image is stretched to fill a 16:9 monitor.

• In an SD sequence, an HD image is anamorphically squeezed to fit the 4:3 monitor.

You cannot output a sequence that mixes SD and HD material. To output a mixed sequence 
as HD, you need to transcode the clips that use the unsupported resolution to an HD 
resolution, see “Transcoding HD Media” on page 72. All master clips then share the same 
format. 

You might also need to apply an effect, such as Reformat or Resize, in which case you need 
to render the effects. This process creates new media in the format of the sequence.

You can set an option to highlight clips that do not match the project format. See 
“Highlighting Clips in a Mixed-Format (SD and HD) Timeline” in the Help.

n If you have a sequence that mixes SD and HD clips, and you need to recapture the SD clips 
in an HD resolution, you can create a subsequence of the SD clips, modify the format of the 
subsequence, see “Understanding Options for Modifying the Sequence Format” on page 66, 
decompose, and recapture.

Displaying Formats in a Bin

The Format column displays the format of a clip or sequence as determined by the project 
type, such as 30i NTSC or 1080i/59.94. This is especially useful if you have both SD and 
HD clips in the same bin.

Format column
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For information on displaying a column, see “Manipulating Bin Columns” in the Help.

Editing at 60 fps

The project type 720p/59.94 uses a screen resolution of 1280 x 720 at a frame rate of 
60 frames per second. Editing at 60 fps is similar to editing at 24 fps because both 
resolutions are progressive — they use full frames instead of interlaced fields. Note the 
following:

• Single-frame step commands move at 1/60th of a second. Single-field step commands 
are deactivated; if you click a button, the application beeps.

• You can mark IN and OUT points at 1/60th of a second increments.

• You can trim at 1/60th of a second increments.

• Transition effects default to one-second duration (60 frames).

• Deck control for capture and digital cut is limited to 30 fps. A message box warns you if 
you try to mark an odd timecode value (such as 01:00:00:03). 

n 1080i/50 and 1080i/59.94 are interlaced resolutions that you edit at 25 frames per second 
and 30 frames per second. 

Working with True 24 FPS Timecode

Avid HD editing applications support direct device control at 24 fps, enabling you to capture 
true 24-fps timecode from HD decks. When you are capturing 23.976-fps or 24-fps material 
in HD, the Capture tool displays 24-fps timecode for the Mark IN and Mark OUT points. 
After you capture a clip, the Start and End timecodes are also shown as 24-fps timecode.

Transcoding HD Media

For HD projects, the Consolidate/Transcode dialog box lists compatible HD resolutions. For 
resolution information, see “Resolution Specifications: HD” in the Help. For information on 
transcoding media, see “Using the Transcode Command” in the Help.

Using HD Universal Mastering

Some combinations of an Avid editing application and Avid input/output hardware provide 
HD Universal Mastering capabilities.

HD Universal Mastering allows 1080p high-definition sequences (both NTSC and PAL) 
edited at one frame rate to be played back in real time at a different frame rate and with 
audio conversion that matches the video conversion.
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If you create a sequence in one frame rate (for example, 24 fps), you can then output the 
sequence at an alternate frame rate (for example, 25 fps). This modifies the duration of the 
sequence to roughly 96% of its original length.

HD Universal Mastering preserves synchronization with the converted video by remastering 
audio at a different sample rate to generate replacement audio tracks from previously 
mixed-down audio clips. Once replacement audio tracks have been generated, you can edit 
them into a new sequence, or edit them into the original sequence as alternative tracks, and 
then use the Digital Cut tool to output the sequence.

The following frame rates are supported for HD Universal Mastering of sequences (sample 
rates are included as examples of remastered audio):

HD Universal Mastering applies only to sequences created in a 1080p project format, and 
the audio quality is best if you are working with 48 kHz audio.

Converting Audio for HD Universal Mastering

Before you output your sequence with HD Universal Mastering, you need to convert the 
audio tracks so that they match the frame rate of the video tracks

To prepare audio tracks for HD Universal Mastering:

1. Load a sequence in the Record monitor or the Timeline.

2. Click the Track buttons in the Track Selector panel in the Timeline to select the audio 
tracks you want to mix down.

Original Frame Rate Mastered Frame Rate Original Sample Rate Mastered Sample Rate

23.976 fps 24 fps 48000 47952

23.976 fps 25 fps 48000 46034

24 fps 23.976 fps 48000 48048

24 fps 25 fps 48000 46080

25 fps 24 fps 48000 50000

25 fps 23.976 fps 48000 50050
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3. Perform an audio mixdown.

For information on how to mix down audio, see “Mixing Down Audio Tracks” in the 
Help.

The audio is mixed down, and your Avid editing application displays the new master 
clip in the bin.

4. Select the mixed-down audio clip in the bin, and do one of the following:

t Select Clip  > Change Sample Rate.

t Right-click the clip and select Change Sample Rate.

The Change Sample Rate dialog box opens.

5. Click the Sample Rate menu, and select the appropriate conversion option:

t 23.97fps -> 24fps for Universal Mastering

t 24fps -> 25fps for Universal Mastering

t 24fps -> 23.97fps for Universal Mastering

t 25fps -> 23.97fps for Universal Mastering

t 25fps -> 24fps for Universal Mastering

t 23.97fps -> 25fps for Universal Mastering
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6. (Option) Click the Quality menu and select one of the following conversion quality 
options:

t High

t Medium

t Low

n Avid recommends you accept the default Quality setting of High. Selecting a lower Quality 
setting might lead to degraded audio quality in your media output.

7. (Option) Select the Delete Original Media option if you want the system to delete the 
original media automatically after the conversion process is complete.

8. (Option) Click the Target Drive menu and select a drive for the new media files different 
from the drive setting in the Audio Project settings. For more information on Audio 
Project settings, see “Audio Project Settings for Capture” in the Help.

Make sure that you choose a target drive with enough storage space for the generated 
media files and the ability to play back media. 

9. Click OK.

10. Select Clip > New Audio Track twice to create two new audio tracks in the Timeline.

11. Use the Track Selector buttons to select only the two new audio tracks.

12. Mark an IN point on the first frame of the sequence.

13. Make sure the position indicator in the Timeline is on the first frame of the sequence.

14. Click the Overwrite button to add the converted audio to original sequence.
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Performing a Digital Cut with HD Universal Mastering

Once you have mixed down your audio tracks and added the new audio clip to your 
sequence, you can output your sequence at a new frame rate by performing a digital cut.

To perform a digital cut with HD Universal Mastering:

1. Make sure your sequence is loaded in the Source monitor.

2. Select Output > Digital Cut.

The Digital Cut tool opens. 

3. Select the video tracks you want represented in the digital cut by using the Sequence 
Track buttons.

4. Deselect all audio tracks except the converted tracks by using the Sequence Track 
buttons (see “Converting Audio for HD Universal Mastering” on page 73).

Sequence 
Track 
buttons

Output 
Format 
menu

Play Digital Cut 
button

SD 
Downconve
rt menu
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5. Click Output Format, and select the appropriate frame rate option:

t 23.976

t 24

t 25

6. (Option) Click SD Downconvert, and select the appropriate resize option. The options 
available depend on the selected Output Format option. For more information on SD 
Downconvert, see “Video Output Tool Settings: HD Tab” in the Help.

7. Select the appropriate options for your digital cut.

For more information on using the Digital Cut tool, see “Using the Digital Cut Tool” in 
the Help.

8. Click the Play Digital Cut button.

Your Avid editing application cues the record deck, then plays and records the sequence 
at the remastered frame rate. The playback appears in the Record monitor and in the 
Client monitor. Once the digital cut completes (or is aborted), the input/output hardware 
resets to the original project frame rate.

n If you select a deck or tape for your digital cut that is set for a frame rate different from the 
current sequence format, a message reminds you to switch the genlock signal to match the 
selected output rate and indicates the genlock changes that best match the output. Also, there 
might be a slight delay in playback as the input/output hardware adjusts the frame rate.

Video Color Space for HD

Color space determines how the color components of the video signal are stored and 
processed. HD video uses an international specification for the YCbCr color space called 
ITU-R 709. It is an expansion of the earlier YCbCr specification for SD called ITU-R 601. 
ITU-R 601 and ITU-R 709 share some information: for example, for 8-bit components, 
black is mapped to 16 and white is mapped to 235. However, color values can change when 
you are converting from SD to HD, and vice versa. Avid HD editing applications 
automatically compensate for these differences.

n YCbCr and YPbPr refer to the same color space. Avid editing systems use YPbPr to 
designate HD analog output, both in the Video Output tool and on the back of Avid 
input/output hardware. The HD tab of the Video Output tool provides sliders to adjust the 
YPbPr analog output through the YPbPr connectors on the back of the Avid hardware
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Working with HDV

Avid editing applications provide the following High Definition Video (HDV) project types. 
For HDV projects, you should select HDV as the raster type. (Some project types are not 
available for some Avid input/output hardware configurations.)

• 720p/23.976

• 720p/25

• 720p/29.97

• 720p/50

• 720p/59.95

• 1080i/50

• 1080i/59.94

You can capture from an HDV device, edit in native HDV, and export to an HDV device 
using these project types.

You can also use HDV in other project types, but Avid editing applications are more efficient 
and perform better with the dedicated HDV project types. The other project types you can 
use include:

• PAL 25i

• NTSC 30i

n You cannot capture or export native HDV in the non-HDV project types.

Understanding HDV

HDV is a low-cost prosumer format that allows you to record HD video onto standard DV 
videocassettes. This is achieved through the use of interframe compression, where a given 
frame in the video stream can be composed of information from adjacent frames. Frames are 
grouped into a sequence called a “Group of Pictures,” or GOP. Long-GOP (also known as 
IPB encoding) refers to the structure of HDV media. 

A GOP contains several different types of compressed frames: 

• I frames, which are compressed frames that do not depend on any frames around them. 
I frames anchor the beginning of the GOP.

• P (predictive) frames and B (bidirectional) frames, which depend on the frames 
around them.



Working with HDV

79

Interframe compression is more efficient than frame-based schemes (such as DV 25), 
allowing high-bandwith HD images to be contained on media designed for standard 
definition (SD). However, HDV is more difficult to edit since frames are not independent of 
one another. Avid provides a workflow that allows you to edit natively with 
HDV-compressed video without requiring a transcode to frame-based media, and without 
limiting where you make your cuts.

The Avid editing application uses a technique called long-GOP splicing when encoding an 
HDV MPEG-2 sequence for export. For more information, see “Long-GOP Splicing for 
HDV Encoding” on page 83.

HDV uses MPEG-2 video encoding and MPEG-1 audio encoding. 1080i records at about 
25Mbps and 720p records at about 19Mbps. Sony provides HDV cameras that record at 
1080i/59.94 and 1080i/50. JVC® cameras record at 720p/29.97 and 720p/23.976.

In the 1080i formats, the data rate of the video is reduced before compression by 
horizontally resizing the video display (raster) from 1920 x 1080 pixels to 1440 x 1080 
pixels. In contrast, 720p projects use the standard HDV raster size of 1280 x 720. A special 
resolution, DNxHD-TR (for Thin Raster), improves the performance of 1080i HDV editing. 
This resolution matches the 1080i HDV raster size, reducing artifacts that would come from 
repeated compressions when rendering effects and graphics.

HDV Basic Workflow

A basic workflow for an HDV project is as follows:

To work with HDV:

1. Select one of the following Avid project types depending on the format in which your 
HDV camera records and the project types available for your input/output hardware:

- 720p/23.976

- 720p/25

- 720p/29.97

- 720p/50

- 720p/59.94

- 1080i/50

- 1080i/59.94

2. Click the Raster Type menu, and select HDV.
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3. Do one of the following:

- Capture HDV material.

- Import an HDV file.

The media is brought in as one video track and two 48-kHz audio tracks.

4. Edit the material.

5. Select the sequence.

6. Output the sequence back to the HDV device using the Export to HDV Device dialog 
box.

You can also export the file in other formats or use Windows Media 9 for export to a 
third-party HD-DVD authoring system, See “Exporting HDV as Windows Media” on 
page 86.

Capturing and Importing HDV

You can capture HDV only through a IEEE 1394 port, as described in “Capturing HDV” on 
page 80.

You can import an HDV transport stream file (.m2t). Transport streams combine video and 
audio for transmission through an IEEE-1394 port. Your Avid editing application separates 
the transport stream after import or capture into the video and audio for editing. 

After import or capture, the master clips in the Avid editing application contain HDV 
long-GOP MPEG-2 video in MXF format and 2 channels of uncompressed 48 kHz 16-bit 
audio.

Capturing HDV

How you capture HDV material depends on your system configuration:

• On a system with Avid Mojo SDI input/output hardware, use the 1394 port on the Mojo 
SDI.

• On other systems, use a 1394 port on the computer (Host 1394). On a Windows system 
using Avid Adrenaline or Avid Mojo input/output hardware, this 1394 port must be on 
an optional IEEE-1394 card installed on a bus separate from the one used by the Avid 
Adrenaline or Avid Mojo.

The Sony 1080i HDV cameras mark accurate timecode and can be used for batch capturing.
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The JVC 720p/29.97 HDV camera restarts timecode every time the system starts to capture. 
You cannot batch capture HDV material with a JVC 720p/29.97 HDV camera.

For more information, see “Capturing DV Media Directly from a DV Device” in the Help.

To capture HDV material:

1. Set up an HDV project, depending on the format in which your HDV camera records.

2. If you are using Avid Adrenaline, Avid Mojo, or Avid Mojo SDI input/output hardware, 
do one of the following:

t Select Special > Device > IEEE 1394.

t Click the DNA/1394 button on the Timeline to show 1394.

3. Select Tools > Capture.

The Avid system automatically selects the correct resolution for native HDV.

4. Select other options, and start to capture.

For more information about capturing, see “Capturing Media: Basics” in the Help.

Importing HDV

To import HDV media, you must import an HDV transport stream. You cannot import 
transport stream types other than HDV.

n The file name extension .m2t does not indicate if the transport stream contains HDV media.

To import an HDV transport stream:

1. Select File > Import.

The Import As dialog box opens.

2. Select Files of Type > HDV files (*.m2t).

3. Select the target drive (no other import options are needed).

4. Click Open.

Your Avid editing application copies the media in a fast import as native HDV.

Mixing SD and HD Resolutions with HDV

You can mix SD resolutions and HD resolutions in the same Timeline with HDV as long as 
they have compatible frame rates and raster sizes. See “HDV Compatibility Guidelines” on 
page 88.
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Playing Back HDV Media

Depending on your input/output hardware, there might be some limitations when you play 
back HDV media. With a DV device connected in IEEE-1394 mode, you can play back to 
the DV device in Draft Quality and Best Performance quality only. With no device 
connected, you can play back as Full Quality and use the full-screen playback monitor. You 
can play back to the DV device as Full Quality only if you first transcode the material to 
DNxHD or DNxHD-TR. For more information, see the table in “Rendering and Transcoding 
HDV Media” on page 82.

In a 1080i HDV project you can play back through some Avid input/output hardware 
configurations (including through a non-1394 output on an Avid Mojo SDI) by changing the 
project type.

If you have a system with Avid Nitris DX input/output hardware, you do not need to 
transcode your HDV media or change your project type for playback. 

To play back HDV media:

t In the Project window, click the Format tab. From the Project Type menu, select a 
project type as follows.

- For 1080i/50 projects, select 25i PAL.

- For 1080i/59.94 projects, select 30i NTSC

The media is downconverted and plays in SD with an anamorphic squeeze.

Rendering and Transcoding HDV Media

You cannot render to an HDV resolution. Also, you might need to transcode the HDV 
sequence (see “Outputting HDV through Avid Input/Output Hardware” on page 85). The 
following table provides information on which resolutions are used for rendering and 
transcoding in each project type when you select HDV as the raster type.

HDV Project Type Renders or Transcodes to

720p/23.976 DNxHD 60, DNxHD 90, DNxHD 90x, DVCPro HD

720p/25 DNxHD 60, DNxHD 90, DNxHD 90x, DVCPro HD

720p/29.97 DNxHD 75, DNxHD 110, DVCPro HD

720p/50 DNxHD 120, DNxHD 185, DNxHD 185x, DVCPro HD

1080i/50 DNxHD–TR 120

1080i/59.94 DNxHD–TR 145
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For more complete information on rendering and transcoding, see “Basics of Effects 
Rendering” and “Using the Transcode Command” in the Help.

Outputting HDV

To send your edited HDV sequence back to an HDV device, you need to use a transport 
stream. You can use an existing transport stream or create a new one. To create a digital cut 
to go out to other devices, you need to first transcode the sequence.

Long-GOP Splicing for HDV Encoding

Your Avid editing application uses a technique called long-GOP splicing when encoding an 
HDV MPEG-2 sequence for export. When you export to an HDV device, the application 
uses splicing to reconstruct only the edited sections of the media, such as cut points, 
transitions, and segments that contain effects. Other areas of the sequence are copied intact. 
The result is faster encoding at higher quality.

Exporting to an HDV Device

The Export to HDV Device dialog box lets you create a transport stream file. You cannot use 
the standard Digital Cut tool to output HDV. You must use a IEEE 1394 port to output the 
transport stream file back to the HDV device. You can export an entire sequence or the 
marked section between IN and OUT points.

To export the HDV material to an HDV device:

1. If you are using Avid Adrenaline, Avid Mojo, or Avid Mojo SDI input/output hardware, 
do one of the following:

t Select Special > Device > IEEE 1394.

t Click the DNA/1394 button on the Timeline to show 1394.

2. Select the sequence or marked section.
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3. Select Output > Export to Device > HDV.

The Export to HDV Device dialog box opens.

4. Select options as described in the following table:

5. Click OK.

The transport stream file is created (or saved, if you used an existing transport stream).

Option/Suboption Description

Use Existing Transport Stream Select this option if you previously exported or output a 
transport stream and saved it.

Create New Transport Stream/ 
Delete Transport Stream after 
writing to HDV Device

Not available if you use an existing transport stream. Select to 
create a transport stream and then save it.

Create New Transport Stream/ 
Use Marks

Not available if you use an existing transport stream. When 
you select this option, the system uses current IN and OUT 
points in the selected clip or sequence to determine starting 
and ending frames for the export. To output the entire clip or 
sequence, deselect this option.

Create New Transport Stream/ 
Use Enabled Tracks

Not available if you use an existing transport stream. When 
this option is selected (default), the system uses tracks that are 
enabled in the Timeline. To output the entire clip or sequence, 
deselect this option.
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Outputting HDV through Avid Input/Output Hardware

You can use Avid input/output hardware to output a sequence created with HDV media, but 
you must transcode the sequence and then use the standard Digital Cut tool.

To perform a digital cut on a system using Avid input/output hardware:

1. If you are using Avid Adrenaline, Avid Mojo, or Avid Mojo SDI input/output hardware, 
do one of the following:

t Select Special > Device > Avid DNA.

t Click the DNA/1394 button on the Timeline to show DNA.

2. Select the sequence or marked section.

3. Transcode the sequence as described in “Rendering and Transcoding HDV Media” on 
page 82.

4. Select Output > Digital Cut

5. Proceed as with any digital cut.

See “Using the Digital Cut Tool” in the Help.

Exporting an HDV Transport Stream

You can export an HDV transport stream for use in other applications.

To export an HDV transport stream:

1. Select the sequence or marked section.

2. Select Export in the Settings tab of the Project window.

The Export Settings dialog box opens.

3. Select Export As > HDV.

4. Select Use Marks and Use Enabled Tracks as desired.

See “Export Settings: HDV” in the Help.

5. Click OK. 

You can also export to other formats, such as QuickTime movie, or use the Send To 
function to send the sequence to an application such as Sorenson Squeeze. You can also 
export to Windows Media 9 for finishing to HD-DVD.

To export to other formats:

t Export the sequence or use the Send To function as usual.

See “Exporting Frames, Clips, or Sequences” or “Improving Workflow Using Send To” 
in the Help.
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Exporting HDV as Windows Media 

Use the following samples as a guide when exporting an HDV sequence as Windows Media 
for use on the Web or for use in DVD authoring:

To export HDV as Windows Media for use on the Web:

1. Select the sequence or clips you want to export. 

2. Select File > Export. 

The Export As dialog box opens. 

3. Click the Options button. 

The Export Settings dialog box opens. 

4. Select Export As > Windows Media. 

5. Set the following:

6. Click Save to export the sequence. 

7. In the Export As dialog box, select the destination folder for the file. 

8. Click Save. 

The sequence is exported using the selected settings. 

Setting Value

Width 720

Height 540

FPS 60

Video Type Progressive

Pixel Aspect Ratio 16:9

Codec Windows Media 9

VBR Enabled and set to Quality

Audio Settings Leave set at defaults
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To export HDV as Windows Media for use in DVD authoring:

1. Select the sequence or clips you want to export. 

2. Select File > Export. 

The Export As dialog box opens. 

3. Click the Options button. 

The Export Settings dialog box opens. 

4. Select Export As > Windows Media. 

5. Set the following:

6. Click Save to export the sequence.

7. In the Export As dialog box, select the destination folder for the file.

8. Click Save. 

The sequence is exported using the selected settings.

Setting Value

Width 1440

Height 1080

FPS 60

Video Type Progressive

Pixel Aspect Ratio 16:9

Codec Windows Media 9

VBR Enabled and set to Quality

Audio Settings Leave set at defaults
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Finishing HDV on DS Nitris

The following procedure outlines the steps to take if you want to finish an HDV sequence on 
an Avid DS Nitris system.

To finish an HDV sequence on an Avid DS Nitris system:

1. When in a 1080i/59.94 HDV project, transcode your sequence to DNxHD 145. 

2. Export as an AFE. 

3. Import the AFE file to Avid DS Nitris v7.6 QFE 3 or later. To access Avid DS updates, 
go to www.softimage.com/avidds and click Download > QFE and other fixes.

n To create an AFE file from an Avid editing product running on a Macintosh system, copy the 
project folder from the Macintosh system to the Avid DS Nitris system. Then use MediaLog 
on the Avid DS Nitris system to create the AFE file. For more information, see the 
Avid DS Nitris Conform Guide.

HDV Compatibility Guidelines

You can change the format of a project using the Project Type menu in the Format tab of the 
Project window. You can also mix certain formats in the Timeline as long as they are at the 
same frame rate. The following table describes which formats are compatible with HDV 
material that you capture.

HDV captured at
Can change in Project 
Type menu to Can mix in Timeline with

720p/23.976 Cannot change format DNxHD-TR
DVCPRO HD
All 23.976 NTSC resolutions (DV 25, 1:1, and so on)

720p/25 25p PAL
1080p/25

DNxHD

720p/29.97 1080p/29.97 DNxHD

720p/50 Cannot change format DNxHD

1080i/50 25i PAL DNxHD-TR
DVCPRO HD
All 25i PAL resolutions (DV 25, 1:1, and so on)

1080i/59.94 30i NTSC DNxHD-TR
DVCPRO HD
All 30i NTSC resolutions (DV 25, 1:1, and so on)

http://www.softimage.com/avidds


1 Section II
Finishing Tools

Avid Symphony offers a wide range of tools for adding the finishing touches to
your project. The following chapters describe features that are unique to Symphony:

• Motion Tracking and Stabilization

• Symphony Color Correction

- Understanding Color Correction Mode

- Performing Color Corrections

- Managing Color-Corrected Sequences

- Color Correction Techniques

- Spot Color Correction

- Safe Colors

For information about other tools and features you might use, see the following topics
in the Help:

• Using the Reformat Effects

• Understanding the Intraframe Effects

• Getting Started with the Paint and AniMatte Effects

• Scratch Removal
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3 Motion Tracking and Stabilization

Your Avid editing application can track the motion of a selected area in an image over time. 
Once you have obtained tracking data, you can use it to control the motion of a digital video 
effect such as a Picture-in-Picture or a Paint effect. You can also use tracking data to 
stabilize an image to compensate for camera motion.

This chapter includes the following main topics:

• Understanding Motion Tracking

• Workflow for Motion Tracking

• Effects and Effect Parameters That Use Tracking Data

• Understanding the Tracking Interface

• Setting Up an Effect for Tracking

• Preparing to Generate Tracking Data

• Understanding How to Generate Tracking Data

• Generating Tracking Data

• Offset Tracking

• Understanding Generated Tracking Data

• Customizing Tracking Data Display

• Setting the Reference Frame for a Tracker

• Understanding the SteadyGlide and Smoothing Options for Tracking

• Using SteadyGlide or Smoothing to Process Tracking Data

• Modifying Tracking Data

• Limiting the Effect of Position Tracking Data to a Single Axis

• Playing Effects That Use Tracking Data

• Understanding Stabilizing

• Stabilizing an Image

• Guidelines for Using Multiple Trackers When Stabilizing

• Using the Region Stabilize Effect
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• Editing Segments That Use Tracking Data

• Reusing Existing Tracking Data

• Copying and Pasting Tracking Data

• Conforming Symphony Meridien Sequences with Tracking Data

• Examples of Effects Using Motion Tracking

Understanding Motion Tracking

This section includes conceptual information that helps you to understand how tracking 
works and when you might want to use it.

Understanding the Tracking Process

Motion tracking works by searching for a distinctive pattern of pixels in each frame of a 
video segment. As the pattern moves over time, your Avid editing application records the 
movement as a series of points, one for each frame or field in the segment. For example, if a 
car is moving across a segment, you can track a distinctive pattern on the side of the car, 
such as the shape of its side mirror. The result is a set of tracking data points that represent 
the movement of the car over time.

Once you have a set of data points, you can associate them with an effect parameter to 
control how an effect moves. For example, if you need to hide the identity of the person 
driving the car in your segment, you can associate the tracking data with the Position 
parameter of a Blur effect. The tracking data then controls the movement of the Blur effect 
so that the blurred area remained over the person’s head throughout the segment.

Each set of data points is contained within a structure called a tracker. Depending on the 
kind of motion you need to track, you might need one, two, or more trackers. For simple 
two-dimensional movement, a single tracker is sufficient. If you need to track rotational 
movement or scaling information, you need two trackers so that the system can calculate the 
position of one point in the image relative to a second point. For even more complex motion, 
such as that involved in corner pinning an image, you might need three or four distinct points 
to correctly track perspective or the angle at which the image is tilted.

Uses of Motion Tracking

One common use for motion tracking is to replace a moving area in one image with new 
material. For example, you can track the motion of a distinctive area on a vehicle and then 
use that data to replace an advertising sign on the vehicle or to replace or blur the license 
plate. In many cases, especially when the motion of the vehicle is complex, using tracking 
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data to control the movement of the foreground replacement is much quicker than using 
keyframes to define the movement by hand. For an example of this use of motion tracking, 
see “Example 1: Replacing the License Plate on a Moving Vehicle” on page 141.

Sometimes a shot is designed from the outset with motion tracking in mind. A director might 
attach a target to the moving vehicle so that it can be tracked easily. You could create a 
replacement sign as a graphic and import it or shoot a replacement sign against a keying 
background. During editing, you use tracking data to control the movement of the 
replacement material in a Picture-in-Picture or a chroma key effect promoted to 3D Warp.

Another use for motion tracking is to create an effect in which a foreground object follows a 
background object but remains offset from it. For example, you might track the movement of 
a hand in a background clip and then use that tracking data to control the movement of a 
foreground object so that the object’s movement appears to be controlled by the moving 
hand.

When you stabilize an image, you use tracking information somewhat differently. By 
tracking an object that should be motionless — for example, part of a building — you collect 
information about the movement of the camera from one frame to the next. The Stabilize 
effect then applies the inverse of that movement to each frame in order to eliminate the 
camera motion.

Motion Tracking and Footage Characteristics

The motion tracking tools in your Avid editing application allow you to track movement in 
many kinds of footage successfully.

However, there will always be some footage that is difficult or even impossible to track 
successfully. There might be no consistent pattern to track across multiple frames, or 
insufficient distinction between the pattern you want to track and the surrounding material. 
Typically, tracking requires a distinct edge in the target area, for example the edge of a 
moving vehicle against a background, or the edge of an advertising sign against the body of 
a vehicle.

n In some cases, you might be able to temporarily apply a color correction or a Color Effect 
that you can use to make a pattern more distinct. For example, if a blue vehicle does not 
track well against a sky background that is a similar shade of blue, you could use a 
secondary color correction on the vehicle to change its color temporarily.
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Workflow for Motion Tracking
The following workflow outlines the main stages of the motion tracking process and 
indicates where to find more detailed information and procedures for each stage.

Motion tracking provides considerable workflow flexibility. As you become a more 
experienced user of motion tracking, you can modify the order of these stages or merge them 
together to suit your editing style and the requirements of a particular project.

1. (Option) Before you begin working with the motion tracking tools, develop a general 
concept and design for the effect you want to create.

In some cases, you can design your shoot itself with tracking in mind, for example, by 
attaching a distinctive target to a moving object that you can later track and replace with 
an effect.

2. Set up the effect that you want to control using tracking information.

You access motion tracking from within an effect parameter for a specific effect, so you 
must set up the effect first. For more information, see “Setting Up an Effect for 
Tracking” on page 102.

3. Prepare to generate tracking data by creating trackers and customizing how the system 
will conduct the tracking operation.

For more information, see “Preparing to Generate Tracking Data” on page 104.

4. Generate tracking data.

Depending on the complexity of the movement you want to track, you might need to 
track one, two, or more distinct points in the image. Also, if you are not able to track one 
target area successfully throughout your segment, you might need to add one or more 
additional tracker regions and track each additional region.

For more information, see “Generating Tracking Data” on page 114 and “Performing 
Offset Tracking” on page 117.

5. If necessary, process or modify the tracking data.

For example, you might want to smooth the path of the tracking points, or adjust some 
of the points by hand. For more information, see “Using SteadyGlide or Smoothing to 
Process Tracking Data” on page 124 and “Modifying Tracking Data” on page 124.

6. Play back the effect.

The system calculates the motion of the effect by incorporating the tracking data and 
displays the result. For more information, see “Playing Effects That Use Tracking Data” 
on page 130.

7. If necessary, continue to adjust the tracking information or other effect parameters until 
you are satisfied with the look of the effect.
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Effects and Effect Parameters That Use 
Tracking Data

You can enable tracking and use tracking data for most segment effects that can move over 
time, including Picture-in-Picture, keys, Intraframe™ effects, titles, and all 3D effects. 
In some cases, you must promote an effect to 3D to access tracking for the effect or to access 
the full range of tracking options.

Effect parameters that can use tracking data divide into two groups:

• The Position, Scaling, and Rotation parameters allow you to use tracking data to control 
the specific kinds of motion associated with each parameter. You can work with tracking 
enabled in any combination of these parameters at the same time. For example, you can 
work with tracking enabled in both the Position and the Scaling parameters to control 
both the position of an effect on the X and Y axes and the size of the effect.

• The Tracking parameter category provides a more flexible way to define and use 
tracking data by allowing you to enable up to four trackers. The Tracking parameter is 
the only parameter that allows you to work with more than two trackers at one time and 
is therefore the only option for controlling complex motions that involve perspective 
changes or tilting of the effect.

You can also use the Tracking parameter with only one or two trackers enabled to 
control simpler motions such as position and scaling. This is the only option for such 
control in effects that do not have Position, Scaling, and Rotation parameters, such as 
Intraframe effects. This is also an alternative method for controlling simpler motions in 
effects that do have Position, Scaling, and Rotation parameters.

It is important to understand that the two groups of parameters that use tracking data are 
mutually exclusive. When you enable the Tracking parameter, tracking is automatically 
disabled in the Position, Scaling, and Rotation parameters. When you enable tracking in the 
Position, Scaling, or Rotation parameters, the Tracking parameter is automatically disabled.

The following table provides a complete list of the effects and effect parameters that can use 
tracking data. For reference information on these effects and their parameters, see “Effects 
Reference” and “Effects Parameter Reference” in the Help.
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Understanding the Tracking Interface
The interface items that you use when tracking divide into three groups according to their 
locations:

• The Effect Editor

For more information, see “Tracking Controls in the Effect Editor” on page 97.

• The Effect Preview monitor

For more information, see “Tracking Controls in the Effect Preview Monitor” on page 
97.

• The Tracking window

For more information, see “Opening The Tracking Window” on page 98 and “Tracking 
Window Components” on page 98.

Effect Available Parameters

Picture-in-Picture (2D) Position, Scaling

Paint

AniMatte

Blur Effect

Mosaic Effect

Scratch Removal

Spot Color Correction (Symphony only)

Tracking

Stabilize Position, Scaling, Tracking

Matte Key effect (applied from Key category in the 
Effect Palette)

Position, Scaling

Imported Matte Key clip (2D) Position, Scaling

Titles (2D) Position, Scaling

3D Warp (including promoted Picture-in-Picture 
effects, keys, 3D Xpress shape effects, and titles)

Position, Rotation, Scaling, Tracking
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Tracking Controls in the Effect Editor

The Effect Editor includes tracking controls within those effect parameter categories that can 
use tracking information. These controls allow you to enable tracking for the parameter and 
to define which trackers apply to that parameter.

The appearance of tracking controls in the Effect Editor varies depending on whether or not 
the effect has been promoted to advanced keyframes.

The following illustration shows the tracking controls for the Position parameter category in 
both standard keyframes and advanced keyframes.

For more information, see:

• “Effects and Effect Parameters That Use Tracking Data” on page 95

• “Enabling Tracking in the Effect Editor” on page 104

• “Creating and Mapping Trackers” on page 107

Tracking Controls in the Effect Preview Monitor

The Effect Preview monitor displays tracking controls that you can manipulate directly. The 
monitor displays the tracking boxes that you use to define the target area and the search area 
on the first frame or field of the region that you want to track. As tracking takes place, the 
monitor displays the generated data points for each frame or field. Once tracking data has 
been generated, you can display tracking data points in various ways and manipulate them in 
the monitor. For more information, see the following sections:

• “Setting Up Tracking in the Effect Preview Monitor” on page 109

• “Tracking Data in the Effect Preview Monitor” on page 118

• “Customizing Tracking Data Display” on page 120

• “Modifying Tracking Data” on page 124

Tracker controls for Position 
parameter category — effect 
with standard keyframes

Tracker controls for Position 
parameter category — effect 
promoted to advanced keyframes
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The following illustration shows a typical display of tracking boxes and data points.

Opening The Tracking Window

Many of the controls that you use to create, customize, and modify trackers are located in the 
Tracking window.

For more information on the features of the Tracking window, see “Tracking Window 
Components” on page 98.

To open the Tracking window, do one of the following in the Effect Editor:

t Enable tracking in an effect parameter for a tracker that is not currently mapped.

For more information, see “Creating and Mapping Trackers” on page 107.

t Click the Tracking Tool button.

You might need to resize the Effect Editor to see the Tracking Tool button in the column 
of buttons on the right side.

Tracking Window Components

The Tracking window has the following main features:

• An area containing controls for setting up and performing tracking, controlling the 
display of tracking data, and modifying tracking data

• A timeline representation of each tracker for the current effect
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The following illustration shows the Tracking window.

The following table provides a brief description of each interface item in the window and 
indicates where to find more detailed information.

Tracking Window Components

Control Description

Start Tracking Starts a tracking operation from the current location 
of the position indicator. For more information, see 
“Generating Tracking Data” on page 114.

New Tracker Creates a new tracker. For more information, see 
“Creating and Mapping Trackers” on page 107.

Go to Previous Region 
and Go to Next Region

Click one of these buttons to move to the previous or 
next region boundary in the tracker timelines. For 
more information, see “Moving to a Tracking 
Region” on page 117.

Tracking Engine Allows you to choose between the two available 
tracking engines, Correlation Tracker and 
FluidTracker. For more information, see 
“Understanding Tracking Engines” on page 113.
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Track 
Background/Foreground

Allows you to choose between tracking the 
background shot and tracking the foreground shot, 
In the great majority of cases, you will want to track 
the background shot. For more information, see 
“Setting Up Tracking in the Tracking Window” on 
page 112.

Point Range Controls how many of the tracking data points 
appear in the Effect Preview monitor. For more 
information, see “Customizing Tracking Data 
Display” on page 120.

Display Controls the display in the Effect Preview monitor, 
allowing you to view either the tracking data or the 
results of the effect. For more information, see 
“Customizing Tracking Data Display” on page 120.

Stretch Points Mode Allows you to stretch data points. For more 
information, see “Stretching a Range of Tracker 
Data Points” on page 128.

Enable Tracker button 
(Tracker timeline 
displays)

When the Enable Tracker button is active for a 
tracker, tracking boxes and tracking data points 
display in the Effect Preview monitor. Also, when 
the Enable Tracker button is active for a tracker, the 
system generates tracking data for that tracker 
during a tracking operation. The button is purple 
when active and gray when inactive. For more 
information, see “Enabling, Disabling, and Deleting 
Trackers” on page 108.

Offset Tracking (Tracker 
timeline displays)

When this option is selected, the tracker uses offset 
tracking to calculate a continuous motion for the 
effect from multiple regions of tracking data. For 
more information, see “Offset Tracking” on page 
115.

Tracking Window Components (Continued)

Control Description
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SteadyGlide (Tracker 
timeline displays)

When this option is selected, the tracking data for 
the tracker is processed to remove unwanted jittery 
motion while preserving underlying smooth 
movement such as a camera pan or zoom. The value 
set in the Smoothing Value text box controls the 
extent of the processing. For more information, see 
“Using SteadyGlide or Smoothing to Process 
Tracking Data” on page 124.

Smoothing (Tracker 
timeline displays)

When this option is selected, the tracking data for 
the tracker is processed to smooth the path between 
selected points. The value set in the Smoothing 
Value text box controls the amount of smoothing 
applied. For more information, see “Using 
SteadyGlide or Smoothing to Process Tracking 
Data” on page 124.

Smoothing Value 
(Tracker timeline 
displays)

Enter a value in this text box between 1 and 100 to 
control the amount of smoothing performed by the 
SteadyGlide or Smoothing processes. The larger the 
value, the more smoothing is performed. For more 
information, see “Using SteadyGlide or Smoothing 
to Process Tracking Data” on page 124.

Tracker Color box 
(Tracker timeline 
displays; also visible in 
the Effect Editor)

Shows the color the system uses to display 
information for this tracker in the Effect Preview 
monitor and allows you to change the tracker’s 
display color. For more information, see 
“Customizing Tracking Data Display” on page 120. 

Tracker Name text box 
(Tracker timeline 
displays; also visible in 
the Effect Editor)

Shows the name of the tracker and allows you to 
change the name of the tracker. For more 
information, see “Creating and Mapping Trackers” 
on page 107.

Tracking Window Components (Continued)

Control Description
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Setting Up an Effect for Tracking

The first stage of the motion tracking workflow is to set up the effect to which you want to 
apply tracking data. To do this, you need to edit the necessary footage into a sequence and 
apply the effect. In most cases, you will also want to make initial parameter adjustments to 
the effect.

Understanding Video Layers and Motion Tracking

Since motion tracking either controls the movement of an effect in relation to a moving area 
in a clip or controls the stabilization of a clip, you need one of the following situations for 
motion tracking to be useful:

• Two (or more) layers in the Timeline, where one contains the video you intend to track 
and another contains the material to which you will apply the effect (that material might 
be video, an imported graphic, or a title clip).

• A single video layer on which you draw one or more Intraframe objects. When you 
track movement in the video, you can use that tracking data to control the movement of 
the Intraframe objects.

• For stabilizing only, a single video layer that you intend to stabilize.

In most circumstances when you are working with two video layers, the material you intend 
to track forms the background layer and the effect is on the foreground layer. However, the 
system can track either the foreground or the background layer, so you can place the material 
you want to track on top of the material that receives the effect if necessary.

Tracker timeline 
(Tracker timeline 
displays)

Shows information about the tracking data in the 
tracker. Color coding indicates the status of the data. 
For more information, see “Setting Up Tracking in 
the Effect Preview Monitor” on page 109 and 
“Tracking Data in the Tracker Timelines” on page 
118.

Tracker Close button 
(Tracker timeline 
displays)

Closes the tracker and permanently deletes any 
information within it. For more information, see 
“Enabling, Disabling, and Deleting Trackers” on 
page 108.

Tracking Window Components (Continued)

Control Description
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Applying an Effect for Motion Tracking

You apply an effect for motion tracking in the same way that you apply any effect that either 
operates on a multilayer sequence or allows you to draw a foreground object on top of a 
video layer. For more information, see “Applying Effects” in the Help.

Making Non-Tracking Parameter Adjustments to an Effect 

The final look of an effect that uses tracking is almost always the result of combining the 
tracking data with standard effect parameter adjustments. You will usually need to define the 
appearance of the effect in the first frame or field of the segment; you might also need 
keyframe adjustments at other points in the segment.

In most cases, you can choose whether to make these adjustments before or after you 
generate the tracking data itself. As long as the standard adjustments as well as the tracking 
data are in place when you play the effect, you see the final result of all the adjustment data.

For example, if you are replacing a sign on a moving vehicle, you need to use standard effect 
parameter adjustments to set the initial size, shape, and position of the sign. Depending on 
the complexity of the material, you might make these adjustments using basic parameters 
such as Position and Scaling, or you might need to place each corner independently using 
the Corner Pin parameter.

If you want the effect to be offset from the moving area that you plan to track, you can 
establish that offset by adjusting the Position parameters. The final motion of the effect 
maintains that offset from the tracking data points as it moves. If you want the size of the 
effect to change in a manner that is not dependent on changes in the moving area, you can set 
up that change in size by using keyframes and the Scaling parameters.

When you are working with Intraframe effects, you must draw the foreground object that 
you want to control with tracking information and select it with the Selection tool before you 
can generate tracking data. As with other effects, however, you can establish the precise size, 
shape, and position of the object either before or after generating tracking data.

n You can choose which frame in a tracked segment is the reference frame — the frame at 
which the tracking data makes no change to the look of the effect. For more information, see 
“Setting the Reference Frame for a Tracker” on page 121.
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Preparing to Generate Tracking Data
There are several procedures that you need to follow before you can generate tracking data. 
These procedures control how the system operates as it creates the tracking data.

Enabling Tracking in the Effect Editor

The first step in creating tracking data is to enable tracking for an effect parameter in the 
Effect Editor. Once you do this, other tracking controls become available.

The basic procedure for enabling tracking in an effect parameter is simple, but there are 
slight variations depending on:

• The parameter type

• Whether the effect you are working with is 2D or 3D

• Whether the effect you are working with is using standard keyframes or advanced 
keyframes

n For Intraframe effects, trackers can be enabled only when an Intraframe object is selected.

To enable tracking for an effect parameter:

t Perform the appropriate steps for your effect type and effect parameter, as described in 
“Options for Enabling Tracking in the Effect Editor” on page 105.

Once you have enabled tracking for a parameter, the Tracking window opens. For more 
information on the Tracking window, see “Tracking Window Components” on page 98.

When you first enable tracking for a parameter, the system creates appropriate default 
trackers and maps them to the parameter, as described in the table. For more 
information, see “Creating and Mapping Trackers” on page 107.
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Options for Enabling Tracking in the Effect Editor

The following table describes the available methods for enabling tracking in the Effect 
Editor.

Options for Enabling Tracking in the Effect Editor

Parameter and 
Keyframe Type Procedure and Result Illustration

Position, Rotation, 
or Scaling in any 
effects using 
standard keyframes

• Click the Use Tracking button.

The application creates an appropriate 
number of trackers (one for Position, two 
for Rotation or Scaling) and maps them to 
the parameter.

Position or Scaling 
in 2D effects using 
advanced keyframes

• Open the Position or Scaling category, then 
click the enable button for the Tracking 
subcategory.

The application creates an appropriate 
number of trackers (one for Position, two 
for Scaling) and maps them to the 
parameter. You must open the Tracking 
subcategory to see the list of mapped 
trackers and any additional controls.

Position, Rotation, 
or Scaling in 3D 
Warp effects using 
advanced keyframes

• Open the Position, Rotation, or Scaling 
category, and then click the enable button 
for the Position Tracking, Rotation 
Tracking, or Scale Tracking subcategory.

The application creates an appropriate 
number of trackers (one for Position, two 
for Rotation or Scaling) and maps them to 
the parameter. You must open the Position 
Tracking, Rotation Tracking, or Scale 
Tracking subcategory to see the list of 
mapped trackers and any additional 
controls.

Tracking in any 
effect using 
standard keyframes

• Click one or more of the individual tracker 
enable buttons.

The application creates and maps a tracker 
for each tracker enable button you click, 
and also enables the Tracking 
parameter category.
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Understanding Tracker Selectors and Tracker Function

Each parameter includes a number of tracker selectors appropriate to its function in 
controlling movement. When you enable tracking in a parameter, the application looks for 
existing trackers and maps them to the parameter’s tracker selectors. If trackers do not yet 
exist, the system creates them and then maps them to the parameter’s tracker selectors. In the 
Tracking parameter category, new trackers are created and mapped as you enable individual 
tracker selectors.

When you are working in the Position, Scaling, and Rotation parameters, the number of 
trackers you can use is limited by the type of movement controlled by the parameter. For 
example, the Position parameter includes a single tracker selector since only one point is 
required to define movement in X and Y. 

Tracking in 2D 
effects using 
advanced keyframes

• Open the Tracking parameter category, and 
then click one or more of the individual 
tracker enable buttons.

The application creates and maps a tracker 
for each tracker enable button you click, 
and also enables the Tracking category.

Tracking in 3D 
Warp effects using 
advanced keyframes

• Open the Corner Tracking parameter 
category, and then click one or more of the 
individual tracker enable buttons.

The application creates and maps a tracker 
for each tracker enable button you click, 
and also enables the Corner Tracking 
category.

Options for Enabling Tracking in the Effect Editor (Continued)

Parameter and 
Keyframe Type Procedure and Result Illustration
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When you are working in the Tracking parameter, you can use any number of trackers up to 
a total of four. The following table describes the kinds of motion that you can control with a 
given number of trackers.

Creating and Mapping Trackers

Your Avid editing application performs initial tracker creation and mapping automatically 
when you first enable tracking for an effect parameter.

For most tracking work, there is no need to create additional trackers beyond those that are 
created automatically by the system. Accepting the defaults and creating your tracking 
information with them is quicker and more straightforward.

In some situations, however, you might want to create extra trackers. For example, you 
might want to track more than the minimum number of points necessary for a parameter so 
that you can experiment with different combinations of tracking points. You also might want 
to change the mapping of trackers so that an effect parameter uses a different tracker or 
combination of trackers from that originally created by the application. For more 
information about the uses of different tracker combinations, see “Understanding Tracker 
Selectors and Tracker Function” on page 106.

The system allows up to eight trackers for each effect.

Number of Trackers Description

One Allows control of position on the X and Y axes only. Use one tracker if you want 
your effect to move in only two dimensions on the plane of the screen.

Two Allows control of position, scaling, and rotation. Use two trackers if you want your 
effect to change size or rotate.

Three Allows control of position, scaling, rotation, and skew. Skew refers to a 
transformation that tilts or squashes an object along one axis while retaining its 
orientation along the other axis. This has the effect, for example, of transforming a 
rectangle into a parallelogram. Use three trackers if you want your effect to skew in 
this manner.

Four Allows control of position, scaling, rotation, skew, and perspective. Perspective 
refers to the way parallel lines appear to converge and changes depending on the 
angle from which an object is viewed. Use four trackers if you want to control 
perspective for your effect.
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To create a new tracker manually:

1. In the Tracking window, click the New Tracker button.

For more information, see “Opening The Tracking Window” on page 98.

A new tracker timeline display appears in the bottom area of the Tracking window. The 
system names the tracker using the next letter of the alphabet that is not already in use, 
up to the letter D. If all of the letters A through D are in use, subsequent new trackers are 
named “Untitled Tracker.”

2. (Option) If you want to rename the new tracker, click the Tracker Name text box, and 
type a new name.

The new tracker appears as an option in all the tracker selector Fast menus in the Effect 
Editor.

To map a tracker manually, do one of the following, depending on the interface style in 
the Effect Editor:

t Click the Fast Menu button for the appropriate tracker selector in the parameter, and 
then select the tracker you want.

t Click the tracker selector in the parameter, and then select the tracker you want.

Enabling, Disabling, and Deleting Trackers

Once you have created a tracker, you can enable and disable it as necessary. Enabling and 
disabling a tracker has a different effect depending on whether you do it in the Tracking 
window or in the Effect Editor.

• When you enable or disable a tracker in the Tracking window, you control whether or 
not the tracker displays in the Effect Preview monitor and whether or not your 
application generates tracking data for that tracker.

• When you enable or disable a tracker in the Effect Editor, you control which sets of 
tracking data your application uses to control the effect. This allows you to compare the 
look of an effect under the control of different tracker combinations.

You can also delete existing trackers. When you do so, you permanently erase that tracker 
and any tracking data associated with it.

To enable or disable a tracker in the Tracking window:

t Click the Enable Tracker button for the tracker in the tracker’s timeline.
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To enable or disable all trackers at once:

t Alt+click (Windows) or Option+click (Macintosh) the Enable Tracker button for any 
tracker.

To enable or disable a tracker in the Effect Editor:

t Click the Enable button for the appropriate tracker selector.

n In the Tracking (or Corner Tracking) parameter category, clicking the Enable button that 
controls the whole parameter disables all the trackers at the same time but does not change 
the enable status or the mappings of the individual trackers. When you click the Enable 
button for the whole parameter again, the system reenables all the individual trackers.

To delete a tracker:

t In the Tracking window, click the Close button in the top right corner of the tracker’s 
timeline.

Setting Up Tracking in the Effect Preview Monitor

You define the region of interest (the area of an image that each tracker tracks) and the larger 
area it searches within by making direct adjustments to the tracking box display in the Effect 
Preview monitor.

Each tracking box display includes three elements: 

• An inner rectangle used to define the target area

• An outer rectangle used to define the search area

• A data point locator, which appears at the center of the rectangles

Each rectangle has a corner adjustment handle.

The following illustration shows the tracking box display.

Adjustment handles

Search Area box

Data point locator

Target area box
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n You can change the color of the tracking boxes display for a tracker. This might make it 
easier to see the display against the background image. For more information, see 
“Customizing Tracking Data Display” on page 120.

To display tracking boxes in the Effect Preview monitor:

1. If you have not already done so, enable, create, and map the trackers with which you 
want to work.

2. In the Display Tracking Data area of the Tracking window, make sure that Tracking 
Data is selected in the Display menu.

3. Make sure that the Enable Tracker button is active (purple) in the tracker timeline 
display of the Tracking window for each tracker that you want to display.

4. Make sure that you are monitoring the track in the Timeline that contains the material 
you want to track.

5. Move the position indicator to the first frame or field of the segment, or to the first frame 
or field of the tracker region.

A tracking box display appears in the Effect Preview monitor for each tracker. For more 
information on tracking regions, see “Performing Offset Tracking” on page 117.

To move a tracking box display in the monitor:

t Click anywhere within the boxes except the adjustment handles, and drag the boxes to a 
new position.

To resize a box in a tracking box display:

t Drag the adjustment handle for the box.

For more information on what to consider when making these adjustments, see 
“Guidelines for Positioning Tracking Boxes” on page 110.

n If you have multiple trackers enabled, you might find it difficult to select one. You can 
disable some of the trackers temporarily in the Tracking window to simplify the display in 
the Effect Preview monitor and make it easier to select and manipulate a particular tracker.

Guidelines for Positioning Tracking Boxes

When you position tracking boxes, consider the following factors:

• Locating the boxes over material that the system can track successfully

• Locating the boxes so that the tracking data you generate accurately represents the 
movement you want to track
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The system tracks most successfully on an area of the image that is easily distinguishable 
from the parts of the image that surround it. For example, a bright dot tracks extremely well 
if it is generally surrounded by darker material. You will often need to scrub through the 
entire clip to get a sense of which areas are good candidates for tracking.

To represent the movement you want to track accurately, you need to consider the geometry 
of the motion that you want to achieve. For complex movement such as controlling a 
replacement sign for a bus that is receding into the distance as well as moving across the 
screen, you need to track enough points to represent the change in shape and size of the sign 
over time. Tracking two corners allows you to control changes in scale and rotation (the 
corners should be diagonally opposite if scaling on the X axis differs from scaling on the Y 
axis). Adding third and fourth trackers fills in the other two corners as needed for more 
complex transformations.

Remember that you do not have to track points at the exact location where you want the 
finished effect to appear. You can track any set of points that represent the right movement. 
For example, you might want to add a small sign to the door of a moving car. Since the door 
panel is a uniform surface you cannot track areas on it. However, you can gather tracking 
data to control the positioning and scaling you need for the sign, for example by tracking 
two or more of the corners of the car’s window.

Guidelines for Resizing Tracking Boxes

When you make adjustments to resize either of the tracking boxes, you should consider the 
following factors:

• Defining material that the system can track successfully

• Ensuring that tracking proceeds successfully from frame to frame or from field to field 
throughout the range of frames or fields you are tracking

• Minimizing the length of time the system spends generating tracking data

In general, the smaller you can make the boxes, the less image information the tracking 
engine has to search and the faster it can work. However, if you set the boxes too small, you 
increase the possibility that the system will lose the search pattern between one frame or 
field and the next.

n You can also refine how the system follows a target area by setting controls in the 
Tracking window. For more information, see “Setting Up Tracking in the Tracking Window” 
on page 112.
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Size the Target Area box so that it is as small as possible while still enclosing a distinct area 
to track. Remember that the pattern needs to remain distinct throughout the range you 
are tracking. 

Size the Search Area box so that it is as small as possible while remaining large enough to 
encompass the movement of the target area from one frame or field to the next. You will 
probably need to scrub through the clip you are tracking to check how much a prospective 
target area moves from one frame or field to another.

Setting Up Tracking in the Tracking Window

In addition to defining the search criteria for a tracker in the Effect Preview monitor, you can 
also set up the following aspects of tracking behavior in the Tracking window.

• Choose which tracking engine to use

For more information on available tracking engines, see “Understanding Tracking 
Engines” on page 113.

• Choose whether the region to track is in the background or the foreground clip.

You can choose to track either the background or foreground for a multilayer effect. In 
the great majority of situations you will want to track the background to define the 
movement of an effect or painted object layered above the background shot.

One situation in which you need to choose Track Foreground is when you are stabilizing 
an image using a 3D Warp effect promoted to advanced keyframes. For more 
information, see “Stabilizing an Image” on page 132.

The following illustration shows the area of the Tracking window that contains these 
controls.

To switch the tracking engine:

t In the Setup Tracking area of the Tracking window, select the tracking engine you want 
to use from the Tracking Engine menu.

To switch between background and foreground tracking:

t In the Setup Tracking area of the Tracking window, select the option you want to use 
from the Track Background/Foreground menu.
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Understanding Tracking Engines

The term tracking engine refers to the calculation methods that your application uses to 
recognize a moving pattern and generate data for it. Your Avid editing application lets you 
choose between two tracking engines:

• Correlation Tracker

This is the same tracking engine that is used in Avid DS Nitris systems.

• FluidTracker

This tracking engine uses the same motion analysis methods used in 
FluidMotion Timewarp.

In most cases, both tracking engines produce accurate tracking data when the target area is 
distinctive. The difference between the two trackers is primarily one of speed. In general, the 
Correlation Tracker generates tracking data faster than the FluidTracker when the area being 
searched is small. If you need to search a larger area, you might find that the Correlation 
Tracker becomes too slow to be useful, in which case you should switch to the FluidTracker.

In the following two specific situations, FluidTracker usually produces more accurate data 
than the Correlation Tracker:

• When the points you want to track start outside the visible area of the frame

• When you are using four trackers to control the corner-pinning of an image

Understanding How to Generate Tracking Data
When you have made all the preparations necessary to set up the tracking operation, you can 
generate tracking data.

You can generate tracking data for any number of the available trackers in a single operation.

You can generate tracking data for the entire length of the segment, or for any part of the 
segment starting from the location of the position indicator. This allows you to stop tracking 
at any point in the segment and resume later, or to retrack over any part of the segment 
whenever you need to do so.

You can also create separate tracking regions for different parts of your segment, and define 
a different target area for each region. This is primarily useful for performing offset tracking. 
Once you have created a region, you can move the position indicator to the start of that 
region and generate tracking data for the region. For more information, see “Offset 
Tracking” on page 115.
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As the system generates tracking data, it updates the tracker timeline displays to show the 
status of tracking data over time. For more information on the tracker timeline display, see 
“Understanding Generated Tracking Data” on page 118.

Generating Tracking Data
To generate tracking data:

1. In the Tracking window, click the Enable Tracker button for each tracker you want the 
system to track.

n Alt+click (Windows) or Option+click (Macintosh) the Enable Tracker button for any tracker 
to enable all trackers at once.

2. Move the position indicator to the location where you want to start generating tracking 
data.

This location can be at any point in the segment, but in most cases, the position indicator 
will be either:

- At the beginning of the segment.

- At the beginning of a region.

- At the location where you stopped generating tracking data and from where you 
want to resume tracking.

For information about moving to the beginning of a tracking region, see “Moving to a 
Tracking Region” on page 117.

3. Click the Tracking button.

The system begins to generate tracking data. 

As the tracking operation proceeds:

- The Effect Preview monitor displays each frame or field on which tracking is being 
performed, and shows the tracking data point for that frame or field as a cross.

- The application updates the timeline for each tracker to indicate the status of the 
tracking data over time. If you are tracking where there is no existing tracking data, 
the application replaces the red bar at the bottom of the line with a black bar at the 
top as data is generated, as shown in the following illustration. If you are retracking 
where tracking data already exists, you see no change in the tracker timeline, but the 
old tracking data is being replaced with new data.
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n When you start tracking from the beginning of a tracking region, your Avid editing 
application steps back one frame from the region boundary before it starts tracking. This is 
normal behavior to ensure that motion at the region boundary is tracked correctly.

To stop a tracking operation, do one of the following:

t Press the space bar.

t Press Ctrl+period (Windows) or Command+period (Macintosh).

t Click any element of the application’s interface.

The tracking operation stops.

Offset Tracking

You can use your application’s offset tracking capabilities to create smooth effect motion 
from tracking data that you generate using more than one target area. This lets you track 
motion successfully when a single target area is not available for the full duration of 
a segment.

Understanding Offset Tracking

The simplest case for motion tracking is when you can track a single distinct area for the full 
length of a segment. For example, if a bus is moving through the scene and the entire side of 
the bus is visible throughout the segment, you can select any area or set of areas on the side 
of the bus and track them throughout the segment.

Other situations might be more complex. For example, if a bus is moving slowly through the 
scene but is also relatively close to the camera, you might find that an area you choose to 
track at the beginning of the segment is no longer visible later in the segment because it has 
moved out of the frame. Or perhaps you have a shot where a bus moves through a scene but 
passes behind a foreground sign, again with the result that an area you choose to track at the 
beginning becomes unavailable later in the segment.

In these situations, you can generate useful tracking data by using offset tracking. Offset 
tracking lets you track one target area until it becomes unavailable because it leaves the 
frame or is hidden by another object, then track another target area that shows the same kind 
of motion as the first. Your application calculates the offset from the first set of tracking 
points to the second, and takes account of this offset when animating the final effect. The 
result is an effect that follows a continuous path.
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If necessary, you can track more than just two targets. You can also track one target, switch 
to a second (for example, when the first becomes temporarily hidden), and then return to the 
first when it becomes visible again.

To track more than one target area in a segment, you add a new tracker region to a tracker 
timeline. You can then set a new target area in the first frame or field of the new region and 
track that target area.

Adding and Deleting Tracker Regions

If you have a situation where you cannot track a single target area successfully for the whole 
length of a clip, you can add one or more new tracker regions to the tracker timeline and 
track a new target area for each of the regions.

In most cases, you use tracker regions in combination with the offset tracking feature, so that 
your finished effect combines the tracking data from more than one target area into one 
continuous motion. For more information on the concept of offset tracking, see 
“Understanding Offset Tracking” on page 115.

To add a new tracker region for a tracker:

1. In the tracker’s timeline, move the position indicator to the location where you want the 
new region to start.

2. Right click in the tracker’s timeline, and select Add New Tracker Region.

Your application creates a new region that extends from the location of the position 
indicator to either the start of the next tracker region or the end of the timeline. The start 
of the new region appears as a vertical bar in the tracker timeline.

To delete a tracker region for a tracker:

1. In the tracker’s timeline, move the position indicator to any location within the region.

2. Right-click in the tracker’s timeline, and select Delete Tracker Region.

Your application deletes the tracker region. The region’s vertical boundary bar 
disappears from the timeline, and any tracking data for the region is deleted. A red bar 
appears at the bottom of the tracker’s timeline for the duration of the old region, 
indicating that you need to retrack these frames to get new tracking data, as shown in the 
following illustration.

Tracker Region boundaries
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Moving to a Tracking Region

When you have multiple tracking regions in the tracker timelines, you can move between 
them by using the Go to Previous Region and Go to Next Region buttons.

To go to the beginning of the previous or next tracking region:

t Click the Go to Previous Region or Go to Next Region button.

Performing Offset Tracking

To perform offset tracking:

1. Make sure that offset tracking is enabled for each tracker you plan to use.

Offset tracking is enabled by default, and the Offset Tracking button is purple when 
offset tracking is enabled.

2. In the first frame or field of your segment, set up a tracker for your first target area, as 
described in “Preparing to Generate Tracking Data” on page 104.

3. Begin generating tracking data, as described in “Generating Tracking Data” on page 
114.

4. When the target area disappears, stop tracking by pressing the space bar.

5. (Option) If necessary, step back a few frames or fields in the segment until the position 
indicator is on the last frame or field with a good tracking data point.

6. Right-click in the tracker timeline and select Add New Tracker Region.

A vertical bar appears in the tracker timeline to show the beginning of the new region, 
and the tracking boxes for the tracker appear in the Effect Preview monitor.

7. Drag the tracking boxes to the location of your second target area and size them 
as necessary.

Location of start of deleted tracker region 
boundary. Previous tracking data has been 
deleted from this point to the end of the 
deleted region, as indicated by the red bar.
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8. Begin tracking from the start of the new region by clicking the Tracking button.

n When you start tracking from the beginning of a tracking region, your Avid editing 
application steps backward one frame from the region boundary before it starts tracking. 
This is normal behavior to ensure that motion at the region boundary is tracked correctly.

9. (Option) If necessary, repeat steps 3 through 7 for additional target areas (or to return to 
tracking the original target area when it becomes visible again).

Understanding Generated Tracking Data

Once the system has completed generating tracking data, a set of tracking data points exists 
for each tracker enabled during the tracking operation. You can display these points in the 
Effect Preview monitor. You can also view information about the status of the tracking data 
in the tracker timeline display.

Tracking Data in the Effect Preview Monitor

Tracking data points display in the Effect Preview monitor.

While tracking is taking place, your application shows the location of the current tracking 
data point as a cross.

Once tracking has stopped, your application displays, by default, every point created during 
the tracking operation. The data point for the current frame or field displays as a flashing 
cross; all other data points display as solid dots.

You can control which sets of data points display and how many of the points display. You 
can also manipulate the points directly in the monitor in a variety of ways. For more 
information, see “Modifying Tracking Data” on page 124.

Tracking Data in the Tracker Timelines

The tracker timeline display shows you the status of tracking data over the length of 
the effect.
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The following table describes the display options.

Tracking data exists for this part of the 
timeline. The data points are not 
selected in the Effect Preview monitor

Tracking data exists for this part of the 
timeline. These data points are currently 
selected in the Effect Preview monitor

No tracking data exists for 
this part of the timeline

Display Markers define 
a range of frames for IN 
to OUT tracking data 
display

Vertical bar marks the start 
of a new tracking region

Reference Frame Marker 
marks the frame at which 
the tracking data does not 
alter the effect

Color Description

Black Line at top 
of timeline

Tracking data exists for this part of the segment, and the data points for this part of the 
segment are not currently selected in the Effect Preview monitor. For more information, see 
“Generating Tracking Data” on page 114.

White Line at top 
of timeline

Tracking data exists for this part of the segment, and the data points for this part of the 
segment are currently selected in the Effect Preview monitor. For more information, see 
“Selecting Tracker Data Points” on page 125.

Red Line at bottom 
of timeline

Tracking data does not exist for this part of the segment.

Vertical Bar Marks the start of a new tracking region. For more information, see “Offset Tracking” on 
page 115.

Display Markers Define the beginning and end of a range of frames. When In to Out is selected in the Point 
Range menu, the Effect Preview monitor only shows tracking data points for this range of 
frames. For more information, see “Customizing Tracking Data Display” on page 120.

Reference Frame 
Marker

Marks the location of the reference frame — the frame at which the tracking data does not 
modify the effect. For more information, see “Setting the Reference Frame for a Tracker” 
on page 121.
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Customizing Tracking Data Display
You can customize how your application displays tracking data in the following ways:

• You can enable or disable display for each tracker

• You can customize the color used to display each tracker

• You can control how many of the tracking data points display

• You can control whether the Effect Preview monitor shows tracking data or shows the 
results of applying the tracking data to the effect

To turn the tracking display on or off for a tracker:

t In the Tracking window, click the Enable Tracker button for the appropriate tracker.

The Enable Tracker button is purple when the display is on.

n Alt+click (Windows) or Option+click (Macintosh) the Tracking Box Display button for any 
tracker to turn the display on or off for all trackers at once.

To customize the display color for a tracker:

t Click the Tracker Color box, and then on the Color palette click the color you want 
to use.

To define the range of data points in the display:

1. (Option) If you want to define a range of frames for which you want data points to 
display, do one of the following:

t Drag the Display Markers in any one of the tracker timelines to define the beginning 
and end of the range you want.

t Use the position indicator in the tracker timelines along with the Mark IN and Mark 
OUT buttons to define the beginning and end of the range you want.

The Display Markers move to the beginning and end points you establish.
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2. In the Display Tracking Data area of the Tracking window, click the Point Range menu, 
and then select an option.

To choose Tracking Data or Effect Results display:

t In the Display Tracking Data area of the Tracking window, select the option you want to 
use from the Display menu.

n The Display menu affects what you see in the Effect Preview monitor once tracking data is 
available and while you are parked on a frame or are stepping through the effect. The 
Display menu does not affect what you see in the Effect Preview monitor while tracking is 
taking place (when you always see the current data point represented as a cross). Also, when 
you play an effect with tracking data, for example by clicking the Play button in the Effect 
Preview monitor, you always see the results of the effect.

Setting the Reference Frame for a Tracker
The reference frame for a tracked segment is the frame at which the tracking data makes no 
change to the appearance of the effect. For example, for a Stabilize effect, the reference 
frame is the frame at which the tracking data causes no change in the position of the image. 
The location of the reference frame is marked on the tracker timeline by a red diamond.

By default, your Avid editing application considers the first frame of a tracked segment to be 
the reference frame. In every frame after the first, the effect is modified by the tracking data 
for that frame.

Option Description

Current Displays the data point at the current location of the position indicator for each 
enabled tracker.

In to Out Displays the data points for the range currently defined by the Display 
Markers in the Tracking window for each enabled tracker. Shows the points 
for the current frame or field as flashing crosses.

All Displays every data point for each enabled tracker. This is the default option. 
Shows the points for the current frame or field as flashing crosses.

Reference Frame Marker
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You can choose to set the reference frame to any other frame in the segment. This can be 
useful when trimming changes the location of the head frame for the segment, or in other 
circumstances where the position of the reference frame influences the final look of the 
effect. For example, if you set the reference frame for a Stabilize effect to the frame at the 
midpoint of the segment, the tracking data at that frame causes no change in the position of 
the image. In all earlier and all later frames, the effect is modified by the tracking data for 
that frame.

To set the reference frame for a tracker:

1. In the tracker timeline, move the position indicator to the frame you want to set as the 
reference frame.

2. Right-click the tracker timeline, and select Set Reference Frame.

The red diamond reference frame marker moves to the location of the position indicator.

Understanding the SteadyGlide and Smoothing 
Options for Tracking

Your Avid editing application provides two options for processing the tracking data in a 
tracker to smooth the motion it represents. You can turn these options on or off at any time, 
and you can control the extent of the processing they perform by setting a smoothing value. 
The original set of tracking data points is not changed in any way by the processing. For 
information on using these options, see “Using SteadyGlide or Smoothing to Process 
Tracking Data” on page 124.

SteadyGlide™

SteadyGlide processes tracking data to reduce abrupt, jittery movements without affecting 
underlying motion. SteadyGlide is particularly useful as a tool for stabilizing unwanted 
camera motion without eliminating desirable motion. You typically use SteadyGlide with 
the Stabilize effect, or with Stabilize Tracking turned on for an effect parameter in the 3D 
Warp effect. For example, you can use SteadyGlide to reduce any jittery motion in a pan shot 
with a hand-held camera while retaining the underlying motion of the pan itself. For more 
information on stabilizing, see “Stabilizing an Image” on page 132.

When you are using SteadyGlide, the display shows a graph of the jittery motions that your 
application is removing. It is not easy to assess the final look of the effect from this 
information, so you should view the effect results to determine whether you need to adjust 
the smoothing value further.
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Smoothing

Smoothing processes tracking data to smooth out the path between the tracking data points. 
The higher the Smoothing value you define, the smoother the path becomes. You typically 
use Smoothing when compositing an image or a paint object over a tracked region of a 
moving background, for example, when the motion of the tracked region is not completely 
smooth but you want the motion of the image or paint object to be smooth.

When you are using Smoothing, the display shows the smoothed curve that results from the 
processing, which gives a useful visual indication of the amount of smoothing your 
application is applying. The following illustrations show typical results for Smoothing using 
different smoothing values.

Tracking points before smoothing Smoothing with Smoothing Value = 10

Smoothing with Smoothing Value = 90Smoothing with Smoothing Value = 50
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Using SteadyGlide or Smoothing to Process 
Tracking Data

To use SteadyGlide or Smoothing:

1. In the tracker timeline, click the SteadyGlide button or the Smoothing button.

The button is purple when the processing option is turned on.

n SteadyGlide and Smoothing are mutually exclusive processing operations. You cannot 
perform both SteadyGlide and Smoothing at the same time, and if you turn on one, the other 
will automatically be turned off if it was on previously.

2. In the Smoothing Value text box, type a smoothing value between 1 and 100.

The smoothing value controls the extent of the smoothing performed by both the 
SteadyGlide and the Smoothing options. The larger the value, the more smoothing is 
performed.

If you are displaying tracking data in the Effect Preview monitor, the display updates to 
show the results from the processing.

3. (Option) If necessary, check the effect results and adjust the smoothing value until you 
are satisfied with the results, or click the SteadyGlide or Smoothing button again to turn 
off the processing if you decide you do not want it.

Modifying Tracking Data
You can manipulate tracking data points in the Effect Preview monitor in a variety of ways. 
You can select individual data points or ranges of data points. You can delete points, move 
one or more points, and stretch a range of points. If necessary, you can move points outside 
the limits of the frame to extend the movement of an effect smoothly out of the frame.

Unlike the processing performed by SteadyGlide and Smoothing, these kinds of adjustments 
change the tracking data itself. They are reversible only by using your application’s Undo 
feature, or by retracking to generate a new set of tracking data points.

n Depending on the speed of the motion you have tracked, your tracking data points might be 
very close together at normal magnification and therefore hard to distinguish from one 
another. You can use your Avid editing application’s standard methods for zooming and 
panning in the Effect Preview monitor to zoom in on your tracking data and view it more 
clearly. For more information, see “Using the Effect Preview Monitor” in the Help.
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Finding a Specific Tracker Data Point

Whenever multiple data points are displaying for a tracker (when In to Out or All is selected 
in the Point Range menu), the data point for the current frame or field displays as a flashing 
cross in the Effect Preview monitor. This makes it easy to see the current data point even 
when a set of points are very close together.

To find a specific data point:

t Move the position indicator to the frame or field for which you want to find the data 
point.

The data point for that frame or field flashes in the Effect Preview monitor.

To isolate the point further, you can select Current in the Point Range menu in the 
Tracking window, so that the point for the current frame or field is the only point that 
appears in the Effect Preview monitor.

Selecting Tracker Data Points

To select a single data point:

t Click the point in the Effect Preview monitor.

The point is highlighted with a circle in the monitor, and the corresponding part of the 
tracker timeline display changes to white.

To select a single data point and move to the frame or field for that point:

t Double-click the point in the Effect Preview monitor.

The point is highlighted with a circle in the monitor and with a flashing cross, the 
corresponding part of the tracker timeline display changes to white, and the system 
automatically moves to the frame or field for that point.

To select a contiguous range of data points, do one of the following:

t Click the first data point in the range you want to select, and then Shift+click the last 
data point in the range you want to select.

t Drag the pointer across the range of data points that you want to select to lasso them.

The points in the range are highlighted with a circle and the corresponding part of the 
tracker timeline display changes to white.

The following illustration shows a range of selected data points.
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Deleting Tracking Data From Points

You can delete the tracking data generated by the tracking engine for a single data point or 
for a range of data points. When you do this, your application repositions the selected point 
or points onto a straight line between the two unselected points that bound your selection. 
The data points remain fully functional. They display in the Effect Preview monitor at their 
newly calculated locations, and they remain available for you to modify further.

To delete one or more selected data points:

t Press the Delete key.

The system repositions the selected data points along a straight line between the two 
unselected points that bound the selected points.

Selected points before deleting Result of deleting — points are repositioned in a straight 
line between the unselected bounding points
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Moving Tracker Data Points

To move a single selected data point:

t Drag the point to a new location.

To move a range of selected data points:

t Drag any one of the points in the range to a new location.

All the selected data points move along with the one you drag and maintain their 
positions relative to one another, as shown in the following illustrations.

Moving Tracker Data Points Outside the Frame Boundary

If you track a target area that moves out of the frame, the tracking engine can no longer track 
the target area and generates invalid data points. You have two options to ensure consistent 
motion if you want your effect to move smoothly out of the frame.

• You can use offset tracking to track a second target area that does not leave the frame 
until the end of the segment. For more information, see “Offset Tracking” on page 115.

• You can move the very last data point outside the boundary of the frame so that it 
extends the line of motion that has been successfully tracked earlier in the segment. 
(You need to reduce the magnification in the Effect Preview monitor to less than 100% 
to view the area outside the frame.) You can then delete all of the invalid points between 
that final point and the last valid data point. Your application repositions the points you 
delete on a straight line. When the effect plays back, the repositioned data points ensure 
that the effect moves smoothly out of the frame. If the motion you are tracking is, for 
example, simple straight line movement, this might be quicker than setting up an extra 
tracking region.

Selected range of data points 
before move.

Selected range of data points 
during move. The points move 
as a group and maintain their 
positions with respect to one 
another.

Selected range of data points 
after move.
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Stretching a Range of Tracker Data Points

You can select a range of data points and then stretch them into a new position. In contrast to 
simply moving a range of points, the stretching process uses one moving point and one or 
two anchor points. As you move the moving point, all the other points in the selected range 
stretch to new relative positions.

This feature is particularly useful when the system generates tracking data points that are 
slightly offset from the area you are tracking but otherwise represent the motion you are 
tracking accurately. For example, if you are tracking an area on a moving vehicle, a 
combination of changes in the image from frame to frame and the system’s updating of the 
target area might yield tracking data points that lag behind the area you are tracking.

The following illustration shows this behavior.

You can select a range of points that are slightly out of the ideal position in this way and 
stretch them so that they more exactly represent the path of the object you want to follow. 
This enables you to achieve the motion you need for your effect without retracking or 
moving many data points individually.

Object being 
tracked

Tracking data 
points

Frame 1

Frame 6

Frame 11

This illustration represents data points created by tracking an area across 11 frames. 
Until Frame 6, the system tracks the object accurately. After Frame 6, a small amount of 
error is introduced. By Frame 11, the data point lags behind the object being tracked 
somewhat. Stretching the points between 6 and 11 so that the last point is placed over 
the last triangle quickly creates a complete set of usable points.
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To stretch a range of data points:

1. Select the range of points as described in “Selecting Tracker Data Points” on page 125.

2. In the Modify Tracking Data area of the Tracking window, click Stretch Points Mode.

The button is purple when Stretch Points mode is turned on.

3. Drag one of the selected points to a new location.

The points in the selected range are relocated proportionally along the path between the 
point you have moved and the anchor point or points. If you move a point at either end 
of the selected range, the point at the opposite end becomes the anchor. If you move a 
point in the middle of the range, the two end points become anchors.

The following illustrations show these two behaviors.

Original range of selected points 
before stretching.

When you stretch by moving one end point, the point at 
the other end of the range becomes the anchor while you 
drag the moving point. After the stretching process, all 
the selected points are relocated proportionally between 
the point you have dragged and the anchor point. 

When you stretch by moving a point in the middle of 
the range, both end points of the range become 
anchors while you drag the moving point. After the 
stretching process, all the selected points are 
relocated proportionally between the point you have 
dragged and the two anchor points. 
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Limiting the Effect of Position Tracking Data to a 
Single Axis

In some circumstances, you might want to track an area to generate data on its X, Y position 
but then control the movement of the effect on only one axis. You can limit the effect of 
Position tracking data to one axis to achieve this effect.

n Limiting Position motion to a single axis is also an option when you want to stabilize a shot 
without eliminating camera motion in one direction, such as a pan. However, a more flexible 
approach to handling this scenario for most shots is to use data from both axes and then use 
SteadyGlide to process the data. For more information, see “Stabilizing an Image” on page 
132 and “Using SteadyGlide or Smoothing to Process Tracking Data” on page 124.

To limit the effect of Position tracking data to a single axis:

1. In the Effect Editor, open the Position parameter category.

2. Click the Enable button for X Only or Y Only.

The Enable button changes to pink when selected.

Playing Effects That Use Tracking Data
Once you have generated tracking data and have modified it to create acceptable sets of data 
points, you can play the effect to check its movement over time.

n The real-time status of an effect is not altered when it uses tracking data. If an effect is 
normally real time, it remains real time when it uses tracking data. If an effect normally 
requires rendering, it continues to require rendering when it uses tracking data. Playback of 
an effect while still in Effect mode also follows the normal behavior of the effect.

To play an effect that uses tracking data:

1. Move the position indicator to the beginning of the effect.

2. Click the Play button.

X Only and Y Only buttons
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3. (Option) If you are not satisfied with the appearance of the effect, you can do one or 
more of the following to further modify its movement:

t Adjust the effect’s keyframe parameters.

For more information, see “Changing a Standard Keyframe’s Parameters” in the 
Help.

t Modify the existing tracking data.

For more information, see “Modifying Tracking Data” on page 124.

t Retrack all or part of the segment to generate new tracking data.

For more information, see “Generating Tracking Data” on page 114.

Understanding Stabilizing
Stabilizing allows you to track an object in a shot that should not be in motion and then use 
the tracking data to keep that object stationary and eliminate the unwanted motion. (Objects 
such as buildings, telephone or light poles, and fixed objects in nature such as rocks, are 
good candidates for tracking when you use the Stabilize effect.) This process exposes black 
around the edges of the repositioned frames, so you might need to resize or reposition the 
clip to remove the exposed edges.

If you use stabilizing and also process the tracking data using SteadyGlide, you can 
eliminate unwanted jittery movement while retaining underlying camera motion such as a 
pan. For more information, see “Using SteadyGlide or Smoothing to Process Tracking Data” 
on page 124.

You can also use stabilizing to create unusual special effects. For example, if you stabilize an 
object that is actually moving in a clip, you force other parts of the clip to move from frame 
to frame. You can take a clip of a person running down a street, stabilize on that person, and 
force the buildings in the shot into motion.

Unlike other effects that use motion tracking, stabilizing works with only one layer of video, 
using the tracking data to move each frame of the video as much as is needed to keep the 
tracked object stationary. 

n Clips that contain extreme camera motion might be hard to stabilize successfully since they 
need to be resized substantially to remove exposed edges. As a result, you might lose so 
much of the image information that the clip is no longer useful.
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Stabilizing an Image
If you need to eliminate unwanted motion in a video clip, such as motion from an unstable 
camera or even more subtle motion such as that introduced during the telecine process as a 
result of gate weave, you can use:

• The Stabilize effect

• The Stabilize Tracking parameter control in a 3D Warp effect promoted to advanced 
keyframes.

n The Region Stabilize effect is an alternative option for stabilizing a clip. For more 
information, see “Using the Region Stabilize Effect” on page 134.

To stabilize a segment:

1. Do one of the following:

t Apply the Stabilize effect from the Image category in the Effect Palette.

t Apply the 3D Warp effect from the Blend category in the Effect Palette (or promote 
an effect that uses tracking data to 3D), and then promote the effect to advanced 
keyframes by clicking the Promote to Advanced Keyframes button in the Effect 
Editor.

n The Stabilize effect itself is one of the effects that you can promote both to 3D and to 
advanced keyframes, so you can stabilize an image using the Stabilize effect and then 
promote it to access additional effect functionality. When you promote the Stabilize effect to 
3D and to advanced keyframes, Stabilize Tracking is automatically activated for all effect 
parameters that use tracking data.

2. Enable and prepare one or more trackers, by doing one of the following:

t For the Stabilize effect, open the Tracking parameter category and click the Enable 
button for one or more trackers.

t For the 3D Warp effect promoted to advanced keyframes, open the Position 
Tracking, Rotation Tracking, Scaling Tracking, or Corner Tracking parameter 
categories, then click the Stabilize Tracking button, and then enable one or more 
trackers.

For more information, see “Preparing to Generate Tracking Data” on page 104. For 
specific information on the number of trackers to use when stabilizing, see “Guidelines 
for Using Multiple Trackers When Stabilizing” on page 133.

3. (Option) If you are using the 3D Warp effect, in the Tracking window, choose Track 
Foreground from the Track Background/Foreground menu.
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4. Generate the tracking data.

For more information, see “Generating Tracking Data” on page 114.

5. Click the Play Loop button to play the segment repeatedly.

The system repositions each frame or field in the segment so that the object you have 
tracked remains in the same position that it occupies in the first frame or field.

6. (Option) Use SteadyGlide with your trackers if you want to remove jittery motion, such 
as that in a hand-held camera shot, while retaining underlying motion such as a pan.

For more information, see “Using SteadyGlide or Smoothing to Process Tracking Data” 
on page 124.

7. As the segment plays, notice where black has been exposed at the edges of the frame by 
the stabilizing process.

8. When you have finished reviewing the stabilized segment, press the space bar to 
stop playback.

9. (Option) If necessary, recenter the image using the Position parameter sliders in the 
Effect Editor.

n This step is useful if you see more exposed edge material on one side of the image than on 
the opposite side. By recentering the image, you can balance the size of the exposed edges on 
either side and reduce the amount of resizing needed to eliminate the edges.

10. (Option) If necessary, adjust the Scaling parameter sliders in the Effect Editor to enlarge 
the image enough to eliminate the exposed edges.

11. Continue to review the effect and adjust parameter controls until you are satisfied with 
the final look.

Guidelines for Using Multiple Trackers When 
Stabilizing

As with other effects that use motion tracking, the number of trackers that you need when 
stabilizing depends on the complexity of the motion you want to stabilize. However, 
multiple trackers might introduce unnecessary additional motion that is detrimental to the 
final look of the clip, so you should use them only when they are absolutely necessary.

When the motion of an unstable camera is limited to movement on the X and Y axes only, 
you need only one tracker (enabled either in the Position parameter category or in the 
Tracking parameter category). Even when you see a small amount of rotational movement or 
change in scale in an image you want to stabilize, you will probably find that a single point 
stabilizes the image well enough to give an acceptable result without introducing 
unwanted motion.
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If you are stabilizing a clip that shows significant changes in scaling, rotational, or other 
movement, or if you are using the Stabilize effect to create a special effect, you might need 
to use two or even more tracking points.

Using the Region Stabilize Effect
The Region Stabilize plug-in effect provides an alternative option for stabilizing an image. 
Although the Region Stabilize effect provides fewer controls than the Stabilize effect or the 
Stabilize Tracking option in 3D Warp, its simplicity makes it easier to use, and it might be 
all you need in some circumstances. Region Stabilize also provides two options that are 
unavailable in Stabilize:

• The AutoZoom option automatically resizes and repositions the segment to remove 
exposed black around the edges of frames repositioned as a result of the stabilization 
process.

• The Progressive Source option allows you to specify that the footage you are tracking is 
progressive material so that it is tracked correctly in an interlaced project.

The following illustration shows the Region Stabilize parameters.

For a reference summary of the Region Stabilize effect and its parameters, see “Image: 
Region Stabilize” in the Help.

Stabilizing an Image with the Region Stabilize Effect

You apply the Region Stabilize effect from the Image category in the Effect Palette.

To stabilize a clip with the Region Stabilize effect:

1. Enter Effect mode by selecting Toolset > Effects Editing.

For more information, see “Entering Effect Mode” in the Help.

The Effects Editing toolset appears.

2. In the Effect Palette, click the Image category.

3. Drag the Region Stabilize Effect icon to the segment you want to stabilize.
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4. Move the effect position bar to the segment with the Region Stabilize effect.

A wire frame appears in the Effect Preview monitor to indicate the region of interest. 
This is the area you want to use in stabilizing the image.

5. Reposition and resize the wire frame by doing one of the following:

t Use the sliders in the Region of Interest parameter category.

t Click the wire frame, and drag it in the Effect Preview monitor.

Select a region that contains one or more features that do not change much from frame 
to frame, for example, objects such as buildings or rocks. Another approach is to shoot 
the scene with stabilization in mind: include an object, such as a reflective sticker, that 
you intend to use as your region of interest.

6. Click the Model Fast Menu button, and select the type of stabilization:

Option Description

Translational Keeps the region of interest steady along both the horizontal and the 
vertical axes.

Horizontal Constrains horizontal motion in the region of interest. Features in the 
region of interest can move vertically but not horizontally.

Vertical Constrains vertical motion in the region of interest. Features in the 
region of interest can move horizontally but not vertically.
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7. (Option) Turn on Auto Zoom:

a. Click the triangular opener for the Options parameter category.

b. Select Auto Zoom.

Stabilization exposes black around the edges of the repositioned frames. Auto Zoom 
compensates by resizing and, if necessary, repositioning the clip to remove the 
exposed edges.

8. (Option) Select Progressive Source:

a. Click the triangular opener for the Options parameter category.

b. Select Progressive Source.

Select Progressive Source if your footage was captured or converted to progressive 
footage (not interlaced). If your sources are progressive, selecting Progressive Source 
produces smoother results.

n Progressive Source has no effect in 24p projects because the application assumes that you 
are using progressive footage.

If you click the Progressive Source button and your underlying source is not progressive, you 
may see motion artifacts between fields in the rendered effect.

9. Render and review the effect.

If the rendered clip does not perform as expected, see “Making Adjustments to the 
Region Stabilize Region of Interest” on page 136.

10. (Option) Add keyframes to further refine the motion of the stabilized clip.

11. Continue to review and refine the effect until you achieve the results you want.

12. (Option) Resize and, if necessary, reposition the clip to eliminate black edges.

Making Adjustments to the Region Stabilize Region of Interest

If the Region Stabilize effect does not perform as expected, it might be due to one of the 
following:

• Large motion — If an object in your region of interest moves too far away from the 
region from one frame to the next, the rendered clip might display unexpected results.

• Extraneous motion — An object in your region of interest might move over the course 
of the clip in a way that unpredictably affects the stabilization.

• Insufficient texture — The region of interest might not have enough features to allow 
Region Stabilize to track it effectively.
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If the Region Stabilize effect does not perform as expected, experiment with the following 
adjustments:

• Increase the size of the region of interest, or reposition it, to encompass large motion.

• Decrease the size of the region of interest to eliminate extraneous motion that is 
affecting the stabilization.

• Select a new region of interest.

• Add keyframes to reestablish or refine the region of interest over the course of the clip.

Editing Segments That Use Tracking Data
Once tracking data exists for a segment, you can edit that segment in a number of standard 
ways without losing the tracking data and having to retrack.

Segment Mode Editing with Segments That Use Tracking Data

Tracking data persists during Segment mode editing. For example, if you shift the position 
of a segment that contains tracking data, or copy a segment to another point in your 
sequence, the data is still available. If you lift a portion of the segment out of your sequence, 
tracking data is preserved on all parts of the segment for the range of frames in each part.

Remember, however, that if you move only the foreground layer of a multilayer effect, the 
tracking data will be useful only to the extent that it corresponds, or can be made to 
correspond, to the background layer at its new location. For example, if you shift an effect 
segment with tracking data a few frames with respect to the background material beneath it, 
you might be able to continue to use the tracking data to follow the background area 
(perhaps by selecting all the points and moving them a little). If you shift the effect segment 
substantially, or even place it over a different background clip, the tracking data remains 
available but has no practical use.

n In some situations, it might be useful to create a multilayer effect with motion tracking as a 
nested effect. If you do this, you can move or divide the nested effect during segment editing 
and be sure that the effect will stay in sync with the tracked material. For more information, 
see “Nesting Effects” in the Help.

Trimming Segments That Use Tracking Data

If you trim in from the edges of a segment, tracking data is preserved for both the new length 
of the segment and for the material you have trimmed. If you later trim the edges of the 
segment back out, the tracking data is still available to control the motion of your effect.

If you trim out beyond the tracked data for an effect, you must track over the range of these 
new frames to generate data for them.
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If you edit a segment into a sequence by marking it to be longer than you will finally need, 
you can track the whole segment, trim it in, and know that you can adjust the trims back out 
when fine-tuning your sequence without having to retrack. This might be a useful approach 
if you know that a clip is likely to be trimmed.

Adding Transition Effects to Tracked Segments

If you add a transition effect to a tracked segment, you usually need to track the additional 
frames that are used by the transition. For example, if you add a standard one-second, 
centered-on-cut dissolve at the beginning of a tracked segment, the dissolve will use 
one-half-second of new material from the tracked segment’s master clip.

It might be difficult to track these additional frames after you apply the transition effect 
because the Effect Preview monitor displays the combination of outgoing and incoming 
media created by the transition effect. In the case of a dissolve, for example, the monitor 
shows the blend of outgoing and incoming frames, which often obscures the pattern you 
need to track.

You can avoid this problem by doing the following:

1. Trim the tracked segment out by the number of frames that the transition requires.

2. Track the frames added by this trim.

3. Trim the tracked segment back in to the original edit point.

4. Add the transition effect.

Reusing Existing Tracking Data
Once you have created tracking data for an effect, that data is available for reuse in several 
different contexts. You can reuse tracking data within the same effect. You can also copy and 
paste tracking data to another effect, as described in “Copying and Pasting Tracking Data” 
on page 139.

Trackers initially created and mapped to one effect parameter are available for use in any 
other parameter in the effect that can use tracking data. For example, you might create a 
single tracker with the default Point A name in the Position parameter category. This tracker 
is available for use in other parameters such as Scaling.

n The Tracking parameter and the Position, Scaling, and Rotation parameter categories form 
two mutually exclusive groups. You cannot have tracking enabled in both groups at the same 
time. For more information, see “Effects and Effect Parameters That Use Tracking Data” on 
page 95.
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You are less likely to want to use tracking information outside the effect for which it was 
created since the information refers specifically to the motion in one particular background 
clip. No other background clip is likely to contain exactly the same movement. However, 
there are some circumstances in which you might want to move tracking data to a new effect, 
such as the following two examples:

• You might want to move tracking data to an additional effect applied over the same 
background clip in the sequence. This might be a duplicate use of the background at 
another point in the sequence or an extra effect layered above the first (such as a second 
Picture-in-Picture effect tied to the same background movement).

• You might want to destabilize a stable shot so that it has a handheld look. To do this, you 
can track a segment that does have unsteady camera motion, and then copy the resulting 
tracking data to an effect on the segment you want to destabilize.

Copying and Pasting Tracking Data
You can copy one or more trackers and their associated tracking data and then paste those 
trackers into another effect. You can also copy one or more trackers and paste them within 
the same effect to create two versions of a tracker. This might be useful if you want to make 
two different sets of modifications to tracking data and then compare how each set changes 
the effect.

To copy and paste tracking data into another effect:

1. Enable the trackers you want to copy in the Tracking window.

2. Do one of the following:

t Select Edit > Copy.

t Press Ctrl+C (Windows) or Command+C (Macintosh).

3. Move the position indicator to the effect to which you want to copy the trackers.

4. Make sure that the Tracking window is active.

5. Do one of the following:

t Select Edit > Paste.

t Press Ctrl+V (Windows) or Command+V (Macintosh).

The trackers appear in the Tracking window below any existing trackers. For example, if 
you are pasting into an effect that has trackers T1 and T2, the pasted trackers are 
numbered T3 and T4.

6. (Option) If existing trackers in the effect have the same name or color as the trackers 
you paste, you might want to rename the trackers that have duplicate names or change 
their assigned colors to avoid confusion.
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To copy and paste tracking data within the same effect:

1. Enable the trackers you want to copy in the Tracking window.

2. Do one of the following:

t Select Edit > Copy.

t Press Ctrl+C (Windows) or Command+C (Macintosh).

3. Do one of the following:

t Select Edit > Paste.

t Press Ctrl+V (Windows) or Command+V (Macintosh).

Duplicate copies of the enabled trackers appear in the Tracking window with new 
tracker numbers.

4. Rename the duplicate copies, and change their assigned colors so that you can continue 
to distinguish between the different versions.

Conforming Symphony Meridien Sequences with 
Tracking Data

Tracking data in sequences originally created on Symphony Meridien systems is available 
for use when those sequences are opened in your Avid editing application. You can 
manipulate the data in all the ways described in “Using SteadyGlide or Smoothing to 
Process Tracking Data” on page 124 and “Modifying Tracking Data” on page 124. You can 
also add new regions to the tracker timelines, for example, to perform offset tracking.

Neither of the tracking engines used by current Avid editing applications works in the same 
way as the tracking engine used in Symphony Meridien systems. As a result, if you retrack 
all or part of a segment containing tracking data created on a Symphony Meridien system, 
the new data that you create does not match the old data exactly.

Examples of Effects Using Motion Tracking
This section includes two illustrated examples of typical uses of motion tracking to control 
effects. Studying these examples will help you to understand how you can use motion 
tracking in your own work.

n If you find it difficult to distinguish details in the printed versions of the following 
illustrations, you can view them in full color in the online version of this guide available 
from the Online Library for your application.
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Example 1: Replacing the License Plate on a Moving Vehicle

This example uses motion tracking to track the license plate on a truck and then replace the 
plate with an imported graphic. 

In this case, the license plate in the footage is white and the surrounding areas of the truck 
are generally dark, so the exact corners of the license plate are good targets for the tracking 
operation. However, if tracking the exact corners of the plate is difficult, you can track other 
points on the back of the truck to achieve the same control over the changing size and shape 
of the replacement plate. For more information, see “Guidelines for Positioning Tracking 
Boxes” on page 110.

All four corners of the license plate have been tracked for this example to ensure that any 
skew and perspective changes are recorded by the tracking data. In fact, changes in 
perspective are relatively small in this clip since the plane of the back of the truck remains at 
almost exactly the same angle with respect to the plane of the screen. You might be able to 
achieve an acceptable finished look for this clip by using three trackers or even just two 
trackers on opposite corners of the license plate, especially since the replacement object 
is small.

Original Material

These illustrations show the original materials used for this example. On the left is the 
first frame of the video clip. The effect will replace the white license plate. On the right is 
the graphic used as the replacement license plate. A blur has been applied to the 
graphic so that it will blend in with the clip. (You could do this in a graphics application or 
use Blur mode in the Paint Effect.) In the finished effect, a softened border is also 
applied to disguise the sharp edge of the graphic.
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This illustration shows the tracking data points that the system generates for the four 
trackers. As the truck moves into the distance and the plate gets smaller, the points 
move closer together.

Tracking Information

This illustration shows the location of the 
four tracking boxes at the four corners of 
the license plate.
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These illustrations show images from the beginning, middle, and end of the clip. The 
images on the left are from the original clip; the images on the right show the final effect 
with the replacement license plate. The replacement plate is positioned and sized 
manually in the first frame of the clip. The size and shape of the replacement changes 
under the control of the tracking data in the remaining frames of the clip.

Comparison of Original Video and Finished Effect
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Example 2: Special Effects Using Targets for Motion Tracking

This example uses special effects footage that has been specifically created to make use of 
motion tracking. White targets have been placed in the shot to be tracked. After tracking 
these targets, you can use the tracking data to control the movement of an effect layer, for 
example, a keyed video image or an object created with the Paint Effect. In this example, the 
tracking data controls the movement of an object created with the Paint Effect.

These two illustrations show the first frame of the clip. On the left is the original video showing 
the target white dots on the wand. On the right is the image with the Paint object added. 

Original Material

This illustration shows the two tracking 
boxes located over the targets. 

Tracking Information

This illustration shows the generated 
tracking data points for the entire clip.
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These illustrations show images from the beginning, middle, and end of the clip. The 
images on the left are from the original clip; the images on the right show the final effect 
with the Paint object.

Comparison of Original Video and Finished Effect
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4 Understanding Color Correction Mode

As it does with other modes (such as Trim mode and Effect mode), your Avid editing 
application changes the screen display to provide a specialized interface for Color 
Correction mode. This interface includes the Color Correction tool itself (containing the 
controls for adjusting color), and a reconfigured monitor window that allows you to view 
several segments in your sequence side-by-side.

“Color Correction Mode Basics” in the Help provides basic information on how to enter 
Color Correction mode and descriptions of the main elements of the Color Correction mode 
display.

The following main topics in this chapter provides more detailed information on how to 
control and customize the Color Correction mode display:

• Color Correction Monitors

• The Color Correction Tool

• Working with Color Correction Effect Templates

• Displaying Color Correction Information in the Timeline

• Understanding Color Correction Indicator Lines in the Timeline

Color Correction Monitors

The monitor window in Color Correction mode displays three monitors. The default display 
and basic behavior of these three monitors is described in “Understanding Color Correction 
Monitors” and “Using Monitor Buttons in Color Correction Mode” in the Help.

• Understanding Image Display in Color Correction Monitors

• Customizing Image Display in Color Correction Monitors

• Source Menu Commands in Color Correction Monitors

• Adjusting the Dual Split Image Display in Color Correction Monitors

• Displaying 16:9 Video in Color Correction Monitors

• Using the Play Loop Button in Color Correction Mode
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• Reviewing Color-Corrected Clips with the Edit Review Button

• Controlling Frame Display in the Monitor Window

Understanding Image Display in Color Correction Monitors

By default, the center monitor shows the current segment (the segment the position indicator 
is on in the Timeline). The left monitor shows the previous segment (the segment before the 
current segment), and the right monitor shows the next segment (the segment after the 
current segment).

When you move in the sequence by clicking a monitor button or by placing the position 
indicator on a new segment in the Timeline, all three monitors update to maintain the same 
relationship between displayed segments.

The following illustrations show the default monitor display behavior.

The position indicator 
is on segment B in the 
Timeline. The three 
monitors display 
segments A, B, and C.

Example 1

The position indicator 
has moved to segment C. 
All three monitors have 
updated so that they now 
display segments B, C, 
and D.

Example 2
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Customizing Image Display in Color Correction Monitors

You can customize the type of image that displays in each monitor in Color Correction 
mode. For example, you can display segments other than the default previous, current, and 
next segments, or you can display the entire sequence in one monitor. You can also replace 
video image display with a waveform or vectorscope display to help you analyze images as 
you correct.

To configure the display in a monitor:

t Click the monitor’s Source menu, and select one of the commands described in “Source 
Menu Commands in Color Correction Monitors” on page 149.

Source Menu Commands in Color Correction Monitors

The following table describes the commands available in the Source menu for monitors in 
Color Correction mode.

Command Description

Empty Displays no image (black).

Entire Sequence Makes the entire sequence available in the monitor. This is useful when you want to 
compare shots from many different places in a sequence. For example, you can 
display the current segment and the next segment in two monitors for immediate 
shot-to-shot comparison and display the entire sequence in the third monitor so that 
you can quickly navigate to any other part of the sequence you want to view. When 
you change the current segment, the entire sequence updates to that segment.

n You can use the Play Loop button in the Command palette to play the whole 
sequence in the active monitor even if the monitor is not set to Entire 
Sequence. For more information, see “Using the Play Loop Button in Color 
Correction Mode” on page 151.

Reference Locks the current frame (the frame the position indicator is on) in the monitor. When 
the other monitors update as you navigate in the Timeline, this frame continues to 
display as a reference. This is useful if you want to use a specific place in your 
sequence as a reference against which to compare all other shots, for example, a 
segment that contains optimal skin tones.

n If you use the right monitor to display a reference image and keep the current 
segment in the center monitor, you can use the convenient Escape key shortcut 
to switch between these two monitors. For more information, see “Switching 
Between Current and Reference Monitors Using the Escape Key” in the Help.

To lock the current frame as a reference, right-click (Windows) or Ctrl+Shift+click 
(Macintosh) in the Composer window or the Color Correction tool, and select 
Reference Current.
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Adjusting the Dual Split Image Display in Color Correction Monitors

You can use the Dual Split button below a monitor to split the image display so that it shows 
the image before and after the current color correction adjustments are applied. For 
information on this basic procedure, see “Using Monitor Buttons in Color Correction Mode” 
in the Help.

Most Avid editing applications support the display of this split-screen view in the Client 
monitor as well as in the monitor window.

When Dual Split is turned on, the uncorrected image appears on the left and the image 
with currently active corrections applied appears on the right, as shown in the 
following illustration.

Current Displays the current segment. This option is not available in the Source menu if 
another monitor is already set to Current.

Previous Displays the segment immediately before the current segment.

Next Displays the segment immediately after the current segment.

Second Previous Displays the segment two segments before the current segment (the segment the 
position indicator is on in the Timeline).

Second Next Displays the segment two segments after the current segment.

Waveform and 
Vectorscope commands

• Quad Display

• RGB Histogram

• RGB Parade

• Vectorscope

• Y Waveform

• YC Waveform

• YCbCr Histogram

• YCbCr Parade

These commands configure the monitor as a Waveform monitor or Vectorscope 
monitor. Your Avid editing application displays the information for the currently 
active monitor. For more information, see “Working with the Waveform Monitors 
and the Vectorscope Monitor” on page 276.

Command Description
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n If you are reading a black-and-white hardcopy version of this document, you will find it 
useful to view the color images in the online version of the document available from the 
Online Library for your Avid editing application (Help > Online Library).

To resize the box that contains the split-screen image:

t Drag one of the box’s triangular handles in the monitor.

Displaying 16:9 Video in Color Correction Monitors

The monitor window in Color Correction mode can display wide-screen 16:9 video as well 
as standard format 4:3 video in the monitors, just as it can in other modes.

For more information on switching to or from 16:9 display, see “Using the 16:9 Display 
Format” in the Help.

Using the Play Loop Button in Color Correction Mode

The Play Loop button has a specialized function in Color Correction mode. The Play Loop 
button does not appear in the monitor window but does control the playback of material in 
the monitors. You can access the Play Loop button from the Play tab of the Command 
palette or from the keyboard if it has been mapped to a keyboard location.

When you click the Play Loop button, your Avid editing application plays the whole 
sequence in the active monitor, starting from the current position of the position indicator. 
Playback is not limited to the current segment alone, regardless of the Source menu 
command selected for the monitor. This is useful whenever you want to view the whole 
sequence quickly without switching monitors or making a new Source menu choice.

Image with currently 
active corrections 
applied

Uncorrected image Triangular handle for adjusting 
size of uncorrected image
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Reviewing Color-Corrected Clips with the Edit Review Button

The Edit Review button has a specialized function in Color Correction mode. Your Avid 
editing application plays the current clip along with parts of the previous and next clips, 
allowing you to quickly review the color correction on a clip in the context of the adjoining 
clips.

The Edit Review button does not appear in the monitor window, but you can access the Edit 
Review button from the Play tab of the Command palette or from the keyboard if it has been 
mapped to a keyboard location.

When you click the Edit Review button, your AVid editing application plays part of the 
previous clip, all of the current clip, and part of the next clip. When playback is complete, 
the position indicator returns to its location in the current clip before you clicked the button.

The amount of material your application plays from the previous and next clips is 
determined by the current Preroll and Postroll settings in the Play Loop tab of the Trim 
Settings dialog box. For more information on trim settings, see “Trim Settings” in the Help.

Controlling Frame Display in the Monitor Window

You can control the behavior of the Go to buttons in the monitor window (Go to Previous 
Shot, Go to Next Shot, Go to Previous Uncorrected Shot, and Go to Next Uncorrected Shot) 
by selecting options in the Fast Forward and Rewind area of the Composer Settings dialog 
box.

You can set your application to jump to the first frame of the relevant segment (the default 
setting), the last frame, or the frame that is marked with a locator. For more information, see 
“Composer Settings: FF/REW Tab” in the Help.

Although the default first-frame behavior might be acceptable in many circumstances, the 
availability of the option Stop at Locators makes it possible to mark a reference frame for 
each segment in your sequence before you begin color correction. As you move around in 
your sequence, you always see the reference frame in the monitors.

n You can add locators while in Color Correction mode by mapping the Add Locator button to 
the keyboard or by using the Command palette in Active mode. However, you cannot change 
Composer settings while in Color Correction mode.
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To control frame display with locators:

1. In Source/Record mode, add a locator to your chosen reference frame for each segment 
of the sequence.

For more information, see “Using Locators” in the Help.

n To navigate successfully in the sequence while in Color Correction mode, you must place a 
locator in every segment. You should not have more than one locator in any segment.

2. In the Settings tab of the Project window, double-click Composer.

The Composer Settings dialog box opens.

3. In the FF/REW tab, select Stop at Locators, and then click OK.

4. Enter Color Correction mode by clicking the Color Correction Mode button at the 
bottom of the Timeline.

As you use the Composer Window buttons to move around in your sequence, the 
Composer window changes to display the frame marked by the locator in each segment.

The Color Correction Tool
In Color Correction mode, you make adjustments to color using the Color Correction tool. It 
is also where you control how much and what kind of material you are correcting at any one 
time.

The following illustration shows the Color Correction tool in its default configuration.

Correction Type button Group tabs Color Correction Tool buttons

Subdividing tabs Enable buttons

Color Match control

Color Correction buckets
Color adjustment sliders

Automatic Color 
Correction buttons
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Selecting Correction Types

The Color Correction tool has a Correction Type button that you use to select the type of 
color correction you want to make. Selecting a correction type is one of the first and most 
important steps you take when making any color correction in the Color Correction tool.

When you move the position indicator to a segment that has color correction, the Correction 
Type button changes to indicate the type of correction that is applied to that segment. If you 
click the Correction Type button, the correction type for the segment is highlighted in the 
Correction Type menu.

To select a correction type:

t Click the Correction Type button, and select the type you want from the menu.

The options available in the Correction Type menu fall into two categories:

- Relationship color corrections: All but one of the options allow you to select a 
relationship so that you can apply a correction to a group of related clips in one 
operation. For more information, see “Understanding Relationship Color 
Corrections” on page 154 and “Options for Relationship Color Corrections” on 
page 156.

- Color Correction effect corrections: The last option allows you to make a color 
correction using the Color Correction effect. There are some situations where you 
need to use a Color Correction effect rather than a relationship color correction to 
make a correction. For more information, see “Using the Color Correction Effect” 
on page 286.

Understanding Relationship Color Corrections

Relationship color corrections allow you to define the scope of any correction you make. For 
example, if all the material from one source tape in your project needs the same color 
correction because the camera had poor white balance, you can make that correction to every 
segment in a sequence that you captured from that source tape in one operation.

Relationship color corrections also distinguish between Source corrections and Program 
corrections. You can make both a Source correction and a Program correction on a segment, 
allowing you to make two different correction passes on the same material. A common use 
of this feature is to make color corrections for different purposes at different stages in your 
editing workflow. For example, you might make a set of corrections specifically to correct 
problems with the color in your source footage, and then later make a separate set of 
corrections to make final adjustments for artistic or editorial purposes. The terms “Source” 
and “Program” reflect this kind of workflow.
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The Color Correction tool uses color coding on both the Correction Type button and the 
active Color Correction tabs to indicate the type of correction you are applying or the type of 
correction that currently exists for a segment:

• Green indicates Source corrections.

• Blue indicates Program corrections.

• Gray indicates a Color Correction effect correction.

Relationship color corrections appear in the Timeline with green dots, indicating that they 
will play back in real time, subject to the playback capabilities and constraints of your 
system. Like any other effect, you might need to render a relationship color correction to 
ensure real-time, full-quality playback in some circumstances. For more information, see 
“Real-Time Preview of Video Effects” in the Help.

n Your Avid editing application processes relationship color corrections before all other 
effects, with the exception of Timewarp effects. (Timewarp effects are processed first to 
ensure that they do not become unrendered when you apply a color correction.) This 
processing order can determine how you choose to apply color corrections in combination 
with other effects, and is one of the factors that might require you to use a Color Correction 
effect rather than a relationship color correction. For more information, see “Using the 
Color Correction Effect” on page 286.

n You can also apply a Source Segment or a Program Segment correction to the material 
between marked IN and OUT points. For more information, see “Customizing Color 
Correction Mode Settings” on page 165.

You can apply a relationship correcton and a color correction effect on the same segment. 
This results in two distinct corrections. The relationship correction is applied first, and its 
result is the input to the color correction effect.

This approach differs from applying two corrections by applying one on the Source side and 
another on the Program side. In this case, a single correction is made using the merged 
values from the Source and Program sides.
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Options for Relationship Color Corrections

The following table describes the relationship color correction options available in the 
Correction Type menu.

Using the Source Clip Name Relationship

For many project situations, the Source Tape, Master Clip, and Sub Clip relationships are 
sufficient to allow you to make any Source color corrections to groups of related clips.

When a sequence is moved from another Avid editing application, however, a common 
workflow involves decomposing the sequence and recapturing. This destroys the original 
clip relationships by creating a new master clip (with a .new.xx extension) for every segment 
in the sequence. For more information on this process, see “Using Decompose When 
Recapturing” in the Help.

The Src (Source) Clip Name relationship is designed to allow you to make related 
corrections after decomposing and recapturing by referencing the clip name. It applies a 
correction to the current segment and to any other segment that has the same clip name. The 
Source Clip Name relationship ignores the clip name extensions that are created during the 
decomposing and recapturing cycle.

Relationship Description

Src (Source) Tape Corrects the current segment and all other segments in the sequence 
that use material from the same source tape.

Src (Source) Clip Name Corrects the current segment and all other segments in the sequence 
that have the same clip name. (This relationship ignores clip name 
extensions — .new and any subsequent characters — created during 
decomposing and batch capturing.) For more information on using this 
option, see “Using the Source Clip Name Relationship” on page 156.

Master Clip Corrects the current segment and all other segments in the sequence 
that use material from the same master clip.

Sub Clip Corrects the current segment and all other segments in the sequence 
that use material from the same subclip.

Src (Source) Segment Corrects only the current segment (the segment the position indicator is 
on in the Timeline).

Prog (Program) Track Corrects the current segment and all other material on that segment’s 
track.

Prog (Program) Segment Corrects only the current segment.
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As long as the clip names are consistent, this relationship effectively allows you to color 
correct by the original master clip relationship even though that relationship is not directly 
available to you. If you use the Source Clip Name relationship in this way, you should check 
the clip names before color correcting and verify that they are consistent. If you find names 
that are in conflict, you can rename them so that they will be correctly referenced by the 
Source Clip Name relationship.

Converting Relationship Color Corrections

You can convert one kind of Source relationship correction to another, or one kind of 
Program relationship correction to another.

You cannot directly convert a Source relationship correction to a Program relationship 
correction, or a Program relationship correction to a Source relationship correction. 
However, you can use your application’s color correction effect template capabilities to 
make such a conversion indirectly.

To convert a Source relationship correction to another Source relationship correction, 
or a Program relationship correction to another Program relationship correction:

1. Move the position indicator to the segment that carries the correction you want to 
convert.

2. Click the Correction Type button, and choose a new type from the menu.

To convert a Source relationship correction to a Program relationship correction, or a 
Program relationship correction to a Source relationship correction:

1. Move the position indicator to the segment that carries the correction you want to 
convert.

2. Save the adjustment values for the existing correction as a template, for example by 
dragging from the Color Correction Effect Template button to a bin.

3. Click the Remove Effect button to remove the existing correction.

4. Click the Correction Type button and select the new correction type you want.

5. Drag the color correction effect template that you saved in step 2 from the bin, and drop 
it in the monitor displaying the current segment.

For full information on working with color correction effect templates, see “Working 
with Color Correction Effect Templates” on page 171.
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Understanding the Group and Subdividing Tabs

The Color Correction tool uses a tabbed design to arrange its controls and to indicate their 
relationship to one another. At the top level of the hierarchy are five tabs that contain the 
controls for each main color correction group. Within some of these group tabs are one or 
more additional sets of tabs, arranged vertically on the left side of the tool, that subdivide the 
controls for that group.

n You can hide any of the top-level tabs (along with their subdividing tabs) so that they do not 
appear in the Color Correction tool. This is useful if you normally use only a small number 
of the tabs. For more information, see “Customizing Color Correction Mode Settings” on 
page 165.

The complete hierarchical structure of the Color Correction tool is shown in the following 
illustration:

Group tabs at the top of the Color Correction tool with a Source 
correction type selected. The Correction Type button and the active tab 
are colored green 

Group tabs at the top of the Color Correction tool with a Program 
correction type selected. The Correction Type button and the active tab 
are colored blue 

Subdividing tabs on the left side of the Color 
Correction tool, shown in relation to the higher level 
HSL group tab. The active tabs are green. Names 
on the inactive tabs appear dimmed.

Group tab — for example, HSL

Group subdividing tab — for example, Controls within 
HSL (The HSL group has a second level of subdividing 
tabs — for example, Highlights within Controls.)

Individual control — for example, Brightness 
slider within the Highlights pane of the Controls 
subdividing tab within the HSL group.
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For more information on the detailed organization of each group and the controls within 
each tab, see the chapter “Performing Color Corrections” on page 181.

Displaying Group and Subdividing Tabs

To display a color correction group tab:

t Click the tab in the area containing the group name.

n Do not click the Enable button when you want to display a color correction group tab.

The tab name is highlighted and colored based on the correction type, the tab moves to 
the front, and the specific controls for that tab appear.

The following illustrations show how the display changes when the Curves tab is 
clicked.

Click in this area of a tab to display the tab. 
Do not click the Enable button.

The Curves tab name appears 
dimmed, and the tab displays behind 
the currently active HSL tab. The 
active HSL tab appears blue.

Before

The Curves tab appears blue, and 
the tab displays in front of the other 
group tabs. The curves controls are 
now visible in the tab.

After
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To switch between group tabs using the keyboard:

t Press the Page Down key (to cycle from left to right) or the Page Up key (to cycle from 
right to left).

To display a subdividing tab:

1. Click the group tab in the area containing the group name.

2. Click the subdividing tab in the area that contains the subdivision name.

The tab name is highlighted and colored based on the correction type, the tab moves to 
the front, and the specific controls for that tab appear.

3. (Option) If necessary, click the second-level subdividing tab in the area that contains the 
second-level subdivision name.

This step is necessary when you want to display the second-level subdividing tabs 
within the Controls and Luma Ranges subdivisions of the HSL group.

To display a group or subdividing tab using a Tab button:

1. Enter Color Correction mode, for example, by clicking the Color Correction Mode 
button at the bottom of the Timeline.

2. Select Tools > Command Palette.

3. Click the CC tab.

4. Select Active Palette.

5. Click the Tab button with which the group or subdividing tab is associated.

For information on associating group and subdividing tabs with Tab buttons, see 
“Associating Group and Subdividing Tabs with Tab Buttons” on page 160.

In the Color Correction tool, the tab is highlighted, the tab moves to the front, and the 
specific controls for the tab appear.

n You can also map the Tab buttons to any mappable key on your keyboard or to any mappable 
button location in the user interface. For more information, see “The Command Palette” in 
the Help.

Associating Group and Subdividing Tabs with Tab Buttons

The Command palette contains twelve Tab buttons that you can use to provide one-click 
access to specific tab displays. For example, if you adjust the Luma Ranges graphs 
frequently as part of your color correction work, you can configure three Tab buttons to 
display the three Luma Ranges tabs (Highlights, Midtones, and Shadows).
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To associate a Color Correction tab with a Tab button:

1. In the Color Correction tool, click the tab that you want to map to a Tab button.

For example, click the Highlights tab within the Luma Ranges tab within the HSL group 
to assign that specific subdividing tab.

2. Select Tools > Command Palette.

The Command palette opens.

3. Click the CC tab.

The Color Correction buttons appear, including the twelve Tab buttons.

4. At the bottom of the Command palette, select Active Palette.

5. Alt+click (Windows) or Option+click (Macintosh) the Tab button with which you want 
to associate the Color Correction tab.

Understanding Interaction Between Color Correction Groups

Understanding how the color correction groups work together is important. Adjustments 
made in each group are applied cumulatively to the current segment and its related material. 
If you make an adjustment in one group and then go on to make another adjustment in a 
different group, the image will show the cumulative effect of both adjustments.

This behavior provides you with a great deal of flexibility. For example, you can use one 
group of controls to make relatively broad initial adjustments and then switch to another 
group to fine-tune your correction. If you are unhappy with some of your finer adjustments, 
you can disable that group or reset its controls to default settings without disrupting the 
initial group.

Tab buttons
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The following illustration shows an example of this kind of control over color correction 
groups.

You effectively have up to five layers of correction available for a Source correction, and 
potentially another five if you also apply a Program correction to the same segment. For 
more information on enabling, disabling, and resetting the groups, see “Working with the 
Enable Buttons” on page 162.

n If you make adjustments in multiple groups, keep in mind how the cumulative adjustments 
will affect the final image. Adjustments might accumulate, or cancel each other out, in ways 
that you do not want. Keep each stage of your correction distinct, and do not duplicate the 
same adjustment in both groups.

Working with the Enable Buttons

Each group tab in the Color Correction tool, each subdividing tab and individual control 
within each group, and each color vector within the Secondary groups, has an Enable button. 
These buttons provide an immediate visual guide to the status of the controls while you are 
making corrections. They also allow you to turn controls on and off in various combinations 
and quickly reset controls to their default values.

n You cannot reset controls not currently displayed. If you Alt+click (Windows) or 
Option+click (Macintosh) the Enable button for a tab whose controls are not currently 
displayed, you display the controls but do not reset them. Alt+click (Windows) or 
Option+click (Macintosh) the button again to reset the controls.

The Green and Blue curves are adjusted, but the Curves tab is turned off. The Curves tab 
adjustments are not currently applied to the segment. Adjustments made in the HSL tab 
are applied to the segment because the HSL tab is turned on, even though the HSL 
controls are not currently visible.

Enable button for Curves 
tab is turned off.

Enable button for 
HSL tab is turned on.
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To turn a control or tabbed group of controls on, do one of the following:

t Click the Enable button for the control or tabbed group of controls.

t Adjust any individual control that is linked to the Enable button.

The Enable button changes to pink, and the control or tabbed group of controls becomes 
active. Your Avid editing application includes the adjustments in that control or group of 
controls when calculating the corrected color.

To turn a control or tab off:

t Click the Enable button for the control or tab.

The Enable button changes to gray.

To reset a control or a tabbed group of controls to its default values:

1. Display the control or group of controls you want to reset.

2. Alt+click (Windows) or Option+click (Macintosh) the Enable button for that control or 
group of controls.

All controls linked to that button return to their default values.

Understanding Interaction Between Enable Buttons

The Enable buttons are linked in a hierarchical relationship that mirrors the relationship of 
the tabs themselves. When you change the status of an Enable button, the change can affect 
several levels of the hierarchy.

When you turn on an individual control, for example, you automatically turn on all related 
Enable buttons at higher levels in the hierarchy. By enabling an individual slider in the HSL 
group, you enable not only the button for that slider but also the buttons for all the associated 
tabs, up to and including the HSL group tab itself. The following illustration shows an 
example of this behavior.

When the Enable button for the 
Hue slider is turned on, the Master 
tab, Controls tab, and HSL tab 
Enable buttons are also turned on.
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When you Alt+click (Windows) or Option+click (Macintosh) an Enable button to reset 
controls, you automatically reset all controls at a lower level in the hierarchy. For example, if 
you Alt+click (Windows) or Option+click (Macintosh) the Enable button for the Red 
ChromaCurve™ graph in the Curves tab, only that one control is reset to its default value. 
However, if you Alt+click (Windows) or Option+click (Macintosh) the Enable button for the 
Curves tab, all the controls in the Curves tab will reset to their default values.

When you turn an Enable button off, your Avid editing application stops including controls 
below that button in the hierarchy when it calculates the corrected color for the segment. 
Individual controls below that button retain their values and can be reactivated at any time. 
Their Enable buttons remain pink.

n A small number of controls in the Color Correction tool appear in more than one tab as a 
convenience for users who prefer to remain in a single tab whenever possible, but their 
enable behavior remains tied to the tab that is their primary home. For example, several 
HSL slider controls also appear in the Curves tab. If you adjust one of these sliders in the 
Curves tab, you turn on the Enable buttons for the HSL > Controls > Master tab hierarchy.

n If you are reading a black-and-white hardcopy version of this document, you will find it 
useful to view the color images in the online version of the document available from the 
Online Library for your Avid editing application (Help > Online Library).

In the following illustration, the Curves tab Enable button is turned off, so none of the 
adjustments in the Curves tab are applied to the correction. Individual controls inside the tab 
retain their values and can be reactivated by clicking the Curves tab Enable button again.
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Using the Color Correction Tool Buttons

In addition to the Enable buttons, and specific control buttons within groups, the Color 
Correction tool has a group of buttons on the right side that control several important 
operations. 

Use these buttons to:

• Create Color Correction effect templates.

For more information, see “Working with Color Correction Effect Templates” on page 
171.

• Customize the operation of color correction.

For more information, see “Customizing Color Correction Mode Settings” on page 165.

• Set Safe Color limit values.

For more information, see “Safe Color Basics” and “Safe Colors” in the Help.

• Add comments to color-corrected segments.

For more information, see “Adding Comments to Color Correction Effects” on page 
170.

Customizing Color Correction Mode Settings

You can customize the appearance and behavior of Color Correction mode by selecting 
options in the Correction Mode Settings dialog box. For example, you can control which of 
the group tabs display, allowing you to remove from the tool any group that you do not 
normally use.

To customize Color Correction mode:

1. Do one of the following:

t In the Color Correction tool, click the Correction Mode Settings button.

t In the Project window, click the Settings tab, and then double-click Correction.

The Correction Mode Settings dialog box opens.

2. Select the options you want, as described in “Correction Mode Settings” on page 166.

3. Click OK.

Color Correction Effect 
Template button

Correction Mode Settings button
Safe Color Settings button

Comments button
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Correction Mode Settings

The following table describes the options available in the Correction Mode Settings dialog 
box.

Tab Option Description

Tabs HSL

Channels

Levels

Curves

Secondary

Define which group tabs appear in the Color Correction tool. Select 
the groups that you want to display in the Source tab.

Units RGB

Hue

Saturation/Gain

Luma

Composite

For each type of color adjustment, select an item from the menu to 
define the unit of measurement used for that adjustment type in the 
Color Correction tool. The following units of measurement are 
available in one or more of the menus:

• 10 Bit: Measures the adjustment on a scale from 0 to 1024.

• 8 Bit: Measures the adjustment on a scale from 0 to 255.

• Percent: Measures the adjustment on a percentage scale from 
0 to 100.

• IRE: Measures the adjustment in IRE units.

• mVolts: Measures the adjustment in millivolts.

• Degree: Measures the adjustment on a scale of degrees that 
represent a position on the color wheel. 0/360 represents the 
existing hue; 180 represents the opposite hue on the wheel (inverts 
the hue).

n The RGB value for a color in the Color Correction tool will not 
be identical to the RGB value for the same color in a graphics 
application such as Adobe Photoshop®. For example, the 10-bit 
RGB values for reference black and reference white are 288 
and 726 respectively. The 8-bit RGB values for reference black 
and reference white are 16 and 235 respectively.

n The 10-bit and 8-bit options for RGB units provide different 
measurement scales for the adjustment, but do not change the 
degree of precision with which the correction is made. For more 
information, see “How Color Correction Handles Color Space 
and Bit Depth” on page 169.
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Levels Solid Histograms When this option is selected, the histograms in the Levels tab of the 
Color Correction tool display as solid forms. When this option is 
deselected, the histograms display as a line graph.

Color Histograms When this option is selected, histograms that represent a single color 
channel display in the color of that channel. For example, histograms 
in the Red tab display in red.

Dynamic Histograms When this option is selected, the histograms update on-the-fly as you 
move other controls such as triangular sliders and control points on 
the Curve graph. This provides instant feedback on your adjustments, 
but the updating process might not always be smooth due to system 
processing limitations.

When this option is deselected, the histograms do not update until you 
release the controls you are adjusting.

Use Full Ranges When this option is selected, some histograms redraw to display the 
full 10-bit range of level values on the horizontal axis. The option 
applies to the Red, Green, Blue, and Master histograms. You then 
have additional headroom and footroom available for making 
adjustments beyond the normal range of values. 

This is sometimes useful when dealing with extreme color 
deficiencies in analog video material, such as very low RGB levels. It 
is not usually necessary to use full ranges with digital material since 
digital video has built-in headroom and footroom limits.

Tab Option Description

Solid histogram deselectedSolid histogram selected
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Features Secondary Vectors Controls which color vectors appear on the input vector color wheel in 
the Secondary group. Select one of the following values:

• Show All

• Show Standard

• Show Custom

• Show Enabled

For more information and illustrations of these options, see 
“Customizing the Display of Secondary Color Correction Vectors” on 
page 257.

Saved Color Labels Select an item from the menu to control how custom colors are named 
in bins. For information on saving custom colors, see “Saving Custom 
Colors to a Bin” on page 199.

• None: Your Avid editing application does not supply a name.

• RGB: Your application uses the 8-bit values for the red, green, and 
blue components as the name.

• Name: Your application uses the name from the standard HTML 
color scheme that most closely matches the color you are saving.

• Name and RGB: Your application uses both the Name and the 
RGB information. This is the default option.

Use Marks for 
Segment Correction

When this option is selected, the system applies either Source 
Segment or Program Segment color correction to all segments 
between marked IN and OUT points. If the IN and OUT points are in 
the middle of segments, the system includes the whole segments when 
it makes the correction.

This option is deselected by default.

Eyedropper 3 x 3 
Averaging

When this option is selected, your Avid editing application calculates 
the color value to pick by averaging the values of a 3 x 3 sample of 
pixels centered on the eyedropper’s position. This is often useful for 
picking up a color accurately by sight because it compensates for 
shifts in color value from one pixel to another. When this option is 
deselected, the system selects the color value of the exact pixel at the 
eyedropper’s position.

Show Eyedropper Info When this option is selected, the numerical RGB values appear on the 
color swatches in the Color Match controls.

Tab Option Description
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How Color Correction Handles Color Space and Bit Depth

When your Avid editing application makes some color correction adjustments, it converts 
the YCbCr color information in the media stored on disk into RGB color information (a 
better format for many color corrections) and then converts the information back to the 
original format for playback and storage. This round-trip conversion takes the color 
information from an 8-bit or 10-bit YCbCr color space into a 12-bit RGB color space and 
then back to 8-bit or 10-bit YCbCr. The 12-bit RGB color space that your application uses is 
designed to preserve color information as fully as possible during this process. Clipping of 
the original color values is virtually eliminated, and round-off errors from the two 
conversions are minimized.

The options for measuring units available in the Correction Mode Settings dialog box are a 
convenience that allows you to make adjustments using the units that are most useful or 
familiar to you. When your application makes the color correction adjustments, it always 
uses the 12-bit RGB color space and always works with the same degree of accuracy. 

Features 
(continued)

Eyedropper Picks from 
Anywhere in 
Application

When this option is selected, the eyedropper can pick a color from 
anywhere in your Avid editing application’s interface, for example the 
swatch for a custom color in a bin.

Show ChromaWheel and 
ChromaCurve Graphs

When this option is selected, the system displays color backgrounds 
for the ChromaWheels in the Hue Offsets tab of the HSL group and 
for the ChromaCurve graphs in the Curves tab. These backgrounds 
can make it easier to understand the effect that an adjustment will 
have on an image.

When this option is deselected (the default option), the system does 
not display the color backgrounds. You might prefer to use this option 
when you are working since it allows you to assess color in your video 
images without interference from other brightly colored on-screen 
elements.

AutoCorrect Contains three menus for defining the automatic color corrections that 
are made when you apply the Color Correction effect from the Effect 
Palette. For information on the options available in the AutoCorrect 
tab of the Correction Mode Settings dialog box, see “AutoCorrect 
Options” on page 186.

Tab Option Description
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Adding Comments to Color Correction Effects

You can add comments to color-corrected segments to assist you in your work. For example, 
you might want to briefly note the type of adjustment you made to a segment or to make 
notes during a preliminary correction pass of ideas for adjustments to be done later during a 
final pass.

The Comments button indicates whether a comment is present on a segment.

If the position indicator is on a segment that has a comment, the icon on the Comments 
button is yellow.

If the position indicator is on a segment that has no comment, the icon on the Comments 
button is not yellow.

To add a comment to a segment:

1. In Color Correction mode, move the position indicator to the segment to which you 
want to add a comment.

For information on entering Color Correction mode, see “Entering and Leaving Color 
Correction Mode” in the Help.

2. In the Color Correction tool, click the Comments button.

The Comments dialog box opens.

3. Type your comment in the text window, and click OK.

To remove a comment:

1. In Color Correction mode, move the position indicator to the segment from which you 
want to remove the comment.

For information on entering Color Correction mode, see “Entering and Leaving Color 
Correction Mode” in the Help.
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2. In the Color Correction tool, click the Comments button.

The Comments dialog box opens.

3. Click Remove.

To view or edit a comment in the Comments dialog box:

1. In Color Correction mode, move the position indicator to the segment for which you 
want to view the comment.

For information on entering Color Correction mode, see “Entering and Leaving Color 
Correction Mode” in the Help.

2. In the Color Correction tool, click the Comments button.

The Comments dialog box opens and displays the text of the comment.

3. (Option) To edit the comment, click in the text window and make your edits using 
standard word processing procedures.

To display comments in the Timeline:

t Click the Timeline Fast Menu button, and select Clip Text > Comments.

Your Color Correction comments appear in the Timeline.

Working with Color Correction Effect Templates
Your Avid editing application offers the following versions of Color Correction effect 
templates:

• The Automatic Effect Templates feature saves recent corrections automatically and lists 
them in the Effect Palette.

• The Color Correction buckets provide an easily accessible location within the Color 
Correction tool for the short-term storage of Color Correction effect templates.

• The Color Correction Effect Template button allows you to create a template for any 
color correction and save it to a bin in the same way that you save other kinds of effect 
templates. The Save Correction button in the CC tab of the Command palette performs 
the same function.

Like templates for other effects, Color Correction effect templates save all the adjustment 
values for a color correction so you can apply those values quickly to another segment. You 
can apply all the values at once by dragging the template into the monitor containing the 
current segment, or you can apply the values for the controls in a single tab in the Color 
Correction tool by dragging the template onto the tab that contains the group of controls you 
want to change.
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You can also apply a Color Correction effect template to multiple segments at once by 
selecting the segments and then double-clicking the effect template icon in the bin or in the 
Effect Palette. To do this, you must be in editing or Effects mode.

n You can also save custom colors to bins. For more information, see “Saving Custom Colors 
to a Bin” on page 199.

How Color Correction Effect Templates Save Settings

When you create a Color Correction effect template, the system saves all the Color 
Correction settings for the segment. This is true whether the template is created 
automatically by the system or manually by saving to a bin or a bucket. The system 
remembers both the values set for each control and the status of each Enable button.

Automatic templates update when you make new adjustments on the same segment. For 
example, when you have made only a single adjustment, the template contains the value of 
that adjustment. If you make another Source side adjustment to the same clip, the template 
updates to include the value of the new adjustment. In contrast, templates saved to a bin or a 
bucket do not update when you make new adjustments to the segment. To save the new 
adjustments you must save a new template to a bin or a bucket.

If you make multiple corrections on the same segment (for example, a Source correction and 
a Program correction), the template includes all those adjustments. When you apply the 
template globally by dragging it into the active monitor, you apply all corrections that the 
template includes.

Since this behavior might lead to confusing results, it reinforces the need in most 
circumstances to keep Source and Program color corrections completely separate. In 
general, you should use Program corrections only for final adjustments, which are often 
made across a whole track. For more information on keeping Source and Program 
corrections separate, see the note at the end of “General Workflow for Making Color 
Corrections” on page 181.

n You can specify which settings you apply in a template by dragging the template to the active 
tab in the Color Correction tool. This changes only those settings contained within that tab. 
Using this method, you can, for example, apply settings one tab at a time without applying 
any other settings that might also be saved in a template.

n If you make a Source color correction on a clip and then make a Program correction, the 
system saves a second template in the Effect Palette list. This second template is a duplicate. 
The two templates are identical in the information they contain — each contains both the 
Source and the Program information — and applying either to a new segment will apply all 
the saved information.
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Using Automatic Effect Templates

Your Avid editing application saves the most recent color corrections made in a sequence 
(up to a limit of 16 corrections) and makes them available in the Effect Palette. This provides 
you with automatically created templates for all your most recent corrections. You can 
quickly apply any one of these templates to another segment in the sequence by dragging it 
or simply by highlighting it in the Effect Palette and pressing Enter (Windows) or Return 
(Macintosh).

The Effect Palette lists all color-corrected sequences that are loaded in the Record monitor at 
the bottom of the scrollable list of effect categories. The effect categories list might therefore 
contain effect categories, bins that contain saved effects, and color-corrected sequences. 

The following illustration shows an effect categories list containing all three of these items.

When you select a color-corrected sequence in the effect categories list of the Effect Palette, 
a list of templates for the most recent corrections made to that sequence appears in the right 
side of the Effect Palette.

Each template is named using either the clip name of the segment on which it was originally 
made or, if a comment is associated with that segment, the text of the comment. For more 
information on comments, see “Adding Comments to Color Correction Effects” on page 
170.

The templates are ordered in the Effect Palette based on the time at which they were created, 
with the most recently created template at the top of the list. The templates are also 
numbered to indicate the order of their creation, with the most recently created template 
always numbered “1.”

The list is limited to the 16 most recent corrections. If the list already contains 16 templates, 
the system removes the oldest template from the list when you make a new correction.

Effect categories

Bin that contains 
saved effects

Color-corrected 
sequences in the 
Record monitor

Newest correction

Oldest correction
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Saving a Color Correction Effect Template to a Bin

You can save a Color Correction effect template to a bin using either the Color Correction 
Effect Template button in the Color Correction tool or the Save Correction button in the CC 
tab of the Command palette.

Color correction templates saved to a bin are saved permanently, unlike templates saved to a 
bucket, which are not saved beyond the current working session, or automatic templates, 
which are deleted when you have made 16 more recent corrections.

To save a Color Correction effect template to a bin:

1. In Color Correction mode, make sure that the position indicator is in the segment that 
contains the settings you want to save.

For information on entering Color Correction mode, see “Entering and Leaving Color 
Correction Mode” in the Help.

2. Do one of the following:

t Click the Color Correction Effect Template button, press and hold the mouse 
button, and then drag the effect icon to a bin.

t With Active Palette selected in the Command palette, click the Save Correction 
button in the CC tab.

t If the Save Correction button is mapped to a key, press that key.

A new effect template appears in the bin, containing all the color correction adjustment 
values for the segment. The new effect template is identified in the bin by its effect icon. 
By default, your Avid editing application names the template using the clip name of the 
segment. Effect icons for open bins are also displayed in the Effect Palette.

3. (Option) To rename the template, click the template name and type a new name.

To permanently save a color correction effect template currently stored in a bucket:

t Click the color correction icon in the bucket and drag it to a bin.

For more information, see “Saving a Color Correction Effect Template to a Bucket” on 
page 174.

Saving a Color Correction Effect Template to a Bucket

The Color Correction tool provides eight buckets, located below the Color Match control, 
that you can use to save Color Correction effect templates for the duration of a working 
session. You can then apply the template quickly to any segment.

The buckets are initially labeled C1 through C8. When you fill a bucket with a Color 
Correction effect template, a Color Correction icon appears on the bucket.
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Color Correction effect templates saved to buckets do not remain from one session to 
another. When you end your session, your Avid editing application deletes the templates. 
However, you can save an effect template from a bucket permanently by dragging it to a bin. 
For more information, see “Saving a Color Correction Effect Template to a Bin” on page 
174.

n The Color Correction buckets are also available as buttons in the CC tab of the Command 
Palette. You can map these buttons to any mappable key on your keyboard or to any 
mappable button location in the user interface. For more information, see “The Command 
Palette” in the Help.

The following illustration shows the Color Correction buckets.

To save a Color Correction effect template in a bucket:

1. In Color Correction mode, make sure that the position indicator is in the segment that 
contains the settings you want to save.

For information on entering Color Correction mode, see “Entering and Leaving Color 
Correction Mode” in the Help.

2. Alt+click (Windows) or Option+click (Macintosh) the bucket in which you want to save 
the template.

You can click any one of the eight buckets to save to it. Empty buckets have a label that 
begins with the letter “C,” for example, C5. Buckets that already contain a template have 
a Color Correction icon. If you Alt+click (Windows) or Option+click (Macintosh) a 
bucket that already contains a template, you overwrite the previous template with the 
new adjustment values.

The values are saved as a template. If the bucket was previously empty, a Color 
Correction icon replaces the “C” label on the bucket.

Buckets C1 and C2 filled (Color 
Correction icon appears)

All buckets empty
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Clearing Color Correction Effect Templates from Buckets

You can clear a Color Correction effect template from a bucket without having to overwrite 
the template with a new one.

To clear a Color Correction bucket of its saved correction during an editing session:

t Move the position indicator to any uncorrected segment in the Timeline and then 
Alt+click (Windows) or Option+click (Macintosh) the bucket.

The template information is cleared from the bucket. A label beginning with the letter 
“C,” for example, C3, replaces the Color Correction icon on the bucket.

Applying Color Correction Effect Templates

To apply all adjustment values in a Color Correction effect template to the current 
segment, do one of the following in Color Correction mode:

t Click the effect icon for the template in the bin, the Effect Palette, or the Color 
Correction bucket, and drag it to the monitor containing the current segment or to the 
segment in the Timeline.

For information on entering Color Correction mode, see “Entering and Leaving Color 
Correction Mode” in the Help.

n For tips on working with templates in the Effect Palette, see “Saving a Color Correction 
Effect Template to a Bin” on page 174.

t Select the template in the bin or the Effect Palette, and then press Enter (Windows) or 
Return (Macintosh).

t Click the appropriate Color Correction bucket.

t If you have mapped the Color Correction bucket to the keyboard, press the appropriate 
key.

Your Avid editing application applies all the Color Correction adjustments in the 
template to the segment that is the current location of the position indicator. 

To apply adjustment values from a Color Correction effect template selectively to a 
single tab of color correction controls:

1. In the Color Correction tool, click the tab to which you want to apply the template.

2. Click the effect icon for the template in the bin, the Effect Palette, or the Color 
Correction bucket, drag it to the tab, and drop it anywhere in the tab.

The controls in that tab update to reflect the values in the template. Other color 
correction controls are not affected.
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n If you apply template settings to a subdividing tab (for example, the Controls tab in the HSL 
group), the image in the monitor does not reflect those settings until you enable the group 
tab (for example, the HSL tab).

If you apply a saved Color Correction effect template to a segment that already has a color 
correction, you overwrite the existing correction. The existing Color Correction settings are 
lost. If the existing correction is itself saved as a template, the template might also be lost 
(depending on the scope of the existing correction). Make sure you want to replace the 
existing correction before you apply a saved Color Correction effect template to a clip that 
already has a correction. You can use the Undo command to undo the effect of a Color 
Correction effect template. However, once the Undo command is no longer available, you 
cannot recover the original Color Correction settings.

Color Correction Effect Templates and Relationship Type Selections

If you save a relationship color correction effect to a bin as an effect template, the 
relationship type of the original effect is saved as part of the template. However, depending 
on how you apply the effect template to another segment, the new color correction might use 
the relationship saved as part of the template, or it might use the currently selected 
relationship in the Correction Type menu. You should choose one of the following methods 
for applying a color correction effect template based on whether you need the relationship 
type saved with the template or the relationship type currently selected in the Correction 
Type menu.

• When you apply the effect template by dragging it to a segment in the Timeline, the new 
color correction uses the relationship type saved with the template.

• When you apply the effect template by dragging it to the Current monitor in the 
Composer window, the new color correction uses the relationship type saved with the 
template. However, a Color Correction Effect icon is also added to the clip. This is a 
duplicate of the color correction that you can remove.

• When you apply the effect template by double-clicking it in the bin or by dragging it to 
an individual tab in the Color Correction tool, the new color correction uses the 
relationship type currently selected in the Correction Type menu.

• In addition, when you apply a color correction saved in a bucket by clicking the bucket, 
the new color correction uses the relationship type currently selected in the 
Correction Type menu.
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Displaying Color Correction Information in the 
Timeline

The Timeline works the same way in Color Correction mode as it does in other modes. You 
can move the position indicator from one place to another in your sequence, select and 
deselect tracks, and perform other normal Timeline operations. 

The Timeline has one control that is specific to color correction: the Color Correction option 
in the Timeline Fast menu. When you select Color Correction, the Timeline displays 
indicator lines to show which segments have relationship color corrections. For more 
information on color correction indicator lines in the Timeline, see “Understanding Color 
Correction Indicator Lines in the Timeline” on page 178.

To display color correction information in the Timeline:

t Click the Timeline Fast Menu button, and select Color Correction.

The Timeline display updates to show the color correction indicator lines.

Understanding Color Correction Indicator Lines 
in the Timeline

A segment in the Timeline that has Source color correction is marked with a green line at the 
bottom of the segment; a segment that has Program color correction is marked with a blue 
line at the top of the segment. For information on displaying or hiding color correction 
indicator lines in the Timeline, see “Displaying Color Correction Information in the 
Timeline” on page 178.

The appearance of the indicator line indicates the relationship that applies to the correction 
on that segment. A dotted line indicates a correction that applies only to that segment 
(Source Segment or Program Segment relationship); a solid line indicates a correction that 
applies beyond the individual segment (Source Tape, Source Clip Name, Master Clip, Sub 
Clip, or Program Track).
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Color Correction is available in the Timeline in all modes, but it might be most useful while 
you are working in Color Correction mode as a guide to which segments have already 
received either Source or Program adjustment.

As effects that normally play in real time, all relationship color corrections appear with 
green dots in the Timeline unless they have been rendered. These dots continue to display in 
the Timeline even if the Color Correction option is dselected in the Timeline Fast menu.

Green lines indicate 
Source color corrections.

Blue lines indicate 
Program color corrections.

Dotted line indicates that the correction 
applies to this segment only.

Solid line indicates that the correction 
applies beyond this individual segment. 
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5 Performing Color Corrections

This chapter describes all procedures for making color corrections that are not covered in 
“Color Correction: Basics” in the Help. It also provides a complete explanation of all the 
individual controls in the Color Correction tool and how to use them.

• General Workflow for Making Color Corrections

• Using Automatic Color Corrections

• Using the Color Match Control

• The HSL (Hue, Saturation, Luminance) Group

• The Channels Group

• The Levels Group

• The Curves Group

• The Secondary Group

• Working with the Waveform Monitors and the Vectorscope Monitor

• Using the Color Correction Effect

General Workflow for Making Color Corrections
The Color Correction tool gives you a great deal of flexibility when you make color 
corrections. The exact workflow that you employ depends on your individual methods, your 
degree of familiarity with the color correction controls, and the requirements of your project. 
However, the basic steps to take when making a correction will be similar for all users. 

The following steps outline a typical color correction operation. You can adapt the exact 
order in which steps are performed or repeated to conform to your particular needs.
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n In general, you should not attempt to make Source relationship corrections and Program 
relationship corrections as part of the same corrective operation or to use Program 
corrections for your first color correcting pass. If you do so, you lose flexibility and control 
for later stages of your project and you reduce the power of the Color Correction tool. Even 
if you expect to need only one color correction pass (and could use Program relationships 
for that pass), you should make that pass using Source relationships. If your needs for the 
project change, you will still be able to make a second set of corrections using Program 
relationships.

1. In Source/Record mode, load the sequence into a monitor.

2. Click the Color Correction Mode button below the Timeline to enter Color Correction 
mode.

3. (Option) If necessary, configure the Color Correction mode display so that it conforms 
to the requirements of your project and editing style.

For more information on the display and how to configure it, see “Color Correction 
Mode Basics” in the Help and “Understanding Color Correction Mode” on page 147.

4. Preview the material in the sequence to develop a sense of the kinds of corrections that 
are needed and the approach you will use to make them. 

For example, you might look for a shot that you would like to use as a reference for your 
adjustments and lock that shot in one of the monitors. You might also make decisions 
about the Source or Program relationships that you want to use as you work. For general 
guidance on what to look for when previewing material, see “Color Correction 
Techniques” on page 303.

n You might prefer to preview extensively and plan your corrections in advance. If you have 
more color correcting experience, you might work by moving back and forth frequently 
between making corrections and assessing the material on which you are working.

5. Make sure that the Record Track button for the track on which you want to make 
corrections is the topmost selected button in the Track Selector panel in the Timeline.

You can color correct any number of tracks, including nested tracks by stepping into the 
nest. However, you can correct only one track at a time. Color correction is applied to 
the topmost selected track in a sequence.

6. Use the Composer Window buttons or the position indicator in the Timeline to move to 
a segment you want to correct.

7. Select a relationship to control the scope of the corrections, or choose to apply a Color 
Correction effect correction.

Depending on your circumstances, you might use the same relationship throughout the 
sequence, or you might select different relationships for different segments. For more 
information, see “Selecting Correction Types” on page 154.
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8. Click the appropriate tabs in the Color Correction tool to display the controls you want 
to use to make the correction.

For more information, see “Understanding the Group and Subdividing Tabs” on page 
158.

9. Adjust the controls until you are satisfied with the correction.

Remember that you can repeat steps 7 and 8 to make successive adjustments using 
several different groups of controls and to selectively turn them on and off while you 
assess their effect on the segment. You can use the Dual Split button in the monitors to 
view corrected and uncorrected images side by side.

10. (Option) Add a comment for the correction.

11. Repeat steps 5 through 10 for each segment you want to correct.

12. When you are satisfied with the corrections throughout the sequence, click one of the 
mode buttons (Source/Record, Trim, or Effect) or make a selection from the Toolset 
menu to exit Color Correction mode and return to other editing operations.

Using Automatic Color Corrections
Both color correction groups include buttons that allow you to make automatic color 
corrections to correct contrast problems, balance color, or remove color casts by identifying 
areas of an image that should be color neutral.

You can also apply up to three automatic color corrections in a single operation by selecting 
options in the AutoCorrect tab of the Correction Mode Settings dialog box and applying the 
Color Correction effect from the Effect Palette to one or more segments in a sequence. For 
more information, see “Correcting Color Automatically Using the Color Correction Effect” 
in the Help and “Setting AutoCorrect Options” on page 184.

The Color Match control also corrects automatically by adjusting an image so that a poor 
color value matches a better one. You select the colors on which you want Color Match to 
operate using an eyedropper. For more information, see “Using the Color Match Control” on 
page 191.
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Understanding Automatic Color Correction

Automatic color correction simplifies the work of correcting common color problems in 
video images. When you use one of the automatic color corrections, Symphony analyzes the 
existing color characteristics of an image and makes adjustments to color correction controls 
that usually eliminate or at least significantly reduce a specific color problem.

You will often want to begin your color correction work by using automatic color 
corrections, especially if you do not have time for detailed manual adjustments, if you only 
need to correct basic color problems such as color casts, or if you lack experience with the 
manual controls in the Color Correction tool.

Since automatic color correction adjusts controls in the Color Correction tool just as you 
would when making manual corrections, you are always free to make additional adjustments 
manually if you need to fine-tune the correction. Also, automatic color corrections can help 
you learn how to recognize color problems in images and what kinds of adjustments you 
might make to correct images manually. For example, if the Auto Balance automatic 
correction in the Hue Offsets subdividing tab adjusts an image by adding yellow in the 
ChromaWheels, then the analysis of that image revealed a blue color cast.

Automatic color corrections operate within normal limits for legal video levels. For 
example, an automatic color correction does not make an adjustment that takes a significant 
area of an image beyond legal luminance levels.

Setting AutoCorrect Options

You control how Color Correction makes automatic corrections when you apply the Color 
Correction effect from the Effect Palette by choosing options in the AutoCorrect tab of the 
Correction Mode Settings dialog box.

For information on applying the Color Correction effect from the Effect Palette, see 
“Correcting Color Automatically Using the Color Correction Effect” in the Help.
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To set AutoCorrect options:

1. Do one of the following:

t In the Settings tab of the Project window, double-click Correction.

t In the Color Correction window, click the Correction Mode Settings button.

The Correction Mode Settings dialog box appears.

2. Click the AutoCorrect tab.

3. Select an option from each of the three menus to define the first, second, and third 
automatic color correction that Avid Color Correction makes when you apply the Color 
Correction effect from the Effect Palette.

For detailed information on the options available, see “AutoCorrect Options” on page 
186.

For information to help you to decide on the best order for these corrections, see 
“Considerations When Using Automatic Color Correction” on page 190.

First Correction menu

Second Correction menu

Third Correction menu
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AutoCorrect Options

The following table describes the available options in the AutoCorrect tab of the Correction 
Mode Settings dialog box.

Option Description

Nothing Makes no adjustment. For example, if you only want to make two 
automatic corrections when you drag the Color Correction effect from the 
Effect Palette, set the Third Correction menu in the AutoCorrect tab to 
Nothing.

HSL Auto Balance Makes adjustments to the three ChromaWheels to balance the colors in the 
image. The equivalent of clicking the Auto Balance button in the Hue 
Offsets subdividing tab of the HSL tab.

HSL Auto Black Adjusts the Setup slider in the Hue Offsets subdividing tab of the HSL tab 
to make the darkest areas of the image as dark as possible. The equivalent 
of clicking the Auto Black button in the Hue Offsets subdividing tab of the 
HSL tab.

HSL Auto Contrast Adjusts the Gain and Setup sliders in the Hue Offsets subdividing tab of 
the HSL tab to maximize the tonal range in the image. The equivalent of 
clicking the Auto Contrast button in the Hue Offsets subdividing tab of the 
HSL tab.

HSL Auto White Adjusts the Gain slider in the Hue Offsets subdividing tab of the HSL tab 
to make the brightest areas of the image as bright as possible. The 
equivalent of clicking the Auto White button in the Hue Offsets 
subdividing tab of the HSL tab.

Curves Auto Balance Makes adjustments to the Red, Green, and Blue curves to balance the 
colors in the image. The equivalent of clicking the Auto Balance button in 
the Curves tab.

Curves Auto Contrast Makes an adjustment to the Master curve to maximize the tonal range in 
the image. The equivalent of clicking the Auto Contrast button in the 
Curves tab.
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Adjusting Contrast and Balance Automatically

You can adjust the contrast and balance the color automatically for an image simply by 
clicking buttons. An automatic contrast adjustment expands the tonal range of the image, 
which usually improves sharpness and detail. An automatic balance adjustment evens out 
the influence of the different color channels in the image, which usually greatly reduces or 
even eliminates any color cast.

Automatic contrast and balance buttons appear in the Color Correction tool in the following 
locations:

• The HSL > Controls > Master tab, as shown in the following illustration:

• The HSL > Hue Offsets tab, as shown in the following illustration:

• The Curves tab, as shown in the following illustration:

For information on correcting contrast or balance automatically in the Hue Offsets 
subdividing tab, see “Correcting Color Automatically in the Hue Offsets Tab” in the Help.

To make an automatic contrast or balance adjustment in the Curves tab:

1. Enter Color Correction mode, for example, by selecting Toolset > Color Correction.

2. In the Timeline, make sure that the Record Track button for the video track on which 
you want to make corrections is the topmost selected track.

Auto White button

Auto Contrast buttonAuto Black button

Auto Balance 
button

Auto White button

Auto Contrast buttonAuto Black button

Auto Contrast button

Auto Balance button
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3. In the Timeline or in the Composer window, navigate to the segment you want to 
correct.

4. In the Curves tab of the Color Correction tool, click either the AutoBalance or the 
AutoContrast button.

- Auto Balance: Makes adjustments to the Red, Green, and Blue curves to balance the 
colors in the image. This eliminates any color cast for most images.

- Auto Contrast: Makes an adjustment to the Master curve to maximize the tonal 
range in the image. The brightest areas of the image and made as bright as possible 
and the darkest areas of the image are made as dark as possible.

The system analyzes the currently selected frame in the segment and adjusts the 
appropriate color correction controls.

Understanding the Remove Color Cast Buttons

You can remove a color cast automatically by clicking a Remove Color Cast button and 
using an eyedropper to identify an area in your image that you want to be color neutral 
(white, black, or a shade of gray). Symphony analyzes the current color characteristics of the 
area you have selected and then adjusts color correction controls to make that area color 
neutral.

Remove Color Cast buttons provide more precise control over color cast removal than Auto 
Balance buttons because their adjustments are limited either by luminance range or by the 
impact that they have on existing curve graphs. However, Remove Color Cast buttons are 
only useful when you are working with an image that has areas that should be color neutral. 

Remove Color Cast buttons appear in the Color Correction tool in the following locations:

• Below each of the three ChromaWheels in the Hue Offsets subdividing tab of the HSL 
tab, as shown in the following illustration:

• In the Curves tab, as shown in the following illustration:

Remove Color Cast button

Remove Color Cast button
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Each ChromaWheel Remove Color Cast button is associated with the wheel above it. 
Adjustments are made only to that wheel; only the parts of the image that fall within the 
luminance range controlled by that wheel are changed. You choose which ChromaWheel to 
adjust based on the luminance level of the area you want to identify, as follows:

• To make white or light gray areas of an image color neutral and remove a cast 
throughout the lightest part of the image, use the Remove Color Cast button below the 
Highlights ChromaWheel.

• To make mid-gray areas of an image color neutral and remove a cast throughout the 
midtones of the image, use the Remove Color Cast button below the Midtones 
ChromaWheel.

• To make black or dark gray areas of an image color neutral and remove a cast 
throughout the darkest parts of the image, use the Remove Color Cast button below the 
Shadows ChromaWheel.

The Curves tab Remove Color Cast button works by adding a point to each of the Red, 
Green, and Blue curves that makes the area you identify with the eyedropper color neutral. 
You can use the Curves tab Remove Color Cast button repeatedly to identify multiple areas 
that you want to be color neutral. Each new use adds another point to each of the three 
curves. (You can add new points up to the 16-point limit, although once several points are 
distributed along the curve, further points are unlikely to improve the image significantly.) 

The effect of each added point on the image as a whole varies depending on the shape of the 
entire curve. In general, each new point affects the image most in areas with similar 
luminance values to the area you identify with the eyedropper, and affects the image least in 
areas with very different luminance values.

Using the Remove Color Cast Buttons

To use a Remove Color Cast button:

1. Enter Color Correction mode, for example, by selecting Toolset > Color Correction.

2. In the Timeline, make sure that the Record Track button for the video track on which 
you want to make corrections is the topmost selected track.

3. In the Timeline or in the Composer window, navigate to the segment you want to 
correct.

4. Do one of the following:

t Click the Remove Color Cast button below a ChromaWheel in the Hue Offsets 
subdividing tab of the HSL tab.

t Click the Remove Color Cast button in the Curves tab.

The button appears highlighted.
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5. Drag the pointer into the image.

The pointer changes to an eyedropper.

6. Continue to drag the eyedropper until it is over the part of the image you want to 
become color neutral, and then release the mouse button.

Avid Color Correction analyzes the part of the image you have identified and adjusts the 
controls to remove the color cast.

Considerations When Using Automatic Color Correction

Although automatic color corrections are much simpler to learn and perform than manual 
corrections, practice and experience will still improve your ability to correct a range of 
images with different color characteristics. If one set of automatic corrections does not 
produce good results, remove it and try a different combination. Remember also that some 
images might require manual correction in addition to or instead of automatic correction.

The following tips and suggestions will help you to achieve the best possible results when 
using automatic color correction:

• The Auto Contrast correction is most useful for images that should have areas of strong 
highlight (white or close to white) as well as areas of strong shadow (black or close to 
black). If you make an Auto Contrast correction on an image that should not have such a 
full tonal range (many close-ups fall into this category), the correction might introduce 
too much contrast. When an image requires strong highlights but not strong shadows (or 
the reverse), you can use the Auto White or the Auto Black button to set the white or 
black point without making the overall range of tones too extreme.

• When you perform both an Auto Contrast and an Auto Balance correction, the order in 
which you perform these two operations affects the final quality of the correction. In 
most cases, you achieve the best results for most images by doing the following:

- In the Hue Offsets subdividing tab of the HSL tab, use Auto Contrast first, and then 
use Auto Balance

- In the Curves tab, use Auto Balance first, and then use Auto Contrast
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• There is usually no gain in performing an automatic correction more than once on the 
same image, even if the second correction would be made in a different group from the 
first. For example, once you have performed an Auto Balance in the Curves tab, you do 
not usually see any improvement in the color balance of the image if you perform a 
second Auto Balance either in the Curves tab or in the Hue Offsets subdividing tab of 
the HSL tab.

• If an Auto Contrast and Auto Balance combination has improved an image but some 
color cast remains, you can often fine-tune the correction using one or more of the 
Remove Color Cast buttons.

• Automatic corrections you make in the Hue Offsets subdividing tab of the HSL tab and 
those you make in the Curves tab do not produce identical results for most images (and 
might produce markedly different results for some images). This is because the methods 
for calculating the corrections are different and because the controls that are being 
adjusted operate differently. Automatic corrections in the Curves tab often work well for 
correcting basic problems caused by incorrect camera color balancing. Automatic 
corrections in the Hue Offsets subdividing tab of the HSL tab are often better for more 
extreme problems such as bad lighting conditions. However, there are no rules that 
cover all situations. If automatic correction in one color correction group does not yield 
good results, remove it and try a correction in the other group.

Using the Color Match Control
Each Color Correction group includes a Color Match control. This control allows you to 
quickly make a correction by selecting input and output colors from your images, or from 
the Windows Color dialog box or the Macintosh Colors panel.

When you use the Color Match control, the system replaces the input color value with the 
output color value and adjusts all the other color values in the image proportionally. The 
system also automatically adjusts the other controls in the group to reflect the change. You 
can set the combination of color channels or components the system uses to determine the 
match by making menu selections.

For example, if you want to replace the blue sky tone in one image with that in another to 
match the two shots, you can use the Color Match control to pick the two colors and 
automate the color adjustment.

When you are working in the Curves group, the Color Match control also includes the 
NaturalMatch™ feature. NaturalMatch allows you to replace the hue values in an image 
with new output values without distorting the saturation and luminance values in the image.

You can also Alt+drag (Windows) or Option+drag (Macintosh) colors to a bin and save them 
as custom colors. You can then drag a custom color into the Color Match control at any time.
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n Slightly different versions of the Color Match control also appear as effect parameters in the 
Spot Color Correction effect and the Paint Effect. For more information on spot color 
correction, see the chapter “Spot Color Correction” on page 321.

Making a Correction with the Color Match Control

The following illustration shows the Color Match control.

To make a correction using the Color Match control:

1. If you have not already done so, click the Color Correction Mode button below the 
Timeline to enter Color Correction mode.

2. In the Color Correction tool, click the tab that includes the Color Match control with 
which you want to work.

3. (Option) Select Eyedropper 3 x 3 Averaging in the Correction Mode Settings dialog 
box.

When you select Eyedropper 3 x 3 Averaging, the system calculates the color value to 
pick by averaging the values of a 3 x 3 sample of pixels centered on the eyedropper’s 
position. This is often useful for picking up a color accurately by sight because it 
compensates for shifts in color value from one pixel to another. When this option is 
deselected, the system selects the color value of the exact pixel at the eyedropper’s 
position.

n For information on the Correction Mode Settings dialog box, see “Correction Mode 
Settings” on page 166.

4. Select the input color (the color to be replaced):

a. Move the pointer over the input color swatch.

The pointer changes to an eyedropper.

b. Press and hold the mouse button, and then drag the eyedropper to the area of the 
image in the monitor from which you want to select an input value.

c. Release the mouse button to complete the selection.

The input color appears in the input color swatch.

Input color 
swatch

Output color 
swatch

Match Type 
button

Match Color 
button
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n You can also select an input color from the Windows Color dialog box or the Macintosh 
Color Picker by double-clicking the input color swatch. However, you will usually want to 
select your input color from the current segment.

5. Select the output color:

a. Move the pointer over the output color swatch.

The pointer changes to an eyedropper.

b. Press and hold the mouse button, and then drag the eyedropper to the area of the 
image in the monitor from which you want to select an output value.

The output color swatch in the Color Match control updates as you move the 
eyedropper in the image.

c. Release the mouse button to complete the selection.

The output color appears in the output color swatch.

n Your output color is usually selected from an image other than the current segment, such as 
the next segment or a reference frame. Alternatively, you can double-click the output color 
swatch and select a color from the Windows Color dialog box or the Macintosh Color 
Picker. The Windows Color dialog box and the Macintosh Color Picker are useful for 
selecting an “ideal” replacement color such as a completely neutral gray. You can also use 
the Windows Color dialog box or the Macintosh Color Picker to create and store custom 
colors. For more information on using the Windows Color dialog box or the Macintosh 
Color Picker, see “Adjusting a Color Parameter” in the Help.

6. Click the Match Type button, and select a Match Type to determine the exact nature of 
the match the system makes.

The options available in the Match Type menu depend on the group in which you are 
working. For more information on Match Type options, see “Match Type Options” on 
page 193.

7. Click the Match Color button to make the correction. 

The system adjusts the current segment and resets the group controls to reflect the 
adjustment. The corrected image displays in the monitor that contains the current 
segment.

Match Type Options

The options available in the Match Type menu reflect the way in which color is handled in 
the group in which you are working. The following tables describe the options available in 
the Match Type menu.
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HSL Group (Controls Tab) Match Type Options

The following table describes the Match Type options for the HSL group in the Controls tab.

HSL Group (Hue Offsets Tab) Match Type Options

The following table describes the Match Type options for the HSL group in the Hue Offsets 
tab.

Option Description

H + S + L The system matches based on the hue, saturation, and luminance of the color selected 
in the output color swatch.

Hue The system matches based on only the hue of the color selected in the output color 
swatch.

Saturation The system matches based on only the saturation of the color selected in the output 
color swatch.

Luminance The system matches based on only the luminance of the color selected in the output 
color swatch.

H + S The system matches based on both the hue and the saturation of the color selected in 
the output color swatch.

H + L The system matches based on both the hue and the luminance of the color selected in 
the output color swatch.

S + L The system matches based on both the saturation and the luminance of the color 
selected in the output color swatch.

Option Description

Master The system matches based on both the hue and the saturation across the full tonal 
range.

Highlights The system matches based on both the hue and the saturation across the highlights 
portion of the tonal range as defined in the Luma Ranges tab.

Midtones The system matches based on both the hue and the saturation across the midtones 
portion of the tonal range as defined in the Luma Ranges tab.

Shadows The system matches based on both the hue and the saturation across the shadows 
portion of the tonal range as defined in the Luma Ranges tab.
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Channels Tab Match Type Options

The following table describes the Match Type options for the Channels tab.

Levels Tab Match Type Options

The following table describes the Match Type options for the Levels tab.

Option Description

Master The system matches based on the luminance of the color selected in the output color 
swatch.

R + G + B The system matches based on the values of all three color channels of the color 
selected in the output color swatch.

Red The system matches based on only the value of the Red color channel of the color 
selected in the output color swatch.

Green The system matches based on only the value of the Green color channel of the color 
selected in the output color swatch.

Blue The system matches based on only the value of the Blue color channel of the color 
selected in the output color swatch.

R + G The system matches based on the values of the Red and Green color channels of the 
color selected in the output color swatch.

R + B The system matches based on the values of the Red and Blue color channels of the 
color selected in the output color swatch.

G + B The system matches based on the values of the Green and Blue color channels of the 
color selected in the output color swatch.

Option Description

Black Point The system adjusts the black point of the image to the brightness value of the color 
selected in the output color swatch.

Gray Point The system adjusts the gray point of the image to the brightness value of the color 
selected in the output color swatch.

White Point The system adjusts the white point of the image to the brightness value of the color 
selected in the output color swatch.
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Curves Tab Match Type Options

The following table describes the Match Type options for the Curves tab.

Option Description

Master The system matches based on the luminance of the color selected in the output color 
swatch.

R + G + B The system matches based on the values of all three color channels of the color 
selected in the output color swatch.

Red The system matches based on only the value of the Red color channel of the color 
selected in the output color swatch.

Green The system matches based on only the value of the Green color channel of the color 
selected in the output color swatch.

Blue The system matches based on only the value of the Blue color channel of the color 
selected in the output color swatch.

R + G The system matches based on the values of the Red and Green color channels of the 
color selected in the output color swatch.

R + B The system matches based on the values of the Red and Blue color channels of the 
color selected in the output color swatch.

G + B The system matches based on the values of the Green and Blue color channels of the 
color selected in the output color swatch.

NaturalMatch Select NaturalMatch to select or deselect the NaturalMatch feature.

When this command is selected, all the match types in the Curves and Secondary 
groups use NaturalMatch when making a correction and match types appear in the 
Color Match control with the extension (Nat). For more information on NaturalMatch, 
see “Understanding NaturalMatch” on page 197.
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Secondary Tab Match Type Options

The following table describes the Match Type options for the Secondary tab.

Understanding NaturalMatch

In many situations when you are correcting on a shot-to-shot basis, color matching is 
complicated by differences in lighting between one shot and another. For example, you 
might want to match the skin tone in Shot A, which is in shadow, with that in Shot B, which 
is brightly lit. To achieve a natural-looking correction, you need to replace the hue of Shot A 
while preserving luminance and saturation characteristics that suggest shadow.

NaturalMatch solves this problem by making calculations that compensate for the luminance 
and saturation qualities of the original image when making the correction. The correction 
that is made when you use NaturalMatch adopts the new hue value, preserves the original 
luminance value, and adjusts the saturation value in relation to the other values. 
NaturalMatch allows you to use the quick correction method offered by the Color Match 
control even when images show significant differences in lighting.

Color Match Example Using NaturalMatch

The following illustrations show an example of the use of the Color Match control and the 
NaturalMatch feature to correct color from shot to shot.

n If you are reading a black-and-white hardcopy version of this document, you will find it 
useful to view the color images in the online version of the document available from the 
Online Library for your Avid editing application (Help > Online Library).

Option Description

Hue The system matches based on only the hue of the color selected in the output color 
swatch.

Saturation The system matches based on only the saturation of the color selected in the output 
color swatch.

H + S The system matches based on both the hue and the saturation of the color selected in 
the output color swatch.

NaturalMatch Select NaturalMatch to select or deselect the NaturalMatch feature.

When this command is selected, all the match types in the Curves and Secondary 
groups use NaturalMatch when making a correction and match types appear in the 
Color Match control with the extension (Nat). For more information on NaturalMatch, 
see “Understanding NaturalMatch” on page 197.
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This original image is very gray and shows poor skin 
tones. The RGB values for a point in the center of the 
man’s forehead are R:61, G:62, B:66 — an almost 
completely neutral gray.

Uncorrected Image

Though this image would benefit from further correction 
(particularly to improve the contrast ratio), it is improved 
dramatically as a result of the color match. The skin tones 
and the color of the tent in the background now match the 
reference image well.

Corrected Image

This image shows much better color characteristics, 
including good skin tones and a better color for the canvas 
of the tent. If we want to present these two shots next to 
one another in a sequence, we will almost certainly want to 
make their color characteristics match better. One way to 
do this is with the Color Match control. If we use the center 
of the forehead in the first image as an input value and the 
center of the forehead in this reference image (R:110, G:70, 
B:56) as an output value, and then make a Color Match 
using NaturalMatch to automatically generate Curves 
adjustments for all three color channels, we can quickly 
match the skin tones in the weak image to those in the 
better one.

Reference Image
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Saving Custom Colors to a Bin

You can save a color that you have selected in the Color Match control as an item in a bin. 
For example, you might want to save a skin tone that you want to match throughout your 
sequence. You can then load that color back into the Color Match control whenever you need 
to make a match based on that color.

To save a color to a bin:

1. In the Color Match control, Alt+click (Windows) or Option+click (Macintosh) the 
swatch that contains the color you want to save, and drag the rectangular outline to a 
bin.

While you drag, the pointer changes to a hand, and a rectangular outline appears.

The color appears in the bin as a rectangular color icon. The system assigns the color a 
name based on the current Saved Color Labels settings in the Correction Mode Settings 
dialog box. For more information, see “Customizing Color Correction Mode Settings” 
on page 165.

2. (Option) If you want to rename the custom color, click the existing name in the bin and 
type a new name.

To load a custom color into the Color Match control:

t Click the color icon in the bin, and drag it to the appropriate color swatch in the Color 
Match control.

Getting RGB Information Using the Color Match Control

By default, the color swatches in the Color Match control display the RGB values for the 
selected color. This makes the Color Match control useful as an information palette to check 
the exact RGB value of a sample area in your image.

For example, if you have an area in your image that you know should appear white, you can 
sample that area using the Color Match eyedropper and check how far its RGB values depart 
from a true white. If the values are R:231, G:217, B:229, then you know that a little green 
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needs to be added to achieve white. (In other words, the image has a magenta cast.) If you 
want this area in the image to be exactly reference white (R,G,B:235), you know that you 
also need to adjust the white point slightly to increase the RGB values.

The HSL (Hue, Saturation, Luminance) Group
The HSL (Hue, Saturation, Luminance) group provides controls that allow you to alter 
attributes such as hue, saturation, gain, and gamma. These controls resemble the color 
adjustment controls found in the Video Input tool and in the Color Effect.

The HSL group also allows you to specify an offset for the hue of an image, a control that is 
especially useful for correcting a color cast. For example, when an object in an image that 
should be a neutral gray appears tinged with a color, you can use the offset adjustment to 
restore the correct gray color.

The HSL group provides additional control by allowing you to make adjustments in three 
different luminance ranges — highlights, midtones, and shadows. You can define the exact 
scope of each of these ranges and get visual confirmation of which parts of an image fall in 
each range. Having control over different luminance ranges is useful in a number of 
situations. For example, video images often contain chroma noise in the brightest and 
darkest areas. Using the HSL controls for the highlight and shadow ranges, you can make 
adjustments to reduce the noise without affecting the midtones in the image.

You can invert both the chrominance and luminance values in an image with a single click. 
You can also set clipping values for both the High and Low ends of the luminance range.

The HSL controls are capable of correcting a wide range of problems. If you are comfortable 
working with the HSL group and gain some experience using it, you might be able to make 
most of your common corrections without needing to employ any other group. For some 
kinds of adjustments, however, you might find the blending properties or the individual color 
channel control of other groups more suitable.

Making Corrections Using the Controls Tab in the HSL Group

The Controls tab of the HSL group includes sliders for making adjustments to hue, 
saturation, and luminance values. It also includes the Color Match control for making hue, 
saturation, and luminance adjustments automatically, based on selected input and output 
color values. For information on the Color Match control, see “Using the Color Match 
Control” on page 191.
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The following illustration shows the Controls tab.

To make a color correction using the Controls tab:

1. If you have not already done so:

a. Move the position indicator to the segment you want to correct.

b. Click the Correction Type button and select a correction type.

c. Click the HSL tab.

n For more information on correction types, see “Selecting Correction Types” in the Help.

2. Click the Controls subdividing tab in the first vertical group on the left side of the Color 
Correction tool.

3. Click the appropriate subdividing tab in the second vertical group on the left side of the 
Color Correction tool.

This tab selection determines the brightness range across which your adjustments will 
apply. The following table describes the available options.

n By default, highlight, midtone, and shadow ranges represent equal one-third subdivisions of 
the full brightness range. You can customize these ranges using the controls in the Luma 
Ranges tab. For more information, see “Understanding the Luma Ranges Tab” on page 211.

Tab Description

Master Adjustments apply to the whole image.

Highlights Adjustments apply to the brightest parts of the image only.

Midtones Adjustments apply to the midrange of brightness values only.

Shadows Adjustments apply to the darkest parts of the image only.
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4. Make your adjustments by doing one of the following:

t Adjust one or more of the individual sliders or buttons. For more information, see 
“Using the Sliders in the HSL Group” on page 202 and “Controls Tab Controls” on 
page 203.

t Use the Color Match control to make a correction by selecting input and output 
colors. For more information, see “Using the Color Match Control” on page 191.

Using the Sliders in the HSL Group

The following illustration shows the Hue slider.

To adjust the HSL sliders, do one of the following:

t Type a value in the text box, and then press Enter (Windows) or Return (Macintosh).

t Drag the slider.

t Click one of the direction buttons to change the value in small increments.

t Click and hold one of the direction buttons to change the value quickly over a large 
range.

n You can “nudge” the numerical value of a control up or down by small increments. To do 
this, click in the text box, and then press the Up Arrow key to increase the value or the Down 
Arrow key to decrease the value.

You can also use the mouse scroll wheel to change values in the Color Correction tool. Click 
a slider or click in a value text box, then press the Ctrl key and use the scroll wheel to change 
the value in small increments, or press the Ctrl and Shift keys (or the Ctrl and Alt keys) and 
use the scroll wheel to change the value in increments of -10 or +10.

Each slider has an Enable button that you can click to turn that slider on or off or 
Alt+click (Windows) or Option+click (Macintosh) to reset the slider to its default value. 
For more information, see “Working with the Enable Buttons” on page 162.

Text box

Enable 
button

Direction buttons

Slider
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Controls Tab Controls

The following table describes the individual controls available in the Controls tab of the 
HSL tab.

Control Description

Invert Chroma 
(Master subdividing 
tab only)

Replaces the color value of every pixel in the image with the opposite color value on 
the color wheel. This is the equivalent of setting the Hue control to 180 or –180.

Hue Shifts the hues in the image around the color wheel. Values range from –180 to 180, 
where 0 is the default and causes no change in the image. When applied in the Master 
subdividing tab, a value of 120 shifts red to blue, and a value of –120 shifts red to 
green.

Saturation Specifies the amount or intensity of color. Values range from 0 to 200, where 100 
represents no change to the image, 0 represents complete desaturation (monochrome 
image), and 200 represents maximum saturation.

n The Master subdividing tab Saturation slider is also available as the Master 
Saturation slider in the Curves tab. Adjusting the Master Saturation slider in 
the Curves tab enables the HSL > Controls > Master tab hierarchy.

Brightness Adjusts the luminance of the image by shifting the luminance value of every pixel by 
the value set in the control. Values range from –100 to 100, where –100 subtracts 100 
from the 8-bit luminance value of every pixel and 100 adds 100 to the 8-bit luminance 
value of every pixel.

The effect of the Brightness control is very similar to that of the Setup control. One 
important difference, however, is that the Brightness control interacts with the 
Contrast control, while the Setup control interacts with the Gain and Gamma controls. 
If you have made a Contrast adjustment, it is better to adjust luminance further using 
the Brightness slider. If you have made an adjustment using the Gain or Gamma 
controls, it is better to adjust luminance further using the Setup control.

Contrast Increases or decreases the amount of contrast in the image. Values range from –100 to 
100, where –100 represents no contrast (all pixels mapped to neutral gray) and 100 
represents maximum contrast.

Invert Luma 
(Master subdividing 
tab only)

Reverses the brightness level of every pixel in the image. Dark areas become light, and 
light areas become dark.
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Understanding the Hue Offsets Tab

The Hue Offsets tab of the HSL group includes controls for adjusting hue and saturation 
values at the same time using ChromaWheel color wheels and linked text boxes. These 
controls are especially well-suited for correcting color casts in images. 

n Since the ChromaWheels provide a control similar to the physical controllers on traditional 
color correction equipment, experienced colorists might choose to use them as their 
preferred controls for many color adjustments.

Gain Adjusts the gain or white point for the image. Values range from 0 to 200, where 100 
represents the unchanged image.

The main difference between Brightness and Gain is that Brightness adjusts by adding 
to the 8-bit luminance value of every pixel, while Gain makes an adjustment based on 
a percentage of the original luminance.

Gamma Adjusts the midpoint of the luminance range. Values range from 0.1 to 10, where 1 
represents the unchanged image. Lowering the value darkens the midtones and brings 
the image closer to black. Raising the value lightens the midtones and brings the 
image closer to white.

Setup Adjusts the setup or black point for the image. Values range from –255 to 255, where 
0 represents the unchanged image.

The effect of the Setup control is very similar to that of the Brightness control. One 
important difference, however, is that the Setup control interacts with the Gain and 
Gamma controls, while the Brightness control interacts with the Contrast control. If 
you have made an adjustment using the Gain or Gamma controls, it is better to adjust 
luminance further using the Setup control. If you have made a Contrast adjustment, it 
is better to adjust luminance further using the Brightness slider.

n The Master subdividing tab Gain, Gamma, and Setup sliders are also available 
in the Curves tab as the Master Gain, Master Gamma, and Master Setup 
sliders. Adjusting any of these sliders in the Curves tab enables the HSL tab, 
the Controls subdividing tab, and the Master brightness subdividing tab.

Clip Low Sets the Low clip for the image. All pixels with the Low clip value or less are clipped 
to black. The default setting is 16 on an 8-bit scale, representing the normal broadcast 
value for black.

Clip High Sets the High clip for the image. All pixels with the High clip value or more are 
clipped to white. The default setting is 235 on an 8-bit scale, representing the normal 
broadcast value for white.

Control Description
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You can also use the Color Match control to automatically make a hue offset adjustment 
based on input and output colors. For information on the Color Match control, see “Using 
the Color Match Control” on page 191.

The following illustration shows the Hue Offsets tab.

Understanding ChromaWheel Color Wheels

The Hue Offsets tab includes four ChromaWheel color wheels that allow you to make 
adjustments across the same luminance ranges as the Controls tab. The wheels are arranged 
in the following order from left to right: Shadows, Midtones, Highlights, and Master.

ChromaWheel Displays

By default, each Chroma Wheel displays as a graphical outline that resembles the design of 
the Vectorscope monitor in the Video Input tool. Colors are oriented in the same manner as 
in the Vectorscope monitor, with red near the top. Axes indicate the offset in degrees from 
the 0° point, which corresponds with red.

You can display color backgrounds in the ChromaWheels that help you to understand the 
effect of an adjustment as you work. For more information, see “Customizing Color 
Correction Mode Settings” in the Help.

n The Hue Offsets color wheels are designed to create a familiar environment for users by 
duplicating the general appearance of the Vectorscope monitor. They are not calibrated in 
the same way as in the Vectorscope monitor.

Color Match controlShadows 
ChromaWheel

Midtones 
ChromaWheel

Highlights 
ChromaWheel

Master 
ChromaWheel
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Each wheel contains a crosshair pointer that identifies the currently selected point on the 
wheel. Each pointer has a distinctive appearance to help you distinguish them from one 
another. The following table shows the four pointers.

How ChromaWheels Work

The ChromaWheel color wheel is a circular graph that represents hue and saturation values. 
Hue values are mapped around the circumference of the wheel, with colors in the same 
positions that they occupy on a vectorscope. Red is at the 0° point on the wheel, and cyan is 
at the 180° point.

As you move around the wheel counterclockwise from red to cyan, you move through 
positive degree values. For example, green is at +120°. As you move around the wheel 
clockwise from red to cyan, you move through negative degree values. For example, blue is 
at –120°

Saturation values are mapped along the radius of the wheel. The center point of the wheel 
represents zero saturation (neutral gray); the edge of the wheel represents maximum 
saturation. As you move out from the center of the wheel, you shift from less to more 
saturation. Saturation values are measured on a scale from 0 (zero saturation) to 100 
(maximum saturation). 

By picking a specific point on the wheel, you select an exact combination of hue and color 
intensity to add to your image. You can select a gray with a slight yellow tinge near the 
center of the wheel, for example, or an intensely saturated blue at the outer edge.

Color Wheel Pointer

Shadows

Midtones

Highlights

Master
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n If you are reading a black-and-white hardcopy version of this document, you will find it 
useful to view the color images in the online version of the document available from the 
Online Library for your Avid editing application (Help > Online Library).

When you use ChromaWheels to correct a color cast, you use a basic principle of color 
theory: you can cancel out one color in an image by adding an equal amount of the opposite 
color on the wheel. For example, to remove a red cast, add some cyan. To remove a yellow 
cast, add some blue. You do not even need to remember which colors are opposite when you 
have the color wheel as a control. Simply add some color from the opposite side of the wheel 
from the color you want to remove, and then fine-tune your adjustment until you are 
satisfied with the result.

Making Corrections Using the Hue Offsets Tab

To make a correction using the Hue Offsets tab:

1. If you have not already done so:

a. Move the position indicator to the segment you want to correct.

b. Click the Correction Type button and select a correction type.

c. Click the HSL tab.

n For more information on correction types, see “Working with Correction Types” in the Help.

2. Click the Hue Offsets subdividing tab in the first vertical group on the left side of the 
Color Correction tool.

Saturation increases 
from the center of 
the wheel toward 
the edge.

Hue changes as 
you move around 
the wheel.

The graphical outline shows the 
degree values for measuring hue.
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3. Make your adjustments by doing one or more of the following:

t Click one of the automatic color correction buttons, or use one of the Remove Color 
Cast buttons, to adjust one or more of the ChromaWheel color wheels 
automatically. For more information, see “Correcting Color Automatically in the 
Hue Offsets Tab” in the Help and “Using the Remove Color Cast Buttons” on 
page 189.

t Drag the crosshair pointer on the appropriate ChromaWheel color wheel.

As you move the pointer in the wheel, the Hue and Amt (Amount) text boxes update 
to display numerical values for the adjustment.

n For more precise control over the movement of the crosshair pointer in the central area of 
the wheel, press and hold the Shift key while dragging the pointer.

t Type values in the Hue and Amt text boxes for the appropriate ChromaWheel color 
wheel to set the offset you want. You must press Enter (Windows) or Return 
(Macintosh) after typing a value for it to take effect.

Hue values range from –180 degrees to 180 degrees where 0 degrees is the position 
of red on the wheel. Amount values range from 0 to 100. When you change the Hue 
and Amount values, the pointer on the color wheel updates to represent the 
adjustment.

n You can “nudge” the numerical value of a control up or down by small increments. To do 
this, click in the text box, and then press the Up Arrow key to increase the value or the Down 
Arrow key to decrease the value.

You can also use the mouse scroll wheel to change values in the Color Correction tool. Click 
a slider or click in a value text box, then press the Ctrl key and use the scroll wheel to change 
the value in small increments, or press the Ctrl and Shift keys (or the Ctrl and Alt keys) and 
use the scroll wheel to change the value in increments of -10 or +10.

t Use the Color Match control to calculate an offset automatically, based on input and 
output colors. For more information, see “Using the Color Match Control” on 
page 191.

4. Fine-tune your adjustments until you are satisfied with the result.

Remember that you can make adjustments on more than one color wheel and turn them 
on and off individually to assess their effect on the image.
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Examples of Hue Offsets Settings

The following illustrations help you to understand the Hue Offsets controls by showing the 
effect on an image of several simple adjustments made in the Master Hue Offsets 
ChromaWheel color wheel.

The Master wheel is used in these examples because it operates across the entire luminance 
range and alters the image in ways that are easy to see and understand. You have more 
precise control of corrections if you use the Shadows, Midtones, and Highlights wheels to 
make adjustments in specific luminance ranges.

n If you are reading a black-and-white hardcopy version of this document, you will find it 
useful to view the color images in the online version of the document available from the 
Online Library for your Avid editing application (Help > Online Library).

This original image has a yellow cast. The swatch to the left, which shows the sample RGB 
values for an area of the ladder, indicates that there is relatively less blue than red or green in 
the grays of the image. You might not need to change this coloring, but you might want to 
restore the metal objects in the image to a more neutral gray or even to change the look and 
mood of the image by creating a different cast. One way to do this easily is using the Hue 
Offsets ChromaWheel color wheels.

Original Image
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Adjustment 1 alters the original image by introducing just enough blue to make the grays in 
the image neutral. The RGB values in the ladder now show almost equal amounts of red, 
green, and blue. The yellow cast is corrected by moving the crosshair pointer in the 
ChromaWheel color wheel in the opposite direction from yellow.

Adjustment 2 increases the intensity of the blue that is being added to the original image. 
Metal objects in the image are now distinctly blue-gray, and the sample values from the 
ladder show more blue than red or green.

Adjustment 1

Adjustment 2
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Adjustment 3 adds a large amount of blue to the original image. The metal objects now look 
very blue, and the grain elevators are so saturated in blue that they have lost a lot of detail. 
Though you might be unlikely to make such an extreme adjustment except as part of a 
deliberately unrealistic look, it demonstrates how much an image can be changed with a 
single adjustment of a Hue Offsets ChromaWheel color wheel.

Understanding the Luma Ranges Tab

The Luma Ranges tab allows you to view and customize the luminance ranges that you are 
using to define the highlights, midtones, and shadows in other parts of the HSL group. You 
make these adjustments on a Luma Ranges graph.

You can view your images in three different ways while you are working in the Luma 
Ranges tab. You can view the uncorrected image, the image with all active corrections 
applied, or a three-tone preview that uses white, gray, and black to indicate the three 
luminance ranges.

You might use the Luma Ranges tab as a tool to adjust the three luminance ranges before 
you make other HSL adjustments. Alternatively, you might make HSL adjustments that 
affect the different ranges and then use the Luma Ranges tab to fine-tune the brightness 
ranges to which those adjustments apply. For example, you can make an adjustment that you 
like in the Highlights wheel of the Hue Offsets tab and then fine-tune the range of pixels to 
which that adjustment applies using the Luma Ranges tab.

Adjustment 3
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The following illustration shows the Luma Ranges tab with the Highlights subdividing 
tab displayed.

Understanding the Luma Ranges Graph

The Luma Ranges graph shows curves for each of the three luminance ranges: highlights, 
midtones, and shadows. You can always see all three curves, but you can make adjustments 
only to the curve that is active as defined by your subdividing tab.

The graph plots brightness values from 0 to 255 on the horizontal axis and percentage values 
on the vertical axis. The system defines a luminance range as the area in the graph where the 
curve for that range is highest in the graph. The following illustration shows this 
arrangement for the default curves.

Preview buttons

Text boxes

Luma Ranges graph

Shadows Midtones Highlights
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When you adjust a curve, you move a control point on the curve up or down on the graph. 
This results in more or less of the curve being highest in the graph, which enlarges or 
reduces the luminance range for that curve. 

For example, if you raise the highlights curve near the center of the graph and drop the 
midtones curve in the same area, you expand the highlights range toward the middle of the 
full luminance range and contract the midtones range into a smaller area. The following 
illustration shows this adjustment.

To fine-tune luma range adjustments, you should understand the role of all three curves in 
defining exactly how the system treats each level of brightness. At any point on the 
brightness scale (the horizontal axis of the graph), percentage values are plotted for all three 
ranges — shadows, midtones, and highlights. Though a luminance range is broadly defined 
by which curve is highest in the graph, each brightness level is affected more precisely by all 
three ranges in the relative percentage amounts shown on the graph. 

For example, in the default Luma Ranges settings, brightness level 175 is defined as 50% 
highlight, 50% midtone, and 0% shadow. Brightness level 215 is defined as 95% highlight, 
5% midtone, and 0% shadow. If you have made adjustments to the highlights luminance 
range elsewhere in the HSL tab, those adjustments are dominant in controlling pixels of 
brightness 215 but share control of pixels of brightness 175 equally with the midtones 
adjustments.

With some practice, you will find that you can control the relative impact of your 
adjustments in different luminance ranges very precisely.

Expanded highlights rangeReduced midtones range
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Adjusting Luminance Ranges

To adjust luminance ranges:

1. If you have not already done so:

a. Move the position indicator to the segment you want to correct.

b. Click the Correction Type button and select a correction type.

c. Click the HSL tab.

n For more information on correction types, see “Working with Correction Types” in the Help.

2. Click the Luma Ranges tab in the first vertical group of subdividing tabs on the left side 
of the Color Correction tool.

3. Click one of the following tabs in the second vertical group of subdividing tabs on the 
left side of the Color Correction tool:

- Highlights: Displays the Luma Ranges graph with the highlights curve available for 
editing

- Midtones: Displays the Luma Ranges graph with the midtones curve available for 
editing

- Shadows: Displays the Luma Ranges graph with the shadows curve available for 
editing

4. Select one of the following options to control how your image displays in the active 
monitor:

- Input: Displays the uncorrected image in normal color

- Three-tone: Displays the uncorrected image using white, gray, and black to 
represent the highlights, midtones, and shadows luminance ranges

- Output: Displays the image in normal color with all active corrections applied

You can switch back and forth freely between these settings as you work to assess your 
adjustments.

5. Adjust the active curve by adding and adjusting control points using the procedures in 
“Manipulating Luminance Range Curves” on page 215.
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Manipulating Luminance Range Curves

To add a control point to a curve:

t Click the curve at the point where you want to move it.

A new control point appears with a circle around it to indicate that it is the active point.

To move a control point:

1. Click the control point to activate it.

A circle appears around the control point.

2. Do one of the following:

t Click the point on the graph, and drag it until the curve is in the position you want.

t Type values in the In and Out text boxes to define the position of the point on the 
graph. You must press Enter (Windows) or Return (Macintosh) after typing a value 
for it to take effect.

n You can “nudge” the numerical value of a control up or down by small increments. To do 
this, click in the text box, and then press the Up Arrow key to increase the value or the Down 
Arrow key to decrease the value.

You can also use the mouse scroll wheel to change values in the Color Correction tool. Click 
a slider or click in a value text box, then press the Ctrl key and use the scroll wheel to change 
the value in small increments, or press the Ctrl and Shift keys (or the Ctrl and Alt keys) and 
use the scroll wheel to change the value in increments of -10 or +10.

To delete a control point:

t Click the point to activate it, and then press the Delete key.

Examples of Three-Tone Previews

The following illustrations show sample three-tone previews for a typical video image and 
for a test monochrome gradient.

n If you are reading a black-and-white hardcopy version of this document, you will find it 
useful to view the color images in the online version of the document available from the 
Online Library for your Avid editing application (Help > Online Library).
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Monochrome gradient (Imported PICT graphic) Video image

Original images

Three-tone preview using 
default luma range settings

Three-tone preview with expanded 
midtones range. The midtones 
range now includes more of areas 
such as the sign in the window and 
the drape beside it.

Expanded midtones range

Luma Ranges graph used 
to create the expanded 
midtones range shown in 
the images immediately 
above
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The Channels Group
The Channels group provides controls that allow you to redefine each output color channel 
(red, green, blue) by blending different input color components in various proportions. 

You can work with components from both the RGB (red, green, blue) and the YCbCr 
(luminance, red chroma, blue chroma) color spaces. Because you can blend up to four input 
components to create each output color channel, the Channels group offers very precise 
control over the final composition of each color channel.

The Channels group also enables you to preview the individual color channels in 
monochrome. This is useful for checking the amount of contrast or noise in each channel.

The Channels group is particularly useful for identifying a color channel that is deficient in 
some way — one that is lacking in contrast or is noisy, for example — and repairing it by 
“borrowing” from another color channel. For some kinds of images, borrowing in this way is 
the only way to improve the appearance of the image significantly.

For example, you might preview the input channels for a segment and notice that, although 
the master input shows acceptable overall contrast, the green channel is clipped to white and 
has therefore lost contrast in the highlight range. It is not possible to “unclip” these green 
highlights by working in the existing green channel, since the brightness value of all the 
pixels in the highlight range is the same (or very nearly so). The best solution to this problem 
is to blend a percentage of one of the other channels into the green channel to reintroduce 
some contrast and detail. You might redefine the green channel as 80% green and 20% red to 
solve the problem.

As in other groups, you can use the Color Match control to set the blending controls 
automatically, based on selected input and output colors. For information on the Color 
Match control, see “Using the Color Match Control” on page 191.

The following illustration shows the Channels tab in its default configuration.
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Making Corrections Using the Channels Tab

To make corrections using the Channels tab:

1. If you have not already done so:

a. Move the position indicator to the segment you want to correct.

b. Click the Correction Type button and select a correction type.

c. Click the Channels tab.

n For more information on correction types, see “Working with Correction Types” in the Help.

2. Preview the input image by selecting an input type in the Preview pane:

- Red Input: Displays the uncorrected red channel in monochrome

- Green Input: Displays the uncorrected green channel in monochrome

- Blue Input: Displays the uncorrected blue channel in monochrome

- Master Input: Displays the complete uncorrected image in color

For more information on previewing options, see “Considerations When Working with 
Color Components” on page 220.

3. Adjust the blend for each channel in the Channel Blending pane.

For more information on using the Channel Blending pane, see “Using the Channel 
Blending Pane” on page 219.

4. Preview the output image by selecting an output type in the Preview pane:

- Red Output: Displays the red channel in monochrome with the Channel Blending 
pane adjustments applied

- Green Output: Displays the green channel in monochrome with the Channel 
Blending pane adjustments applied

- Blue Output: Displays the blue channel in monochrome with the Channel Blending 
pane adjustments applied

- Master Output: Displays the complete image in color with the Channel Blending 
pane adjustments applied

5. Repeat steps 2 through 4 as necessary until you are satisfied with the result.

Remember that you can switch between Preview options freely at any time and that you 
can use the Enable buttons to turn each channel blending formula on and off or to reset it 
to its default values.
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Using the Channel Blending Pane

The Channel Blending pane includes text boxes and buttons for each of the three RGB color 
channels. Use these controls in combination to blend components and to create a formula for 
the corrected color channel.

In its default configuration, the pane shows only one component for each channel. Each 
component is represented by a text box that defines the percentage of the component that is 
in the channel and a button that allows you to select the component type. You can add up to 
three more components for a total of four.

To select a component type:

t Click the Component Type button, and select a type from the menu.

For information on the available options, see “Component Type Options in the Channels 
Tab” on page 220.

To adjust the amount of a component in the blend:

t Type a value in the text box for the component, and then press Enter (Windows) or 
Return (Macintosh). Values can range from –200% to 200%.

n You can “nudge” the numerical value of a control up or down by small increments. To do 
this, click in the text box, and then press the Up Arrow key to increase the value or the Down 
Arrow key to decrease the value.

You can also use the mouse scroll wheel to change values in the Color Correction tool. Click 
a slider or click in a value text box, then press the Ctrl key and use the scroll wheel to change 
the value in small increments, or press the Ctrl and Shift keys (or the Ctrl and Alt keys) and 
use the scroll wheel to change the value in increments of -10 or +10.

To add a new component to the formula for a channel:

t Click the “more” button to the right of the existing components.

The “more” button changes to a plus (+) button, and a new set of component controls 
appears to the right of the button.

To remove components from the formula:

t Click the plus (+) button to the left of the components you want to remove.

The system removes all components to the right of the plus (+) button you click.

Channel text box

Component Type button
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Component Type Options in the Channels Tab

The following table describes the component type options available in the Channels tab of 
the Color Correction tool.

Considerations When Working with Color Components

When you find that one of your color channels has a problem that you want to correct by 
blending, you need to look for another color component that can correct the problem while 
minimizing any unwanted changes. In general, you should look for a component that 
exhibits less of the specific problem you want to correct but that otherwise looks similar to 
the problem channel.

You do not have to restrict your component choices to the same color space (RGB or 
YCbCr). In fact, it is common practice when performing advanced color correction to 
borrow from a different color space. For example, if you have a green channel that is noisy 
in the highlight range, you might find that the Cb (blue chroma) component has less 
highlight noise but is otherwise similar in its brightness distribution to the green channel. 
Blending a percentage of Cb into the green channel reduces the noise without greatly 
disturbing other aspects of the channel.

Option Description

Red The input red channel.

Green The input green channel.

Blue The input blue channel.

Luma The luminance channel in the component video signal.

Cr The red chroma channel in the component video signal.

Cb The blue chroma channel in the component video signal.

Offset A constant value that adjusts all the other values in the formula.

Invert This option subtracts the component from the overall formula instead of adding it. 
Select one of the other options, and then select Invert to invert it. A minus sign (–) 
appears after the component name when it is inverted. This has the same effect as 
entering a negative value for a component: 20% Green – is the same as 
–20% Green.
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You can preview the full range of color components available by temporarily redefining one 
of the existing channels. For example, if you want to see what the Cb component looks like 
in comparison to your problem green channel, you can redefine the red channel as 100% Cb. 
Then you can switch back and forth between the Red Input and Green Input previews to 
compare the two.

n The total of the percentages you set for a channel does not need to be 100. The percentage 
values simply indicate relative proportions of one component as opposed to others.

Examples of Channel Blending Settings

The following illustrations show two representative Channel Blending settings for the red 
channel.

The following detailed example shows how an individual channel is altered by blending. 

n If you are reading a black-and-white hardcopy version of this document, you will find it 
useful to view the color images in the online version of the document available from the 
Online Library for your Avid editing application (Help > Online Library).

The Blue Input monochrome preview shows that the blue channel lacks contrast. Blending 
25% of the green channel information into the blue channel (as shown in the illustration of 
the controls) introduces somewhat more contrast into the blue channel. 

The effect on the Master image in this case is not dramatic; this might or might not be 
desirable, depending on your project needs. A little extra detail has been obtained in the 
lower half of the image, but the color characteristics have changed so that the image is less 
intensely yellow. This probably improves the look of the sky; however, it reduces the 
strength of the yellow color in the sunflowers.
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The Levels Group
The Levels group allows you to control the relative brightness or darkness of an image by 
defining the white point, gray point, and black point of video material.

You can do this for the master channel (red, green, and blue combined) or for each of the 
color channels. You can also control the white and black points only for the luminance range 
and for the composite signal to ensure your sequence is within legal limits. If you make 
adjustments in the master channel and in one or more of the other channels, the final output 
is the cumulative result of all the adjustments.

Blue Input preview Blue Output preview

Master Input preview Master Output preview
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There are four ways to define the white, gray, and black points. You can type numerical 
values, adjust sliders on a histogram control, move control points on a ChromaCurve graph, 
or use the Color Match control to set points automatically, based on selected input and 
output colors. For information on the Color Match control, see “Using the Color Match 
Control” on page 191.

The main use of the Levels group is to rebalance the color or luma range. The group 
provides a great deal of control over the amount of contrast and detail visible in the video 
image, especially since you can make adjustments on the individual color channels. The 
Levels group is, therefore, a more refined and specialized version of the Gain, Gamma, and 
Setup controls in the HSL tab.

You might want to extend the range of contrast and detail in an image that lacks a full range 
(either in one color channel or across all the color channels), or you might want to 
deliberately reduce detail in part of the range (perhaps to expand another part of the range 
that is more important in the image). You might also want to adjust the gray point with 
respect to the black and white points in order to rebalance the midtones without significantly 
affecting the highlights and shadows.

It is important to understand the difference between a circumstance in which detail can be 
enhanced with the Levels group and one in which a blending adjustment in the Channels 
group is more useful. If a channel (for example, green) is clipped to white, then it does not 
contain enough information to contribute much detail; it must be repaired by borrowing 
contrast from another color component in the manner described in “The Channels Group” on 
page 217. If, however, the green channel contains an acceptable range of tones but they are 
shifted toward the highlight end of the brightness range, resetting the black point in the 
Levels group improves contrast and detail by spreading the available information over a 
bigger range.

The following illustration shows the Levels tab in its default configuration.

Subdividing 
tabs

Input histogram

Input text boxes Curve graph

Output histogram

Color Match control
Output text boxes
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Understanding Input and Output Levels Adjustments

When you make an adjustment in the Levels tab, you are changing the relationship between 
input and output values for your image. You can make adjustments on both the input and the 
output side, and understanding the differences between input and output adjustments is 
important.

Examples of Black Point Input and Output Adjustments

A typical default setup for the Levels tab shows the following values on both the input and 
the output side:

The black point and white point values represent normal, safe limits for video broadcast.

If you make an adjustment on the input side, you change the range of input values being 
mapped to the same range of output values. For example, if you move the black point up to 
60, you instruct the system to map all values of 60 or less to the output value of 16. As a 
result, input values between 60 and 235 are now mapped to the full output range of 16 to 235 
(176 input steps on the 8-bit scale are mapped to 220 output steps on the 8-bit scale). You 
have clipped some black values, but you have also spread the remaining input values over a 
greater range. Depending on the exact nature of the image, this will probably result in some 
degree of improvement in contrast and detail. 

The input and output values for this adjustment are as follows:

Black Point Gray Point White Point

16 128 235

Black Point Gray Point White Point

Input 60 128 235

Output 16 128 235
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The following illustrations show the effect of this adjustment for a monochrome gradient 
and a video image.

n If you are reading a black-and-white hardcopy version of this document, you will find it 
useful to view the color images in the online version of the document available from the 
Online Library for your Avid editing application (Help > Online Library).

If you make an adjustment on the output side, you change the total range of output steps 
available. For example, if you leave the input points unchanged and change the output black 
point to 60, you are deliberately reducing the range of values in the image (220 input steps 
are mapped to only 176 output values). The input and output values for this adjustment are 
as follows:

Unadjusted images Adjusted images

Black Point Gray Point White Point

Input 16 128 235

Output 60 128 235
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The following illustrations show the effect of this adjustment for a monochrome gradient 
and a video image.

Examples of Gray Point Input and Output Adjustments

Gray point adjustments work in a similar way to black and white point adjustments except 
that output gray point changes will not change the total output range. If you change the input 
gray point to 100 while keeping all other values at their default setting, you are instructing 
the system to map input values from 16 to 100 to output values from 16 to 128, and input 
values from 100 to 235 to output values from 128 to 235. This brightens the image 
somewhat. The input and output values for this adjustment are as follows:

Unadjusted images Adjusted images

Black Point Gray Point White Point

Input 16 100 235

Output 16 128 235
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The following illustrations show the effect of this adjustment for a monochrome gradient 
and a video image. In the adjusted monochrome gradient, the mid-gray value has moved 
toward the left.

n If you are reading a black-and-white hardcopy version of this document, you will find it 
useful to view the color images in the online version of the document available from the 
Online Library for your Avid editing application (Help > Online Library).

If, however, you change the output gray point to 100, you are essentially performing the 
opposite correction. Input values from 16 to 128 are mapped to output values from 16 to 
100. Input values from 128 to 235 are mapped to output values from 100 to 235. This has the 
effect of darkening the image somewhat. The input and output values for this adjustment are 
as follows:

Unadjusted images Adjusted images

Black Point Gray Point White Point

Input 16 128 235

Output 16 100 235
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The following illustrations show the effect of this adjustment for a monochrome gradient 
and a video image.

Making Corrections Using the Levels Tab

To make corrections using the Levels tab:

1. If you have not already done so:

a. Move the position indicator to the segment you want to correct.

b. Click the Correction Type button and select a correction type.

c. Click the Levels tab.

n For more information on correction types, see “Working with Correction Types” in the Help.

2. Click the appropriate subdividing tab on the left side of the Color Correction tool.

The subdividing tab selects the type of levels adjustment you want to make. The 
following options are available:

- Composite: Allows you to adjust high and low points for the composite signal to 
ensure that your sequence remains within legal composite limits

- Luma: Allows you to adjust levels based on luminance values only

Unadjusted images Adjusted images
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n Controls in the Composite and Luma tabs work slightly differently from those in the other 
Levels tabs. For more information on working with the Composite and Luma tabs, see 
“Working with the Composite and Luma Tabs in the Levels Tab” on page 234.

- Red: Allows you to adjust levels for the red channel only

- Green: Allows you to adjust levels for the green channel only

- Blue: Allows you to adjust levels for the blue channel only

- Master: Allows you to adjust levels for all three color channels

3. Make adjustments to the controls until you are satisfied with the result. 

For more information on the individual controls and how to use them, see 
“Understanding the Levels Tab Controls” on page 229.

Understanding the Levels Tab Controls

This topic provides detailed explanations of the different controls in the Levels tab.

The Levels controls are dynamically linked. When you make an adjustment to one of the 
controls, that adjustment is reflected in all other appropriate controls. For example, if you 
change the input black point value in the text box, the histogram slider and the control point 
for black on the ChromaCurve graph changes.

Understanding Histograms

A histogram is a graph of information about the color values of all the pixels in an image. 
Color values are plotted on the horizontal axis of the graph; the number of pixels is plotted 
on the vertical axis. For example, if an image contains 120 pixels of color value 30, then a 
bar 120 units high appears at the 30 point along the horizontal axis. A background grid 
indicates the quartile points on each axis to assist you when you are reading the graph and 
making adjustments.

Histograms provide an easily understood summary of the color range of an image. If an 
image is mostly dark, the bars of its histogram are concentrated at the low end. If an image 
contains only a small number of discrete color values, its histogram shows discrete spikes 
for each of those values. The following illustrations show several examples of histogram 
patterns.

n If you are reading a black-and-white hardcopy version of this document, you will find it 
useful to view the color images in the online version of the document available from the 
Online Library for your Avid editing application (Help > Online Library).
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This image has large areas that are very dark and a relatively 
even distribution of values in the rest of the brightness range. 
The histogram shows a sharp spike at the very low end, a 
concentration of values in the lowest 25% of the range, and a 
relatively even distribution in the rest of the range.

This image, like the last, has more dark values than light. But 
the distribution of values is less extreme, and this is reflected 
in the histogram, which shows a more rounded peak at the 
low end, fewer extremely low values, and relatively more 
midtone values.

This image has very large highlight areas in the background 
and on the chicks. Most of the rest of the image is relatively, 
but not extremely, dark. The histogram shows sharp spikes at 
the high end, relative concentration in the low to middle 
range, and few values in the middle to high range.

Example 3

Example 1

Example 2
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Understanding ChromaCurve Graphs

A ChromaCurve graph shows the relationship of input values (on the horizontal axis) to 
output values (on the vertical axis). The graph in the Levels tab has three control points for 
manipulating black, gray, and white points. A background grid indicates the quartile points 
on each axis to assist you when you are reading the graph and making adjustments.

The following illustration shows the Levels tab Curve graph.

The default curve that displays in the graph (before any adjustments have been made) is 
therefore an ascending 45 degree straight line, since input and output values are the same 
across the entire range. (In the previous illustration, the line of the graph is horizontal for the 
extreme low and high values because of standard video limiting. All input values of 16 and 
below are mapped to an output value of 16; all input values of 235 and above are mapped to 
an output value of 235.)

If you make an adjustment that moves part of the line below the 45 degree angle, you make 
the output values for that part of the image lower than the input values. If you make an 
adjustment that moves part of the line above the 45 degree angle, you make the output values 
for that part of the image higher than the input values.

If you make an extreme adjustment to a curve so that it becomes a horizontal line, you are 
converting all input values to the same output value.

Control point for white point

Control point for gray point

Control point for black point
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For example, in the following illustration, all input values are mapped to an output value of 
128. When this adjustment is made across all three color channels, the result is a uniform, 
mid-gray image.

When you make less extreme adjustments, the result is a true curve, since the graph updates 
by calculating a curve based on the values of the control points and their positions with 
respect to one another. For example, if you move the control point for gray, the white point 
and black point remain in the same positions. Intermediate values along the curve are 
calculated based on the relative position of the new gray point with respect to the white and 
black points. The following illustration shows this behavior for a typical gray point 
adjustment.

ChromaCurve graph for a typical gray point 
adjustment. Because of the exact position of the gray 
point, the curve is steeper near the black point and 
somewhat shallower near the white point. The 
adjustment therefore boosts values in the lower half 
somewhat more than in the upper half. One benefit of 
this is that values near the white point receive some 
adjustment but are not clipped to white.
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Using the Histogram Controls in the Levels Tab

To make adjustments to the histogram controls:

t Click the appropriate triangular slider below the histogram, and drag it to its new 
position.

The following illustration shows the Black Point, Gray Point, and White Point sliders.

For example, if you want to move the input black point toward gray, click the Black 
Point slider and move it to the right.

n When you make an adjustment to the input controls, the input histogram does not update. 
The input histogram always shows the distribution of values for the uncorrected image. The 
appropriate text box, the ChromaCurve graph, and the output histogram do update.

Using the Text Boxes in the Levels Tab

To set black, white, and gray points for both input and output:

t Type a numerical value in the appropriate text box, and then press Enter (Windows) or 
Return (Macintosh).

The following illustration shows the input text boxes.

Black Point slider Gray Point slider White Point slider
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For example, if you are working with 8-bit values and you type 50 in the In Black Point 
text box, you set the black point to 50 on a scale from 0 to 255.

n You can “nudge” the numerical value of a control up or down by small increments. To do 
this, click in the text box, and then press the Up Arrow key to increase the value or the Down 
Arrow key to decrease the value.

You can also use the mouse scroll wheel to change values in the Color Correction tool. Click 
a slider or click in a value text box, then press the Ctrl key and use the scroll wheel to change 
the value in small increments, or press the Ctrl and Shift keys (or the Ctrl and Alt keys) and 
use the scroll wheel to change the value in increments of -10 or +10.

Using the ChromaCurve Graph in the Levels Tab

You adjust the ChromaCurve graph in the Levels tab by clicking one or more of the three 
control points and dragging it to a new position.

To adjust a control point:

t Click a control point, and drag it to a new position.

When you click a control point, a circle appears around it to indicate that it is selected.

Working with the Composite and Luma Tabs in the Levels Tab

The Composite tab shows histograms that represent the levels in the composite image before 
and after correction. The Luma tab shows histograms that represent the luminance levels in 
the image before and after correction. They are useful for checking whether your 
color-corrected images are within the composite and luminance limits you need to meet and 
for adjusting levels to meet those limits, if necessary.

Black Point text box White Point text box

Gray Point text box
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The Composite tab can display unit information in either IRE units or millivolts, depending 
on which option you select in the Correction Mode Settings dialog box. The Luma tab can 
display unit information in a broader range of unit types. For more information, see 
“Customizing Color Correction Mode Settings” on page 165.

You can make only black point and white point adjustments in the Composite and Luma 
tabs. By adjusting these two points, if necessary, you can bring any values that exceed your 
composite or luminance limits back into an acceptable range.

The following illustration shows the controls for the Composite histogram and Curve graph.

You can use the Composite and Luma tabs together with the Safe Color feature to ensure 
that your images remain within limits. If you set the Safe Colors feature to warn you when 
composite and luminance limits are exceeded, parts of the image that exceed the limit appear 
orange in the histograms and you can use these warnings to guide your adjustments. For 
more information on safe colors, see “Safe Color Basics” in the Help and the chapter “Safe 
Colors.”

Examples of Levels Adjustments

The following illustrations show some common levels adjustments. In the first example, 
white, black, and gray points are all adjusted to create a small but significant change in the 
amount of contrast available in the image. In the second example, a gray point adjustment 
alone greatly increases the amount of detail that can be seen.

n If you are reading a black-and-white hardcopy version of this document, you will find it 
useful to view the color images in the online version of the document available from the 
Online Library for your Avid editing application (Help > Online Library).

Two control points in Curve graphBlack and white points only on histogram
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In this example, the intention is to enhance the contrast between the white building exterior 
and the black building interior toward which the car is driving. By changing the input black 
point to 19 and the input white point to 206, you increase the contrast range. These 
adjustments leave the entire image a little dark and lacking in detail, so a gray point 
adjustment is made to place more of the overall tonal range between gray and white. The 
final image shows strong contrast between the lightest and darkest areas and sharp highlights 
around the letters in the foreground.

Example 1

Unadjusted image Adjusted image
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In this example, the gray point adjustment substantially increases the proportion of the tonal 
range that lies between gray and white. As a result, detail is greatly enhanced in the image, 
revealing such details as the lettering on the wall at the extreme right.

The Curves Group
The Curves group allows you to control color by placing up to 16 control points on a 
ChromaCurve graph and then adjusting the points. 

As in the Levels tab, you can control the master channel or any individual color channel.

The ChromaCurve graphs in the Curves tab are similar to those in the Levels tab, except that 
they allow you to add up to 16 control points. With 16 control points, you can control color 
with great precision in the Curves tab since you can make detailed adjustments to many 
different subdivisions of the brightness range.

Example 2

Unadjusted image Adjusted image
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By default, ChromaCurves in the Curves tab display as a graph line plotted through a set of 
control points. You can also choose to display color backgrounds in the Curves tab 
ChromaCurves that help you to understand the effect of an adjustment as you work. For 
more information, see “Customizing Color Correction Settings” in the Help.

For more information on how ChromaCurve graphs operate, see “Understanding 
ChromaCurve Graphs” on page 231.

You can also type numerical input and output values in text boxes or use the Color Match 
control to automatically add control points to the curves, based on selected input and output 
colors. For more information on the Color Match control, see “Using the Color Match 
Control” on page 191 and “Curves and the Color Match Control” on page 241.

The Curves tab also contains four slider controls — Master Saturation, Master Gain, Master 
Gamma, and Master Setup. These sliders work in exactly the same way as the Saturation, 
Gain, Gamma, and Setup sliders in the HSL > Controls > Master tab, allowing you to make 
some HSL-type adjustments without having to leave the Curves tab. When you adjust any of 
these sliders, you enable the HSL > Controls > Master hierarchy of tabs. For more 
information on the function of these controls, see “Controls Tab Controls” on page 203.

Making Corrections Using the Curves Tab

The following illustration shows the Curves tab.

To make corrections using the Curves tab:

1. If you have not already done so:

a. Move the position indicator to the segment you want to correct.

b. Click the Correction Type button and select a correction type.

c. Click the Levels tab.

n For more information on correction types, see “Working with Correction Types” in the Help.

Curve graphs Sliders Color Match control
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2. Do one or more of the following:

t Adjust the curves until you are satisfied with the results.

For more information on adjusting curves, see “Adjusting Curves” on page 239.

t Adjust the Master Saturation, Master Gain, Master Gamma, or Master Setup slider 
controls.

For more information, see “Using the Sliders in the HSL Group” on page 202 and 
“Controls Tab Controls” on page 203.

Adjusting Curves

Adjusting ChromaCurve graphs in the Curves tab is similar to adjusting the three-point 
ChromaCurve graph in the Levels tab. In the Curves tab, however, you can set up to 16 total 
control points on a ChromaCurve graph.

To add a control point:

t Click the curve line in the graph at the point where you want the new point to appear.

A new control point appears with a circle around it to indicate that it is the active control 
point.

To select a control point:

t Click the control point you want to select.

A circle appears around the control point to indicate that it is the active control point.

New control point

Active control point

Inactive control point
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To move a control point, do one of the following:

t Click the control point, and drag it to the location on the graph where you want to place 
the point.

The curve updates as you drag the control point.

t Type input and output values for the position of the control point in the Input and Output 
text boxes below the ChromaCurve graph. You must press Enter (Windows) or Return 
(Macintosh) after typing a value for it to take effect.

n You can “nudge” the numerical value of a control up or down by small increments. To do 
this, click in the text box, and then press the Up Arrow key to increase the value or the Down 
Arrow key to decrease the value.

You can also use the mouse scroll wheel to change values in the Color Correction tool. Click 
a slider or click in a value text box, then press the Ctrl key and use the scroll wheel to change 
the value in small increments, or press the Ctrl and Shift keys (or the Ctrl and Alt keys) and 
use the scroll wheel to change the value in increments of -10 or +10.

To delete a control point:

1. Click the control point to activate it.

A circle appears around the control point.

2. Make sure that the pointer is over the curve graph that contains the control point you 
want to delete.

3. Press the Delete key.

n A curve is defined by at least two control points. If you have only two control points set in a 
curve graph, you cannot delete one.

Input text box Output text box

Control point at 100 on the 
input (horizontal) axis, 69 on 
the output (vertical) axis
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To anchor a portion of the curve so that it does not move when you are making other 
adjustments:

1. Place two control points at either end of the portion of the curve you want to anchor.

2. Place a third control point very close to the point that separates the portion of the curve 
you want to anchor from the portion of the curve you want to adjust.

3. Place a fourth control point on the portion of the curve that you want to adjust.

When you drag the new control point to adjust the curve, the portion of the curve 
between the first two control points will not move.

Curves and the Color Match Control

When you use the Color Match control in the Curves tab, a gray crosshair marker appears in 
each appropriate ChromaCurve graph to mark the intersection of the input value as defined 
by the input color swatch in the Color Match control and the output value as defined by the 
output color swatch in the Color Match control.

Third control point. The 
curve will adjust around 
this point but will not 
move between the first 
two points.

First two control 
points define the 
portion of the curve 
you want to anchor.

Fourth control point. Click this 
point, and drag it to adjust the 
upper portion of the curve.

Anchored portion of 
the curve

Adjusted portion of 
the curve
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When you click the Match Color button, the system adds new control points and updates the 
ChromaCurve graphs to reflect the color match. If you are not using NaturalMatch or if the 
ChromaCurve graphs have not received any previous adjustment, the new control points will 
appear at the location of the crosshair marker. If you are using NaturalMatch or if the 
ChromaCurve graphs have already received some adjustment, the system makes a more 
complex calculation to reflect the input saturation and luminance values or to take earlier 
ChromaCurve graph adjustments into account. In these cases, the new control points will not 
appear at the location of the crosshair marker.

The following illustrations show this behavior both before and after you click the Match 
Color button.

The crosshair marker on the Green ChromaCurve graph 
represents the values for Green in the color swatches — Input 
131, Output 105. Since R+G+B is selected as the Match Type, 
similar crosshair markers appear on the Red and Blue 
ChromaCurve graphs.

When you click the Match Color button, the system creates a 
new control point and updates the curve to reflect the color 
match. In this illustration, NaturalMatch is selected and the 
calculation is not complicated by other control points, so the new 
control point is created at the exact location of the crosshair 
marker. The Green input and output values as shown in the color 
swatches now appear in the Input and Output text boxes below 
the graph.

Input text box Output text box
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Examples of Curve Adjustments

The following illustrations show a series of simple adjustments made to an image using the 
Red ChromaCurve graph in the Curves tab. By comparing the results of these adjustments, 
you can learn how curves can be used to control color across different parts of the brightness 
range.

n If you are reading a black-and-white hardcopy version of this document, you will find it 
useful to view the color images in the online version of the document available from the 
Online Library for your Avid editing application (Help > Online Library).

In each adjustment example, the new corrected image and the curve used to produce it are 
shown together with one other image from the series for the purpose of comparison.

n In each example, the color of the background behind the control point represents the color 
change to the image. In the first example, creating a curve through the darker cyan area 
causes reds to be reduced in the darker parts of the image. In the second example, creating a 
curve through the lighter cyan area causes reds to be reduced in the lighter areas of 
the image.
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Adjustment 1. Red is reduced primarily in the shadows range (the lower part of the curve). 
Notice how much of the red tone is lost from the background grass, the shirt, and the lower 
red signpost, which loses much of its detail. The higher red signpost is relatively less 
desaturated, however, and some of the reddish tinge is retained in the cloud highlights in the 
top right.

Uncorrected Image

Adjustment 1
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Adjustment 2. Red is reduced primarily in the highlights range (the upper part of the curve). 
The differences between this adjustment and adjustment 1 are most apparent in the lower 
signpost, which retains more redness and detail, and in the background, where the crop in 
the lower right retains more red tones, but the cloud highlights in the top right have lost their 
red tinge.

Adjustment 1

Adjustment 2
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Adjustment 3. Red is reduced more evenly across the entire luminance range but with the 
largest change in the midtones. Though the differences between this adjustment and 
adjustment 2 are subtle, the strong midtone reduction in red is most noticeable in the skin 
tones, which appear more gray than in either adjustment 1 or adjustment 2. However, 
adjustment 3 retains both some detail in the lower signpost and some of the reddish 
highlights in the clouds.

Adjustment 2

Adjustment 3
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Adjustment 4. Red is boosted relatively evenly across the entire luminance range but with 
the largest change in the midtones. Here the difference from adjustment 3 is obvious 
throughout the image. The most extreme differences appear in the midtone range, for 
example, in the hands.

Adjustment 3

Adjustment 4
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Adjustment 5. Red is boosted primarily in the highlights range. Here the most noticeable 
difference can be seen in the crop in the background. In adjustment 4, where red has been 
boosted more in the lower ranges, the crop looks more orange. In adjustment 5, where red 
has been boosted very little in the shadows range, the crop looks more yellow-green.

Adjustment 4

Adjustment 5
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Adjustment 6. In the final adjustment, red is boosted primarily in the shadows range. In 
comparison with adjustment 5, there is much more of a red or orange tinge in the darker 
parts of the image (for example the crop in the lower right and the lower part of the shirt). 
Highlights in the clouds, however, have much less of a red tinge.

Adjustment 5

Adjustment 6
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The Secondary Group

Secondary color correction allows you to make real-time adjustments to parts of an image 
defined by hue and saturation values. You can apply secondary adjustments, like other 
adjustments made in Color Correction mode, to a single segment or to multiple segments 
that you define by setting Source or Program relationships.

Secondary color correction works best when the range of colors that you want to change in 
an image is isolated in the area or object that you want to change and does not appear 
elsewhere in the image. For example, you can use secondary color correction to change the 
look of a sky as long as the blue tones of the sky are not present elsewhere in the image.

If you want to change the colors in part of an image without affecting any other part of the 
image in any way, you can use the Spot Color effect or certain modes in the Paint Effect to 
isolate part of the image using drawing tools, and then color correct that part only. For 
example, if you had a clip showing three red cars and you wanted just one of the cars to be a 
different color, you could use the Spot Color effect. For more information, see “Spot Color 
Correction” on page 321.

The following illustrations show a typical example of a secondary color correction. The 
original color of the turban is changed with virtually no alteration to the color characteristics 
of other parts of the image.

n If you are reading a black-and-white hardcopy version of this document, you will find it 
useful to view the color images in the online version of the document available from the 
Online Library for your Avid editing application (Help > Online Library).

Before After 
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Understanding Secondary Color Correction

The Secondary group provides controls for making hue and saturation adjustments to as 
many as 12 distinct parts of the full color range in an image.

Secondary color correction is most useful for images in which the following two 
circumstances apply:

• You want to change the color characteristics of some parts of the image without altering 
the rest of the image in any way.

• The parts of the image that you want to change are characterized by hue and saturation 
values that are absent or nearly absent from the rest of the image.

For example, you might be correcting a shot of a person wearing a bright yellow scarf. After 
earlier stages of color correction, you are pleased with the image in general, but the scarf 
remains too bright. You can use secondary color correction to select the bright yellow of the 
scarf and then make an adjustment to alter the yellow color. The system applies that 
adjustment to only the bright yellow pixels in the image. As long as no other parts of the 
image are bright yellow, your correction changes the color of the scarf alone, preserving the 
rest of the image untouched.

The following illustration shows the Sec (Secondary) tab in its default configuration.

Input Vector controls Input Vector
color wheel

Output Vector 
color wheel

Selected Vectors panel

Output Vector controls Color Match control

Color Correction 
buckets

Color Selection buttons
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Secondary Color Correction Workflow

The workflow for secondary color correction differs slightly from that used in other color 
correction groups since you must make corrections in two distinct stages. In the first stage, 
you define the range of color in the image that you want to alter using the Input Vector 
controls, the Color Selection buttons, or the Color Match control. In the second stage, you 
change the hue and saturation values of the defined range of color using the Output Vector 
controls or the Color Match control.

The following procedure lists the main steps involved in making a secondary color 
correction and provides cross-references to detailed information on each step.

1. In Color Correction mode, verify that you have selected the track in which you want to 
make the correction. 

2. Click the Sec (Secondary) tab.

3. Select a correction type to control the scope of the correction.

For more information, see “Selecting Correction Types” on page 154.

4. Move the position indicator to the segment you want to correct.

5. Select a predefined color vector as a starting point for defining the color range you want 
to correct.

For more information, see “Understanding Secondary Color Correction Vectors” on 
page 253 and “Selecting Vectors” on page 260.

6. Adjust the input values of the vector until it corresponds to the color range you want to 
correct.

For more information, see “Adjusting Input Vector Values” on page 261.

7. (Option) As an alternative to steps 5 and 6, use the Color Selection buttons to select, 
enable, and adjust an input color vector based on colors that you sample from the image. 
For more information, see “Using the Color Selection Buttons” on page 266.

8. Correct the color range you have defined by adjusting the output values of the vector.

For more information, see “Adjusting Output Vector Values” on page 270.

n You can also use the Color Match control to quickly make a correction based on input and 
output color values that you select, and then fine-tune the correction using Input and Output 
Vector controls. For more information, see “Using the Color Match Control for Secondary 
Corrections” on page 271.
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Understanding Secondary Color Correction Vectors

Secondary color correction is based on the concept of color vectors. A vector is a subset of 
the full color range in an image. When you work in the Secondary group, you select a 
predefined vector as a starting point, adjust the vector so that it represents the exact color 
range you want to correct, and then change the color characteristics of that vector.

Standard and Custom Vectors

Your Avid editing application provides twelve predefined color vectors. The first six, known 
as standard vectors, represent the following major colors: Green, Yellow, Red, Magenta, 
Blue, Cyan. The remaining six, known as custom vectors, represent other, more narrowly 
defined colors that are useful starting points for common corrections (for example, blues that 
can be easily customized to define the sky color in an image).

Vector Display in Color Wheels

The Secondary tab displays vectors graphically in color wheels similar to those used in the 
Hue Offsets tab of the HSL group. In these displays, the full wheel represents the complete 
range of possible hue and saturation values, and each vector appears as a distinct area within 
the wheel. For more information on the color wheels and how they represent hue and 
saturation values, see “Understanding ChromaWheel Color Wheels” on page 205.

n If you are reading a black-and-white hardcopy version of this document, you will find it 
useful to view the color images in the online version of the document available from the 
Online Library for your Avid editing application (Help > Online Library).
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The following illustration shows a color wheel that displays all the available color vectors.

Each vector displays with a boundary line and a center point. The center point marks the 
base hue and saturation values for the vector, while the boundary lines indicate the range of 
hue and saturation values that the vector contains. Center points for standard vectors are 
filled circles; center points for custom vectors are crosshairs.

The hue range of a vector is represented by the arc of the wheel that it covers, and the 
saturation range of a vector is represented by the part of the wheel’s radius that it covers.

n The exact range of values included in a vector is also related to the shape of that vector. 
Standard vectors always appear as wedge shapes — they have no upper saturation limit, and 
their hue ranges are constant regardless of the saturation level. Custom vectors always 
appear as ellipses — their saturation ranges are fully adjustable, and their hue ranges scale 
with the saturation level. 

The following illustrations show how to interpret the hue and saturation ranges of a vector 
from its color wheel display.

Center point

Boundary line



The Secondary Group

255

Examples of Varying Hue Ranges

These three examples show three versions of a Red vector with different hue ranges (or 
widths). The top row shows the color wheel display for each version of the vector. The 
bottom row shows the color range defined by that vector with the rest of the color wheel 
shown as grayscale. 

Hue width 30o  (default) Hue width 10o  Hue width 60o  

Zero degree line (location of pure red 
on the color wheel)

The vector extends for 30o of arc — 
15o either side of pure red. A narrower 
arc limits the vector to a smaller range 
of reds. A wider arc expands the vector 
to include more yellow and magenta 
hues (see next illustration).

Hue Range Example Using Red Standard Vector
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Examples of Varying Saturation Ranges

These three examples show three versions of a custom vector with different saturation 
ranges (or widths). The top row shows the color wheel display for each version of the 
vector. The bottom row shows the color range defined by that vector with the rest of the 
color wheel shown as grayscale. 

Saturation width 40 (default) Saturation width 15 Saturation width 80 

Saturation Range Example Using Custom Vector

This custom vector (#3 in the Selected Vectors panel) 
has a default saturation value of 35 and a default 
saturation width of 40. Its saturation range therefore 
excludes very low saturation levels and a wide band 
of high saturation levels. Reducing the saturation 
width reduces the range of color intensity included in 
the vector even further. Increasing the saturation 
width expands the range of color intensity (see next 
illustration).
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Customizing the Display of Secondary Color Correction Vectors

You can customize which vectors appear in the color wheels by setting options in the 
Features tab of the Correction Mode Settings dialog box.

To customize a vector display:

1. Open the Correction Mode Settings dialog box by doing one of the following:

t In the Project window, click the Settings tab, and then double-click Correction in 
the Settings scroll list.

t In the Color Correction tool, click the Correction Mode Settings button.

The Correction Mode Settings dialog box opens.

2. Click the Features tab.

3. Click the Secondary Vectors menu, and then select an option.

For detailed information on the available options, see “Options for Secondary Color 
Correction Vector Display” on page 257.

4. Click OK.

Options for Secondary Color Correction Vector Display

The following table describes available options in the Secondary Vectors menu in the 
Features tab of the Correction Mode Settings dialog box.

Features tab

Secondary Vectors menu
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Option Description Display in Color Wheels

Show All Shows all twelve vectors in the color wheels of 
the Secondary tab.

Show 
Standard

Shows the six standard vectors (Green, Yellow, 
Red, Magenta, Blue, Cyan) in the color wheels of 
the Secondary tab. This setting also shows 
custom vectors that are enabled. This is the 
default setting.

Show 
Custom

Shows the six custom (elliptical) vectors in the 
color wheels of the Secondary tab. This setting 
also shows standard vectors that are enabled.

Show 
Enabled

Shows only those vectors that are currently 
enabled in the Selected Vectors panel. The 
illustration shows the Red standard vector and 
one custom vector.
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Understanding the Selected Vectors Panel

The Selected Vectors panel provides a central location in the Secondary group tab for 
controls that allow you to select or enable individual vectors. 

In addition, the Selected Vectors panel includes the following check boxes:

• Invert Last Vector: Checking this box inverts the effect of the enabled vector furthest to 
the right in the Selected Vectors panel. When you invert a vector, you apply the 
adjustment to all parts of the image except those parts defined by the vector. For more 
information, see “Inverting a Vector” on page 273.

• Isolate: Checking this box isolates the selected vector in the image by displaying all 
other parts of the image as grayscale.

You can use Isolate both as a preview feature and as an effect in its own right. While you 
are making a secondary color correction, you can select Isolate to see the extent of a 
vector more clearly. If you leave Isolate selected as part of a finished secondary color 
correction, you create a special secondary color correction that isolates one color range 
while displaying the rest of the image as grayscale. For more information, see “Isolating 
the Selected Vector” on page 269.

The following illustration shows the Selected Vectors panel with the Green vector selected.

n If you are reading a black-and-white hardcopy version of this document, you will find it 
useful to view the color images in the online version of the document available from the 
Online Library for your Avid editing application (Help > Online Library).

Vector names
Color swatches

Enable buttons

Standard vectors Custom vectors

Invert Last Vector check box

Isolate check box
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The color swatches for each vector in the Selected Vectors panel update in real time to 
provide a visual indication of the defined color range for the vector. The following 
illustrations show this behavior for the Red vector color swatch.

Selecting Vectors

You must select a vector to make an adjustment. Any adjustments that you make using 
controls in the Secondary tab are made to the currently selected vector.

To select a vector, do one of the following:

t Click the center point of the vector in the color wheel.

t Click the vector’s color swatch in the Selected Vectors panel. 

For more information, see “Understanding the Selected Vectors Panel” on page 259.

t Use the syringe to define an input vector.

The system automatically selects, enables, and adjusts the appropriate vector based on 
the colors you sample. For more information, see “Using the Color Selection Buttons” 
on page 266.

A white box appears around the color swatch for the selected vector in the Selected 
Vectors panel, and the selected vector appears highlighted in the color wheels.

Enabling and Disabling Vectors

You can enable and disable vectors in any combination using Enable buttons. Enable buttons 
for vectors function in the same way as Enable buttons elsewhere in the Color Correction 
tool. For more information on Enable buttons, see “Working with the Enable Buttons” on 
page 162.

To enable or disable a vector, do one of the following:

t Click the vector’s Enable button in the Selected Vectors panel.

t Use the syringe to define an input vector.

The system automatically selects, enables, and adjusts the appropriate vector based on 
the colors you sample. For more information, see “Using the Color Selection Buttons” 
on page 266.

Enable buttons are pink when the associated vector is enabled and gray when the 
associated vector is disabled.

Default Red vector color swatch Red vector color swatch after hue is adjusted to +20o
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Resetting Vectors

You can use a vector’s Enable button to quickly reset the vector to its default values. For 
more information on Enable buttons, see “Working with the Enable Buttons” on page 162.

To reset a vector:

t Alt+click (Windows) or Option+click (Macintosh) the vector’s Enable button in the 
Selected Vectors panel.

The system resets the vector to its predefined values.

Adjusting Input Vector Values

Once you have selected a predefined vector as a starting point for a secondary correction, 
you adjust that vector so that it represents as accurately as possible the specific color range 
that you want to correct. 

Secondary color correction allows you to make adjustments using several different kinds of 
controls. You can also use the Isolate check box to select a preview display that makes it 
easy to see what parts of an image are included in a vector.

To adjust an input vector:

1. Select the vector you want to adjust.

For more information, see “Selecting Vectors” on page 260.

2. Adjust the vector by doing one or more of the following:

t Manipulate the vector directly in the Input color wheel.

For more information, see “Repositioning Vectors in the Color Wheel” on page 262.

t Adjust the input sliders.

For more information, see “Input Vector Sliders” on page 262.

t Select colors from the image using the syringe and eyedroppers.

For more information, see “Using the Color Selection Buttons” on page 266.

You might want to click Lock Vectors at some stage in the adjustment process to prevent 
the output image from exhibiting premature color changes while you fine-tune your 
input vector. For more information, see “Locking Vectors While Adjusting an Input 
Vector” on page 263.

3. As you make your adjustments, use the Isolate feature to verify what parts of the image 
are currently defined by the vector. For more information, see “Isolating the Selected 
Vector” on page 269.
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Repositioning Vectors in the Color Wheel

You can reposition a vector in the color wheel by dragging its center point. This changes the 
hue and saturation values of the vector.

To reposition a vector in a color wheel:

1. Move the pointer over the center point of the vector.

The pointer changes to a hand.

2. Click the mouse button, and drag the center point of the vector to a new location in the 
color wheel.

As you drag the center point around in the color wheel, the Hue and Saturation sliders 
update to show the current hue and saturation values, and the vector’s color swatch 
updates in the Selected Vectors panel to show the currently selected color.

3. Release the mouse button when you are satisfied with the hue and saturation values.

Input Vector Sliders

You can change the values of a vector by adjusting the Input Vector sliders. These sliders 
work in exactly the same way as other sliders in the Color Correction tool, for example, 
those in the HSL group. For more information, see “Using the Sliders in the HSL Group” on 
page 202.

The following table describes the individual sliders available for input vectors.

Control Description

Hue Shifts the hue value for the center point of the vector around the color wheel. On the 
default Degree unit scale, 0 (the center point of the slider) represents red and –180 or 
180 (the end points of the slider) represents cyan.

Saturation Shifts the saturation value for the center point of the vector between the center and the 
outer edge of the color wheel. On the default Percent unit scale, 0 represents no 
saturation (the center of the wheel) and 100 represents full saturation (the outer edge of 
the wheel).

Hue Width Sets the hue range of the vector. On the default Degree unit scale, values represent the 
number of degrees of arc that the vector covers on the color wheel, with the Hue value 
being the midpoint of the arc. For standard vectors, values range from 0 to 180; for 
custom vectors, values range from 0 to 100.
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Locking Vectors While Adjusting an Input Vector

You can lock the Hue and Saturation controls for Input and Output vectors together. When 
the vectors are locked, any changes you make to the Input Hue and Saturation values (either 
by adjusting the sliders or by dragging the vector in the vector wheel display) are matched 
by equivalent changes to the Output Hue and Saturation values.

To lock Input and Output Hue and Saturation controls together:

t Click Lock Vectors (below the Hue and Saturation sliders).

If you lock the Input and Output vectors together while you are fine-tuning your Input 
vector (before you make an Output vector adjustment), you can avoid the impression 
that you are correcting your image prematurely (and inaccurately). The image that you 
see in the monitor does not show any false color changes while you are manipulating the 
Input vector. This is especially useful if you are demonstrating corrections for a client, 
who might be confused by seeing inaccurate color changes while you are setting up an 
input vector.

Saturation Minimum 
(standard vectors)

Saturation Width 
(custom vectors)

For standard vectors, sets the minimum saturation value for the vector. Pixels in the 
image below the saturation minimum are not included in the vector even if their hue 
value is within the vector’s hue width.

For custom vectors, sets the saturation range of the vector. On the default Percent 
scale, values represent the saturation range as a percentage of the maximum saturation 
width. For example, a vector with Saturation Width 40 extends across 40% of the full 
saturation range. Pixels in the image outside this saturation range are not included in 
the vector even if their hue value is within the vector’s hue width.

Softness Sets a softness value for the vector. Values range from –255 to 255. 

Positive values blend the corrected color into areas of the image beyond the limits of 
the defined input vector. The higher the value, the further into adjacent color values the 
blend extends.

Negative values blend the uncorrected color into parts of the area defined by the input 
vector. The higher the value, the more of the uncorrected color is retained in the input 
vector area.

When Softness is set to 0, the correction has a hard edge at the limit of the defined 
input vector. The default Softness setting of 30 creates a softened edge without 
extending the corrected color significantly outside the defined input vector.

For illustrations of the effect of various Softness settings, see “Examples of Softness 
Adjustments” on page 264.

Control Description
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Workflow for a Secondary Color Correction Using Lock Vectors

A typical workflow for making a secondary color correction using Lock Vectors might 
include the following steps:

1. Define an initial color range for the Input vector, for example by using the Syringe.

2. Turn on Lock Vectors, and fine-tune the hue and saturation values for the Input vector, 
for example by dragging the Input Hue and Saturation sliders.

Because the input and output vectors are locked together, these adjustments do not 
change the output colors in the monitor.

3. Turn off Lock Vectors, and adjust the Output vector until the color range you have 
defined changes to the finished color you want.

4. (Option) If you need to fine-tune the whole correction further but do not want to change 
the color shift that you have established from Input to Output values, turn on Lock 
Vectors and shift the vectors slightly by dragging in the vector wheel display.

Examples of Softness Adjustments

Softness is an important control for fine-tuning the effect of a secondary correction on an 
image. You can control the appearance of the transitional areas between a corrected part of 
the image and the rest of the image. You can also quickly compensate for inaccuracies in the 
input vector definition by expanding or contracting the color range over which the correction 
has an effect.

The following illustrations show the effect of a range of Softness adjustments on a test 
image.

n If you are reading a black-and-white hardcopy version of this document, you will find it 
useful to view the color images in the online version of the document available from the 
Online Library for your Avid editing application (Help > Online Library).
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The original image is a radial gradient from green to red. The basic adjustment uses the default Green 
input vector and an output vector that shifts the Hue by 180 degrees on the color wheel. The effect of 
this adjustment is to change the strongly green area near the center of the image to magenta.

Adjusted image: Softness 0

The following illustrations show the effect of a variety of Softness adjustments on the correction. The 
illustrations show the image as it appears with Preview Selected in the Secondary tab so that the 
extent of the adjustment is easy to see. 

Softness 0 The correction is defined by a hard 
edge, and no blended color appears outside 
the area defined by the input vector.

Softness +30 This is the default Softness setting. The 
correction color blends slightly into areas of the image 
with color values adjacent to the defined color range. 
The outside edge appears green because the 
uncorrected color is dominant in the blend at the edge 
of the area affected by the correction.

Original image
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Using the Color Selection Buttons

You can use the Color Selection buttons to select, enable, and adjust a vector by sampling 
colors from an image. The system provides three distinct sampling tools that allow you to 
define an initial color vector and then fine-tune the vector by adding to or subtracting from 
the defined color range.

You can use the Color Selection buttons together with the Color Match control to quickly 
perform a complete secondary color correction. For more information, see “Using the Color 
Match Control for Secondary Corrections” on page 271.

You can also use the Color Selection buttons to refine the definition of an existing vector by 
sampling colors within or adjacent to that vector.

Softness +128 The correction now expands 
into more of the surrounding color, and the 
gradual blend from magenta back to green is 
more easily visible.

Softness +255 With Softness at its maximum 
positive value, the correction now affects an area 
substantially larger than the area defined when 
Softness is set to 0. However, the area that is 100% 
corrected color (magenta) remains the same.

Softness –128 When Softness values are 
negative, the blended area is within the limits 
of the original input vector. Only a small area in 
the center is now 100% magenta.

Softness –255 With Softness at its maximum 
negative value, almost all of the original input 
vector area is affected by a blend of uncorrected 
and corrected color.
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The following illustration shows the Color Selection buttons.

Defining a Vector with the Syringe

To define a vector using the syringe:

1. Click the Syringe button to highlight it.

2. Move the pointer over the image in the active monitor.

The pointer changes to a syringe.

3. Move the tip of the syringe over the area of color you want to sample in the image.

4. Press and hold the mouse button, and drag the tip of the syringe over the area of color 
you want to sample.

The system samples every color value that the tip of the syringe passes over. The input 
color swatch in the Color Match control updates as you drag the syringe to show the 
most recently sampled color. 

n Try to cover the area that you want to sample as fully as possible, but take care not to stray 
outside that area. Remember that you can make further refinements to the vector after 
completing the initial selection.

5. When you have finished sampling, release the mouse button.

The system does the following:

- Selects and enables the closest vector to the range of colors you have sampled.

- Adjusts the Input Vector values for the vector so that it includes the full range of 
colors that you sampled with the syringe.

- Sets the Output Vector values to match the Input Vector values.

- Automatically selects the Isolate check box so that the vector you have defined is 
visible in the monitor. For more information, see “Isolating the Selected Vector” on 
page 269.

6. (Option) Refine the vector definition.

For more information, see “Refining a Vector Definition with the Add to Selection and 
Subtract from Selection Buttons” on page 268.

Syringe button

Add to Selection button

Subtract from Selection button
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n The Syringe button remains selected until you explicitly turn it off by clicking it or by 
clicking one of the other Color Selection buttons. This means that you can perform repeated 
operations with the syringe without having to reactivate it for each operation.

Refining a Vector Definition with the Add to Selection and 
Subtract from Selection Buttons

You can refine the definition of a vector by adding or subtracting colors that you sample 
using the Add to Selection and Subtract from Selection buttons. You can use these buttons to 
refine any vector, regardless of how you originally defined the vector.

To refine a vector using the Add to Selection and Subtract from Selection buttons:

1. Select the vector that you want to refine.

2. Click the Add to Selection or Subtract from Selection button to highlight it.

3. Move the pointer over the image in the monitor.

The pointer changes to an eyedropper.

4. Move the tip of the eyedropper over the color you want to add to or subtract from the 
vector, and then click the mouse button.

The system updates the vector to include or exclude the color you have selected.

n The Add to Selection or Subtract from Selection button remains selected until you explicitly 
deselect it by clicking it or by clicking one of the other Color Selection buttons. This means 
that you can perform repeated operations with the eyedropper without having to reselect it 
for each operation.

The Undo command works with eyedropper color selections. If you select too much color 
with the Add to Selection eyedropper or subtract too much with the Subtract from Selection 
eyedropper, select Edit > Undo or press Ctrl+Z (Windows) or Command+Z (Macintosh) to 
have the system delete the effect of that selection on the vector.

When the system calculates revised vector areas based on selections made with the Add to 
Selection and Subtract from Selection eyedroppers, it is constrained by the geometric limits 
of the vector (wedge-shape for standard vectors and ellipse for custom vectors). As a result, 
you might include or exclude more colors than you expect. In general, the Color Selection 

Add to Selection button

Subtract from Selection button
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buttons are excellent tools for quickly adjusting a vector to approximately the area you 
require. However, you might still need to fine-tune the vector using the sliders to achieve a 
precise match with the color range you want to correct.

Isolating the Selected Vector

You can isolate the selected vector in an image. The system displays those parts of the image 
that fall within the selected vector in color, with the rest of the image in grayscale. This 
makes it easy to see which parts of an image are included in a selected vector while you are 
making corrections.

You can choose to use Isolate only as a preview feature that allows you to see the extent of 
vectors clearly. In this case, you must deselect Isolate when you have finished making the 
correction. Alternatively, you can use Isolate as a special Color Correction effect that 
isolates parts of an image in color while displaying the rest of the image in grayscale. In this 
case, you leave Isolate selected when you have finished making the correction.

To isolate the selected vector:

1. Make sure that the position indicator is in the segment that you want to isolate.

2. Click Isolate in the Selected Vectors panel of the Secondary tab.

The active monitor changes to isolate the selected vector.

3. Make input and output adjustments to the vector until you are satisfied with the look of 
the correction.

4. Do one of the following:

t To leave the areas of the image outside the vector grayscale, leave Isolate selected.

t To return the image to a full-color display, click the Isolate check box to deselect it.

n Isolate shows the effect of any output adjustment you have made to the vector. If you have 
made output adjustments and want to see a preview that shows only the input color range, 
disable the Output Vector Hue and Saturation sliders by clicking their Enable buttons.

The following illustration shows a typical image and its appearance when Isolate is 
selected. For more illustrated examples of the effect of isolating a vector, see “Examples 
of Inverted and Isolated Images” on page 121.

n If you are reading a black-and-white hardcopy version of this document, you will find it 
useful to view the color images in the online version of the document available from the 
Online Library for your Avid editing application (Help > Online Library).
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Adjusting Output Vector Values

Once you have an input vector defined correctly, the final step in the secondary color 
correction process is to adjust the output values for the vector to change the color 
characteristics.

Because you have already defined the extent of the vector using input adjustments, only hue, 
saturation and luminance values are adjustable for output. To change the color 
characteristics for that vector, you only need to define a new combination of hue, saturation, 
and luminance values.

Original image in full color.

Corrected image with Isolate selected. The 
preview shows the effect of an adjustment that 
changes the pale blue robe to match the green 
color of the shoes in the top left corner of the 
original image. Areas of the image not affected 
by the correction display as grayscale. The 
preview allows you to see which additional 
areas of the image are affected by the 
adjustment and confirm which areas are not — 
for example, the blue jacket in the bottom right.

Corrected image in full color. The correction has 
completely changed the color of the robe. A few 
other small areas of the image have also been 
changed by the correction, but most of the 
image retains its original color. 
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n You might make an output vector adjustment that causes the saturation levels in an image to 
exceed the RGB Gamut limits that you have set in the Safe Color Settings dialog box. 
Depending on the current settings in the Safe Color Settings dialog box, the system might 
ignore the excess value or display a warning. For more information, see “Safe Colors” on 
page 325.

To adjust output vector values:

1. Select the vector you want to adjust.

2. Adjust the output vector values by doing one of the following:

t Manipulate the vector directly in the Output color wheel. For more information, see 
“Repositioning Vectors in the Color Wheel” on page 262.

t Adjust the output sliders. 

The Output Vector Hue and Saturation sliders are identical to their Input Vector 
equivalents. For more information, see “Input Vector Sliders” on page 262.

The Output Vector Luminance slider changes the luminance value for the final color. 
Values for the Luminance slider range from –10 to +10, where –10 reduces the 
luminance by 10% of the full black-to-white luminance range, and +10 increases the 
luminance by 10% of the full black-to-white luminance range.

As you adjust the output values, the active monitor updates to show the effect of the 
correction on your image. If Isolate is selected, the monitor shows the corrected areas of 
the image in color and the unaffected areas of the image as grayscale.

3. Do one of the following:

t To have the areas of the image outside the vector continue to display as grayscale, 
make sure that Isolate is selected.

t To have the image appear as a full-color display, make sure that Isolate is 
deselected.

Using the Color Match Control for Secondary Corrections

You can use the Color Match control to make secondary color corrections based on color 
values that you sample from images or select from the Windows Color dialog box or the 
Macintosh Color Picker. If necessary, you can make further refinements to the input and 
output vectors after the color match to achieve the precise correction that you want.
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You can use the Color Match control together with the syringe to perform a secondary color 
correction based on a range of sampled color values. In most circumstances, this is the 
preferred method for achieving a good correction when the hue and saturation values of the 
area you want to correct are somewhat varied. This method also shows the selected vector 
before you complete the match, making it easier to verify that you have a well-defined input 
vector.

You can also use the Color Match control to make a secondary color correction with the 
same basic methods that you use to make Color Match corrections in the other Color 
Correction tabs. In this case, the system applies the match to a predefined range of colors 
centered on the single color value that you sample, and you cannot see the input vector until 
the color match is completed. Though generally less precise and less controllable than the 
first method, this technique might produce acceptable results quickly if you need to correct 
an area of uniform color.

To make a secondary color correction using the Color Match control and the syringe:

1. Select, enable, and define the input vector using the syringe.

For more information, see “Defining a Vector with the Syringe” on page 267.

n As part of the vector definition process, the system automatically selects Isolate.

2. Select the output color using the standard Color Match eyedropper.

For more information, see “Making a Correction with the Color Match Control” on page 
192.

3. Click the Match Type button, and select a Match Type to determine the exact nature of 
the match the system makes.

For more information on the options available in the Secondary group, see “Match Type 
Options” on page 193.

4. Click the Match Color button to make the correction.

The system adjusts the output values for that vector, deselects Isolate, and displays the 
corrected image in the monitor that contains the current segment.

5. (Option) Make further adjustments to the vectors using the Input Vector and Output 
Vector sliders until you are satisfied with the correction.

Input color 
swatch

Output color 
swatch

Match Type 
button

Match Color 
button
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To make a secondary color correction with the Color Match control only:

1. Select the input color using the standard Color Match eyedropper.

For more information, see “Making a Correction with the Color Match Control” on page 
192.

2. Select the output color using the standard Color Match eyedropper.

3. Click the Match Type button, and select a Match Type to determine the exact nature of 
the match the system makes.

For more information on the match types available in the Secondary group, see “Match 
Type Options” on page 193.

4. Click the Match Color button to make the correction.

The system selects and enables a vector, adjusts the input and output values for that 
vector based on the sampled colors, and displays the corrected image in the monitor that 
contains the current segment.

5. (Option) Make further adjustments to the vectors using the Input Vector and Output 
Vector sliders until you are satisfied with the correction.

Inverting a Vector

You can invert a vector to apply a correction to every part of the image except for the area 
defined by the vector. The most common use of this technique is to isolate an object in its 
original color while altering the color of every other part of the image. For example, you 
might want to partially desaturate most of the image while retaining full color in the areas 
defined by the vector.

n You can invert only one vector in each correction, and the vector that is inverted is always 
the enabled vector farthest to the right in the Selected Vectors panel. In the common case of 
using inversion to isolate one object in color, the vector that you invert is likely to be the only 
vector you need to adjust. If you do make adjustments to multiple vectors in a segment, make 
sure that the inversion applies to the vector you want by making that vector the enabled 
vector farthest to the right in the Selected Vectors panel.
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To invert a vector:

1. Select the vector, and make input adjustments to it using standard methods.

2. Click Invert Last Vector in the Selected Vectors panel.

The system inverts the vector, selecting all parts of the image not defined within the 
vector. If you are working with Isolate selected, the display updates to show the area 
defined by the vector as grayscale and the rest of the image in color.

3. Adjust the output hue and saturation values for the vector.

4. Make sure that the Isolate check box is selected or deselected as necessary to produce 
the final effect that you want. For more information, see “Isolating the Selected Vector” 
on page 269.

Examples of Inverted and Isolated Images

The following illustrations show the effects of Isolate and Invert Last Vector on a typical 
image. Using these two features alone or in combination, you can achieve a wide range of 
special Color Correction effects in which one area of the image stands out from the rest.

n If you are reading a black-and-white hardcopy version of this document, you will find it 
useful to view the color images in the online version of the document available from the 
Online Library for your Avid editing application (Help > Online Library).
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Original Image

Image with Isolate selected. The 
selected vector displays in color.

Image with Isolate selected and a 
correction made to the selected 
vector.

Examples of Isolate and Invert Last Vector

Image with Invert Last Vector 
selected and a correction made to 
all parts of the image other than 
the selected vector.

Image with both Isolate and Invert 
Last Vector selected. The selected 
vector displays as grayscale while 
the rest of the image displays 
in color.
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Understanding How Multiple Vectors Interact

If you make corrections to more than one vector in the Secondary group, those corrections 
are applied cumulatively to the image when it plays back. The order of application moves 
from left to right across the Selected Vectors panel. 

If the color ranges of vectors overlap, the final result in the image is the cumulative result of 
all the corrections for the overlapping vectors. For example, if you use the Green vector to 
change a green object in the image to yellow, and then adjust the Yellow vector so yellow 
objects become red, your original green object is red in the final image.

Working with the Waveform Monitors and the 
Vectorscope Monitor

The waveform and vectorscope commands in the Source menu configure the monitor to 
graphically display color information about your sequence. The system displays the 
information for the currently active monitor.

A waveform indicates the brightness of the image. The higher the green trace goes on the 
scale, the brighter that part of the image is.

Waveform monitors display all the information for the current field or frame overlaid in the 
waveform. That is, each left-to-right trace in the waveform represents one scan line. If you 
see a bright object on the left side of the image, you will see its peak on the left side of the 
waveform. A bright object in the top left of the image produces the same waveform if it is in 
the bottom left of the image.

Displaying a Waveform Monitor or Vectorscope Monitor

To display a Waveform monitor or a Vectorscope monitor:

1. Click in the monitor for which you want to display color information.

The monitor becomes the active monitor.

2. In one of the other monitors, click the Source menu and select a waveform or 
vectorscope command.

The monitor displays the selected waveform or vectorscope information.

For more information, see “Waveform and Vectorscope Commands” on page 277 and 
“Using the Waveform and Vectorscope Information” on page 284.
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Waveform and Vectorscope Commands

The following table describes the waveform and vectorscope commands available in the 
Source menu for monitors in Color Correction mode.

n If you are reading a black-and-white hardcopy version of this document, you will find it 
useful to view the color images in the online version of the document available from the 
Online Library for your Avid editing application (Help > Online Library).

Command Description

Quad Display Displays the following waveform and vectorscope information in a single monitor (clockwise 
from the top left corner): 

• YC Waveform

• Vectorscope

• RGB Histogram

• RGB Parade

For information on each display, see its individual entry in this table.
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RGB Histogram Displays a graph showing which RGB values in the image appear most frequently. The 
darkest values of red, green, and blue in the image appear as peaks on the left of the graph, 
and the brightest values appear as peaks on the right. The height of a peak indicates the 
number of pixels of that value. The width of a peak indicates how many pixels in the image 
have similar values.

For example, if the blue histogram has many tall peaks at the left side, it shows that the image 
has many pixels with low blue values. However, those same pixels might appear in the image 
as many different colors, since they might have any red and green values.

For information on using the RGB Histogram display, see “Using the Waveform and 
Vectorscope Information” on page 284.

Command Description
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RGB Parade Displays waveforms of the RGB (red, green, and blue) components side by side. Since video 
cameras capture in RGB, this display helps to show camera problems. It is also used for 
general reference to the three primary colors.

RGB signals are used together to create all other colors. A white area in the image appears as 
peaks in all three waveforms at the same relative location. A high red level does not mean a 
red image, unless the green and blue levels are low.

RGB Parade incorporates any safe color limits you have set. The system displays RGB 
values in white when the values fall outside the RGB Gamut limits. For more information on 
color limits, see “Safe Color Limits with Waveform and Vectorscope Information” on page 
331.

For information on using the RGB Parade display, see “Using the Waveform and Vectorscope 
Information” on page 284.

Command Description
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Vectorscope Displays chroma information without luma information as a circular graph where the center 
represents no chroma and chroma increases as the trace moves away from the center. 

All white, black, and gray parts of the image appear at the center. Areas with more saturation 
appear further out from the center. Images with an overall color cast produce a vectorscope 
trace that is generally off-center. Colors created by various positive and negative 
combinations of Cb and Cr appear around the circle.

Small squares mark the location of standard color bar vectors. Inner squares represent the 
proper values for 75% color bars, and outer squares represent 100% color bars.

For information on using the Vectorscope monitor, see “Using the Waveform and 
Vectorscope Information” on page 284.

Command Description
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Y Waveform Displays a Waveform monitor with luma information. Luma is the brightness of an image 
without regard to color.

The scale on the left is a digital level scale using a 256-step (8-bit) range; 16 is the level for 
black, and 235 is the level for white.

The scale on the right shows the amount of white in the image as a percentage; 0% represents 
black, and 100% represents white.

Parts of an image can have values outside the 0% to 100% range. The digital video standard 
allows for headroom and footroom so that you can correct a mistake in level in the 
postproduction process. The minimum is digital 0 or –8%, and the maximum is digital 255 or 
108%. 

n Some external software or hardware processing can clip a signal that is outside the 
0% to 100% range.

Y Waveform incorporates any safe color limits you have set. The system displays Luma 
values in white when the values fall outside the Luminance limits. For more information on 
color limits, see “Safe Color Limits with Waveform and Vectorscope Information” on page 
331.

For information on using the Y Waveform display, see “Using the Waveform and 
Vectorscope Information” on page 284.

Command Description
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YC Waveform Displays composite video information. Composite video has the C (chroma) waveform, 
which is derived from Cb and Cr components, riding on the Y (luma) waveform. The Y trace 
is green, and the C waveform is a cyan (blue-green) envelope around the green trace. Because 
the C signal of composite video has equal positive and negative energy, the cyan bands are at 
an equal distance above (Y+C) and below (Y-C) the green waveform.

The left side of the YC Waveform display shows a scale marked either for NTSC or PAL, 
depending on your project.

NTSC black is 7.5 IRE (except in Japan), and NTSC white is 100 IRE.

PAL black is 0 millivolts (mV), and PAL white is 700 mV.

n This tool does not display actual composite video output. It is an accurate software 
model of a perfect encoder. If you convert your material to composite form, you see 
similar results.

The scale on the right shows the amount of white in the image as a percentage; 0% represents 
black, and 100% represents white.

Composite video values above or below these limits are indicated by a red edge on the 
display. In addition, YC Waveform incorporates any safe color limits you have set. The 
system displays Composite values in yellow and Luma values in white when the values fall 
outside the safe color limits. For more information on color limits, see “Safe Color Limits 
with Waveform and Vectorscope Information” on page 331.

For information on using the YC Waveform display, see “Using the Waveform and 
Vectorscope Information” on page 284.

Command Description



Working with the Waveform Monitors and the Vectorscope Monitor

283

YCbCr Histogram Displays a graph showing which YCbCr values in the image appear most frequently. The 
height of a peak indicates the number of pixels of that value. The width of a peak indicates 
how many pixels in the image have similar values.

The upper bar of the histogram represents Y values. The darkest values are on the left and the 
brightest values on the right. An image with good contrast shows a good spread of values 
from darkest to lightest.

An image with a great variety of colors appears as a wide spread in the Cb and Cr histograms. 
If they extend too far from the center, there is too much saturation.

For information on using the YCbCr Histogram display, see “Using the Waveform and 
Vectorscope Information” on page 284.

Command Description
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Using the Waveform and Vectorscope Information

Some of the ways you can use the waveform and vectorscope information include to:

• Align levels of sources using test patterns. If you capture some color bars from your 
source footage, you can measure them and set the color correction needed to restore the 
video levels to the way the program was created. Import the Test Patterns from the 
SupportingFiles folder of your Avid system to become familiar with the proper 

YCbCr Parade Displays waveforms of Y, Cb, and Cr side by side. The Y in YCbCr is the same luma shown 
in the Y Waveform display. In this display, the Y waveform is shown in white on the left side.

Cb and Cr are color difference signals that represent just the color information of a signal 
with the luma removed. Cb and Cr values can be negative or positive. For images that are 
black and white, Cb and Cr are zero. You would see a flat white line halfway up the two right 
bands. As they increase, Cb and Cr are shown in the colors representing those vectors. The 
more the values increase, the more saturated the colors used to display them. Positive Cb is 
represented by blue hues, and negative Cb is represented by yellow hues. Positive Cr is 
represented by red hues, and negative Cr is represented by cyan hues. 

If the Cb or Cr waveforms are not centered, the cause might be a color cast to the image.

For information on using the YCbCr Parade display, see “Using the Waveform and 
Vectorscope Information” on page 284.

Command Description
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Waveform, Parade, and Vectorscope readings. Histograms are not as useful on test 
patterns. For example, with 75% color bars, the Y+C envelope for the yellow and cyan 
bars should match the 100% white level.

• Identify problems with source video. Typical problems include:

- Color levels too high or too low. For more information, see “Safe Color Limits with 
Waveform and Vectorscope Information” on page 331.

- Missing channels in YCbCr or RGB, indicating an equipment problem or a 
damaged cable.

- Clipping in YCbCr, RGB, or YC channels. The trace appears chopped at a certain 
level. If this appears at a level below the maximum, it occurred before the footage 
was captured.

- Images imported at the wrong level settings. If you import images at RGB levels of 
0–255 that you should have imported at 601 levels of 16–235, the images lack 
contrast. If the images have too much contrast, with levels exceeding the 0% and 
100% markings, the opposite is likely. 

With experience, you can learn how to read not only test patterns but actual content on the 
instruments. This facility allows you to:

• Match scene brightness across a cut in the Y Waveform histogram.

• Put your flesh tones along a certain hue axis in the Vectorscope monitor.

• Watch the spread of the Y Waveform histogram to identify a good contrast range 
without clipping. 

• Watch the top of the YC Waveform histogram to make sure you do not have too much 
bright chroma.

• Fix white balance and black balance problems by identifying and centering those 
vectorscope traces.

You can also use the information in the Waveform and Vectorscope monitors to monitor safe 
color limits. For more information, see “Safe Color Limits with Waveform and Vectorscope 
Information” on page 331.

n Waveform and vectorscope monitors show you the values of only one frame or field at a time. 
Move around in the clip to find the most extreme levels or those most representative of the 
scene.
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Using the Color Correction Effect
In addition to color corrections made using relationships, you can also apply color 
corrections using the Color Correction effect.

Some types of corrections can only be made using the Color Correction effect, and it is 
important to understand the situations that call for a Color Correction effect rather than a 
relationship color correction. For more information, see “When to Use the Color Correction 
Effect” on page 287.

You can apply the Color Correction effect in two different ways:

• You can apply it from the Color Correction tool by selecting CC Effect as the correction 
type, as described in “Applying a Color Correction Effect from the Color Correction 
Tool” on page 289.

• You can apply it from the Effect Palette, in the same way as any other effect. When you 
apply the Color Correction effect from the Effect Palette, your application makes the 
automatic color corrections set in the AutoCorrect tab of the Correction Mode Settings 
dialog box. (You can then make further color adjustments in the Color Correction tool if 
you need to do so.) For more information, see “Correcting Color Automatically Using 
the Color Correction Effect” in the Help.

Once you have applied a Color Correction effect, you can work with it in much the same 
way as any other effect. For example, you can save it as an effect template, or delete it using 
standard methods for deleting effects.

n You can apply a relationship correcton and a color correction effect on the same segment. 
This results in two distinct corrections. The relationship correction is applied first, and its 
result is the input to the color correction effect.

This approach differs from applying two corrections by applying one on the Source side and 
another on the Program side. In this case, a single correction is made using the merged 
values from the Source and Program sides.
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When to Use the Color Correction Effect

You need to use a Color Correction effect rather than a relationship color correction in the 
following situations:

• When you want to apply multiple automatic corrections in a single operation.

In this case, you must apply the Color Correction effect from the Effect Palette, as 
described in “Correcting Color Automatically Using the Color Correction Effect” in 
the Help.

• When you want to apply a color correction in combination with certain other effects.

For example, if you have two layers of video with a Picture-in-Picture applied to the top 
layer, you cannot color correct the entire video composite (foreground and background 
together) using a relationship correction. However, if you nest a Color Correction effect 
on top of the Picture-in-Picture, you can correct foreground and background at the same 
time. (This behavior is a result of the fact that relationship color corrections are 
processed before most other effects.) For more information, see “Understanding 
Relationship Color Corrections” on page 154.
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• When you want to apply a color correction to filler.

You cannot apply relationship color corrections to filler. A common example of the use 
of a color correction on filler is when you add a new video track above all other tracks 
and then add a Color Correction effect to that track. This provides a way to apply an 
overall color correction that affects every layer beneath it (for example, adding a little 
brightness to an entire sequence as a final color correction step). The Program Track 
relationship color correction, in contrast, affects the whole of any one track in a 
sequence.

Original setup before color corrections

Relationship correction on bottom 
track — only bottom track has 
chroma inverted

Relationship correction on top track 
— only top track has chroma inverted

Color Correction effect nested on top 
of Picture-in-Picture — entire 
composite has chroma inverted
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Applying a Color Correction Effect from the Color Correction Tool

You can apply a Color Correction effect in the Color Correction tool, and then make any 
combination of color correction adjustments that are available in the Color Correction tool.

When you apply a Color Correction effect from the Color Correction tool, your application 
does not apply the automatic corrections set in the AutoCorrect tab of the Correction Mode 
Settings dialog box.

To apply a Color Correction effect from the Color Correction tool:

1. If you have not already done so, move the position indicator to the segment you want to 
correct.

2. Click the Correction Type button and select CCEffect.

3. Make the color adjustments you want in one or more of the Color Correction tool’s tabs.

Once you make an adjustment, the Color Correction effect appears on the segment.

Color Correction effect applied to filler 
on top track, above multiple other tracks.
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6 Managing Color-Corrected Sequences

The Color Correction tool includes menu commands that allow you to manage sequences 
once they have color correction applied to them. You can update a sequence to apply existing 
color corrections to newly added segments, merge different versions of a color-corrected 
sequence, convert color corrections in a sequence to segment-only relationships, and remove 
groups of corrections from a sequence. 

You can control the extent of the changes for all these operations. You can also choose to 
make the changes on a new copy of the sequence so that the unchanged sequence is still 
available to you.

This chapter describes how to manage sequences with color corrections.

• Updating Color-Corrected Sequences

• Understanding Color Correction Merging

• Merging Color-Corrected Sequences

• Color Correction Merging Example

• Flattening Color-Corrected Sequences

• Removing Color Corrections

For information on how color-corrected sequences conform between Symphony and certain 
other Avid editing applications, see “Conforming Sequences with Color Correction” on page 
40.
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Updating Color-Corrected Sequences
The Update Correction command allows you to make color corrections to a sequence and 
then to edit additional material into the sequence without having to repeat much of your 
color correction work. When you return to Color Correction mode, you can instruct the 
Symphony system to apply existing color corrections to the new segments, based on their 
relationship to the existing material. The system updates any color corrections based on 
Source Tape, Clip Name, Master Clip, or Sub Clip relationships, or based on 
Program Track relationships. 

For example, you are working with a sequence that contains several segments from the same 
source tape. When you first perform a Source color correction pass, you correct these 
segments simultaneously using the Source Tape relationship. Later, you edit new segments 
from the same source tape into the sequence. You can now go back into Color Correction 
mode and use the Update Correction command to apply the color correction from the 
original segments to the new segments automatically.

The following illustrations show the stages of this process for a simple sequence.

Before Segment A corrected using 
Source Tape relationship

Segment B corrected using 
Source Segment relationship

A B

After new edit Segment C material is from the 
same source tape as segment A.

A B C

After update Color correction is applied to 
segment C, based on its Source 
Tape relationship with segment A.

A B C
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To update a color-corrected sequence:

1. In Source/Record mode, edit new material into a previously color-corrected sequence.

2. Click the Color Correction Mode button at the bottom of the Timeline to enter Color 
Correction mode.

3. Right-click (Windows) or Ctrl+Shift+click (Macintosh) in the Color Correction tool, 
and select Update Correction.

The Update Color Correction dialog box opens.

4. Select the Source and Program relationships you want the system to use when deciding 
which segments to update.

By default, all available relationships are selected.

5. Select Create New Sequence if you want the system to create a new copy of the 
sequence and update that copy.

n If you deselect Create New Sequence, the system updates the existing version of the 
sequence. Avid recommends that you create a new sequence when updating. You then retain 
the previous version as a backup. If you update an existing version of a sequence and want to 
return to the previous version, select Edit > Undo.

6. Click OK.

The system updates the sequence and adds color correction to the appropriate new 
segments. If you have selected Create New Sequence, a new sequence appears in the bin 
with the title [OldTitle].Copy 1. You can rename the sequence to indicate more clearly 
that it is an updated version.
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Understanding Color Correction Merging
Your workflow might make it useful to work with two versions of a sequence at the same 
time. For example, you might want an editor to work on one copy of a sequence while a 
colorist continues to make color adjustments on another copy. The Merge Correction 
command allows you to merge the two sequences to reflect the changes made on both 
copies.

Merge Correction merges any color corrections based on Source Tape, Clip Name, Master 
Clip, or Sub Clip relationships, or based on Program Track relationships, into the latest 
version of the edited sequence. For example, if the editor adds new segments from source 
tape 1, and a color correction exists for that source tape, the correction is applied to the new 
segments when the merge takes place. This is true whether the color correction was made 
before the editor began work or whether the color correction is made to the sequence while 
the editor is working with a copy of it. 

You can also control which of the two copies the system prefers if there is a conflict between 
the two copies when merging.

Merging Color-Corrected Sequences

The Merge Correction process begins with the creation of a new sequence, which is then 
copied. The two copies are worked on independently before being merged using the Merge 
Correction command. You can separate the two copies before you make any color 
corrections, or you can make initial corrections and then separate the two copies.

To work with two copies of a sequence and then merge the corrections:

1. Create a first version of your sequence.

2. (Option) Click the Color Correction Mode button at the bottom of the Timeline to enter 
Color Correction mode, and make initial color adjustments to the sequence.
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3. Save the sequence, and then create one or two copies of the sequence.

The way you handle copies of the sequence depends on the requirements of your 
workflow. You need only two versions of the sequence — the original and one copy. For 
example, the colorist might keep the original while the editor works on the copy. 
However, it might be safer to keep the original as a backup and to move forward in your 
workflow with two new copies. 

n Take care to name your copies clearly. For example, if you are creating two copies as well as 
keeping the original, you might use the extensions .Editor, .Colorist, and .Original to 
distinguish the three versions.

For more information on saving and copying a sequence, see “Basic Bin Procedures” in the 
Help.

4. Continue to work on the two copies independently.

5. When you are ready to merge the two copies, enter Source/Record mode, for example, 
by clicking the Source/Record button.

6. Load one copy of the sequence into the Source monitor and the other into the Record 
monitor.

You can load a copy into either monitor. The only difference is that the system merges 
into the sequence in the Record monitor unless you instruct it to create a new sequence 
for the merge in step 11.

7. Click the Color Correction Mode button at the bottom of the Timeline to enter Color 
Correction mode.

8. Right-click (Windows) or Ctrl+Shift+click (Macintosh) in the Color Correction tool, 
and select Merge Correction.

n The Merge Correction command appears dimmed in the Color Correction tool shortcut 
menu and cannot be selected until you load versions of a sequence in both the Source 
monitor and the Record monitor and enter Color Correction mode. 

The Merge Color Correction dialog box opens.
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9. Select the Source and Program relationships you want the system to use when deciding 
which segments to update in the merging process.

By default, all available relationships are selected.

10. Click the Conflict Resolution menu, and select an option to control how the system 
resolves conflicts between the two copies of the sequence:

11. Select Create New Sequence if you want the system to create a new copy of the 
sequence and merge into that copy.

If you deselect this option, the system merges the two copies into the sequence that is 
currently in the Timeline. This is the sequence that you loaded into the Record monitor 
before entering Color Correction mode.

12. Click OK.

The system merges the two existing sequences, based on the options you have selected. 
The merged sequence appears in the Timeline.

Option Description

Prefer Source Sequence Resolves conflicts by preferring the 
information in the sequence you loaded into 
the Source monitor.

Prefer Record Sequence Resolves conflicts by preferring the 
information in the sequence you loaded into 
the Record monitor.

Prefer Latest Resolves conflicts by preferring the most 
recent information. This is the default setting.

Conflict Resolution menu
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Color Correction Merging Example
The following example illustrates the capabilities of the Merge Color Correction command.

The original sequence for this example consists of seven segments that are derived from four 
different source tapes. For simplicity, the segments are edited together in exactly equal 
one-second lengths. The following illustration shows the original sequence before any color 
correction is performed.

The sequence now receives some initial color correction. Source Tape correction is applied 
to the material from source tapes 2 and 4. The following illustration shows the sequence 
after this initial color correction work.

At this point in the workflow, a copy is made of the sequence and an editor continues to 
work on the copy. At the same time, further color corrections are made to the original 
version of the sequence.

The editor makes the following adjustments:

• The fifth segment is replaced by another clip from source tape 2.

• A new segment from source tape 4 is added near the end of the sequence.

• The second segment is trimmed to double its length.

The numbers on the segments indicate the 
source tape from which each segment comes.

2 1 2 3 1 4 1

1. Original sequence

Segments from source tapes 2 and 4 have 
Source Tape corrections.

2. Sequence after initial color correction

2 1 2 3 1 4 1

3. Editor’s copy of sequence after further editing
New segment from 
source tape 4

Replacement segment 
from source tape 2

Lengthened segment 
after trimming

422 1 2 3 4 1
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The colorist modifies his or her version of the sequence by adding Source Tape correction 
for source tape 1.

The editor’s copy of the sequence is now out-of-date with respect to the colorist’s 
corrections. It contains segments from source tapes 1, 2, and 4 that need to be updated to use 
the Source Tape corrections for those tapes. When the two sequences are merged, the 
editor’s sequence is correctly updated. 

Flattening Color-Corrected Sequences
In some circumstances, you might want to convert a color-corrected sequence so that all the 
color corrections become segment-only relationships. This allows you to readjust the color 
correction in a single segment, even if it had previously been corrected as part of a broader 
relationship, without affecting any other segments. As with the other color correction 
sequence commands, you can define by relationship which groups of segments are converted 
to segment-only relationships.

4. Colorist’s copy of sequence after further correction

Source Tape correction added for source tape 1

2 1 2 3 1 4 1

5. Merge process

Editor’s copy Source Tape correction 
is applied to new shots.

Editor’s trim appears in 
merged sequence.

Colorist’s new correction to source tape 1 is 
applied in the merged sequence.

Merged sequence

Colorist’s copy

422 1 2 3 4 1

2 1 2 3 1 4 1

422 1 2 3 4 1
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The following illustrations show this process for a simple sequence.

To flatten a color-corrected sequence:

1. Click the Color Correction Mode button at the bottom of the Timeline to enter Color 
Correction mode.

2. Right-click (Windows) or Ctrl+Shift+click (Macintosh) in the Color Correction tool, 
and select Flatten Correction.

The Flatten Color Correction dialog box opens. The dialog box indicates the number of 
segments that are available for flattening in each relationship category.

Before flattening
Segments A and C are currently corrected using a Source Tape relationship. You cannot 
adjust the Source color correction for one segment without affecting the other.

A B C

After flattening
All three segments are now governed by a segment-only relationship. You can adjust 
each of them independently without changing any other segment.

A B C
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3. Select the Source and Program relationships you want the system to use when deciding 
which segments to flatten.

By default, all available relationships are selected.

4. Select Create New Sequence if you want the system to create a new copy of the 
sequence and flatten segments on that copy.

n If you deselect Create New Sequence, the system flattens the existing version of the 
sequence. Avid recommends that you create a new sequence when flattening. You then retain 
the version that has not been flattened as a backup. If you flatten an existing version of a 
sequence and want to return to the previous version, select Edit > Undo.

5. Click OK.

The system converts the segments you have selected to segment-only relationships. If 
you have selected Create New Sequence, a new sequence appears in the bin with the title 
[OldTitle].Copy 1. You can rename the sequence to indicate more clearly that it is a 
flattened version.

Removing Color Corrections
You can remove the color correction on a specific segment at any time by clicking the 
Remove Effect button in the Composer window while in Color Correction mode.

You can also remove groups of corrections with the same associated relationship using the 
Remove Correction command. This is useful for removing all corrections, or large numbers 
of corrections, at the same time.
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To remove corrections using the Remove Correction command:

1. Click the Color Correction Mode button at the bottom of the Timeline to enter Color 
Correction mode.

2. Right-click (Windows) or Ctrl+Shift+click (Macintosh) in the Color Correction tool, 
and select Remove Correction.

The Remove Color Correction dialog box opens. The dialog box indicates the number of 
segments in the sequence for each relationship category.

3. Select the Source and Program relationships you want the system to use as the criteria 
for removing segments.

By default, all relationships are selected.

4. Select Create New Sequence if you want the system to create a new copy of the 
sequence and remove segments only from that copy.

n If you deselect Create New Sequence, the system updates the existing version of the 
sequence. Avid recommends that you create a new sequence when removing groups of 
corrections. You then retain the previous version as a backup. If you remove corrections from 
the existing version of a sequence and want to return to the previous version, select 
Edit > Undo.

5. Click OK.

The system removes color correction for all segments governed by the relationships you 
have selected. If you have selected Create New Sequence, a new sequence appears in the 
bin with the title [OldTitle].Copy 1. You can rename the sequence to indicate more 
clearly that it is a version from which some corrections have been removed.
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7 Color Correction Techniques

This chapter provides a basic introduction to color correction techniques. It suggests some 
general principles to keep in mind when you are assessing footage and making color 
corrections. The chapter then presents two examples of shots with typical color problems 
and detailed explanations of adjustments that improve those shots.

This information is intended primarily for users who are unfamiliar with the methods of 
color correction and who want some initial guidance on how to handle material that needs 
correction. However, since the chapter is built around specific examples of color corrections 
made with the Color Correction tool, it might also be useful for anyone learning to work 
with the tool and its controls, even an experienced colorist.

This chapter contains the following main topics:

• Guiding Principles for Color Correction

• Examples of Color Correction Problems

Guiding Principles for Color Correction

One useful high-level way to think about the color correction process is to define what the 
overall goals of the process are. Another, slightly more practical and detailed, is to break 
down the typical color correction workflow into clearly defined stages of adjustment. The 
following topics use these two approaches to provide you with a set of guiding principles for 
color correction.

• Goals of Color Correction: Restoration and Adaptation

• Restoring the Original Look

• Adapting the Original Look

• Stages of Color Correction

• Correcting Tonal Range

• Neutralizing Color

• Achieving Shot-to-Shot Consistency

• Achieving a Final Look
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Goals of Color Correction: Restoration and Adaptation

You can think of color correction as having two main goals:

• Restoring the original look of the scene

• Adapting the look of the scene to meet the demands of the project

In some cases, the task of color correction is complete when the first goal has been met. 
Often, however, there is at least some departure from the restored look to achieve 
shot-to-shot consistency or to convey creative concepts. The color corrections applied to any 
particular shot must therefore respect (to varying degrees) two different contexts: the 
original scene at the time the camera captured it and the final situation of the shot within a 
program that has particular creative or communicative aims.

Restoring the Original Look

The first task in color correction is to restore the original look of the scene that has been 
filmed — in other words, to make the image match as closely as possible what an observer 
standing beside the camera would have perceived when the scene was shot.

This is important primarily because viewers have little tolerance for images that have 
unrealistic color values. For example, when a skin tone departs from our normal 
expectations of what skin should look like, we notice. Even when the final image is 
intentionally a distortion of reality, it is useful to restore the original look as a well-balanced 
foundation for subsequent alterations.

The color characteristics of a given shot can depart from the look of the original scene for a 
variety of reasons. At the time of shooting, the camera might not be correctly balanced or the 
scene might be imperfectly lit. During transfers (from film to tape, from one tape to another, 
or from tape to captured media), inconsistencies in materials, processing methods, or 
calibration might alter the colors.

When you are working on an uncorrected shot, you should make intelligent decisions about 
what the scene originally looked like and then bring the shot into line with those decisions as 
much as possible. Since it is unlikely that you were present when the scene was shot, this 
might seem to require a great deal of guesswork, but, in fact, it can be accomplished with 
sufficient accuracy using the following two basic guidelines.

• The human visual system generally maximizes the tonal range available in a scene. For 
example, in low light we adjust to perceive a greater range of dark tones.

• The human visual system generally perceives color accurately and compensates for 
color casts. For example, we perceive a white shirt as white even if it is being 
illuminated by slightly pink light.
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Generally, you can restore the original look of a shot (or at least create a believable 
approximation of the original look) by opening up the tonal range as much as reasonably 
possible and by ensuring that colors look accurate. For more detailed information on how to 
achieve this with adjustments, see “Correcting Tonal Range” on page 306 and “Neutralizing 
Color” on page 307, and the examples later in this chapter.

Adapting the Original Look

An adaptive adjustment deliberately departs from the original look of the scene in some way. 
Such an adjustment might be relatively subtle, for example, lightening one shot to make it 
match another. In this case, you are departing from your commitment to the original look in 
order to achieve shot-to-shot consistency in your sequence. Other kinds of adaptive 
adjustment might be much more dramatic, for example, applying a gold tint to an entire 
sequence for an advertising spot or applying extreme adjustments such as posterization or 
chroma inversion for a music video.

You should generally try to achieve an effective restorative adjustment before you begin 
adaptive adjustments. You will then be building on an image that has good color 
characteristics. Most viewers can probably perceive the difference between a restored, 
well-balanced image with a strong blue tint applied and an unrestored, poorly lit image with 
a strong blue tint applied (and prefer the former).

Remember that your Avid editing application is capable of two levels of color correction and 
that some kinds of adaptive adjustments, especially if they are to apply equally to every shot 
in a sequence, are best applied as Program relationships. However, if your correcting work 
involves only restoration and simple matching for consistency from shot to shot, it is 
probably better to do all your work as Source relationship corrections. This keeps your color 
corrections as a whole simpler and preserves the Program relationship option for any final 
adjustments that you might want to make.

Stages of Color Correction

A typical color correction for a shot will probably include the following main stages of 
adjustment:

• Correcting the tonal range (or contrast ratio)

• Neutralizing color casts

• Achieving consistency between the shots in a sequence

• Achieving a final look
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Different kinds of projects lead to different emphases among these stages and might even 
make some unnecessary. Different working habits also affect how these stages are handled. 
A more experienced colorist might work in a manner that blurs the distinctions between 
them. For a beginner, it might be better to keep them distinct and achieve an acceptable 
result for each one before moving on to the next.

Correcting Tonal Range

Correcting the tonal range usually requires two steps. In the first step, you reset the white 
and black points to make the range of values between the lightest part of the image and the 
darkest part of the image as large as possible. In the second step, you adjust the gray point to 
control how much of the total tonal range falls above and how much below the middle value.

Setting White and Black Points

Setting the white point and the black point is often relatively straightforward, since the shot 
includes an area that should obviously be very light and another area that should be very 
dark. You simply look for what should be the lightest area of the image and adjust controls 
until it becomes as light as possible, and then do the same for the area that needs to be black. 
You can dramatically improve the quality of shots taken using insufficient or excessive light 
just by making white and black point adjustments.

In some cases, however, the shot should have less range of brightness (for example, when the 
whole scene was originally in shadow or was shot at sunset). In such cases, you need to be 
careful to expand the range as much as possible without making parts of the image 
unrealistically light or dark.

Avoid clipping any significant part of the image. You want the range between your lightest 
value and your darkest value to be as large as possible, but in most circumstances you don’t 
want to lose detail by reducing all your very light values to white or all your very dark values 
to black. 

Do not use intense reflected spots of light (known as speculars) to judge where your white 
point should be. If you do so, you define white by an artificial standard that probably occurs 
in only a tiny fraction of the image. A true white object such as an item of clothing might 
appear dull and gray by this standard.

You have a number of choices for controls to use to make white point and black point 
adjustments, including the Gain and Setup sliders in the HSL tab and the various controls in 
the Levels tab.
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Adjusting the Gray Point

Once you have established the range from the brightest part of the image to the darkest part, 
you can adjust the gray point if necessary. When you make a gray point adjustment, you 
define how much of the overall tonal range is between black and midgray, and how much is 
between midgray and white. 

The most obvious effect of a gray point adjustment is that it either lightens or darkens the 
overall look of the image. Large adjustments of the gray point toward either the black point 
or the white point are almost always undesirable because they leave the whole image much 
too dark or too light.

Smaller, well-chosen gray point adjustments, however, can be useful for fine-tuning the 
overall brightness of the image. Also, since a gray point adjustment expands the tonal range 
on one side of the midpoint and contracts it on the other, it can be useful for improving 
contrast and detail overall. For example, some images look better if more contrast is 
available in the range between gray and white, even though the price paid for that extra 
contrast is a reduction in contrast between gray and black.

The main controls for making gray point adjustments are the Gamma slider in the HSL 
group and the gray point controls in the Levels group.

Neutralizing Color

Neutralizing color involves returning the colors in an image to the colors that a viewer would 
have perceived when standing beside the camera. Most film or video images depart from that 
ideal to some degree, and some depart from it dramatically.

One way to think about neutralizing color is to imagine working on a project where every 
shot includes a large card that we know is, when viewed in ideal lighting conditions, a 
perfectly neutral midgray color. If you can correct each image so the card appears midgray 
when your audience views the final program, all other colors in the images should be correct 
also.

Though you cannot normally have such a perfect measuring device in your images, it is 
useful to select an area of each image as a target for your color neutralizing adjustments. If 
you focus on getting the color in that area right, color in the rest of the image should fall into 
place. In some images, there might be an object or area that should be neutral gray, or nearly 
so, and you can use that area as your principal target as you make adjustments. In fact, this is 
exactly how you make corrections to remove color casts using the Remove Color Cast 
buttons. In other images, you might not have any gray color at all, but you will almost 
certainly have some other area where even a small departure from neutral color is noticeable. 
Human skin is probably the most common example. Or you might choose to focus on an 
area where you know the true color, such as a person’s hair.



7  Color Correction Techniques

308

In addition to identifying parts of your image on which to concentrate your attention, it is 
useful to establish how the uncorrected image departs from neutral color before you attempt 
to correct it.

Sometimes this is obvious. You cannot mistake an image with an extreme pink or yellow 
cast. When the problem is more subtle, you can sample a few areas with the Color Match 
eyedropper to get information about the color characteristics of the image. Areas that should 
be white or black are particularly helpful, since these are easily identifiable colors that 
should have nearly identical values for red, green, and blue. If the red value is higher than 
the other two, the image has a red cast. If red and green are higher than blue, the image has a 
yellow cast.

You can neutralize color using many different controls in the Color Correction tool. For 
example, you can use the Curves tab to adjust the proportions of each color. You can use the 
Hue and Saturation sliders in the Highlights, Midtones, and Shadows tabs of the HSL group. 
Or you can use the Hue Offsets color wheels, which allow you to quickly locate the sector of 
the wheel that represents the color cast in the image, and then adjust in the opposite direction 
to that color. Except when a color problem is extreme, you are usually more successful when 
neutralizing color if you make adjustments in individual colors or in specific brightness 
ranges rather than in the Master controls.

The more experienced you become as a colorist, the better you will get at judging even 
subtle color problems by eye and knowing intuitively what kinds of adjustments to make.

Achieving Shot-to-Shot Consistency

The most common reason for departing from the look of the original shot is to achieve 
simple shot-to-shot consistency in the finished program. If a scene in a drama that is 
supposed to take place at one time is shot over two days, and lighting conditions have 
changed from one day to the next, you clearly want to adjust all the shots so they appear to 
be taking place at the same time.

Adjustments for shot-to-shot consistency are relatively straightforward in most cases. You 
simply need to compare shots in the Composer window and then adjust them to match. If 
you have already adjusted tonal range and neutralized color well, a small change to relative 
brightness might be all that is needed. 

Depending on the requirements of your project, you might choose to make adjustments for 
shot-to-shot consistency as Source or as Program relationship corrections. If you have made 
a lot of earlier Source relationship adjustments and you know you do not need to make 
overall adjustments for a finished look, you might choose to move to Program relationships 
to make shot-to-shot corrections. If you expect to need Program relationships for significant 
finishing adjustments that apply across all the segments in your sequence, you should stay 
with Source relationships when making shot-to-shot adjustments.
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Achieving a Final Look

Some projects might require final adjustments to create a finished look. For example, you 
might slightly increase saturation across the whole sequence to create richer-looking colors 
or slightly darken all the shots to enhance a mood of tension or suspense. In certain 
circumstances, you might make substantial changes to the color values of the whole 
sequence or remove color entirely from some parts of it. 

You usually make final corrections of this kind as Program relationship corrections by 
correcting entire program tracks or extended parts of sequences defined by IN and OUT 
points. It is not possible to generalize about which controls to use to make such adjustments. 
You might be called upon to use any combination of color correction controls. The only 
effective preparation for such work is practice using the Color Correction tool and a good 
understanding of the more specific corrections discussed in the sections above. 

Examples of Color Correction Problems
The following topics present examples of typical color correction problems.

• Example 1

• Example 2

• Example 3

The original images are chosen as good illustrations of the kind of color correction work that 
needs to be done to restore a good approximation of what an observer at the scene would 
have perceived when the camera was shooting. They require corrections to improve tonal 
range and to neutralize color casts.

Each example provides the following information:

• An analysis of the original image

• Step-by-step descriptions of the corrections with illustrations (including split-screen 
displays in some instances)

• Sample RGB values that illustrate the results of the corrections

• Suggestions for alternative ways to achieve similar results with the Color Correction 
tool
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Remember that these examples are presented as aids to learning, not as inflexible 
instructions for making corrections or models of what a perfect corrected image looks like. 
Each example shows only one possible way of making a correction and one possibility for a 
final corrected image. As you develop your own color correcting skill and judgment, you 
might prefer to use different combinations of controls and to aim for a slightly different final 
look.

n If you are reading a black-and-white hardcopy version of this document, you will find it 
useful to view the color images in the online version of the document available from the 
Online Library for your Avid editing application (Help > Online Library).

Example 1

Analysis of original image: This image has two obvious problems. First, it lacks contrast 
and detail because it does not have a full tonal range. A correction is required to improve 
sharpness and detail in areas such as the shirt and the man’s hair. Second, the image has a 
strong yellow-green cast. This leads in particular to a very unnatural skin tone.

Uncorrected Image
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Step 1 of this correction is an adjustment to the Contrast slider in the Master Controls tab of 
the HSL group. This adjustment (which sets the Contrast slider value to 11) illustrates one of 
the simplest ways to affect the tonal range of an image. Despite its simplicity, the correction 
improves the image noticeably. Compare the look of the man’s hair on either side of the 
split-screen dividing line.

Step 1: Contrast Correction

Split Screen: Uncorrected Image and Step 1 Correction
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Step 2: Correction to Neutralize Color

Step 2: Correction 
to Neutralize Color

Split Screen: Uncorrected Image and Image After All Corrections
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Step 2 of this correction eliminates the color cast by making a single adjustment on the 
Master Hue Offsets ChromaWheel control in the HSL group. Since the image is obviously 
too green, the correction is made by moving the crosshair pointer away from green. The 
adjustment shown is Hue:–94, Amount:11. (This places the crosshair between the magenta 
and blue parts of the wheel, opposite a point between green and yellow. The sample RGB 
values below confirm that we are reducing both yellow and green in the image.) This 
successfully restores a good skin tone and reveals the man’s shirt to be blue.

Sample RGB values: A sampling of an area of the man’s shirt before and after the 
corrections shows the following values:

Before: R:37, G:56, B:61

After: R:14, G:26, B:55

These numbers reinforce the nature of the corrections that have been made. The hue offset 
adjustment has reduced the red and green levels significantly while preserving the amount of 
blue in the image.

Alternative techniques: This example uses simple corrections that apply across the full 
luminance range. Another method for correcting this image would involve making 
individual adjustments in different ranges such as highlights and shadows. For an illustration 
of this approach, see “Example 2” on page 313. The contrast adjustments could be made 
using the Gain, Gamma, and Setup sliders as an alternative to the one adjustment on the 
Contrast slider. Another alternative for making the contrast adjustment would be to use the 
controls in the Levels tab.

Example 2

Uncorrected Image
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Analysis of original image: The highlight areas of this image (primarily the shirts) are not 
particularly bright, and the shadow areas (such as the underside of the cap brim) could be 
darker. Rebalancing white and black will improve contrast and sharpen the image 
throughout. Also, the image has a red cast, apparent in the slightly pink tone of the shirts. A 
good color-neutralizing correction will eliminate that cast without taking too much red out 
of the skin tones. Since the skin tones are relatively good in the image already, successful 
corrections will not disturb the midtones very much. The corrections in this example are 
therefore made primarily in the highlights and shadows luminance ranges.

Step 1 of this correction adjusts the Gain and Saturation sliders in the Master Controls tab. 
Gain is increased to 103.70, Saturation to 106.17. This brightens the whole image slightly 
and intensifies color throughout to correct the slightly dull look of the original.

Step 1: Corrections in Master 
Controls Tab

Step 2: Correction in Highlights 
Controls Tab
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Step 2 makes a large adjustment to the Gain slider in the Highlights Controls tab. Gain is 
increased to 148.15. This brightens the highlight areas considerably and brings much more 
sharpness and contrast into the lighter areas of the cap and into the shirt in the lower 
right corner.

Step 3 makes adjustments in the Shadows Controls tab. Saturation is reduced to 66.67 and 
Setup is reduced to –9. This makes the darkest areas of the image more nearly black and 
further contributes to the building of contrast in the image.

Step 3: Corrections in Shadows 
Controls Tab

Step 4: Correction to Neutralize 
Color
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Step 4 neutralizes the color cast in the highlights range by making a large adjustment in the 
Highlights color wheel. The adjustment values are Hue:–167.76, Amount:41.32. This 
removes the pink look in the shirts (most apparent by comparing the shirt in the background 
between Step 3 and Step 4). Since the adjustment is made in the highlights range only, it 
doesn’t result in an extreme loss of the red component of the skin tones.

Sample RGB values: A sampling of the darkest shadow area of the cap before and after the 
corrections shows the following values:

Before: R:24, G:24, B:22

After: R:14, G:15, B:17

These values confirm that corrections in the shadows area have resulted in shadows that are 
a more intense black. 

Alternative techniques: The Curves tab is the only other part of the Color Correction tool 
that allows adjustments that affect luminance ranges differently in the manner of this 
example. A similar final result could probably be achieved in the Levels tab, but the 
adjustments there are made on individual color channels rather than on different overall 
luminance ranges.

Split Screen: Uncorrected Image 
and Image After All Corrections
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Example 3

Analysis of original image: In this example, two different cameras have been used to shoot 
the rock climbers. The second camera is correctly balanced and shows good color 
characteristics. In comparison, the images from the first camera show a pronounced blue 
cast. Also, the image from the first camera is too dark. Because the images from the two 
cameras look so different from one another, and because the first image is intrinsically weak, 
corrections are needed to neutralize color and raise the brightness level in the first image. 
The image from the good camera can be used as a reference as these corrections are made. In 
this example, the corrections are made in the Curves tab. One advantage of Curves tab 
adjustments, if you are practiced and comfortable with them, is that you can make quite 
complex changes without having to alter many controls. The corrections in this example are 
made by adding and moving a single control point in each of two ChromaCurve graphs.

Uncorrected Image Reference Image
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Step 1 of this correction removes the excess blue in the image by adjusting the Blue 
ChromaCurve graph in the Curves tab. A control point is placed near the center of the curve 
since the adjustment needs to apply relatively evenly across the whole luminance range. The 
control point is then dragged down to reduce blue. The input and output values for this 
adjustment are 142 and 104 respectively. 

Step 1: Correction to Neutralize Color

Split Screen: Uncorrected Image and Step 1 Correction
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Step 2 of this correction increases the brightness of the image by making an adjustment on 
the Master ChromaCurve graph in the Curves tab. The control point is placed three-quarters 
of the way up the curve and moved up and to the left. The input and output values for this 
adjustment are 178 and 213 respectively. The resulting curve increases brightness 
throughout the image but increases it most in the highlights range. This creates more 
contrast in the lower three-quarters of the luminance range (in a ChromaCurve graph, 
contrast is greater where the curve is steeper).

Step 2: Correction to Match Brightness of Reference Image

Split Screen: Uncorrected Image and Step 2 Correction
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The following illustration compares the corrected image to the reference image from the 
good camera. Some fine-tuning is still possible to match the shots more precisely, but the 
images from the two cameras are now much closer to one another and will look more 
acceptable when viewed in the sequence.

Sample RGB values: A sample of one of the climber’s white helmets before and after the 
correction and in the reference image shows the following values:

Before: R:113, G:139, B:211

After: R:142, G:152, B:174

Reference: R:146, G:174, B:185

Though these samples might not be from precisely the same part of the helmet in all three 
cases, they clearly confirm the nature of the correction. They indicate a relative gain in red 
and green levels, a reduction in blue levels, and a much closer match with the levels in the 
reference frame.

Alternative techniques: The Blue curve correction could be made in the Hue Offsets tab, in 
the Blue Levels tab, or even with a series of adjustments to the HSL sliders in the Controls 
tab. The brightness and contrast adjustment could be made in the HSL tab (using similar 
techniques to those in examples 1 and 2), or it could be made by adjusting white and gray 
points in the Levels tab.

Reference Image and Corrected Image



8 Spot Color Correction

If your Avid editing application uses the advanced color correction interface, you can apply 
color adjustments to parts of images that you define by drawing. You can make these 
adjustments using the Spot Color Correction effect or using color adjustment modes in the 
Paint Effect. Both effects include the Color Match control for making automatic adjustments 
based on selected input and output colors.

• Understanding the Spot Color Correction Effect

• Making Corrections Using the Spot Color Correction Effect

• Using Paint Effect Modes for Color Adjustment

Understanding the Spot Color Correction Effect
The Spot Color Correction effect allows you to make precise color adjustments to a part of 
an image that you define using the Intraframe drawing tools. 

For example, you can outline a figure in a shot or isolate a single object and then adjust the 
color of that figure or object without affecting the color of the rest of the image. As with 
other Intraframe effects, you can use keyframes to adjust the effect over time.

Spot color correction is commonly used as a storytelling device that emphasizes part of an 
image by giving it distinct color characteristics. You can also make color corrections using 
spot color correction whenever you want a color adjustment to be restricted to part of the 
image only.

In many circumstances, you can correct the color in selected areas of an image more quickly 
and easily using the secondary color correction capabilities of the Color Correction tool. 
However, color corrections that define part of an image using drawing tools are sometimes 
the only way to isolate the exact area of an image that you need to correct. For more 
information on secondary color correction, see “The Secondary Group” on page 250.
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The following illustrations show two basic examples of spot color correction. In the first 
example, the background of the shot is outlined with a drawing tool and then desaturated and 
lightened, leaving the car as the only part of the image in color. Additional shapes within the 
main outline of the car have been used to remove any color visible through the car’s 
windows. In the second example, the straw bale on the left is outlined with a drawing tool 
and then enhanced with color adjustments to give it a stronger golden-yellow appearance.

n If you are reading a black-and-white hardcopy version of this document, you will find it 
useful to view the color images in the online version of the document available from the 
Online Library for your Avid editing application (Help > Online Library).

n You can also make color adjustments to Intraframe objects using various modes in the Paint 
Effect. However, you can apply only one kind of adjustment to a selected area using the Paint 
Effect. Using the Spot Color Correction effect, you can enable several kinds of color 
adjustments at the same time.
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Making Corrections Using the Spot Color 
Correction Effect

To make corrections using the Spot Color Correction effect:

1. Select Tools > Effect Palette.

The Effect Palette opens.

2. Click the Image category.

3. Click the Spot Color Correction Effect icon in the Effect Palette, and drag it to the 
segment you want to correct in the Timeline.

4. Click the Effect Mode button to enter Effect mode.

5. From the Effect Editor, select a drawing tool, such as the Polygon tool.

6. Use the drawing tool to define the area on the image that you want to correct.

For more information on working with the Intraframe drawing tools, see “Intraframe 
Editing” in the Help.

7. Adjust parameters in the Effect Editor until you are satisfied with the look of your 
correction.

For information on the parameters available, see “Image: Spot Color Correction” in the 
Help.

8. (Option) If necessary, repeat steps 3 through 6 to define and adjust additional areas for 
correction.

9. (Option) If necessary, use keyframes to adjust the corrected areas over time so that they 
follow movements in the footage.

For more information on keyframing Intraframe objects, see “Intraframe 
Example:Animating a Matte Key Effect” in the Help.

10. Render the effect to play it back in real time.

Using Paint Effect Modes for Color Adjustment
Using some of the modes in the Paint Effect, you can adjust the color of a selected area that 
you have defined.

The main difference between color correction using the Paint Effect and color correction 
using the Spot Color Correction effect is that the Paint Effect can be used to apply only one 
kind of color adjustment. For example, you can adjust the luma range of a selected area by 



8  Spot Color Correction

324

selecting the Luma Range mode of the Paint Effect, but you cannot then make an adjustment 
to the red color channel using the Color Gain mode. The Paint Effect can apply only one 
mode to an object.

To make a correction to an area in an image using a Paint Effect mode:

1. Select Tools > Effect Palette.

The Effect Palette opens.

2. Click the Image category.

3. Click the Paint Effect icon in the Effect Palette, and drag it to the segment you want to 
correct in the Timeline.

4. Click the Effect Mode button to enter Effect mode.

5. From the Effect Editor, select a drawing tool, such as the Polygon tool.

6. Use the drawing tool to define the area on the image that you want to correct.

For more information on working with the Intraframe drawing tools, see “Intraframe 
Editing” in the Help.

7. In the Mode parameter category, click the Fast Menu button, and select one of the 
following color adjustment modes:

- Luma Adjust

- Luma Range

- Luma Clip

- Chroma Adjust

- Color Style

- Color Gain

- Color Match

8. Adjust the parameters in the Mode parameter category until you are satisfied with the 
look of your correction.

For information on Paint Effect modes, see “Image: Paint Effect” in the Help.

9. (Option) If necessary, repeat steps 5 through 8 to define and adjust additional areas for 
correction.

10. (Option) If necessary, use keyframes to adjust the corrected areas over time so that they 
follow movements in the footage.

For more information on keyframing Intraframe objects, see “Intraframe Example: 
Animating a Matte Key Effect” in the Help.

11. Render the effect to play it back in real time.
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Avid Color Correction allows you to set safe limits for the colors that display in your images 
— that is, limits beyond which the application issues a safe color warning. You can also limit 
colors to safe ranges by applying the Safe Color Limiter effect.

The following topics provide all information about the Safe Colors feature of your Avid 
editing application that is not covered in “Avid Color Correction: Basics” in the Help:

• Overview of Safe Color Limits

• Safe Color Settings Options

• Understanding the Graphical View of Safe Color Settings

• Understanding Safe Color Warnings

• Safe Color Limits with Waveform and Vectorscope Information

• Working with the Safe Color Limiter Effect

Overview of Safe Color Limits
Your Avid editing application allows you to set three different types of safe color limits. You 
can set limits for the composite signal range, the luminance range, and the RGB gamut. Your 
Avid editing application can issue safe color warnings when the color values in your video 
material fall outside these limits. Your Avid editing application can also use these limits as 
the default parameters for the Safe Color Limiter effect.

Most broadcasting companies set specific limits for the composite signal and the luminance 
range. Programs that do not meet these limits are not normally accepted for broadcast. For 
example, a typical set of limits for broadcast in the United States might restrict the 
composite signal to a range from –20 IRE to 110 IRE and limit the maximum luminance to 
approximately 100 IRE. Some broadcast standards might be even stricter than these values, 
while others might be somewhat more permissive. 

n The composite signal for a program intended for broadcast should never exceed 120 IRE, 
which is the highest level that can be broadcast.
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If you are working on a program intended for broadcast, you should determine what the safe 
limits for composite and luminance are and type them in the appropriate areas of the Safe 
Color Settings dialog box. You can then instruct the system to warn you when those limits 
are exceeded. For more information, see “Safe Color Settings Options” on page 326.

RGB gamut refers to the intensity of each individual color channel — red, green, and blue. 
This measure of a safe color is less likely to be subject to specific broadcast standards, but it 
is still an important limit type. Colors that have extremely low or high gamut values might 
not display well on television screens. 

Safe Color Settings Options
You set safe color limits and control how those limits are applied by selecting options in the 
Safe Color Settings dialog box. For information on how to open the Safe Color Settings 
dialog box and set limits and options, see “Managing Safe Color Warnings” in the Help.

The following table describes the available limit types, units of measurement, and types of 
action in the Safe Color Settings dialog box.

n The Safe Color Settings button in the Color Correction tool provides a visual indication of 
the status of the Safe Colors feature. If Warn is selected in one or more of the Actions menus, 
the icon on the Safe Color Settings button appears orange to indicate that at least some of 
the Safe Colors options are active. Otherwise, the icon on the Safe Color Settings button 
appears black.

Option Description

Composite Sets safe color values for the composite video signal.

Luminance Sets safe color values based on brightness.

RGB Gamut Sets safe color values based on color range.



Understanding the Graphical View of Safe Color Settings

327

Understanding the Graphical View of Safe Color 
Settings

The Safe Color Settings dialog box includes a graphical indication of the current limit values 
in relation to the default values. This allows you to quickly check that your limits are 
consistent with one another and within an acceptable range without having to read all the 
numerical limit values and remember the default values.

The following illustration shows the location of this graph within the Safe Color Settings 
dialog box. All settings in this illustration are at their default values.

Units buttons Define the units of measurement for the three types of safe color values.

Click the Composite Units button and select either IRE or mVolts (millivolts).

Click the Luminance and RGB Gamut buttons and select from the following options:

• 8 Bit: Measures the adjustment on a scale from 0 to 255.

• % (percent): Measures the adjustment on a percentage scale. Percentage values 
can be lower than 0 or higher than 100..

• IRE: Measures the adjustment in IRE units.

• mVolts: Measures the adjustment in millivolts.

n The RGB value for a color in the Color Correction tool will not be identical to 
the RGB value for the same color in a graphics application such as Adobe® 
Photoshop®. For example, the 8-bit RGB values for reference black and 
reference white are 16 and 235 respectively.

Actions buttons Define how your Avid editing application implements the safe color settings. The top 
button controls both the Composite and the Luminance limit types; the bottom button 
controls the RGB Gamut limit type. 

Click an Actions button and select from the following options:

Ignore — Your application does not limit based on these settings. This is the default 
setting.

Warn — Your application provides warnings when these limits are exceeded. For 
more information on safe color warnings, see “Understanding Safe Color Warnings” 
on page 329.

Option Description
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The graph shows colored bars that represent the current low and high levels for each limit 
type. The colors are the same as those used to display safe color warnings in the monitors. It 
also displays gray vertical lines that represent the default high and low levels for each limit 
type.

The following illustrations present two graphs in detail — the first showing default levels 
and the second showing adjusted levels — and explain how to interpret the graphs.

Safe Color Settings graph

Default Safe Color Settings

Default settings 
values

Default settings 
graph

On the default Safe Color Settings graph, all the 
color bars are aligned with the gray vertical lines 
that represent the default numerical values.

Composite
Luminance

Red

Green

Blue

Low-limit 
indicator bars

High-limit 
indicator bars

Gray lines mark 
default values 
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Understanding Safe Color Warnings
If you select the Warn option for one or more of the types of safe limit, your Avid editing 
application displays warnings when material exceeds the limits you have set. You select the 
Warn option using the Actions button as described in “Managing Safe Color Warnings” in 
the Help.

Warnings appear in the monitors for all limit types — Composite, Luminance, and RGB 
Gamut. (Warning indicators do not appear unless color levels exceed at least one of the 
limits currently set to Warn.) For more information, see “Safe Color Warnings in the 
Monitor Window” in the Help.

Warnings appear in the Color Match control for RGB Gamut limits only.

n Safe color warnings appear when you exceed limits in either field of the frame if you are 
working with two-field media. To move through video material one field at a time and see 
histograms for every field, use the Step Forward One Field button or the Step Backward One 
Field button. In Color Correction mode, these buttons are available on the Move tab of the 
Command palette. You can also map these buttons to your keyboard to use them quickly 
while using Color Correction mode.

Adjusted settings 
values

Adjusted settings 
graph

Adjusted Safe Color Settings

On the adjusted Safe Color Settings graph, 
colored bars that extend beyond the gray lines 
toward the middle of the graph indicate more 
restrictive settings than the defaults. Bars that 
retreat from the gray lines toward the outside of 
the graph indicate more permissive settings than 
the defaults.

High composite and luminance settings 
are now more permissive than the 
defaults represented by the gray lines.

All low limit settings (and RGB high 
settings) are now more restrictive than the 
defaults represented by the gray lines.
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Safe Color Warnings in the Color Match Control

If you select the Warn option for the RGB Gamut limit type, your Avid editing application 
displays warnings in the color swatches of the Color Match control when values exceed the 
limits you have set. If you use the eyedropper to select an input or output color that exceeds 
limits, a warning triangle appears beside the color information in the appropriate color 
swatch. The following illustration shows a swatch with typical Safe Color warnings.

Making Adjustments to Achieve Safe Color Values

If some of your color levels exceed limits, you can return them to safe color values by 
adjusting the color correction controls in any combination. The following procedures show 
how to make various adjustments using the Controls subdividing tab of the HSL group and 
the Curves group.

n You can also use the Safe Color Limiter effect to achieve safe color values automatically. For 
more information, see “Working with the Safe Color Limiter Effect” on page 333.

To bring luminance within safe limits:

1. Click the Controls subdividing tab in the HSL group.

The Controls tab opens.

2. Click the Enable button for the HSL group and the Controls subdividing tab.

3. Click the Enable button for Clip Low and Clip High controls to activate them.

4. Type 16 in the Clip Low text box, and press Enter (Windows) or Return (Macintosh).

5. Type 235 in the Clip High text box, and press Enter (Windows) or Return (Macintosh).

Luminance values are clipped to safe levels.

To bring RGB values within safe limits:

1. In the Master ChromaCurve graph of the Curves tab, click the lower left control point to 
select it.

A circle appears around the point.

2. Under the Master ChromaCurve graph, type 16 in both the input text box and the output 
text box.

The control point moves to 16, 16. Your Avid editing application adjusts RGB values 
under 16 up to 16.

In this example of a swatch for an intense white, both the Red and 
Green levels exceed the High RGB Gamut setting of 235 and warning 
triangles appear. The Blue value remains just within the limit.
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3. In the Master ChromaCurve graph of the Curves tab, click the upper right control point 
to select it.

A circle appears around the point.

4. Under the Master ChromaCurve graph, type 235 in both the input text box and the 
output text box.

The control point moves to 235, 235. Your Avid editing application adjusts RGB values 
above 235 down to 235.

To bring composite levels within safe limits:

1. First adjust luminance and RGB levels using the previous procedures.

If composite levels do not fall within safe limits, continue with step 2.

2. Click the Curves tab.

3. If the composite high warning is on, do the following:

t In the Master ChromaCurve graph, Shift+click the upper right control point, and 
drag it down the curve until the composite high warning turns off.

4. If the composite low warning is on, do the following:

t In the Master ChromaCurve graph, Shift+click the lower left control point, and drag 
it up the curve until the composite low warning turns off.

Safe Color Limits with Waveform and Vectorscope 
Information

To stay well within the limits of television transmitters, cable systems, satellite links, DVD 
encoders, and so on, broadcasters or distributors often issue safe color limits for video levels. 
Video levels outside safe color limits are generally known as “illegal.” A program with 
illegal levels might be rejected on technical grounds or the image quality might suffer with 
further processing. If you know that your delivery master is a VHS tape that does not handle 
high chroma well, set some reasonable limits by yourself.

In Y (luma only) waveforms, reference white of 100% corresponds to a digital level of 235, 
an NTSC level of 100 IRE, and a PAL level of 700 mV. White excursions up to 108% are 
technically possible.

In Y (luma only) waveforms, reference black of 0% corresponds to a digital level of 16, an 
NTSC level of 7.5 IRE, and a PAL level of 0 mV. Black excursions down to –8% are 
technically possible.
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n With both white and black levels, further signal processing (down the line from your Avid 
editing system) might clip the peaks in your material. In addition, you might be required by 
delivery specifications to limit the white peaks to a lower level and the black peaks to a 
higher level. 

Use Y Waveform to see the black and white levels of your image. Sometimes, particularly 
with white levels, keeping the white peaks within the 100% limit does not produce a 
pleasing level for the rest of the image. This is particularly common with backlit subjects, 
where the sky or a window is in the background and the lighting on the foreground is 
insufficient. In these cases, you might want to adjust for the foreground and leave the 
background too bright. 

Chroma peaks are easiest to see on the vectorscope. The theoretical maximum is the circle 
around the outer edge, but to be safe you might like to keep vectors closer to the center than 
the 75% color bar squares. 

Saturated bright or dark colors might have very low or high luma values, together with a lot 
of chroma. Even if neither luma nor chroma alone is excessive, the combination can be 
illegal. For example, vivid yellow and cyan in an image can produce composite levels that 
are too high, and those from vivid blue might be unacceptably low. The YC Waveform is a 
good way to see how far these levels extend. In general, avoid levels above approximately 
120 IRE or 850 mV, and those below –20 IRE or –200 mV. 

n If you are producing a master for broadcast delivery, ask for delivery specifications. To 
ensure you meet particular standards, use a legalizer such as the Safe Color Limiter effect or 
a third-party AVX™ plug-in.

These instruments do not measure analog outputs. If your Avid editing system or other 
device uses analog connections, use an external Waveform monitor to verify levels.

The Y Waveform, YC Waveform, and RGB Parade displays incorporate any safe color limits 
you have set. The following table describes the colors used to represent various conditions. 
“Legal” means the value is within the safe color limits. “Illegal” means the value is outside 
(either above or below) the safe color limits.

Display Component Value Display Color

Y Waveform Luma Legal Green

Illegal White
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Working with the Safe Color Limiter Effect
In addition to the safe color warning system, you can also limit colors to safe ranges by 
applying the Safe Color Limiter effect. The Safe Color Limiter effect modifies color and 
luminance values in video material to bring the material within the safe color limits you 
define. If you use the Safe Color Limiter effect, you do not have to make manual 
adjustments in the Color Correction tool to ensure that video is within limits.

Understanding the Safe Color Limiter Effect

The Safe Color Limiter effect has effect parameters that control high and low color limits for 
luminance, composite signal, and red, green, and blue color gamut. It also allows you to 
change the units with which these limits are measured. These parameters parallel the options 
available in the Safe Color settings.

When you first apply a Safe Color Limiter effect, its parameters default to the current limits 
in the Safe Color settings. In the simplest situation, therefore, you can set limits in the Safe 
Color settings that meet your needs (for example, luminance or composite signal standards 
set by a broadcaster), and then apply the Safe Color Limiter effect to the video material you 
need to limit. Without any further adjustment, the effect modifies the color and luminance 

YC Waveform Composite Legal Cyan

Illegal Yellow

Luma Legal Green

Illegal White

Composite or Luma Outside display boundaries Red

RGB Parade Red Legal Red

Illegal White

Green Legal Green

Illegal White

Blue Legal Blue

Illegal White

Display Component Value Display Color
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values of any pixels in the video material that exceed your limits, ensuring that the video 
meets the required standards. For more information on safe color limit values and possible 
reasons for using them, see “Overview of Safe Color Limits” on page 325.

When you want to make adjustments to the safe color limits that a Safe Color Limiter effect 
is using, you do so using parameter controls in the Effect Editor. You can also view an 
analysis of the image in the Source monitor that makes it easy to see exactly which pixel 
areas in an image are outside the limits set for the effect. For more information, see “Using 
the Safe Color Limiter Analysis Display” on page 335.

The following information provides important additional details on how the Safe Color 
Limiter effect operates:

• The Safe Color Limiter automatically takes variations in broadcast formats into account, 
for example the differences between PAL and NTSC material, and the difference in the 
setup offset between NTSC and NTSC-J.

• Because the primary purpose of safe color limiting is to ensure that video is acceptable 
for SD broadcast, all limiting by the Safe Color Limiter effect is performed in the 601 
color space. When you are working with HD material in the 709 color space, the Safe 
Color Limiter converts the material to the 601 color space to apply limiting, and then 
converts back to the 709 color space. For more information on SD and HD color spaces, 
see “Video Color Space for HD” in the Help.

• Like many other Avid effects, the Safe Color Limiter effect supports both 8-bit and 
16-bit processing. For more information, see “Using 16-bit Processing Support for 
Rendered Effects” in the Help.

Applying the Safe Color Limiter Effect

The Safe Color Limiter effect is a segment effect available from the Image category of the 
Effect Palette. A common scenario for applying the Safe Color Limiter effect is to apply it to 
filler on the top track in the Timeline so that the effect acts on the entire duration of the 
sequence. Depending on your needs, you might also want to apply a Safe Color Limiter 
effect to a single segment in a sequence, or to multiple selected segments.

To apply the Safe Color Limiter effect:

1. Set the default safe color limits you want the Safe Color Limiter effect to use.

For more information, see “Modifying Settings” in the Help and “Safe Color Settings 
Options” on page 326.

2. (Option) If you want to apply the effect across the entire duration of the sequence, add a 
new video track in the Timeline, for example, by selecting Clip > New Video Track.
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3. Do one of the following:

t If you are applying the Safe Color Limiter effect to the entire duration of the 
sequence, drag the effect from the Image category of the Effect Palette, and drop it 
on the empty top video track.

The top video track shows filler material with the Safe Color Limiter effect applied 
to it, and all of the video material in the sequence is limited according to the limit 
values you set in step 1.

t Apply the effect to one or more segments using standard methods, as described in 
“Applying Effects From the Effect Palette” in the Help.

The video in the segment or segments to which you applied the effect is limited 
according to the limit values you set in step 1.

By default, when the Effect Editor is open, the effect changes the display in the Source 
monitor to an analysis mode that highlights pixels in the image that fall outside the 
current safe color limits. For more information on using and understanding this display, 
see “Using the Safe Color Limiter Analysis Display” on page 335.

4. If necessary, enter Effect mode and adjust effect parameters in the Effect Editor.

For more information, see Adjusting Effects in the Help and “Adjusting the Safe Color 
Limiter Effect” on page 335.

Adjusting the Safe Color Limiter Effect

You adjust a Safe Color Limiter effect by changing effect parameter values in the Effect 
Editor. You can adjust the low or high limit values for each limit type (composite, 
luminance, or RGB gamut). You can select the units used to measure the limit values. You 
can also turn the effect analysis display on or off. For reference information on all the Safe 
Color Limiter effect parameters, see “Image: Safe Color Limiter” in the Help.

Using the Safe Color Limiter Analysis Display

An effect analysis display appears by default in the Source monitor when you apply a Safe 
Color Limiter effect. The following illustration shows a typical display.
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The effect analysis display has two layers. The background layer is a copy of the image that 
has luminance reduced to allow the foreground information to stand out clearly. The 
foreground layer highlights those pixels in the image whose color values fall outside the 
limits currently being used by the effect — that is, pixels that are being modified by the 
effect.

The color scheme used for the highlighting is the same as that used for the safe color 
warning indicators that can appear in the monitors in Color Correction mode:

• Yellow: Indicates pixels that fall outside composite limits.

• White: Indicates pixels that fall outside luminance limits.

• Red: Indicates pixels that fall outside RGB gamut limits for red.

• Green: Indicates pixels that fall outside RGB gamut limits for green.

• Blue: Indicates pixels that fall outside RGB gamut limits for blue.

In the illustration above, the pixels highlighted in yellow have color values that fall outside 
the composite limits currently being used by the effect.

When you adjust the limit parameters in the Effect Editor, the analysis display updates. For 
example, if you adjust a limit parameter so that it permits a larger range of values, fewer 
pixels are highlighted in the analysis display.

n If a pixel in the image falls outside current limits for multiple limit types, the analysis display 
uses the color for only one of the types to highlight the pixel. As a result, for example, you 
might adjust the RGB gamut limits so that a pixel no longer has a blue highlight and find 
that the display highlights the pixel using yellow because that pixel is still being limited by 
the composite limits.
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Flatten Correction command (Color Correction 
shortcut menu) 298

Flattening
color-corrected sequences 298
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Font Replacement command (Object menu) 37
Fonts

replacing title fonts 37
Format bin heading 71
Format display in the Project window

described 64
Frame display

controlling in Color correction monitors 152

G
Generating

tracking data 114
Get Info command (Macintosh Finder File menu) 52
GOP (Group of Pictures)

described 78
Gray point adjustments

examples of 224
guidelines for 306

Green tab (Levels group in Color Correction tool) 228
Guidelines

for moving files 25

H
HD

offline SD project formats for 25
HD media

offline formats for 64
transcoding 72

HD Universal Mastering
converting audio 73
described 72
frame rates 72
performing a digital cut 76

HDTV
aspect ratio 56
broadcast graphics workflow 63
film-based workflow 57
supported formats
video-based workflow 61

HDV
capturing 80
capturing through IEEE port 80
changing the project type 88
described 78
exporting to HDV device 83

exporting transport stream 85
finishing on Avid DS Nitris 88
importing 81
Long GOP splicing 83
mixing in Timeline with other resolutions 88
mixing with other resolutions 81
outputting digital cut by transcoding 85
rendering 82
transcoding 82

High-definition television
 See HDTV

Highlights tab (HSL group in Color Correction tool) 
200, 214

Histograms
color correction, display options for 166
described 229
using controls 233

HSL (Hue, Saturation, Luminance) group (Color 
Correction tool) 200

HSL sliders
described 203
making adjustments with 202

Hue Offsets tab (HSL group in Color Correction tool)
ChromaWheel color wheels in 205
described 204
examples of settings for 209
making corrections with 207

I
Importing

HDV transport stream file 80
Input color vectors

adjusting 261
sliders 262

Interaction between color correction groups 161
Interface

for motion tracking 96
Intraframe effects

enabling motion tracking with 104
order of operations with motion tracking 103
using with motion tracking 102

Invert Last Vector feature (Secondary color 
correction)

described 259
examples of images using 274
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Inverting
color vectors 273

IRE units for color correction 166
Isolate feature (Secondary color correction)

described 259
examples of images using 269, 274

Isolated images
examples of 269

Isolating
color vectors in an image 269

ITU-R 709
described 77

L
Levels group (Color Correction tool)

described 222
function compared to Channels group 222

Levels tab (Color Correction tool)
ChromaCurve graphs described 229
examples of adjustments in 235
examples of black point adjustments 224
examples of gray point adjustments 224
histograms, described 229
making corrections in 228
making curve adjustments 234
understanding input and output adjustments in 

224
using histogram controls 233
working with controls in 229

Limitations
motion tracking 93

Locators
controlling frame display in Color Correction 

mode 152
Lock Vectors button (Secondary tab in Color 

Correction tool) 263
Long GOP splicing 83
Luma Ranges graphs

control points on 215
understanding 212

Luma Ranges tab (HSL group in Color Correction 
tool)

adjusting luminance ranges in 214
described 211
three-tone previews in 215
understanding graphs in 212

Luma tab (Levels group in Color Correction tool) 
228, 234

Luminance limits for broadcast 325
Luminance ranges

adjusting 214

M
Macintosh Colors panel

using with Color Match control 191
Macintosh systems

limitations with NTFS drives 52
Mapping

trackers 106, 107
Marks

using with color correction 166
Master tab (HSL group in Color Correction tool) 200
Master tab (Levels group in Color Correction tool) 

228
Masters

delivery requirements 24
Merge Correction command (Color Correction 

shortcut menu) 294
Merging

color-corrected sequences 294
color-corrected sequences, example of 297

Midtones tab (HSL group in Color Correction tool) 
200, 214

Millivolt units for color correction 166
Mixing

SD and HD material 71
Modes

Paint Effect, for spot color correction 323
Modify command

changing sequence format 66
Monitors

16:9 display in Color Correction mode 151
color correction, customizing image display 149
image display in Color Correction mode, 

described 148
reference frame display in Color Correction mode 

149
source menu in Color Correction mode 149

Motion tracking
accuracy of 93
adjusting tracking boxes 109
applying an effect for 103
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changing display color 120
conforming data from Symphony Meridien 

system 140
controls, in Effect Editor 97
controls, in Effect Preview monitor 97
controls, in Tracking window 98
copying and pasting tracking data 139
creating and mapping trackers 107
deleting trackers 108
display of tracking data points 118
displaying tracking boxes 109
editing segments with tracking data 137
effect parameter adjustments with 103
enabling and disabling trackers 108
enabling in the Effect Editor 104
enabling Intraframe effects with 104
establishing an effect offset 103
examples 92, 140
generating data 114
interface, described 96
limitations of 93
limiting Position data to one axis 130
list of available effects and parameters 95
manipulating tracking data points 124
multiple trackers in Tracking parameter 106
offset tracking, overview 115
offset tracking, performing 117
order of adjustments 103
order of operations with Intraframe effects 103
playback of effects 130
preparations for generating tracking data 104
process, described 92
reusing tracking data 138
selecting foreground or background tracking 112
selecting image areas for 110
selecting tracking engine 112
setting tracker reference frames 121
setting up, in Effect Preview monitor 109
setting up, in Tracking window 112
smoothing data 124
smoothing data, overview 122
stopping tracking data generation 114
tracker regions, adding and deleting 116
tracker regions, moving among 117
tracking box positioning guidelines 110
tracking box resizing guidelines 111
tracking engines 113

tracking perspective motion 106
tracking skew motion 106
Tracking window, described 98
understanding tracker creation and mapping 106
using Intraframe effects with 102
video layer requirements for 102
workflow 94

Moving
files, guidelines for 25
settings between systems 46
tracking boxes 109
tracking data points 127

mVolt (millivolt) units for color correction 166

N
NaturalMatch

described 197
example of use 197

New Tracker button (Tracking window) 98
NTFS drives

limitations on Macintosh systems 52

O
Offline editing

SD formats for HD masters 25
Offset tracking

overview 115
performing 117

OMFI MediaFiles folder
transferring media 46

Opening
Tracking window 98

Output
masters, delivery requirements 24

Output color vectors
adjusting 270

P
Paint Effect

Color Match control in 323
making spot color corrections with 323
mode options for spot color correction 323

Perspective
using motion tracking for 106
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Play Loop button
function in Color Correction mode 151

Playback of effects
that use tracking data 130

Point Range menu
brief description 98

Position effect parameter
limiting tracking data to one axis 130
using with motion tracking 95

Program color correction
described 154

Project window
Format display, using 64

Projects
changing formats 64

Q
Quad Display command (Color Correction monitor 

Source menu) 149

R
Red tab (Levels group in Color Correction tool) 228
Reference command (Color Correction monitor 

Source menu) 149
Reference Current command (Color Correction 

shortcut menu) 149
Reference frames

displaying in Color Correction monitors 149
marking with locators in Color Correction mode 

152
Region of interest

adjusting 109
Region Stabilize effect (2D)

described 134
troubleshooting 136
types of stabilization 134

Relationship color corrections
behavior with Color Correction effect templates 

177
converting 157
described 154
using Source Clip Name 156

Remove Color Cast buttons (Color Correction tool) 
188

Remove Correction command (Color Correction 
shortcut menu) 300

Removing
color corrections 300

Removing color casts
guidelines for 307

Replacing
title fonts 37

Resetting
Color Correction tool controls 162

Resizing
tracking boxes 109

Restorative color correction guidelines 304
Reusing

tracking data 138
Reviewing

color-corrected clips 152
RGB gamut limit type

described 325
RGB Histogram command (Color Correction monitor 

Source menu) 149
RGB Histogram display (Color Correction monitors) 

277
RGB Parade command (Color Correction monitor 

Source menu) 149
RGB Parade display (Color Correction monitors) 277
RGB values

displaying with the Color Match control 199
Rotation effect parameter

using with motion tracking 95

S
Safe Color Limiter effect

adjusting 335
analysis display 335
applying 334
described 333

Safe Colors
adjusting color to achieve safe limits 330
graphical view of settings 327
overview 325
setting options for 326
understanding warnings 329
warnings in the Color Match control 330

Safe Colors button (Color Correction tool) 326
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Saving
color correction effect templates to buckets 174

Scaling effect parameter
using with motion tracking 95

SD, mixing with other resolutions 81
Secondary color correction

Add to Selection button 268
avoiding false color changes while demoing 263
Color Match control, using for 271
Color Selection buttons 266
enabling color vectors 260
examples of softness adjustments 264
Invert Last Vector feature 259
Isolate feature 259
overview 251
resetting color vectors 261
Selected Vectors panel 259
selecting color vectors 260
Softness 262
Subtract from Selection button 268
Syringe button 267
vectors, described 253
workflow 252

Segment mode
editing segments using tracking data 137

Selected Vectors panel (Secondary tab in Color 
Correction tool)

color swatch update behavior 259
described 259

Selecting
correction type in Color Correction tool 154
tracking data points 125

Sequences
flattening color-corrected 298
merging color-corrected 294
removing color corrections from 300
updating color-corrected 292

Settings
moving between systems 46

Shadows tab (HSL group in Color Correction tool) 
200, 214

Site settings
moving between systems 46

Skew
using motion tracking for 106

Smooth Selected Points button (Tracking window) 98

Smoothing tracking data
overview 122

Softness
examples of adjustments in secondary color 

correction 264
Sound Designer II audio

support for 45
transferring 45

Source Clip Name relationship (Color Correction) 
156

Source color correction
described 154

Source menu (Color Correction monitors) 149
Spot Color Correction effect

described 321
making corrections with 323

Stabilization
brief description 92
overview 131
using multiple trackers with 133

Stabilizing an image
See also Region Stabilize effect
using Region Stabilize 134

Stabilizing images 132, 134
Stages of typical color correction 305
Standard color vectors 253
Standard definition television (SDTV)
Starting

tracking data generation 114
SteadyGlide

overview 122
using to smooth tracking data 124

Stopping
tracking data generation 114

Stretch Points Mode button (Tracking window) 98
Stretching

tracking data points 128
Substituting

title fonts 37
Subtract from Selection button (Secondary tab in 

Color Correction tool) 268
Symphony

conforming tracking data from Meridien systems 
140
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Symphony Meridien systems
conforming color correction sequences 40

Syringe button (Secondary tab in Color Correction 
tool) 267, 271

T
Tab buttons

accessing Color Correction tool tabs with 160
Tabs

Channels (Color Correction tool) 218
Color Correction tool, described 158
Color Correction tool, displaying 159
Composite (Levels group in Color Correction 

tool) 228, 234
Controls (HSL group in Color Correction tool) 

200
Highlights (HSL group in Color Correction tool) 

200, 214
Hue Offsets (HSL group in Color Correction tool) 

204
Luma (Levels group in Color Correction tool) 

228, 234
Luma Ranges (HSL group in Color Correction 

tool) 211
Master (HSL group in Color Correction tool) 200
Master (Levels group in Color Correction tool) 

228
Midtones (HSL group in Color Correction tool) 

200, 214
Red, Green, and Blue (Levels group in Color 

Correction tool) 228
Shadows (HSL group in Color Correction tool) 

200, 214
Templates

color correction, applying 176
color correction, described 171
color correction, save behavior for 172

Three-tone previews
examples of 215
Luma Ranges tab 215

Timeline
color correction information, described 178
displaying color correction information 178
for tracker information 98
mixing HDV with other resolutions in 88

mixing resolutions in 81
tracking data in 118

Tonal range
automatic color correction of 187
guidelines for correcting 306

Total Conform 23
Tracker Close button (Tracking window) 98
Tracker Color box

described 98
Tracker Name text box

described 98
using 107

Tracker regions
adding and deleting 116
moving among 117

Tracker timelines
described 98
understanding display 118

Trackers
defined 92
deleting 108
enabling and disabling 108
number required for stabilization 133
number required for tracking 92, 106

Tracking boxes
adjusting 109
displaying 109
guidelines, for positioning 110
guidelines, for resizing 111
moving or resizing 109

Tracking button (Tracking window) 98
Tracking data

changing display color 120
conforming from Symphony Meridien systems 

140
copying and pasting 139
enabling, in Effect Editor 104
in Effect Preview monitor 118
in Tracker timeline 118
overview 113
preparing to generate 104
reusing 139
smoothing 124
starting to generate 114
stopping generation 114
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Tracking data points
deleting 126
display in Effect Preview monitor 118
display of flashing points for current frame 118, 

120
locators in tracking boxes 109
moving 127
options for manipulating described 124
selecting 125
setting display range 120
stretching 128

Tracking effect parameter
described 95
multiple trackers in 106

Tracking engines
described 113
selecting 112

Tracking window
controls, described 98
described 98
enabling and disabling trackers in 108
generating tracking data 114
opening 98
selecting foreground or background tracking 112
selecting tracking engine 112
setting up tracking in 112

Transcoding HDV 82
Transferring

audio files to Digidesign Pro Tools 44
files, reference of devices and methods 48
projects between systems 46
settings between systems 46
Sound Designer II audio files 45

Transport stream
creating 83

Trimming
segments with tracking data 137

Troubleshooting
Region Stabilize effect 134

Two-field media
safe color warnings with 329

U
Units of measurement

defining for Color Correction tool 166
Unity

See Avid Unity
Universal Mastering

 See also HD Universal Mastering
HD sequences 72

Update Correction command (Color Correction 
shortcut menu) 292

Updating
color-corrected sequences 292

Use Tracking button (Effect Editor) 104

V
Vectors

See Color vectors
Vectorscope command (Color Correction monitor 

Source menu) 149
Vectorscope display (Color Correction monitors) 

276, 277
Vectorscope monitors (Color Correction)

using to achieve safe color limits 331
Vectorscope monitors (Color correction)

described 276, 277
guidelines for use 284

Video layers
locating and using with motion tracking 102

W
Warnings

safe color 329
safe color, in Color Match control 330

Waveform commands (Color Correction monitor 
Source menu) 149

Waveform display (Color Correction monitors) 276, 
277

Waveform monitors (Color Correction)
using to achieve safe color limits 331
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Waveform monitors (Color correction)
described 276, 277
guidelines for use 284

White point adjustments
guidelines for 306

Windows Color dialog box
using with Color Match control 191

Workflows
color correction 181
conforming and transferring projects 30
film-based HDTV 57
graphics for HDTV 63
motion tracking 94
secondary color correction 252
video-based HDTV 61

X
X Only button (Effect Editor Position parameter) 130

Y
Y Only button (Effect Editor Position parameter) 130
Y Waveform command (Color Correction monitor 

Source menu) 149
Y Waveform display (Color Correction monitors) 

277
YC Waveform command (Color Correction monitor 

Source menu) 149
YC Waveform display (Color Correction monitors) 

277
YCbCr Histogram command (Color Correction 

monitor Source menu) 149
YCbCr Histogram display (Color Correction 

monitors) 277
YCbCr Parade command (Color Correction monitor 

Source menu) 149
YCbCr Parade display (Color Correction monitors) 

277
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